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I Introduction to R-Studio for Mac

R-Studio is a family of powerful and cost-effective undelete and data recovery software. Empowered by new
unique data recovery technologies, it is the most comprehensive data recovery solution for recovering files from
from FAT12/16/32, NTFS, exFAT, NTFS5 (created or updated by Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10),

ReFS (Resilient File System, a new local file system Microsoft has introduced in its Windows 2012 Server),
HFS/HFS+ and APFS (Macintosh), Little and Big Endian variants of UFS1/UFS2 (FreeBSD/?OpenBSD/?NetBSD/?

Solaris), Ext2/3/4FS (Linux), and XFS partitions. It functions on local and network disks, even if such partitions are
formatted, damaged or deleted. Flexible parameter settings give you absolute control over the data recovery.

R-Studio Features
System Requirements
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs
Data Recovery over Network
R-Studio Technician/T80+
Text/Hexadecimal Editor
Technical Information and Troubleshooting
Working with the Third-Party Hardware
R-Studio Emergency
R-Studio Agent Emergency

Window s 9x/?ME/?NT4.0/Window s 2000, XP, Vista, 7,8/8.1, 10, 11, Window s Server 2003, 2008, 2012, 2016, 2019, 2022 are registered

trademarks of Microsoft Corporation.

Mac OS X, OS X, and macOS are registered trademarks of Apple Inc.

All other trademarks are the property of their respective ow ners.

1.1 R-Studio Features

R-Studio is a family of file restoring utilities. It recovers files both on local disks, even if their partition structures
are damaged. A unique IntelligentScan technology and flexible parameter settings give you real control over the
fastest data recovery ever seen.

R-Studio features:

· Host operating systems: macOS Big Sur (11.4), macOS High Sierra (10.13), macOS Sierra (10.12), OS X
El Capitan (10.11), Yosemite (10.10), Mavericks (10.9), Mountain Lion (10.8), Lion (10.7), Snow
Leopard (10.6), Leopard(10.5), Mac OS Server 10.5 Tiger, Mac OS 10.5 Leopard, macOS Server 5.5-
5.0, OS X 10.10 (Yosemite Server 4.0), Mac OS X 10.9 (Mavericks Server), 10.8 (Mountain Lion
Server), 10.7 (Lion Server), Mac OS X Server 10.6 (Snow Leopard Server) and Mac OS X Server 10.5
(Leopard Server running on a computer with Intel, PowerPC G5 or PowerPC G4 processors.

· Automatic check for updates.
· Remotely recovers data over network. Data can be recovered on network computers running Windows,

macOS, Linux, and some other UNIX OS.

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Partition.html
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· Supported file systems:
macOS: HFS, HFS+, HFSX, APFS, FAT/exFAT;
Windows: FAT12/16/32, exFAT, NTFS, NTFS5, ReFS/ReFS2+ file (Resilient File System);
Linux and UNIX: Ext2/3/4FS and XFS (created by Linux or other OS), and UFS1/UFS2, UFS BigEndian

(used by the FreeBSD, OpenBSD, and NetBSD operating systems);
CD/DVD/Images: ISO9660;
Magnetic tape devices: UStar/Tar/CPIO/Pax  (R-Studio Technician/T80+).
Please note, that when a file is being deleted on the HFS, HFS+, HFSX file systems, the computer
completely removes all system information on it, and there is no way to recover the deleted file except by
using the Extra Search for Known File Types option. Nevertheless,  R-Studio is able to read existing files
from HFS, HFS+, and HFSX disks.

· Full access to the system disk even when the Apple's System Integrity Protection is enabled.
· Support for known file types. R-Studio searches for files with known typical features of their structures

allowing the user to search for files on devices with unknown files systems, including an HD, CD, DVD,
floppy disk, Compact Flash Card, USB drive, ZIP drive, Memory Sticks, and other removable media.

· Scan process visualization. While scanning an object, R-Studio graphically shows items that have been
found, including files of known types, FAT and NTFS MFT records, boot records, etc.

· Mass file recovery support.
· Support for estimation of chances for successful recovery.
· Support for file recovery lists - lists of files that can be exported from R-Studio, manually edited, and then

loaded back. Files from such lists will be automatically marked for recovery. 
· APM, Basic and GPT support. R-Studio supports all three partition schemes used to define the low-level

organization of data on disks formatted for use with Macintosh computers.
· Dynamic disk support.
· Support for software Apple software RAIDs
· Support for Apple CoreStorage/FileVault/Fusion Drive Volumes
· Support for BitLocker Drive Encryption encryption, both for the ToGo and System Drive Encryption

methods.
· Software RAID, volume set, and stripe set support. Support for RAID 6, RAID 5, and RAID 4 layouts.

Support for custom RAID layouts. Parameters like block size and order, offsets, and even the number of
stripe blocks can be explicitly specified. Custom RAID configurations can be saved.

· Support for Windows Storage Spaces, created by Windows 8/8.1 and Windows 10/Threshold
2/Anniversary/Fall Creators updates.

· Support for Linux mdadm Volumes
· Support for Linux LVM/LVM2
· Support for Intel Software RAID.
· RAID consistency check (check for valid data parity values).
· Hardware RAID, volume set, and stripe set support.
· Automatic RAID parameter recognition.
· Reverse RAIDs: A technique that decomposes real disk objects into virtual RAIDs. Then those components

of reverse RAID scan be processed like real objects. They can be viewed, edited, imaged, copied to
physical drives, etc. This technique also can re-construct data on the real parents of a virtual RAID. For
example, it becomes possible to re-construct data on a missing disk.

https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-system-disk.html
https://www.r-studio.com/What-is-Raw-File-Recovery.html
https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-disk-format.html
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· Virtual objects can be connected to the host system as read-only virtual drives. They can remain connected
even then R-Studio has been closed.

· Creates image files for an entire drive, logical disk, or its part. Such image files can be processed like regular
drives.  In addition to simple exact object copies (Plain images) and R-Drive Image compatible images. It
can create other disk image and virtual disk formats, together with opening several file formats "read-only".
You may read more about those formats and their properties on the Supported Virtual Disk and Disk Image
Formats page. Images may be saved either on the local or remote computer. Image creation can be stopped
and then resumed. R-Studio can scan objects while creating their images. R-Studio Technician/T80+
supports multi-pass and runtime imaging. Images can be mounted in the operating system as devices which
makes their content accessible to any program including any other data recovery software.

· Recovers files on damaged or deleted partitions.
· Recovers compressed files (NTFS, NTFS5).
· Recovers encrypted files (NTFS5).
· Recovers alternative data streams (NTFS, NTFS5).
· Support for NTFS deduplication.
· Support for symbolic links. Symbolic link recovery options in the Technician/T80+ version.
· Support for file system journal on the HFS+ and Ext3/4fs file systems.
· Support for soft updates journal on the UFS file system.
· Support for extended attributes on the HFS+, Ext3/4fs, XFS, and UFS file systems.
· Support for compressed files on the HFS+ file system.
· Recognizes localized names.
· Recovered files can be saved on any (including network) disks visible by the host operating system.
· A hexadecimal disk and file editor supporting NTFS file non-resident attribute editing. Data alteration is

available on the Technician/T80+ and Corporate versions only.
· Patterns (or templates) in the hexadecimal editor allowing for parsing the data according to specific data

structure. Such patterns may be custom-created.
· File previewer to estimate recovery chances. It shows picture tiles and first frames of video files as icons, and

supports a large number of video/audio/graphic/document file formats. These files can be played back
without their respective applications installed.

· Enhanced remote host scanning procedure. In the new R-Studio network versions, data are analyzed on the
remote host rather than on the home host, thereby the speed of recovery procedure greatly increases.

· Recovered files may be saved on a disk on a connected remote computer rather than be transferred over
network to the local one. Saving recovered files on a remote computer may be useful when the remote
computer has a healthy disk because you do not have to transfer files over network. It may be an external
USB hard drive, for example.

· Support for S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) attribute monitoring.
· R-Studio Emergency*. The R-Studio Emergency version starts from a floppy or compact disk when it is

necessary to recover data on a computer, on which Windows cannot start up because its system files are
corrupted or deleted.

*The R-Studio Emergency is a part of the R-Studio software package. When you buy an R-Studio single
license you may run the R-Studio Emergency or/and install the R-Studio Windows version on one PC only
and you may not transfer the licensed software to another PC. 

https://www.r-studio.com/What-is-Disk-Image.html
http://www.drive-image.com/
https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-is-SMART.html
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R-Studio features available in the Technician/T80+ versions:

· Magnetic tape devices file system: UStar/Tar/CPIO/Pax.
· Multitasking. Several data recovery tasks can be run simultaneously.
· Additional Recovery Options
· Hidden Devices. Some unnecessary device can be hidden in the Main panel.
· Extended file information 
· Symbolic link recovery options
· Drive Copy Wizard to copy any object in the Drives panel to any other object. In addition to byte to byte

copy of any object visible in the Drives panel, smart copy of partitions and drives is available.
· I/O Monitor and Sector Map files.
· Multi-pass and Runtime imaging
· Reverse RAIDs: A technique that decomposes real drive objects into virtual RAIDs. Then those components

of reverse RAID scan be processed like real objects. They can be viewed, edited, imaged, copied to
physical

· Support for third-party hardware.
· Forensic mode.
· File recovery over Internet.

R-Studio recovers files:

· That have been removed without Trash, or when Trash has been emptied;
· Removed by virus attack or power failure;
· After the partition with the files was reformatted, even for different file system;
· When the partition structure on a hard drive was changed or damaged. In this case, R-Studio can scan the

drive trying to find previously existed partitions and recover files from found partitions.
· From disks with bad sectors. In this case, R-Studio can first copy the entire disk or its part into an image file

and then process such image file.

R-Studio can create image files for an entire hard drive, logical disk, or its part. Such image files can be
processed like regular disks. Images are very useful if there is a risk of total data loss due to hardware
malfunction. If bad blocks are constantly appearing on a hard drive, the only way to save the data is to
immediately create an image of that drive. All data search, scan and recovery can be done from this image.

To learn more about the IntelligentScan technology, go to the IntelligentScan topic .

1.2 System Requirements

· A Mac computer with Apple Silicon, Intel, PowerPC G5 or PowerPC G4 processors.
· At least 256 MB of RAM, a mouse, and enough disk space for recovered files, image files, etc.
· macOS 12 Monterey, macOS 11 Big Sur, macOS 10.15 Catalina, macOS Mojave (10.14), macOS High

Sierra (10.13), macOS Sierra (10.12), OS X El Capitan (10.11), OS X Yosemite (10.10), Mavericks
(10.9), OS X Mountain Lion (10.8), Mac OS X Lion (10.7), Mac OS X Snow Leopard (10.6).

· The administrative privileges are required to install and run R-Studio for Mac.
· A network connection for data recovering over network. 

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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1.3 Contact Information and Technical Support

To obtain the latest version of R-Studio, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

Many specific data recovery cases are discussed in the R-TT's Data Recovery Guide.

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average response
time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/SupportRequest.shtml 

File Recovery FAQ: http://www.r-tt.com/File_Recovery_FAQ.shtml

R-TT Forum: http://forum.r-tt.com

1.4 R-Studio Main Panel

When R-Studio starts, its main panel appears on the desktop.
R-Studio Main panel

http://www.r-tt.com
mailto:sales@r-tt.com
http://www.r-studio.com/Data_Recovery_Guide.shtml
mailto:support@r-tt.com
http://www.r-tt.com/SupportRequest.shtml
http://www.r-tt.com/File_Recovery_FAQ.shtml
http://forum.r-tt.com
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Drives panel:

You can select an object by clicking on it.

Properties tab:

This tab shows the properties of an object selected on the Drives panel.

Depending on the selected object, information on this Properties tab may vary.

The Properties tab names and values are described in detail on the Properties tab topic.

Log panel

S.M.A.R.T. Info for a Hard Drive

When a hard drive is selected on the R-Studio main panel, an additional S.M.A.R.T. tab will appear. You may
view the hardware conditions of the drive and copy all S.M.A.R.T. attributes to paste them into a text editor. . 

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a technology widely-used in hard drives
and solid-state devices that monitors their reliability conditions to predict possible hardware failures. 

http://en.wikipedia.org/wiki/S.M.A.R.T.
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S.M.A.R.T. panel

R-Studio shows hard drive S.M.A.R.T. states using their icons. 

Hard drive S.M.A.R.T. states and icons

Normal: This state indicates that the hard drive is in
good conditions. 

Warning: This state indicates that some small
problems with the disk are possible in the future,
you may work with it but with cautions and regular
check of these parameters. Disk imaging is strongly
recommended.

Critical: This state indicates that the hard drive
conditions are critical and chances of hardware
failure are great. The best recommendation for this
case is to stop working with the disk and bring it to
professional data recovery specialists. You may
though continue to work with the disk at your own
risk, but disk imaging is very strongly
recommended.

When a hard drive is selected on the R-Studio main panel, an additional S.M.A.R.T. tab will appear. You may
view the detailed S.M.A.R.T. data of the drive.  

S.M.A.R.T. (Self-Monitoring, Analysis and Reporting Technology) is a technology widely-used in hard drives
and solid-state devices that monitors their reliability conditions to predict possible hardware failures. 

https://www.r-studio.com/What-is-SMART.html
http://en.wikipedia.org/wiki/S.M.A.R.T.


R-Studio for Mac Manual8

© 2024 R-Tools Technology Inc.

Changing the program language

You may select the language of R-Studio main panel. To do so, select an available language on Change

Language on the Help menu

Panel view options

You may set which panels and bars to enable/disable.
To enable/disable:

Toolbar Select/clear Toolbar on the View menu

Toolbar Button Text Select/clear Toolbar Button Text on the View menu

Status bar Select/clear Status bar on the View menu

Device pane Select/clear Device View on the View menu

Properties pane Select/clear Properties View on the View menu

The Log panel Select/clear Event Log on the View menu

Search results Select/clear Find results on the View menu

If you have several tabs in the right pane, you may easily switch to any of the tab by selecting the View menu

Properties Tab to view the Properties tab

Scan Information
Tab

to view the Scan Information Tab tab

Parents Tab to view the Parents tab

Properties Select data types in which the data will be represented

Connect To Remote

Click this button to connect to a remote computer on a
network.

Refresh

Click this button to refresh the panels.

Scan

Click this button to start scanning a selected object.

Partition Search

Click this button to start fast searching for lost and deleted
partitonsi.

Show Files

Click this button to start enumerating files on a selected
object.

Open Image

Click this button to open a previously created
image.
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Create Image

Click this button to create an image of a selected
area.

Create Region

Click this button to create a region on a selected
disk.

Create Virtual RAIDs

Click this button to create a virtual volume set or RAIDS.

Select an appropriate type from the menu.

Remove

Click this button to remove a selected object on the main
panel.

Sometimes, there may be a lot of similar objects on the Drives panel. Those may be components of a RAID, for
example. You may turn numerical indexes for such objects to distinguish them better. Those indexes will appear
before the object names on the Drives panel.

To turn the numerical indexes on/off, go to the Device item on the View menu, and select/clear:

Show Physical Drives Indexes to display the indexes only for hard drives
Show All Objects Indexes to display the indexes for all objects on the Drives panel

You may select the units in which object's start and size are displayed

To select the units

1 Select Devices on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
Show as Sectors
Show as Bytes and Sectors
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Depending on the task R-Studio performs, its panel may vary. Those panels are described in appropriate topics.
The Properties tab names and values are described in detail on the Properties tab topic.

The general settings can be set on the Settings dialog box.

You may also copy the object's information displayed on the  Drives panel. Control-click the object on the
necessary column and select Copy Device/Disk, Copy Label, and so on

R-Studio has two operation modes:

File search on a partition (including recently found during disk scan).

In this mode, R-Studio analyzes MFTs on NTFS partitions, FATs on FAT partitions, and SuperBlocks on
Ext2/3/4FS partitions. Then it displays all files which records have been found in the analyzed tables. Then
recently deleted files, which records still remain, can be recovered. If files have not been found, that means that
their records have been deleted. In this case, the disk must be scanned.

File search supports file masks and regular expressions. Multiple files in different folders can be found and
recovered in one recover session.

R-Studio supports mass file recovery. There is no limit in the number of files that may be recovered during one
session.

File content may be previewed before recovery. 

File or disk binary data can be viewed and edited in the text/hexadecimal editor. Also can be viewed and
changed all attributes for NTFS files. 

Disk scan, searching for partitions.

In this mode, R-Studio scans the entire disk or its part. Using a number of statistic and deterministic criteria
known as the IntelligentScan technology, it determines existing or existed partitions on the disk, and their file
systems. It is also possible to add new partition, by setting manually all required parameters.

A disk can be scanned through several successive scans, each with its own parameters. R-Studio accumulates
the information from successive scans and keeps track of changes in the information obtained from different
scans. The information obtained from the disc scan can be stored in a file. It may be loaded and processed
later at any convenient time.

1.5 R-Studio Settings

You may specify some global setting for R-Studio on the Settings dialog box. You may reach it by selecting
Preferences on the R-Studio menu.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-a-File-System.html
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Main 

Main dialog box

Main settings

System Options

Auto-refresh Drive Tree

If this box is selected, R-Studio automatically refreshes the list of
connected drives. You may disable it if R-Studio experiences
problems with connected devices.

Debug Mode

If this check box is selected, R-Studio for Linux displays an
additional command Create FS Snapshot on the shortcut menu for
an object with a file system. An FS Snapshot contains system data
for the file system only (file descriptions without file contents). If a
problem appears, this snapshot can be sent to R-Studio technical
support to identify the problem. This option greatly slows R-Studio. 

Enable forensic mode (demo)
If this check box is selected, R-Studio turns on the Forensic mode
in demo mode.

Check for update
If this box is selected, R-Studio will automatically check for
updates.

Edit options

Enable Write

If this check box is selected, R-Studio Technician/T80+ enables
you to write any changes made in the Text/?hexadecimal editor. It
enables wiping objects in R-Studio and R-Studio Corporate.

Max changes buffer size
Maximum amount of data stored for the Undo command in the
Text/?hexadecimal editor. R-Studio Technician(/T80+)

User paths

File types 
Specifies a file name and path to the file where the descriptions of
user's known file types are stored. You need to re-start R-Studio or

https://www.r-studio.com/What-is-a-File-System.html
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click the Reload User's File Types button on the Known File Types tab
for the new file to take effect.

RAID layout presets
Specifies a file name and path to the file where the descriptions of
user's RAID layouts are stored

Text/?hexadecimal editor
templates

Specifies the path for pattern description files for Text/?hexadecimal
editor.

Mask presets Specifies a file name and path to the file with file mask presets.

Reset all hidden notifications
This button enables all previously disabled notification and warning
messages.

File Systems

File Systems dialog box

File Systems settings

Default encoding for HFS volumes

Encoding Select the national encoding for the HFS partitions.

Default encoding for Ext2/?Ext3/?
Ext4/?UFS volumes

Encoding
Select the national encoding for the Ext2, Ext3, Ext4, and UFS
partitions.

File system sorting

Disable any sorting
Select this option if the number of files on the drive is so large that
R-Studio sorts files in selected folders for too long time.

Advanced file system interpretation

Minimize drive access

Select this option if a lot of bad sectors are on the drive. R-Studio
will reduce access to internal files in the file system to speed up the
interpretation of file system data.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-are-Bad-Sectors.html


Introduction to R-Studio for Mac 13

© 2024 R-Tools Technology Inc.

Show deleted empty folders Select this option if you want to view empty deleted folders.

Symbolic Links

All settings are available in the Technician/T80+ version only!

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

Symbolic Links dialog box

Symbolic Links

Link conversion (Default) 

Both an object and its symbolic link
are selected for recovery:

If both an object and its symbolic link are selected for recovery,
both the object and its symbolic link will be recovered. The file
path in that symbolic link will be converted from absolute to
relative. Example: If the object C:\ProgramData\Documents is
a symbolic link to C:\Users\Public\Documents, it will be
converted to a symbolic link to ..\Users\Public\Documents.
Therefore, the symbolic link will point to its object regardless of
the place to which the object has been recovered.

Only an object is selected for
recovery:

Only the selected object will be recovered.

Only a symbolic link is selected for
recovery:

The selected symbolic link will be recovered as a real object.

The Data Recovery Topics topic explains processing of symbolic links recovery in more detail.

https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Log 

Log dialog box

 Log options

Maximum
messages in the
Event Log

Specifies the number of messages stored in the log file

Logging

Save log to file If this checkbox is selected, R-Studio writes its log into a log file specified in the File

name field.

File name Specifies the file name of the log file. If that file already exists, the data will be appended to
that file.

Type

Files If this checkbox is selected, R-Studio logs all events with files.

File System If this checkbox is selected, R-Studio logs all events with the file system.

Partition If this checkbox is selected, R-Studio logs all events with FAT.

Recover If this checkbox is selected, R-Studio logs all events with the recovering processes.

Disk If this checkbox is selected, R-Studio logs all events with disks.

Network If this checkbox is selected, R-Studio logs all events with network operation.

Severity

Error If this checkbox is selected, R-Studio adds error messages into its log.

Warning If this checkbox is selected, R-Studio adds warning messages into its log.

Information If this checkbox is selected, R-Studio adds information messages into its log.

Success If this checkbox is selected,, R-Studio adds success messages into its log.

NEVER WRITE A LOG FILE ON THE DISK FROM WHICH YOU RECOVER DATA!!!
Or you may obtain unpredictable results and lose all your data.

https://www.r-studio.com/What-is-FAT.html
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Note: If in the Recover dialog box the Condense successful restoration events check box is selected, the
Log will display only Error, Warning, and Information event messages.

Known File Types 

Known File Types dialog box

You may specify which Known File Types will be enabled/disabled by default. You may also specify know
file types to search for during a specific scan session on the Scan dialog box.

Known File Types

Reset Click this button to reset the settings to the previous state. Active until the Apply

button is clicked.

Select All Click this button to select all file types in the list.

Clear All Click this button to clear all file types in the list except some predefined ones.

Reload User's File
Types

Click this button to apply new file types after the user's file types file has been
changes from the Main tab.

Edit User's File
Types

Click this button to add a new customer's Known File Type, or to edit already
existing ones. See the Customizing File Types help page for more details

Reset to
Recommended

Click this button to reset the settings to the default (Recommended) file set.

https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-Raw-File-Recovery.html
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Bad Sectors 

Bad Sectors dialog box

Bad Sectors settings

Default read retries count Specifies how many times R-Studio will try to read a bad sector. You may
specify this parameter for each drive separately on the Properties tab.
R-Studio treats bad sectors in the following way:
It reads a certain part of disk (predefined by Windows) and
· If Default read retries is set to 0, the entire part with bad sectors will be filled

with the specified pattern. 
· If Default read retries is set to a non-zero value, R-Studio reads again that

part sector by sector, repeating the attempts the specified number of times.
If R-Studio still cannot read a bad sector, it fills the sectors with the
specified pattern. In this case only the bad sectors will be filled with the
pattern, but that extremely slows the disk read process.

For example, if you set Default read retries to 1, a bad sector will be read 2
times.

Set default read retries
count for all drives

Select this option to set Default read retries count for all drives to this value.

Pattern to fill bad blocks Specifies a pattern R-Studio will use to fill bad sectors in files to recover, in
images, or when showing data in the Text/Hexadecimal Editor. You may
specify the pattern either in the ANSI or Hex data format.
Note: R-Studio will never ever try to write anything on the disk from which
data is to recover or an image is to create. 

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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Memory Usage

Memory Usage dialog box

These settings control how much memory R-Studio uses for its work. They help preventing R-Studio from
locking when trying to perform very memory-consuming tasks like scanning large disks or processing file
systems with a lot of files.

Memory Usage settings

Disable memory control If this option is selected, the memory control is disabled.

Limit usage of the process
memory by

If this option is selected, R-Studio will automatically stop performing the task
when the amount of used virtual memory reaches the specified value.

Limit usage of the process
memory by

If this option is selected, R-Studio will automatically stop performing the task
when the amount of used physical memory reaches the specified value.

You may see how much memory R-Studio actually uses on the Memory Usage dialog box.
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1.6 High Sierra- Monterey: Running R-Studio for the First Time

When you start R-Studio for the first time on macOS High Sierra - Monterey, a System Extension Blocked

warning message will appear. 

System Extension Blocked message

At the same time R-Studio will throw its own message:

R-Studio Warning Message

If you need access to your system disk, click the Open Security Preferences button on any of the messages, go
to the Security and Privacy preferences, and click the Allow button..

Security and Privacy preferences

R-Studio will start with full access to your system disk. You need to follow this procedure only once, next time
R-Studio will start without these messages.

If you don’t want to unblock R-Studio, click the Exit button on the R-Studio's message. R-Studio will start
and work properly, but without access to the system disk and when you  start R-Studio next time, its message
will appear again. You will be able to unblock the program if needed.

https://www.r-studio.com/What-is-system-disk.html
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1.7 Ventura+: Running R-Studio for the First Time

When you start R-Studio for the first time on a Mac computer with Apple Silicon running under macOS
Ventura, a System Extension Blocked warning message will appear. 

System Extension Blocked message

\

At the same time R-Studio will throw its own message:

R-Studio Warning Message

If you need access to your system disk, click the Open System Preferences button on any of the messages, go
to the Privacy & Security preferences, select App Store and identified developers in the Security section. 

The To enable system extensions, you need to modify your security settings in the Recovery

environment message will appear.
To enable system extensions...

Click the Shutdown button.

Wait until you Mac is completely off and restart it to macOS Recovery Mode.

Loading to macOS Recovery Mode

1. Quickly press the Touch ID button and then quickly hold it until the Loading up startup options message
will appear on the screen.
2. Click Options and then click Continue.

Select Startup Security Utility from the Utilities menu and then click Security Policy...

In Startup Security Utility, select Reduced Security and then Allow user management of kernel extensions

from identified developers.

Click the OK button and then restart your computer.

https://www.r-studio.com/What-is-system-disk.html
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Upon restart, go to the go to the Privacy & Security preferences again and click the Enable System

Extensions... button in the Security section. 
Security

And restart computer.

R-Studio will start with full access to your system disk. You need to follow this procedure only once, next time
R-Studio will start without these messages.

If you don’t want to unblock R-Studio, click the Exit button on the R-Studio's message. R-Studio will start
and work properly, but without access to the system disk and when you  start R-Studio next time, its message
will appear again. You will be able to unblock the program if needed.

II Data Recovery Using R-Studio

File recovery from Apple computers with Secure Enclave.

Due to hardware implementation of data encryption, data recovery from Apple's Secure Enclave is currently
impossible.

Secure Enclave

http://support.apple.com/en-gb/guide/security/sec59b0b31ff/web
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Secure Enclave is used in Intel-based Mac computers that contain the Apple T2 Security Chip and Mac
computers with Apple silicon.

Many specific data recovery cases are discussed in the R-TT's Data Recovery Guide.

Depending on the situation, data recovery may vary:

1. Recovery of deleted files that have resided on an existing logical disk

This can be done using Basic File Recovery.

2. Recovery of files that have resided on a data disk with a damaged file system, or on a previously
deleted or re-formatted partition

If the file system on such logical disk is damaged, the operating system does not see that logical disk as a
partition without a valid file system. Such partition should be previously scanned. Also, it should be scanned if
you want to recover data on a previously deleted or re-formatted partition.

You may use Fast Search for Lost partitions if you want only to find partitions previously existed on the disk.
It's much faster.

When the partition is scanned, a number of recognized partitions will appear. R-Studio shows them in
different colors depending on which elements of the partition have been found.

An existing partition

An existing partition after drive scan

A recognized partition. Both boot records and file entries are found for this partition
A recognized partition. Only file entries are found for this partition
A recognized partition. Only boot records are found for this partition
A fast found partition

Empty space on the object
A deleted partition

Files that have been found using scan for known file types (raw file search).

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

To successfully recover files from a recognized partition, it is necessary to find a right one which corresponds
to the real logical disk on which the files resided. No strict rules can be applied to that, but the following
considerations should be taken into account:

· If you are going to recover files from a disk with a damaged file system, most likely the right recognized
partition will be a green one.

· If you are going to recover files from a previously deleted or re-formatted partition, most likely the
right recognized partition will be a yellow one.

Also always check the recognized partition's file system, start point, and size. They should be the same for
the recognized partition and real logical disk/partition. When in doubt, try to preview a couple of files from
the recognized partition. If the files are seen correctly, this is the right partition.

R-Studio Features
Contact Information and Technical Support
Basic File Recovery
Advanced Data Recovery
Mass File Recovery 

http://www.r-studio.com/Data_Recovery_Guide.shtml
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-File-System.html
https://www.r-studio.com/What-is-disk-format.html
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Volume Sets and RAIDs
Data Recovery over Network
Text/Hexadecimal Editor
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

2.1 Basic File Recovery

`NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data. 

See the Data Recovery Issues topic for details.

Basic file recovery can be made for deleted files that has resided on an existing disk visible by the operating
system. In all other cases, Advanced Data Recovery is required. 

To recover deleted files from a logical disk (recognized partition),

1 Double-click a logical disk on the R-Studio's Drives panel to enumerate files on the disk

 Other ways to enumerate files

· Select the disk and click the Open Drive Files button, 
or
· Control-click the selected disk and select Open Drive Files on the contextual menu, 
or
· Select Open Drive Files on the Drive menu

If you try to enumerate files on a hard drive or another object without a valid file system on it, a Double-click

a logical disk... message will appear. Select a logical disk on the object or scan the object.

2 R-Studio will change its panel showing the disk's folders/files structure

R-Studio analyzes data on the object and displays all files which records have been found in the analyzed
tables. Then deleted files, which records still remain, can be recovered. If files have not been found, that
means that their records have been deleted. To find such files, Advanced Data Recovery is required.

Please note that R-Studio shows only those files/folders that match a specified file mask.

https://www.R-Studio.com/What-is-drive-scan.html
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 R-Studio Main panel

Panel view options

You may set which panels and bars to enable/disable. To enable/disable

The Toolbar Select/clear Toolbar on the View menu

Toolbar Button
Text

Select/clear Toolbar Button Text on the View menu

The Status bar Select/clear Status bar on the View menu

The Folders panel Select/clear Folders View on the View menu

The Files panel Select/clear Contents View on the View menu

The Log panel Select/clear Event Log on the View menu

The Find Results

panel
Select/clear Find Results on the View menu

You may also arrange the data as required. On the View menu, select Arrange and them a required
arrangement.
You may specify which columns will be visible on the Files panel. On the View menu, select Contents

Columns, and select the columns you want to see.
Files can be shown as a list or as icons/tiles of different sizes.

Files shown as icons/tiles
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Recovery chances
R-Studio shows its estimates of chances for successful file recovery in the Rec column. 

Recovery chances

Undefined

Good

Above average

Average

Below average

Bad

When R-Studio has enumerated files, those estimates may not be accurate and aren't available for most
files. You may improved them by control-clicking any folder on the Content pane and selecting Recheck

Recovery Chances on the contextual menu, and specifying required parameters.

.

The best estimations are though after scanning the disk/partition

File Information
You may view some information about a file. Control-click the file and select Get Info on the context menu.

File Information
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R-Studio Technician/T80+ shows much more information about a file. See the Information about a File
topic for more details.

Folders panel

Deleted folder

Marked folder (all child
objects in this folder are
marked)
Partially marked folder
(some child objects in
this folder are marked)
Cross-linked deleted
folder (A FAT folder
containing data which
also belongs to other
FAT folders.)
Target of a symlinked
folder
Symlink to a folder

Questionable deleted
folder (A FAT folder
found by R-Studio, but
with apparently invalid
content.)
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Files panel:

Deleted file:

Marked deleted file

Selected deleted file
Target of a hard link

Hard link to a file

Sorted by:

You may also arrange the data as required: by their extensions,
creation/modification time, or as a real file structure
See Find and Mark Multiple Files for more details

Find Results panel
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Reopen Drive Files

Click this button to list files
again.

Recover

Click this button to recover selected
folders/files.

Recover Marked

Click this button to recover marked
folders/files.

Find

Click this button to find or/and mark a particular file/folder. 

Find Next

Click this button to find the next object specified in the Find/Mark

dialog box.

Find Previous

Click this button to find the previous object specified in the Find/Mark

dialog box.

File Mask

Click this button to specify a file mask.

The Unmask button appears when a mask is
applied. 

Click this button to remove the applied mask.

Up

Click this button to move highlighting one folder
up.

Options

Click this button to change Recovery
Options.
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Details

A button selecting how the files will be shown:
Details, Small, Medium, Large Icons

The Log panel will show how many files and folders are on the object, and their size. You may specify which
events will be shown in the log pane by setting a log filter.

Note: Metafiles are the file system's internal files invisible to any user, or file system data, which R-Studio
represents as files. These files do not contain user data directly. Unless you want to scrutinize a disk file
system, do not restore them.

If the Too many files... message appears, you may temporally stop file listing and browse through found files.
Then you can resume file listing. You also may skip this file topic and continue. R-Studio will keep
information about the entire file structure.

You may also copy the information about folders and files. 

For the folder (the Folders pane):

Click Copy Folder: To copy the folder's name

Click Copy Path: To copy the path to the folder

For the file (the Contents pane):

Click Copy (Column

Name):
To copy the file's Name, Size, Created, etc., depending on which column is
selected

Click Copy Path: To copy the file path.

Click Copy Selected

Text:
To copy all the columns of the selected file.

3 Select a file/folder to recover

You may select several files/folders in the same parent folder by pressing the Shift button and clicking the
objects simultaneously.

 Marking multiple files/folders from different parent folders manually:

Mark a file/folder to recover by clicking the box left to the object, or select Mark on the contextual menu.
You may mark several files/folders in different parent folders. You may mark all objects in the folder by
selecting Mark All on the Tools or contextual menu. To unmark an object, click the box left to the object
once more or select Unmark on the contextual menu. You may unmark all objects in the folder by selecting
Unmark All on the Tools or contextual menu.
The Log panel will show how many files and folders you have marked, and their total size.

R-Studio can search for a particular file. Go to the Searching for a File topic for details. If you need to find
and mark many files, go to the Find and Mark Multiple Files topic for details.

File content may be previewed before recovery. Go to the Previewing Files topic for details.

If you do not find files that you want to recover:
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Sometimes R-Studio can find the files but not the entire file paths to them. It puts such files into the Extra
Found Files folder. Try to search for the files there. If that does not help, try to find them by using file search
globally on the entire disk. Go to the Searching for a File topic for details

If you still cannot find files that you want to recover but are sure they have existed on the logical disk, you
need to use Advanced Data Recovery to find them.

4 Click the Recover or Recover Marked button

 Other ways to recover selected files

· Control-click the selected file/folder and select Recover or Recover Marked on the contextual menu, 
or
· Select Recover or Recover Marked on the File menu

5 Specify recover options and output folder on the Recover dialog box and click the OK button

Recover dialog box

If you have another computer connected to R-Studio over network, the Recover dialog box will be slightly

different. See Data recovery over network for details.

Recover (Advanced) dialog box

 Recover options

Recover all marked files All files, regardless of the applied mask, will be recovered.



R-Studio for Mac Manual30

© 2024 R-Tools Technology Inc.

Recovered only masked marked files Only files matching the applied mask will be recovered.

Condense successful restoration events If this check box is selected, R-Studio will display only error and
warning messages in its Log

Restore folder structure If this check box is selected, R-Studio recovers the entire path to
the selected object.

Restore from root If this check box is selected, R-Studio recovers the entire path to
the selected object starting from the root folder of the disk.

Recover metafiles If this check box is selected, R-Studio recovers disk metafiles.
Metafiles are the file system's internal files invisible to any user, or
file system data, which R-Studio represents as files. These files
do not contain user data directly. Unless you want to scrutinize a
disk file system, do not restore them.

Recover alternative data streams If this check box is selected, R-Studio recovers alternative data
streams for file systems that support them. Has no effect on FAT
files. See Extended Information Recovery for the NTFS file
system, and Data Recovery on HFS/?HFS+ File System for
the Mac computers.

Recover security If this check box is selected, R-Studio recovers security
attributes for NTFS files. Has no effect on FAT files. See
Extended Information Recovery for details.

Recover extended attributes If this check box is selected, R-Studio recovers extended
(HPFS) file attributes.

Recover real folders structure Enabled when the files are sorted by their extensions or date. See
Find and Mark Multiple Files for details. If this check box is
selected, R-Studio recovers the real folders/?files structure on the
disk rather than that of sorted files.

Skip files with bad sectors If this check box is selected, R-Studio skips files with bad
sectors and displays their list on the Files with bad sectors dialog
box when the recovery has been completed. You may separately
decide later what to do with those files. See Bad sectors for
details. 
If this check box is cleared, R-Studio tries to read those sectors
several times (specified on the Settings/?Bad Sectors dialog
box), and, if fails, fills bad sectors in the recovered file with the
pattern specified on the same box. Information about such files
will appear in the Log.

Do not recover duplicate files from
Extra Found Files

If this check box is selected, R-Studio does not recover files
from Extra Found Files (raw files) that coincide with files
recovered from the file system.

Ignore file mask If this check box is selected, R-Studio recovers all content of a
selected folder, ignoring a specified File Mask.

https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-are-alternate-data-streams.html
https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-are-Bad-Sectors.html
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Open local folder (folders) when done If this check box is selected, the folder with recovered files will be
opened upon recovery completion.

Advanced Specifies options for mass file recovery

If you want to recover multiple files at once, go to the Recover Multiple Files for more information

R-Studio Technician/T80+

It has additional Recovery options.

If a file to be recovered appears to have an invalid name, a Broken File Name dialog box will appear. You
may correct the name and resume file recovery.

Broken File Name dialog box

 Broken File Name properties

File name Shows the current incorrect file name.

New name Field for a new file name.

Edit broken symbols only If this check box is selected, only invalid symbols may be
corrected

Change all invalid symbols to If this check box is selected, all invalid symbols will be changed
to the specified symbol

Buttons

Rename Click to resume file recovery

Rename All Click to resume file recovery. All other files will be renamed
according to the specified rule.

Skip Click to skip this file

Skip All Click to skip all files and stop file recovery

If there is no space available for the recovered files, the There is not enough space on the disk dialog box
will appear. You may either select other place to store the files, skip that particular file or abort the recovery
process.

There is not enough space on the disk dialog box

> R-Studio will recover the selected/marked files/folders to the specified folder and show the results in

the Log pane

The Recovery progress indicator will show the log and progress of recovery process.

Recovery progress indicator
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Note: R-Studio recovers files from Ext2/3/4FS partitions, but writes it to FAT or NTFS local disks. Or you
may write such files to network disks. R-Studio successfully recovers files from Ext2/3/4FS partitions except
its security attributes. R-Studio recovers symlinks as files containing the path to files which symlinks point
to.

Opening several partitions in one tab
Searching for a File
Finding Previous File Versions
Previewing Files
File Masks
Regular Expressions
Event Log
2.1.1 Opening several partitions in one tab

You may open several partitions in one tab. Then you may search for files and recover them from several
partitions at once. This is especially useful if files are to be recovered from several recognized partitions found on
one real partition or a drive.

To open several partitions in one tab,

1 Open one partition in a usual way (double-click a partition, for example).

2 Control-click the next partition, select Show Files In Tab, and select the tab you want the partition
appear in, or

drag the partition from the Device view to the required tab.

Several partitions in one tab

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> R-Studio will show files from several partitions in one tab

Several partitions in one tab

Now files may be searched for, marked for recovery, and recovered.

To remove a partition from the tab,

1 Control-click the required partition in the tab and select Close drive in the contextual menu.

Several partitions in one tab

> R-Studio remove the selected partition from the tab

2.1.2 Searching for a File

R-Studio can find a particular file, if it is difficult to find it manually on the Folders or Files panel. You can also
automatically mark all found files.

To search for a file,

1 Click the Find button

 Other ways to search for the file

· Control-click a folder and select Find on the contextual menu, 
or
· Select a folder and select Find on the Tools menu
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2 Specify a file to be found and its options on the Find dialog box, and click the OK button

Note that a File Mask may be applied.

Find/Mark dialog box

 Find/Mark options

You may specify how to treat specified strings. Please note that R-Studio stores previously entered
search strings.

All Files and
Folders

If this option is selected, R-Studio applies Advanced Options to all files.

File Extensions If this option is selected, R-Studio treats specified strings as file extensions

Files and Folders If this option is selected, R-Studio treats specified strings as file names. Use ? for one
unspecified character  and * for an unlimited number of them to specify file masks. 

Regular
Expressions

If this option is selected, R-Studio treats specified strings as regular expressions

File Id Specifies File Id that R-Studio assigns to a file.

Match case If this check box is selected, R-Studio makes a case-sensitive search

Look at

Files If this check box is selected, R-Studio includes files into a search.

Folders If this check box is selected, R-Studio includes folders into a search. Disables when
the Mark/Unmark All option is selected.

Deleted files If this check box is selected, R-Studio makes a search among deleted files/?folders.

Existing files If this check box is selected, R-Studio makes a search among existing files/?folders.

Look in Specifies where R-Studio searches for, and marks, files. It can look for them on the
Entire disk, or in/from a certain folder.
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You may specify the starting folder for the search.

  identifies current opened folder.

  identifies current starting folder for the search.

 sets starting folder to the current opened folder.

 sets back current starting folder.

Advanced options If this check box is selected, R-Studio will use the advanced options. 

Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more details
on data formats.

Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there are
bad sectors in the files. 

Runtime image Specifies whether the files have already been included into the runtime image.

Recovery
Chances

Specifies files with certain recovery chances. 

Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

Find/?Mark options Specify what R-Studio does with the found files. 
The Find first/previous/next/last options. R-Studio stops at the first/previous/next/last
file that matches the specified search criteria.
Find all files. R-Studio searches for all files that matches the specified search criteria..
The search results appear on the Find Results panel.
Mark/Unmark All. R-Studio marks/unmarks all files that match the search criteria. When
these options are selected, R-Studio  marks/unmarks files only, not folders, regardless
of what Look at: Folders specifies.
Please note, that when performing a new find and mark/?unmark task, R-Studio does
not takes into consideration the previous marked/?unmarked state of files. For example,
if you first mark all doc files, and then all txt files, all doc files remain marked, too. To
unmark them, you should specify doc once again and select Unmark files.

Find/mark
objects only in
real paths, ignore
links to folders

If this check box is selected, links to folders will be treated as real folders: they will
appear among search results or marked objects.

> R-Studio will show/mark the found file(s)

If you need to find and mark many files, go to the Find and Mark Multiple Files topic for details.

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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To repeat the search, 

* Click the Find Next or Find Previous buttons

 Other ways to repeat the search

· control-click a folder and select Find Next or Find Previous on the contextual menu
or
· Select a folder and select Find Next or Find Previous on the Tools menu 

To find all files and show them on the Find Results panel, 

* Select Find all on the on the Find dialog box,

or

select Find all on the Tools menu

> R-Studio will show the found files on the Find Results panel

You may do the following actions on the found files:

Recover, Mark, Preview

by control-clicking the found file and selecting the appropriate item in the contextual menu.

2.1.3 Finding Previous File Versions

R-Studio can find previous versions of files. It searches for them in the file's current folder and in Extra Found

Files.

File versions are searched for using file size. If the size of a files is within 10% of the original filesize, the following
conditions are checked: 

Conditions Legend

File name N

File extension E

Recognized file type T
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To search for previous file versions,

1 Control-click the file and select Find Previous Versions of the File on the contextual menu

* R-Studio will show the files in the list:

File versions

This technique can be used to find deleted original files after attacks of file encrypting viruses.

2.1.4 Previewing Files

R-Studio has a built-in file previewer that allows you to preview both existing and deleted files. You may use this
feature to estimate recovery or a file to be recovered. 

Note: If you use a Mac computer with Apple Silicon, you may need to install Rosetta, a special macOS system
component that enables execution of apps built exclusively for Intel-based Mac computers on Apple Silicon. If
this is necessary, a respective dialog prompt will appear automatically the first time you start the previewer.
Follow its instructions and then start the previewer once again. Remember that a working internet connection is
required to download Rosetta.

If this dialog doesn't appear but the previewer doesn't start, you need to install Rosetta manually. Run Terminal,
enter this string: softwareupdate --install-rosetta, and follow the on-line instructions.

While previewing a file in the external viewer, you may recover it or mark the file for recovery using Previewer
buttons.

Previewer buttons

Mark for recovery, Previous file, Next file, Recover

To preview a file

1 Control-click a file to preview on the Files panel and select Preview on the contextual menu



R-Studio for Mac Manual38

© 2024 R-Tools Technology Inc.

 Other ways to preview the file

· Select the file on the Files panel and click the Preview button,
or
· Select the file on the Files panel and select Preview on the File menu

2 R-Studio will show the content of the file

If you have several files open in the previewer, you may instantly close all of them by selecting Close All

Previews on the File menu.

File Previewer for Pictures:

Pictures can be previewed either as tiles within the main window of R-Studio or in an external previewer.

Within the main window as tiles:

Tile size can be changed..

Pictures as tiles

In the external viewer:

Picture files can be zoomed in/out and rotated.

Picture file previewer

File Previewer for Video and Audio files:

Video and audio files can be played even without their respective application installed.
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Video file previewer

File Previewer for Microsoft/Open/Libre Office Documents:

Documents can be shown (including embedded pictures) even without their respective applications installed.
They can be zoomed in/out for better viewing.

Microsoft/Open/Libre Office document previewer

File Previewer for Adobe Acrobat PDF Files:

Files can be shown even without Adobe Acrobat installed.

The previewer allows the users to jump to a required page, zoom the document, and search for a required text.

Adobe Acrobat pdf document previewer
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The files can be shown in different layouts and rotated. Click the View menu and select the required options.

Supported File Types:

Documents:

MS Office and Open/Libre Office files, even without the programs installed: 
· Word/Writer documents: docx;
· Excel/Calc spreadsheets: xlsx;
· PowerPoint presentation: pptx.

Office 97-2003, without the program installed:
· Word documents: doc;
· Excel spreadsheets xls;
· PowerPoint presentation ppt.

Adobe Acrobat document: pdf.

Multimedia Files

Video formats: 
AIFF, ASF, AVI, BFI, CAF, FLV, GIF, GXF, HLS, QuickTime, 3GP, MP4, Matroska, Maxis XA,
MPEG-DASH, MPEG program stream, MPEG transport stream (including AVCHD), MXF, Material
eXchange Format, SMPTE, MSN Webcam stream, NUT, Ogg, OMA, RL2, TXD, WTV.

Audio formats: 
8SVX, AAC, AAC+, AC-3, ADPCM, AMR-NB, AMR-WB, Amazing Studio PAF Audio, Apple
lossless audio, QuickTime, ATRAC, CELT, DCA (DTS Coherent Acoustics), DPCM, DSD (Direct
Stream Digitial), DSP Group TrueSpeech, DST (Direct Stream Transfer), DV audio, FLAC (Free
Lossless Audio Codec), G.723.1, G.729, GSM, IAC (Indeo Audio Coder), iLBC (Internet Low Bitrate
Codec), IMC (Intel Music Coder), Interplay ACM, MACE (Macintosh Audio Compression/Expansion),
MACE (Macintosh Audio Compression/Expansion), MLP (Meridian Lossless Packing), Monkey’s Audio,
MP1 (MPEG audio layer 1), MP2 (MPEG audio layer 2), MP3 (MPEG audio layer 3), MPEG-4 Audio
Lossless Coding (ALS), Musepack SV7/SV8, Nellymoser Asao, AVC (Audio for Video Codec), PCM
A-law/mu-law, QCELP / PureVoice, QDesign Music Codec, RealAudio, Vorbis, Voxware MetaSound,
WavPack, Westwood Audio, Windows Media Audio, Xbox Media Audio

Graphic files (with file extensions)

3DS Max thumbnail (max), AAA logo (bpr), ACE texture (ace), ADEX (img, rle), AIM Grey Scale (ima,
im), AIPD image (aipd), ARF (arf), AT&T Group 4 (att), AT&T multigen (icn), AVHRR Image (sst),
AVT RAW (raw), AWD (awd), Ability Photopaint Image (apx), Access (g4, acc), Aces200 (ace), Acorn
Sprite (acorn), AdTech perfectfax (adt), Adobe Illustrator (ai), Adobe PhotoParade(images) (php), Adobe
Photoshop (psd), Advanced Art Studio (ocp, art, pic), AirNav (anv), Album bébé (frm), Alias Image File
(pix, als, alias), Alpha Microsystems BMP (bmp), Amapi (2d), Amica Paint (ami, [b]), Amiga IFF (iff,
blk), Amiga icon (info), Amstrad Cpc Screen (cpc), Analyze (avw), Analyze-7 (img), Andrew Toolkit
raster object (atk), Apollo HDRU (hdru, hdr, gn), ArcInfo Binary (hdr), Art Director (art), Artisan (art),
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Artist 64 (a64), Artrage (ptg), Artweaver Document (awd), Astronomical Research Network (arn), Atari
grafik (pcp), Aurora (sim), Auto F/X (afx), AutoCAD DWG (dwg, dwt), AutoCAD DXF (dxf), Autocad
CAD-Camera (img), Autodesk Animator (fli, flc), Autodesk QuickCAD thumbnail (cad), Autodesk
SKETCH thumbnail (skf), Autodesk SketchUp component (skp, skb), Autologic (gm, gm2, gm4), Award
Bios Logo (epa), Axialis Screensaver(images) (ssp), B3D(images) (b3d), BFLI (bfl, bfli, fli, flp, afl), BIAS
FringeProcessor (msk, img, raw, flt), BLP textures (blp), BMF (bmf), BSB/KAP (kap), BYU SIR (sir),
Bert's Coloring (bmg, ibg), Bfx Bitware (bfx), Bio-Rad confocal (pic), Blazing Paddles (pi), Bob Raytracer
(bob), Brender (pix), Brooktrout 301 (brk, 301, brt), Brother Fax (uni), Buttonz & Tilez texture (til),
CALS Raster (cal, cals, gp4, mil), CDU Paint (cdu), CGM (cgm), CImage (dsi), CMU Window Manager
(cmu), CP8 256 Gray Scale (cp8), CSV (csv), Calamus (cpi, crg), Camera RAW (raw), Canon EOS-1D
Mark II RAW (cr2), Canon Navigator Fax (can), Canon PowerShot (crw), Cartes Michelin (big), Casio
QV-10/100 Camera (cam), Casio RAW (bay, raw), Chinon ES-1000 digital camera (cmt), Cisco IP
Phone (cip), Cloe Ray-Tracer (clo, cloe), ColoRIX (rix, sci, scx, sc?), CompW (wlm), CompuServe GIF
(gif, giff), Computer Eyes, Digital Vision (ce), ComputerEyes Raw (ce1, ce2), Contax RAW (bay, raw),
Core IDC (idc), Corel Draw Bitmap(preview) (cdr), Corel Draw Pattern(preview) (pat), Corel
Flow(preview) (bmf), Corel Metafile Exchange(preview) (cmx), Corel PhotoPaint 6.0 (cpt),
CoverDesigner(images) (ncd), CoverDesigner Template(images) (nct), Crayola (art), Creative PC-CAM
RAW (bay, raw), DBW Render (), DIV Game Studio Map (map), DIV Game Studio Multi Map (fpg),
DKB Ray-Tracer (dis), DNG (dng), DPX (dpx), Dali Raw (sd0, sd1, sd2), Datacopy (img), Degas &
Degas Elite (pi1, pc1, pi2, pc2, pi3, pc3, pi4, pi5, pi6), Deluxe Paint, Electronic Arts (lbm, ilbm), Dicom
(dcm, acr, dic, dicom, dc3), Digital F/X (tdim), Digital Research(GEM Paint) (img, gem), Direct Draw
Surface (dds), Discorp CMP Image (cmp), DjVu (djvu, djv, iw4), DolphinEd (dol), Doodle Atari (doo),
Doodle C64 (dd), Doodle C64(Compressed) (jj), Dr Halo (cut), Draz Paint (drz), EA Sports FSH (fsh),
EPS Interchange Format (epi, ept), ERI-chan(Entis Rasterized Image) (eri), ESM Software Pix (pix), Ecchi
(ecc), Eclipse (tile), Edmics (c4), Egg Paint (trp), Electric Image (ei, eidi), Embroidery (bmc), Encapsulated
Postscript (ps, eps), Encapsulated Postscript (Preview) (eps), Enhance Simplex (esm), Enhanced
Compressed Wavelet (ecw), Epson RAW (erf), Eroiica (eif), Everex Everfax (efx, ef3), Explore(TDI) &
Maya (iff, tdi), FIF(Iterated System) (fif), FIT (fit), Face Painter (fpt), Fast Piecewise-constant (pwc), Fax
Group 3 (g3, fax), Fax man (fmf), Faxable PCX (fcx), Faxable TIFF (ftf), Fenix Map (map), Fenix Multi
Map (fpg), FileMagic (mag), Flash Image (fi), FlashCam Frame (ncy), FlashPix Format (fpx), Flexible
Image Transport System (fts, fits, fit), Foculus RAW (bay, raw), Fontasy Grafik (bsg), Fremont Fax96
(f96), Fugawi Map (fx3), Fuji S2 RAW (raf), Fun Painter II (fp2, fun), Fun Photor (fpr), Fuzzy bitmap
(fbm, cbm), GRS16 (g16), Gamma Fax (gmf), GeoPaint (geo), Gfa Raytrace (sul), GigaPaint Hi-res (gih),
GigaPaint Multi (gig), Gimp Bitmap (xcf), Gimp Brush (gbr), Gimp Icon (ico), Gimp Pattern (pat), GoDot
(4bt, 4bit, clp), GunPaint (gun, ifl), HD Photo (wdp, hdp), HDRI (hdr, hdri), HF (hf), HP-48/49 GROB
(gro, grb), HP-49 OpenFire (gro2, gro4), HPGL-2 (hp, hpg, hgl, plt, hpgl, hpgl2, gl2, prn, prt, spl), HRU
(hru), HSI Raw (raw), Half-Life Model (mdl), Hasselblad RAW (3fr), Hayes JTFax (jtf), Hemera Photo
Image (hpi), Hemera Thumbs (hta), Heretic II MipMap (m8), Hi-Eddi (hed), Hires C64 (hir, hbm),
Homeworld Texture (lif), IBM Kips (kps), IBM Printer Page Segment (pse), IM5(Visilog) (im5), IMNET
Image (imt), IOCA (ica, ioca, mod), IPLab (ipl), IPod thumb (ithmb), ISS (iss), IcoFX (ifx), Icon Library
(icl), Imacon/Hasselblad RAW (fff), Image Capture Board (icb), Image Magick file (mif, miff), Image
Speeder (ish), Image System(Hires) (ish), Image System(Multicolor) (ism), Image Systems RLC2 Graphic
(rlc), ImageLab (b&w, b_w), ImagePro Sequence (seq), Imaging Fax (g3n), Imaging Technology (img),
Img Software Set (img), Inshape (iim), InterPaint(Hires) (iph), InterPaint(Multicolor) (ipt), Intergraph
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Format (itg, cit, rle), Interleaf (iimg), Iris CT (ct), Iris Graphics (iris), J Wavelet Image Codec (wic), JBIG
(jbg, bie, jbig), JBIG-2 (jb2), JFIF based file (jb2), JPEG / JFIF (jpg, jpeg, jif, jfif, J, jpe), JPEG 8BIM
header(Mac) (jpg, jpeg, jif, jfif, J, jpe), JPEG XR (jxr), JPEG-2000 Code Stream (jpc), JPEG-2000 JP2
File Format (jp2, j2k, jpx, jpf), JPEG-LS (jls), Jeff's Image Format (jif), Jigsaw (jig), Jovian VI (vi), Jpeg
Network Graphics (jng), JustButtons animated bitmap (btn), KONTRON (img), Khoros Visualization
Image file (vif, viff, xv), KinuPix Skin (thb), Kiss Cel (cel), Koala Paint (koa, kla), Koala
Paint(Compressed) (gg), Kodak Cineon (cin), Kodak DC120 Digital Camera (kdc), Kodak DC25
Camera (k25), Kodak Photo CD (pcd), Kodak Pro Digital RAW (dcr), Kofax Group 4 (kfx), Kolor Raw
Format (kro), Konica Camera File (kqp), LSS16 (lss, 16), LView Pro (lvp), LaserData (lda), Leaf RAW
(mos), Leica RAW (bay, raw), Light Work Image (lwi), LucasFilm Format (lff), Lumena CEL (cel),
LuraDocument Format (ldf), LuraDocument.jpm Format (jpm), LuraWave Format (lwf), LuraWave
JPEG-2000 Code Stream (jpc), LuraWave JPEG-2000 Format (jp2, j2k, jpx, jpf), MAKIchan Graphics
(mag), MGI Photosuite Project(images) (pzp), MGR bitmap (mgr), MRC(Medical Research Council)
(mrc), MTV Ray-Tracer (mtv), Mac Paint (mac, mpnt, macp, pntg, pnt, paint), Mac icon (icns), Macintosh
Quickdraw/Pict (pic, pict, pict2, pct), Mac OSX Resource (rsc, rsrc), Maggi Hairstyles & Cosmetics (fff),
Male MRI (pd, t1, t2), Male Normal CT (fre), Mamiya RAW (mef), Marks Russel File (mrf), Mavica
(411), Maw-Ware Textures (mtx), Mayura Draw (pdx), MegaPaint (bld), Megalux Frame (frm), Micro
Dynamics MARS (pbt), Micro Illustrator Uncompressed (mil), Micrografx Picture Publisher 4.0 (pp4),
Micrografx Picture Publisher 5.0 (pp5), Micron RAW (bay, raw), Microsoft Image Composer (mic),
Microsoft Paint (msp), Microtek Eyestar (img), Mindjongg Format (ipg), Minolta DiMAGE RAW (mrw),
Mobile FAX (rfa), MonkeyCard (pdb), MonkeyLogo (pdb), MonkeyPhoto (mph), MrSid (sid), Msx 2
Screen (sc2), Multiple Network Graphics (mng), NCR Image (ncr), NIST ihdr (pct), National Imagery
Transmission F. (ntf, nitf), NeoBook Cartoon (car), Neochrome(ST & TT) (neo), Neopaint Mask (npm),
Neopaint Stamp (stw), NewsRoom (nsr, ph, bn), Nifti (img), Nikon RAW (nef), Nokia Group Graphics
(ngg), Nokia Logo File (nlm), Nokia OTA bitmap (otb), Nokia Operator Logo (nol), OAZ Fax (oaz, xfx),
OS/2 Bitmap (bmp, bga), Olicom Fax (ofx), Olympus RAW (orf), Open Image Library Format (oil),
OpenEXR (exr), Optigraphics (ctf), Optigraphics Tiled (ttf), Optocat (abs), Oric Hires (hir), Oric TAP
(tap), Os/2 Warp (bga), PABX background (pix), PAX (pax), PC Paint / Pictor Page (pic, clp), PCO
(b16), PM (pm), Page Control Language (pcl), Paint Magic (pmg), PaintShopPro Browser Cache File
(jbf), PaintShopPro Brush (pspbrush), PaintShopPro Brush (jbr), PaintShopPro Frame (pfr, pspframe),
PaintShopPro Image (psp, pspimage), PaintShopPro Mask (pspmask), PaintShopPro Mask (msk),
PaintShopPro Pattern (pat), PaintShopPro Picture Tube (tub, psptube), PaintShopPro Texture (tex), Palm
Pilot (pdb), Panasonic DMC-LC1 RAW (srf), Panasonic LX3 RAW (rw2), Panasonic RAW (bay, raw),
Pegs (pxs, pxa), Pentax *ist D (pef), Pfs Art Publisher (art), Photo Deluxe (pdd, pdb), Photo Filtre Studio
(pfi), PhotoFantasy Image (fsy), PhotoFrame (frm), PhotoStudio File (psf), PhotoStudio Stamp (stm),
Photomatrix (cat), Pic2 (p2), Picasso 64 (p64), Picture Gear Pocket (prc), Picture It! (mix), Pixar picture
file (pic, pxr, picio, pixar), Pixel Power Collage (ib7, i17, i18, if9), Pixia (pxa), Pixibox (pxb), Planetary
Data System (pds, img), Playback Bitmap Sequence (bms), Pocket PC Bitmap (2bp), Pocket PC
Themes(images) (tsk), Polychrome Recursive Format (prf), Portable Bitmap (pbm, rpbm, ppma), Portable
Document Format (pdf), Portable Greyscale (pgm, rpgm), Portable Image (pnm, rpnm, pbm, rpbm, pgm,
rpgm, ppm, rppm), Portable Network Graphics (png, apng), Portable Pixmap (ppm, rppm), Portfolio
Graphics (pgf), Portfolio Graphics Compressed (pgc), Portrait (cvp), Poser Bump (bum), Postscript (ps,
ps1, ps2, ps3, eps, prn), PowerCard maker (crd), PowerPoint(images) (pps), PowerPoint
Presentation(images) (ppt), Print Master (pm), Print Shop (psa, psb), Printfox/Pagefox (bs, pg, gb), Prism
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(cpa), Prisms (pri), Psion Series 3 Bitmap (pic), Psion Series 5 Bitmap (mbm), Punk Productions Picture
(ppp), Puzzle (pzl), Q0 (q0, rgb), Qdv(Random Dot Software) (qdv), Qrt Ray-Tracer (qrt), Quake
Texture (wal), Quantel VPB (vpb), QuickTime Image Format (qtif, qti), RAW DVR (raw), RIPTerm
Image (icn), Radiance (rad, img, pic), Rainbow Painter (rp), Raw (raw, gry, grey), Rawzor (rwz),
Rayshade (pic), Red Storm File Format (rsb), Ricoh Digital Camera (j6i), Ricoh Fax (001, ric), Ricoh
IS30 (pig), Rm2K XYZ (xyz), Rollei RAW (rdc, ia), RoverShot RAW (bay, raw), RunPaint(Multicolor)
(rpm), Saracen Paint (sar), SBIG CCD camera ST-4 (st4), SBIG CCD camera ST-X (stx, st4, st5, st6,
st7, st8), SciFax (sci), SciTex Continuous Tone (sct, ct, ch), Seattle Film Works (sfw), Seattle Film Works
multi-image (pwp, sfw), SecretPhotos puzzle (xp0), Sega SJ-1 DIGIO (sj1), Sharp GPB (img), Siemens
Mobile (bmx), SIF MICHEL-Soft (sif), Sigma RAW (x3f), Silicon Graphics RGB (rgb, rgba, bw, iris, sgi,
int, inta), Sinar RAW (cs1, sti), Skantek (skn), Slow Scan Television (hrz), SmartDraw 6 template (sdt),
SmartFax (1), SmoothMove Pan Viewer (pan), Softimage (pic, si), Solitaire Image Recorder (sir), Sony
DSC-F1 Cyber-shot (pmp), Sony DSC-F828 RAW (srf), Sony PS2 TIM (tm2), Sony Playstation TIM
(tim), Sony RAW (sr2, arw), Spectrum 512 (spu), Spectrum 512(Compressed) (spc), Spectrum
512(Smooshed) (sps), SPOT (dat), SriSun (ssi), Stad (pic, pac, seq), Star Office Gallery (sdg), Starbase
(img), Stardent AVS X (x, avs, mbfs, mbfavs), Starlight Xpress SX (RAW), Stereo Image (jps), ST Micro
RAW (bay, raw), Structured Fax Format (sff), Sun Icon/Cursor (icon, cursor, ico, pr), Sun Rasterfile (ras,
rast, sun, sr, scr, rs), Sun TAAC file (iff, vff, suniff, taac), Syberia texture (syj), Synthetic Universe (syn,
synu), SVG (svg), TG4 (tg4), TI Bitmap (92i, 73i, 82i, 83i, 85i, 86i, 89i), TIFF Revision 6 (tif, tim, tiff),
TMSat image (imi), TRS 80 (hr), TealPaint (pdb), Teli Fax (mh), Thumbnail (tnl), TilePic (tjp), Tiny (tny,
tn1, tn2, tn3), TopDesign Thumbnail (b3d, b2d), Total Annihilation (gaf), Truevision Targa (tga, targa, pix,
bpx, ivb), Ulead Pattern (pst), Ulead PhotoImpact (upi), Ulead Texture(images) (pe4), Usenix FaceServer
(fac, face), Utah raster image (rle, urt), VIPS Image (v), VITec (vit), VRML2 (wrl), Venta Fax (vfx),
Verity (vif), Vicar (vic, vicar, img), Vidcom 64 (vid), Video Display Adapter (vda), Vista (vst), Vivid Ray-
Tracer (img), Vort (pix), Vue d'esprit (vob), WAD(Half life) (wad), WSQ (wsq), WaveL (iwc), Wavefront
Raster file (rla, rlb, rpf), WebShots(images) (wb1, wbc, wbp, wbz), Weekly Puzzle (jig), WebP (webp,
wep), Whypic (ypc), WinFAX (fxs, fxo, wfx, fxr, fxd, fxm), WinMIPS (pic), Windows & Aldus Metafile
(wmf), Windows Animated Cursor (ani), Windows Bitmap (bmp, rle, vga, rl4, rl8, sys), Windows
Clipboard (clp), Windows Comp. Enhanced Metafile (emz), Windows Compressed Metafile (wmz),
Windows Cursor (cur), Windows DIB (dib), Windows Enhanced Metafile (emf), Windows Icon (ico),
Winzle Puzzle (wzl), Wireless Bitmap(level 0) (wbmp, wbm, wap), Word Perfect Graphics(images) (wpg),
Worldport Fax (wfx), X Windows System dump (xwd, x11), X11 Bitmap (xbm, bm), X11 Pixmap (xpm,
pm), XV Visual Schnauzer (p7), Xara(images) (xar), Xerox DIFF (xif), Ximage (xim), Xionics SMP
(smp), YUV 16Bits (yuv, qtl, uyvy), YUV 16Bits Interleaved (yuv, qtl, uyvy), YUV 4:1:1 (yuv, qtl), YUV
4:2:2 (yuv, qtl), YUV 4:4:4 (yuv, qtl), ZX Spectrum Hobetta ($s, $c, !s), ZX Spectrum Snapshot(sna), ZX
Spectrum standard (screen scr), ZZ Rough (rgh), Zeiss BIVAS (dta), Zeiss LSM (lsm), Zoner Callisto
Metafile(zmf), Zoner Zebra Metafile (zbr), Zsoft Multi-page Paintbrush (dcx), Zsoft Publisher's Paintbrush
(pcx, pcc, dcx), byLight (bif)

2.1.5 File Masks

R-Studio shows only those files/folders that match the specified file mask. File mask affects files/folders that are
processed by the Recover and Find commands. 

To specify a file mask,

1 Click the File Mask button
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 Other ways to specify the file mask

· Control-click a folder and select File Mask on the contextual menu
or
· Select the folder and select File Mask on the Tools menu

2 Specify the file mask on the File mask dialog box and click the OK button

Mask dialog box

 File mask options

You may specify options for All Files, File Extensions, Files, and Regular Expressions

Match case If this check box is selected, R-Studio makes a case-sensitive search.

Show empty folders If this check box is selected, R-Studio will show folders with no files in them.

Deleted files If this check box is selected, R-Studio makes a search among deleted files/folders.

Existing files If this check box is selected, R-Studio makes a search among existing files/folders.

Hide symbolic links If this check box is selected, R-Studio hides all symbolic links. It may be selected
by default if the Don't show symbolic links by default option is selected on the
Settings dialog box.

Use advanced
options

If this check box is selected, R-Studio will use the advanced options, even when
they are hidden. 

Advanced Options

Size from/up to Specifies file size limits. See the Data Formats and Multipliers topic for more
details on data formats.

Bad sectors Specifies whether there are bad sectors in the files. Not known: it's unclear if there
are bad sectors in the files. 

Runtime image Specifies whether the files have already been included into the runtime image.

Date Specifies file date boundaries. Dates for Modified, Created, and Last Accessed

timestamps may be set separately. 

The Set for all button sets the specified data for all fields.

> R-Studio will show only those files that match the specified file masks

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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Mask presets

You may set various presets with different file masks. Just click on the Plus button to add the data from the dialog
box to the presets. You may also give presets names, delete them, and store them permanently.

2.1.6 Regular Expressions

Regular expression is a notation for patterns of text, as opposed to exact strings of characters. The notation uses
literal characters and metacharacters. Every character which does not have special meaning in the regular-
expression syntax is a literal character and matches an occurrence of that character. For example, letters and
numbers are literal characters. A metacharacter is a symbol with special meaning (an operator or delimiter) in the
regular-expression syntax.
.  Wildcard: any character
* Repeat: zero or more occurrences of previous character or class
^ Line position: beginning of line
$ Line position: end of line
[class] Character class: any character in the set
[^class] Inverse class: any character not in the set
[x-y] Range: any characters within the specified range
\x Escape: literal use of metacharacter x
\<xyz Word position: beginning of the word
xyz\> Word position: end of the word

For example, the following regular expression .* matches any string of characters, ^a matches any string
beginning with character a.

2.1.7 Event Log

R-Studio logs and displays events in the Log panel. You may set a Log filter to display only needed information
and to write it to a log file. You may specify the log settings on the Settings dialog box.

You may clear or save the log.

R-Studio logs and displays events in the Log panel. You may set a Log filter to display only needed information
and to write it to a log file. You may specify the log settings on the Settings dialog box.

You may clear or save the log 

To clear the log,

* Control-click the Log panel and select Clear Log on the contextual menu.

To save the log to a file,

* Control-click the Log panel and select Save Log to File on the contextual menu.

2.2 Advanced Data Recovery

This chapter explains how to perform advanced data recovery operations.

· Disk Scan
· Fast-Search-for-Lost-Partition
· Customizing File Types

· Customizing File Types-I

· Customizing File Types-II
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· Regions
· Exclusive Regions

· Images
· Wiping Objects
2.2.1 Disk Scan

In order to completely analyze data structure on an object, it must be scanned. Any object on the Drives panel
can be scanned. In addition, you may create a region to scan only a part of an object. The Regions topic
explains how to create and work with regions. Scan is also greatly improves estimations for chances of
successful file recovery.

You may select scan area and some other scan parameters. Scan information may be saved to a file and later this
file may be opened.

You may save scan information on the remote computer if necessary. 

Attention: Scanning large areas may be a very lengthy process!

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

To scan an object

1 Select an object on the R-Studio's Drives panel

2 Click the Scan button

 Other ways to start scan

· Control-click the selected disk and select Scan on the contextual menu, 
or
· Select Scan on the Drive menu

3 Specify the required parameters on the Scan dialog box and click the Scan button

Scan dialog box

 Scan options

Disk Size: Shows the size of the object to be scanned

Start: Sets the start point of the area to be scanned.

Size: Sets the size of the area to be scanned. 

https://www.R-Studio.com/What-is-drive-scan.html
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Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

File Systems: Specifies the file systems which objects are to be searched for.
Current version supports: FAT, NTFS, exFAT, ReFS, Ext2/3/4FS, XFS, HFS,+
APFS, and UFS1/UFS2 file systems.
Please note that if you need to scan an HFS, HFS+, or HFSX disk, always enable the
Extra search for Known File Types option. This is very important because when files are
being deleted on the  HFS, HFS+, HFSX file systems, the computer completely
removes all system information on them, and there is no way to recover the deleted
files except by using the Extra Search for Known File Types option. 

Extra search for
Known File Types

Enables search for Known File Types.

Save scan Info to
File:

If this checkbox is selected, R-Studio will save scan information to a specified file.
Later this file may be opened. Please note, that this option does not save actual disk
data, only information on disk data structure gathered during disk scan.

Simple view If this option is selected, R-Studio will show only scan progress.

Buttons

Scan Starts scanning

Advanced Activates advanced scan options

Known File
Types...

Selects file types that R-Studio will recognize during the disk scan.

Cancel Closes the dialog box

NEVER TRY TO SAVE SCAN INFORMATION TO THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all of your data. 

If a remote computer is connected for Data Recovery over Network, the Scan dialog box will have a
different look 

and the Save Scan Information File dialog box will appear when you select a place to store scan info. You
may save it to the local or remote computer.

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-ExtFS.html
https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-Raw-File-Recovery.html
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Known File Types: While scanning, R-Studio can recognize the data’s particular file type. Using such
information, R-Studio can obtain more information about data/file structure on the object being scanned. By
default, R-Studio tries to recognize the default list of supported file types specified on the Known File Types

tab of the Settings panel, greatly increasing time required for the scan. You may reduce it by selecting only
those file types that you need. Click the Known File Types... button and select the required file types on the
File Types dialog box. These selections will be applied to that scan session only.

File Types dialog box

Known File Types

Set as Default Click this button to set the current list of selected file types as default values.

Revert to Default Click this button to revert the default settings specified on the Known File Types tab
of the Settings panel.

Reset to
Recommended

Click this button to revert to factory-preset default settings.

Select All Click this button to select all file types in the list.

Clear All Click this button to clear all file types in the list except some predefined ones.

 List of known file types

Document

AbiWord
Document: .abw

Adobe InDesign
File: .indd

Adobe PDF
document: .pdf

Apple iWork Keynote
document: .key

Apple iWork Pages
document: .pages

Apple iWork document Capella document: .cap Final Draft
Document: .fdr

FrameMaker
Document: .fm

GNU Info
Document: .info

Garmin MapSource
data: .mps

Lotus AMI Pro
Document: .sam

Lotus Organizer: .or5 Lotus Word Pro
Document: .lwp

Microsoft Office Open
XML Document

Microsoft OneNote
section file: .one

Microsoft Pocket Streets
Map File: .mps

Microsoft PowerPoint
2007 XML
Document: .pptx

Microsoft PowerPoint
Document: .ppt

Microsoft Visio
document: .vsd
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Microsoft Word 2007
XML Document: .docx

Microsoft Word
Document: .doc

Word for Macintosh
Document: .mcw

Microsoft Word2
Document: .doc

Microsoft Works
document: .wps

OLE Storage OpenOffice Writer
document: .odt

OpenOffice
document: .ods

PageMaker
Document: .p65

PostScript
document:.ps

QuarkXPress file: .qxd QuarkXpress
project: .qxp

Rich Text
Document: .rtf

TEX document: .tex Text document: .txt Unicode
document: .txt

WordPerfect
Document: .doc

Document: E-book

Chaoxing SSReader
eBook: .pdg

EPUB eBook: .epub FB2 eBook: .fb2 MOBI eBook: .mobi
Microsoft Money
Data: .mny

Microsoft Reader
eBook: .lit

Microsoft Reader
eBook
annotations: .ebo

Document: Spreadsheet

Apple iWork Numbers
document: .numbers

Lotus 1-2-3 v1
worksheet: .wk3

Lotus 1-2-3 v2
workshee: .wk1, .fmt

Lotus 1-2-3 v3
worksheet: .wk3, .fm
3

Lotus 1-2-3 v4
worksheet: .wk4

Lotus 1-2-3
workbook: .123

Microsoft Excel 2/3/4
worksheet: .xls

Microsoft Excel 2007
XML
Document: .xlsx

Microsoft Excel 4
Spreadsheet: .xls

Microsoft Excel
Spreadsheet: .xls

Quattro Pro
Spreadsheet: .wq1

Document: Database

Cathy database: .caf Data Interchange
Format file: .dif

GDSII database: .gds Microsoft Access 2007
XML
Document: .accdt

Microsoft Access 2007
Database: .accdb

Microsoft Access
Database: .mdb

Microsoft SQL
Log: .ldf

Microsoft SQL
Database: .mdf

MySQL Database
Dictionary: .frm

MySQL database: .myi Omnis Studio
Library: .lbs

Omnis Studio
Database: .df1

OpenOffice Base
document: .odb

dBase III
Database: .dbf

Document: Financial

Microsoft Money
Data: .mny

QuickBooks Backup
File: .qbb

QuickBooks Primary
Data File: .qbw

Quicken Data: .qdf
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TurboTax return
file: .tax

Internet-related files

Compiled HTML
file: .chm

Internet shortcut: .url Microsoft OutLook
Personal Folder: .pst

Microsoft
Outlook/Inbox offline
folder: .ost

Mozilla Firefox browser
extension: .xpi

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

XML document
(Unicode): .xml

Email

E-Mail Message: .eml Microsoft OutLook
Personal Folder: .pst

Microsoft Outlook
Inbox offline
folder: .ost

Mozilla Mail Summary
file: .msf

Outlook Express
Messages: .dbx

The Bat! Address
book: .abd

The Bat! Message
Base: .tbb

The Bat! Message
Index: .tbi

Windows Address
Book: .wab

Font

Adobe PostScript
Font: .pfb

Adobe Printer
Font: .pfm

BDF Unix font: .bdf BGI font: .chr

CPI DOS font: .cpi OpenType font: .otf TrueType Font: .ttf Windows System
Font: .fon

Graphics/Picture

AVHRR Satellite
image: .sst

Adobe Lightroom
preview: .lrprev

Adobe Photoshop
image: .psd

Agfa/Matrix Scodl
Image: .scd

Alias Wavefront Raster
Image: .rla

Amiga icon: .info ArcView Shape:.shp AutoCAD Binary
Image: .dxf

AutoCAD
Drawing: .dwg

AutoCAD Image: .dxf Autodesc Animator Pro
color palette: .col

Autodesc Animator
Pro Image: .pic

Autodesc Animator
Image: .pic

Autologic Image: .gm BMF image: .bmf Bentley MicroStation
CAD Drawing: .dgn

Canon (CR2) RAW
graphics file: .cr2

Canon (CRW) RAW
graphics file: .crw

ColoRIX Image: .rix Computer Graphics
Metafile image: .cg

ComputerEyes Raw
Image: .ce1, .ce1

Continous Edge Graphic
Image: .ceg

Corel Texture
Image: .tex

CorelDraw CMX
Image: .cmx

CorelDraw Image: .cdr Cubicomp Picture
Maker Image
.r8, .g8, .b8

DICOM medical
image: .dcm

Digital Negative
image: .dbg
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Dr. Halo palette: .pal Enhanced MetaFile
Image: .emf

Epson RAW
image: .erf

Epson Stylus
Image: .prn

Erdas LAN/GIS
Image: .lan, .gis

Fractal Image
Format: .fif

Freehand (MX)
Database: .fh10

Fuji RAW image: .raf

GEM Raster
Image: .img

GEM VDI Image: .gdi CompuServe GIF
Image: .gif

Garmin Mapsource
image: .img

Graphics Workshop for
Windows
Thumbnail: .thn

Gridded Binary
Image: .grb

HP Command Language
Image: .pcl

HP Raster Image: .rtl

HSI JPEG Image: .hsi Hemera Photo-Object
Image: .hpi

Hitachi Raster
Image: .hrf

Hotspot Image: .shg

IBM Picture Maker
Image: .pic

JPEG 2000: .jp2 JPEG Digital
Camera: .jpg

JPEG Image: .jpg

Jovian Logic Image: .vi Kodak PhotoCD
Image: .pcd

Kodak RAW
image: .dng

LBM/IFF Image: .lbm

Leica RAW image: .dng Lightwave Object: .lwo Lotus PIC Image: .pic Macintosh PICT
Image: .pct, .pic

Macintosh Paint
Image: .mac

Mamiya RAW
image: .mef

McIDAS Satellite
Image: .goe

Microsoft Paint
Image: .msp

Minolta RAW
image: .mrw

Nikon RAW
image: .nef

OS/2 Icon: .ico Olympus RAW
image: .orf

PBM Image: .pbm PGM Image: .pgm PIX Image: .pix PM Image: .pm

PNG Image: .png PPM Image: .ppm PaintShop Pro
Image: .psp

Panasonic RAW
image: .rw2

PaperPort Image: .max Pentax RAW
image: .pef

Pictor PC Paint
Image: .pic

Print Shop
Image: .pds

Quick Link II fax
Image: .qfx

QuickDraw 3D
Metafile: .3dmf

RAW Digital Camera
image: .dng

RenderMan
Image: .rib

Ricoh RAW image: .dng SGI Image: .sgi STAD Image: .pac Samsung RAW
image: .dng

Seattle FilmWorks /
PhotoWorks
image: .pwm

Sigma RAW
image: .x3f

Sketch Image: .sk SmartDraw file: .sdr

Sony RAW image: .arw Sun Raster Image: .sun SymbianOS
Image: .mbm

TI Image: .92i

Tagged Image Format
File: .tif

TargetExpress
image: .mte

Utah Raster Toolkit
Image: .rle

VITec Image: .vit

Webshots Image: .wb1 Weresc CADE
drawing: .dtc

Windows Animated
cursor: .ani

Windows Bitmap
Image: .bmp
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Windows Color
Palette: .pal

Windows Fax Cover
Image: .cpe

Windows MetaFile
Image: .wmf

Windows cursor: .cur

Windows icon: .ico WordPerfect Graphics
Image: .wpg

X PixMap Image: .xpm X Window Dump
Image: .xwd

Xara Drawing: .xar ZSoft PCX
Image: .pcx

iPhoto Image: .attr

Multimedia: Audio Files

AIFF Sound: .aif AVR Sound: .avr AY Chip music: .ay AdLib Tracker 2
module: .a2m

Advanced Streaming
Format file: .asf

Audacity audio: .au AudioCD file: .cda Battery 3 sample: .nov

CMF music: .cmf Common Loudspeaker
Binary: .cf1

Creative voice file: .voc DiamondWare
sound: .dwd

Digital Speech File: .dss Digital voice file: .dvf EA ASF/MUS audio
file: .asf

Extended M3U
playlist: .m3u

FLAC audio
file: .fla, .flac

KaraBox sound: .mkf La Lossless audio
file: .la

Liquid Audio
File: .la1

MIDI Instrument
definition: .idf

MIDI music: .mid MIDI stream: .mds MPEG Layer I audio
file: .mpg

MPEG Layer II audio
file: .mp2

MPEG Layer III audio
file: .mp3

MUS music: .mus Monkeys audio
file: .ape

Musepack audio
file: .mpc

Next/Sun uLaw
sound: .au

Nitro Composer
sound: .minincs

Nord Modular G2
Patch: .pch2

Ogg Vorbis audio
file: .ogg

OptimFROG audio
file: .ofr

Portable Sound
Format: .psf

RIFF MIDI
music: .rmi

RK Audio sound: .rka Sierra AUD
sound: .aud

Sony OpenMG audio
file: .oma

Super NES audio
file: .spc

TTA audio file: .tta VQF sound: .vqf WavPack audio file: .wv Westwood AUD
sound: .aud

Windows Media Audio
File: .wma

Windows WAVE
sound: .wav

X-MIDI music: .xmi ZyXEL sound: .zyx

aPac audio file: .apc

Multimedia: Video Files

3GPP multimedia
audio/video: .3gp

3GPP2 multimedia
audio/video: .3g2

4X Movie Video: .4xm Adobe Filmstrip
Animation: .fsf

AMV Video: .amv ARMovie video: .rpl Adobe Filmstrip
animation: .fsf

Autodesk
Animator: .fli

BINK Video: .bik BluffTitler video: .bt DVM video: .dvm DeluxePaint
animation: .anm
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Director video: .dcr DriveCam video: .dce Eyemail video: .eye Flash Video: .flv

Intel DVI Video: .dvi Intel Indeo Video
File: .ivf

Interplay MVE
Video: .mve

LZA animation: .lza

LZA Animation: .lza Lotus ScreenCam
video: .scm

MPEG Transport
Stream video: .mts

MPEG video: .mpg

MPEG-2 Transport
Stream video: .m2ts

Matroska video: .mkv MythTV video: .nuv NEOchrome
animation: .ani

Nancy Codec
video: .noa

Nullsoft Video: .nsv QV-10 video: .cam QuickTime video: .mov

SGI movie format: .mv SMJPEG Video: .mjpg Sega FILM/CPK
video: .cpk

Shockwave
video: .swf

Smacker video: .smk Sony Movie Player
video: .mqv

VOB video files: .vob VP6 encoded
Video: .vp6

VideoCD video: .vcd Vivo streaming
video: .viv

Windows AVI
Video: .avi

Windows Media
Video: .wmv

Multimedia Files

MP4 file: .mp4  Material Exchange
File: .mxf

RIFF Multimedia File Real Networks
audio/video: .rm

Archive Files

7-Zip archive: .7z ACE archive: .ace AIN archive: .ain ARJ archive: .arj

ARX archive: .arx Android Package: .apk BAG archive: .bag BIX archive: .bix

BOA
archive: .b58, .boa

BZip2 archive: .bz2 BlackHole archive: .bh Blink archive: .bli

CPIO archive: .cpio ChArc archive: .chz Compress archive: .z Crush archive: .cru

DEB archive: .deb FOXSQZ
archive: .sqz

GZip archive: .gz HA archive: .ha

HAP archive: .hap HPack archive: .hpk Hyper archive: .hyp InstallShield CAB
archive: .cab

InstallShield Z
archive: .z

InstallShield
compressed file

JAR archive: .jar JRC archive: .jrc

LHA/LZARK
archive: .lzh

LZA
archive: .lza, .lzz 

LZOParchive: .lzo, .
lzop

LZX archive: .lzx

LIMIT archive: .lim Microsoft Cabinet
archive: .cab

Microsoft Compress
compressed file

PAKLEO
archive: .pll

QFC archive: .qfc Quantum
archive: .q, .pak

Quark archive: .ark RAR archive: .rar

RPM archive: .rpm ReSOF archive: .sof SAR archive: .sar SBC archive: .sbc

SQZ archive: .sqz SZip archive StuffIt archive: .sit TAR archive: .tar
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UFA archive: .ufa UHArc archive: .uha UltraCompressor 2
archive: .uc2

WRAptor
archive: .wra

WinImp archive: .imp Windows Installer
Merge Module: .msm

Windows Installer
Package: .msi

indows Installer
Patch: .msp

Windows Installer Patch
Creation File: .pcp

Windows Installer
Validation
Module: .cub

YAC archive: .yc YBS archive: .ybs

ZIP archive: .zip ZOO archive: .zoo ZZip archive: .zz iOS Package: .ipa

xz archive: .xz

Executable/Library/DLL

DOS Style
Executable: .exe

ELF Executable
(UNIX)

ELF Library (UNIX) ELF Module (UNIX)

Java Bytecode: .class KolibriOS Executable NetWare Loadable
Module: .nlm

Shell Script

UEFI Executable
.efi

Windows DLL: .dll Windows
Executable: .exe

Windows 9x Device
Driver: .vxd

Windows Device
Driver: .sys

Windows OCX
File: .ocx

Development files

ACUCOBOL object Borland Delphi
Compiled Unit: .dcu

Borland Turbo Pascal
compiled Unit: .tpu

C/C++ Source
Code: .c

COM Type
Library: .tlb

GUI Design Studio
project: .gui

LUA Script: .lua Library: .lib

Microsoft .NET XML
Resource
template: .resx

Microsoft ClassWizard
file: .clw

Microsoft Linker
database .ilk

Microsoft Precompiled
header: .pch

Microsoft Program
database: .pdb

Microsoft Visual C++
project: .mdp

Microsoft Visual Studio
Solution: .sln

Microsoft Visual Studio
project: .dsp

Microsoft Visual Studio
workspace: .dsw

OMF Object
library: .lib

PolySpace results: .chk RDOFF Object
File: .rdf

Resource Compiler
Script File: .rc

Visual Studio Solution
User Options: .suo

Visual Studio Widget
File: .wid

Visual Studio
Workspace Options
file: .opt

VisualBasic
Project: .vbp

WinDev Window: .wdw Windows Compiled
resource (32bit) : .res

XPCOM Type
Library: .xpt

Xcode
Project: .pbxproj

Disk images
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Hyper-V virtual
disk: .vhdx

JAM compressed
disk: .jam

Norton Ghost disk
image: .ghs

QEMU virtual
disk: .qcow2

R-Drive Image disk
image: .rdr

VMware virtual
disk: .vmdk

Virtual PC virtual
disk: .vhd

VirtualBox virtual
disk: .vdi

Other file types

ABBYY Lingvo
dictionary: .lsd

AIX Backup File: .bff ArtMoney Table
file: .amt

CrystalMaker Data
File: .cmdf, .cmmf

Dwarf Fortress save
data: .dat

EasyCrypto
file: .encrypted

Fallout 3 save
game: .fos

Java Applet cache
index: .idx

Kaspersky Anti-Virus
data base: .avc

Kaspersky Anti-Virus
report: .rpt

Kaspersky Anti-Virus
signature bas: .kdc

Magic 3D Easy View
object: .x

Microsoft Security
Catalog: .cat

NHTSA UDS-1992
crash test result: .uds

NOD32 Antivirus
Update file: .nup

ORTIMZeit
project: .ozv

OziExplorer Map
data: .map

PRO100 project: .sto PlayStation 3
Theme: .p3t

RegEdit file: .reg

RegEdit file
(UNICODE): .reg

Source Game Engine
Compiled AI
Nodegraph: .ain

Unreal Package Valve Texture
File: .vtf

WinHelp: .hlp WinHelp
Contents: .cnt

WinXP Prefetch
file: .pf

Windows Backup
File: .bkf

Windows Clipboard
file: .clp

Windows Color
Profile: .icm

Windows
Minidump: .dmp, .mdm
p

Windows National
locale: .nls

Windows Password
file: .pwl

Windows Registry
hive: .dat, .hiv

Windows Thumbnail
cache: .db

Windows User
Interface Module: .wim

Windows shortcut: .lnk X-Plane Scenery: .dsf XNA Game Data: .xnb

Note: Using scan for Known File Types, R-Studio can successfully recover only un-fragmented files.
You may also specify your own file types for scanning. See Customizing File Types for details. User-
defined file types precede over built-in ones, if their definitions overlap.
You may set the defaults for known file types on the R-Studio Settings.
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R-Studio Technician/T80+

Scan (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio will shut down your computer when
scan has been completed. You should select the Save to file checkbox and
specify a place to save scan info to activate this option.

E-Mail notifications If this check box is selected, R-Studio will inform you about the outcome of
the operation via email. 

> R-Studio starts scanning the object, and its panel will show information about new found objects:

The Log pane will show scan progress. Scan may be stopped by clicking the Stop button on the tab. Later
the scan process may be resumed with different scan parameters. Some scan parameters may also be
changed during the scan process. Click the Options button and change them on the Scanning dialog box
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 R-Studio Main panel

Drives panel after scanning:

You can select an object by clicking on it
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The Log pane will show scan progress. Scan may be stopped by clicking the Stop button on the toolbar.
Later the scan process may be resumed with different scan parameters. Some scan parameters may also be
changed during the scan process. Click the Options button and change them on the Scanning dialog box.

You may change some options during the scan process
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Only in the Technician version

To see the information about a newly found object, simply click it on the Drives panel. Click this link to see
the information about the object Recognized24.

When an object is scanned, a number of Recognized partitions will appear. R-Studio shows them in different
colors depending on which elements of the partition have been found.

An existing partition

An existing partition after drive scan

A recognized partition. Both boot records and file entries are found for this partition
A recognized partition. Only file entries are found for this partition
A recognized partition. Only boot records are found for this partition
A fast found partition

Empty space on the object
A deleted partition

Files that have been found using scan for known file types (raw file search).

Although such recognized partitions are virtual objects, files can be searched for and recovered from
recognized partitions as from real logical disks using Basic File Recovery.

All scanned information may be deleted on the contextual menu for a scanned object. 

When an object in the scanned drive is selected, R-Studio shows the scanned area of the object.

https://www.r-studio.com/What-is-Disk-Partition.html
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Object's scanned area

All scanned information may be deleted on the contextual menu for a scanned object. 

Scan information may be saved in a file. Previously saved scan information may be loaded. This can be done on
the Drive or contextual menu for a selected object.

Resuming incomplete scans or scanning the object with different parameters

You may resume the scan of an incompletely scanned object or rescan the already scanned object with different
parameters. The  Scan dialog will be a little bit different in this case.

Scan dialog box for incomplete scans

You may rescan the entire disk, scan unscanned areas, or scan an explicitly  specified area. 

Scan of multiple areas

You may simultaneously scan several  successive or overlapping areas. Click the Advanced button, specify an
offset and size for a new area to scan on the Advanced Scan dialog box and click the Add button. You may
specify and add several scan areas. You may select which areas should be scanned. Selected scan areas can be
merged. Control-click a necessary area and select either Merge Down, Merge Down All, and Merge Selected.
You may also select/unselect unscanned areas.
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Advanced Scan dialog box

R-Studio accumulates the information from successive scans and keeps track of changes in this information
obtained from different scans.

You may manage the areas 

Managing scan information

Scan information may be saved to a file. Previously saved scan information may be loaded. 

To save scan information

1 Select an object on the R-Studio Drives panel

2 Select Save Scan Information on the Drive or contextual menu and save the scan information in a file

The default file extension is *.scn.

If a remote computer is connected for Data Recovery over Network, the Save Scan Information File

dialog box will appear when you select a place to store scan info. You may save it to the local or remote
computer.

To load scan information

1 Select an object on the R-Studio Drives panel

2 Select Open Scan Information on the Drive or contextual menu and select the required file with the
scan information

The default file extension is *.scn.

If a remote computer is connected for Data Recovery over Network, the Open Scan Information File

dialog box will appear when you select a place to load scan info from. You may load it from the local or
remote computer.

> The scan information will appear in the Drives panel
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To remove scan information

1 Select an object on the R-Studio Drives panel

2 Select Remove Scan Information on the Drive or contextual menu

> The scan information will disappear from the Drives panel

NEVER TRY TO SAVE SCAN INFORMATION ON THE OBJECT BEING SCANNED!!!
Or you may obtain unpredictable results and lose all your data. 

2.2.2 Fast Search for Lost Partitions

Drive scan gives very detailed and accurate results but takes long time. If you want to find only partitions

previously existed on the disk you may use fast search for lost partitions which is much faster.

To perform fast search for lost partitions, 

1 Select an object on the R-Studio's Drives panel

Fast search for lost partitions

2 Click the Fast Partition Search button

R-Studio will start searching for lost partitions showing its progress.

Fast search for lost partitions

https://www.R-Studio.com/What-is-drive-scan.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> R-Studio will show fast found partitions in blue. 

Fast search for lost partitions

You may control-click the partition and select Complete scan to scan the entire disk.
2.2.3 Customizing File Types

You may create your own known file types and add their file signatures for scanning in Known File Types. They
will appear in their respective folders on the File Types dialog box. 

You can do that either by using the R-Studio's graphic interface or by direct editing the known file description
file specified on the R-Studio Main settings dialog box.

Creating a Known File Types using a Graphic User's Interface

The easiest way to add your own is to use the R-Studio's graphic interface. 

To create a Known File Type,

1 On the Known File Types settings dialog box, click the Edit User's File Types... button

> The Edit User's File Types dialog box will appear

Edit User's File Types dialog box

https://www.r-studio.com/What-is-Raw-File-Recovery.html
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2 Click the Create File Types button and specify File type properties

Edit User's File Types dialog box

 File Types properties

id digit Required Digital file type identifier. Should be unique for each custom
file type. 

group string Optional Specifies a file type group in which found files will appear.
You may specify either your own groups or select those
predefined on the File Types dialog box. 

description string Optional Brief file description

features NO_SCAN
TXT_ANSI
TXT_UNICODE

Optional Additional properties of the file type. If you want to specify
several properties, they should be separated by a space. 
NO_SCAN: Not to be scanned for. If this flag is used, R-
Studio will not search for such file type. Such files will be
shown when sorting files by their extensions.
TXT_ANSI: The file can be viewed as ANSI text. If this flag
is specified, the file can be correctly represented as an
ANSI text. When previewing, this file will be immediately
sent to Text/hexadecimal editor.
TXT_UNICODE: The file can be viewed as UNICODE text.
If this flag is specified, the file can be correctly represented
as a UNICODE text. When previewing, this file will be
immediately sent to Text/hexadecimal editor.

extension <string> Optional File extension.
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3 Click the Add Signature button, specify the signature parameters, and click the Save button

Edit User's File Types dialog box

 File signature properties

Begin
End

Specifies from where the signature begins.
If End, the offset is from the end of file to the first byte of the signature. That is, if the
signature is two bytes long, the offset value should be 2.

AND
OR

Shows the order of the logical operation (union or intersection)

From A decimal number specifying the leftmost possible offset for the file signature.

To A decimal number specifying the rightmost possible offset for the file signature.

You may specify as many signatures as you need. Moreover, you may specify subgroups within a signature
using the Add Subgroup button. The structure of such possible subgroups is described on the Customizing
File Types-II help page.

> The newly specified file type will appear on the Edit User's File Types dialog box and the File Types
dialog box

Edit User's File Types dialog box

2.2.4 Customizing File Types-I

The syntax of signature description is similar to that of the XML language. They are stored in an .xml file the
path to which is specified on the Setting dialog box.

More advanced features are described in Customizing File Types-II.
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Signature file example

<?xml version="1.0" encoding="utf-8"?>
<FileTypeList>
   <!-- Search for NTFS MFT -->
   <FileType id="5626" group="System Files" description="MFT" features="TXT_ANSI TXT_UNICODE">
      <Signature offset="0" from="begin" count="1">FILE</Signature>
      <Signature offset="7" from="end" count="1">$\x00M\x00F\x00T</Signature>
   </FileType>
</FileTypeList>

File structure

File header

The file starts with a standard  XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

It requires a closing element </FileTypeList>.

Section FileType

This is a description of each file signature. 

Attributes:
id <u32> Required Digital file type identifier.

Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify
either your own groups or
those predefined on the
File Types dialog box. 

Default: unknown

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want
to specify several
properties, they should be
separated by a space. 

Default: 0

extension <string> Optional File extension. Default: null (no extension)

File type properties flags

NO_SCAN Not to be scanned for. If this flag is used, R-Studio will not search for such file type. Such
files will be shown when sorting files by their extensions.

TXT_ANSI The file can viewed as ANSI text. If this flag is specified, the file can be correctly
represented as an ANSI text. When previewing, this file will be immediately sent to
Text/Hexadecimal Editor.

TXT_UNICODE File can viewed as UNICODE text. If this flag is specified, the file can be correctly
represented as a UNICODE text. When previewing, this file will be immediately sent to
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Text/Hexadecimal Editor.
This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If there is not a hexadecimal number after \x , \x are treated as a
part of the string section of the signature

Attributes:
offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the

number of signatures of the same
length. Used when several signatures
of the same length starting with the
same offset can be present in a file.
In this case they should be
sequentially written in the element,
and the size attribute specifies the
length of signature. count*size
should be equal to the number of
bytes in the element.
If only one signature can be on this
offset, count should be equal "1",
and size should be equal to the
length (the number of bytes) of the
signature.

Default: 1

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

from begin
end

Optional Specifies from where the offset is
calculated.
If end, the offset is from the end
of file to the first byte of the
signature. That is, if the signature is
two bytes long, the offset value
should be 2.

Default: begin

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.2.5 Customizing File Types-II

Currently R-Studio supports two versions of file type descriptions. Version 2 extends legacy Version 1 by
adding variable signature offsets and  AND/OR combination of several signatures in one file type. The version of
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file type description is specified by the version attribute of the FileTypeList section . Version 1 is the default
option. 

File structure

Elements common to Versions 1 and 2 of file type description

File header

The file starts with a standard XML header
<?xml version="1.0" encoding="utf-8"?>

Section FileTypeList
<FileTypeList>

Attributes:

version 1.0
2.0

Optional Version of file type description Default: 1.0

It requires a closing element <FileTypeList>.

Comments
<!-- Comment string -->

An XML-standard string for a comment.

Version 1 of file type description

Signature file example

  <FileTypeList>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Signature offset="3" count="1">Abc\x5c\x00\x04</Signature>
      <Signature offset="9" count="2">\x23\x01\xf4</Signature>
    </FileType>
  </FileTypeList>

Section FileType

This is a description of each file signature. 

Attributes:

id <u32> Required Digital file type identifier.
Should be unique for each
file type.

group <string> Optional Specifies a file type group
in which found files will
appear. You may specify
either your own groups or
those predefined on the
File Types dialog box. See
the table below.

Default: unknown

description <string> Optional Brief file description Default: null (no description)
features NO_SCAN

TXT_ANSI
TXT_UNICODE

Optional Additional properties of
the file type. If you want to
specify several properties,
they should be separated
by a space. 

Default: 0
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extension <string> Optional File extension. Default: null (no extension)

File type properties flags
NO_SCAN Not to be scanned for. If this flag is used, R-Studio will not search for such file type.

Such files will be shown when sorting files by their extensions.
TXT_ANSI The file can be viewed as ANSI text. If this flag is specified, the file can be correctly

represented as an ANSI text. When previewing, this file will be immediately sent to
Text/hexadecimal editor.

TXT_UNICODE The file can be viewed as UNICODE text. If this flag is specified, the file can be
correctly represented as a UNICODE text. When previewing, this file will be
immediately sent to Text/hexadecimal editor.

List of predefined file type groups

Group Name on the File Types dialog box.
archive Archive Files
graphics Graphics/Picture
internet Internet-related files
multimedia Multimedia Files
audio Multimedia: Audio Files
video Multimedia: Video Files
font Font
document Document
doc_database Document: Database
doc_sheet Document: Spreadsheet
exe Executable/Library/DLL
unknown Other file types

This section can contain an unlimited number of the Signature elements.If there are several Signature
elements, that means that all those signatures are simultaneously present in the file. Such signatures should have
different offset attributes and they should not overlap.

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature

Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
count <u16> Optional Decimal number specifying the

number of signatures of the same
length. Used when several signatures
of the same length starting with the
same offset can be present in a file. In
this case they should be sequentially
written in the element, and the size
attribute specifies the length of
signature. count*size should be

Default: 1
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equal to the number of bytes in the
element.
If only one signature can be on this
offset, count should be equal to "1",
and size should be equal to the length
(the number of bytes) of the
signature.

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.

from begin
end

Optional Specifies from where the offset is
calculated.
If end, the offset is from the end of
file to the first byte of the signature.
That is, if the signature is two bytes
long, the offset value should be 2.

Default: begin

Version 2 of file type description

Signature file example

<?xml version="1.0" encoding="utf-8"?>
<FileTypeList version="2.0">
  <FileType id="5626" group="_Test" description="Test file" extension="tst">
    <Begin combine="and">
      <Signature from="0" to="20">ABC</Signature>
      <Signature offset="1">CDEFG</Signature>
      <AND>
        <Signature offset="0">DE</Signature>
        <Signature offset="0">RTD</Signature>
        <OR>
          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </Begin>
    <End combine="or">
      <Signature from="3" to="20">ABC</Signature>
      <Signature offset="5">CDEFG</Signature>
      <AND>
        <Signature offset="2">DE</Signature>
        <Signature offset="3">RTD</Signature>
        <OR>
          <Signature offset="12">CP</Signature>
          <Signature offset="16">RTD</Signature>
        </OR>
      </AND>
    </End>
  </FileType>
</FileTypeList>
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Section FileType

This is a description of each file signature. 

Attributes:

Similar to those in Version 1.

The section can contain one element Begin and one End. It should contain at least one of them. 

Example

 <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin [attributes]>
        ...
      </Begin>
      <End [attributes]>
        ...
      </End>
    </FileType>
  </FileTypeList>

Sections Begin and End

Specify the positions of  file type signatures in the file.

Attributes

combine and
or

Optional Shows the order of the logical
operation (union or intersection)

Default: and

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the attribute combine.

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin combine="or">
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          ...
        </AND>
        <OR>
          ...
        </OR>
      </Begin>
      <End>
        <OR>
          ...
        </OR>
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
      </End>
    </FileType>
  </FileTypeList>
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Sections AND and OR

These sections can contain one of several elements Signature. And one or several elements OR or AND. If there
are several elements inside the section they are combined according to the section type (logical AND or OR).

Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature [attributes]> ... </Signature>
        ...
        <Signature [attributes]> ... </Signature>
        <AND>
          <Signature [attributes]> ... </Signature>
          <OR>
            <Signature [attributes]> ... </Signature>
            <AND>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
            </AND>
            <OR>
              <Signature [attributes]> ... </Signature>
              <Signature [attributes]> ... </Signature>
            </OR>
          </OR>
          <Signature [attributes]> ... </Signature>
        </AND>
      </Begin>
    </FileType>
  </FileTypeList>

Element Signature

The element contains a string value of the file signature consisting of ASCII characters and hex bytes in the \xhh
format, where hh is a hexadecimal byte code. If that is not a hexadecimal number after \x, \x are treated as a
part of the string section of the signature

Attributes:

offset <u16> Optional Decimal offset for the signature Default: 0
from <u16> Optional Decimal number specifying the

leftmost possible offset for the file
signature. 
Ignored if the offset attribute is
specified.

Default: undefined

to <u16> Optional Decimal number specifying the
rightmost possible offset for the file
signature. 
Ignored if the offset attribute is
specified.

Default: undefined

size <u16> Optional Decimal number specifying the
number of bytes in the signature.

Default: the number
of bytes written in
the element.
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Example:

  <FileTypeList version=”2.0”>
    <FileType id="2" group="archive" description="ARJ Archive" extension="arj">
      <Begin>
        <Signature offset="3">Abc\x5c\x00\x04</Signature>
        <Signature from="9" to="15">\x23\x01\xf4</Signature>
      </Begin>
    </FileType>
  </FileTypeList>

2.2.6 Regions

Scanning large objects may take a long time. Sometimes, only smaller area of a disk needs to be scanned or
searched for files. Such area is called a region. A region can be created on any object in the R-Studio's Drives

panel. 

Created regions can be scanned, and files on them can be recovered in the same way as from hard drives or
logical disks.

Created regions can be deleted.

Note: R-Studio does not create anything real on the disk. Regions are virtual objects that do not affect actual
data on the disk.

To create a region

1 Select an object on the R-Studio's Drives panel and click the Create Region button

 Other ways to create the region

· Control-click the selected object and select Create Region on the contextual menu
or
· Select the object and select Create Region on the Create menu

2 Specify required parameters on the Create region dialog box and click the Create button

Create region dialog box

 Region options

Disk size: Shows size of the object where the region is to be created. The region cannot be larger
than this size.

Start: Start point of the region

Size: Size of the region. Cannot be larger than Disk size.

Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> A Region object will appear on the Drives panel. 

https://www.r-studio.com/What-is-Disk-Region.html
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To change the size of a region

* Control-click the Region on the R-Studio Drives panel, select Edit on the contextual menu, and enter a
new size on the Edit Region dialog box.

To convert a region into an exclusive one

* Control-click the Region on the R-Studio Drives panel and select Exclude area on the  contextual menu

To remove a region

* Select a Region on the R-Studio's Drives panel and click the Remove button, or

Control-click the selected region and select Remove Region on the contextual menu.

2.2.7 Exclusive Regions

Exclusive regions are areas on any object visible on the R-Studio's Drives panel that are excluded from disk
operations. R-Studio never tries to read/write data from/to such area. Exclusive regions are necessary when, for
example, there are areas with bad sectors on a hard drive, and it is necessary to avoid any disk operations with
such areas to not inflict further damage to such drive and to speed work with it. 

Note: R-Studio does not create anything real on the disk. Exclusive regions are virtual objects that do not affect
actual data on the disk.

To create an exclusive region

1 Control-click  an object on the R-Studio's Drives panel and select Create Exclusive Region on the

contextual menu, or

Select the object and select Create Exclusive Region on the Create menu

2 Specify required parameters on the Create Exclusive Region dialog box and click the Add  button

Create exclusive region dialog box

 Exclusive Region options

Offset: Start point of the exclusive region

Size: Size of the exclusive region. Cannot be larger than Disk size.

https://www.r-studio.com/What-are-Bad-Sectors.html
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Numbers in these fields can be in bytes or sectors. See the Data Formats and Multipliers topic for
more details on data formats.

> An Exclusive Region object will appear on the Drives panel. 

Its properties can be seen on the Excluded Areas tab.

To delete an exclusive region

* Select an Exclusive Region on the R-Studio Drives panel and click the Delete button, or

Control-click the selected region and select Remove Region on the contextual menu.

To change the size of an exclusive region

* Control-click an Exclusive Region on the R-Studio Drives panel, select Edit on the contextual menu,
and add/delete excluded areas on the Edite Exclusive Region dialog box.

You may delete an excluded area by control-clicking it and selecting Remove on the contextual menu.

2.2.8 Images

An image is an exact, byte by byte, copy of any object on the Drives panel. When created, images can be
processed like their original objects. 

Images are very useful if there is a risk of total data loss due to hardware malfunction. If bad blocks are
constantly appearing on a hard drive, you must immediately create an image of this drive. All data search, scan
and restoring can be done from this image.

While creating images, R-Studio can simultaneously perform disk scan and save scan information to lessen time
necessary to process the disk. 

The image can be saved on the remote computer if it is created via network. R-Studio can also load and process
images created with the DeepSpar Disk Imager™.

To create an image,

1 Select an object on the R-Studio's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu
or
· Control-click the selected object and select Create Image File on the contextual menu

2 Specify image options, a file name, and destination for the image on the Drive Image Wizard

Note: To store an image file, you need a free space equal to at least the object size.

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-is-free-disk-space.html
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Create Image (Main) dialog box

 

Create Image (Bad sector processing) dialog box

Create Image (Scan Information) dialog box



Data Recovery Using R-Studio 77

© 2024 R-Tools Technology Inc.

 Image Options (Main)

Image filename Specifies the name and path for the image file

Image type: Compressed image (R-Drive Image compatible): If this option is selected,
R-Studio will create an image file which can be compressed, split into several
parts, and password-protected. This image file is fully compatible with the
images created by R-Drive Image, but incompatible with the previous versions
of R-Studio.
Byte by byte image to a file: If this option is selected, R-Studio will create a
simple exact copy of the object. 
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.
Byte to byte image to a physical disk: R-Studio will create an exact copy of the
disk on another hard drive. Data on the target drive will be overwritten.
Available in the Corporate, Technician, and T80+ license.
Some other image formats are also available in the Technician, and T80+
licenses. You may read more about these formats in the Supported Virtual Disk
and Disk Image Formats page.

Image compression
ratio

You may compress the data in the image to save space. Active only if the
Compressed image (R-Drive Image compatible) is selected.

Estimated size Shows the estimated size of the image file. An actual image size depends on how
much empty space is on the selected partition and what file types are there.

Active only if the Compressed image (R-Drive Image compatible) is selected.

Image split size You may set this option to Automatic and let Windows decide how to split the
image file. This mostly depends on the file system on the destination drive. You
may also either explicitly specify the split size, or choose a preset for various
devices with removable storage. Select Fixed size for that. Active only if the
Compressed image (R-Drive Image compatible) is selected.

http://en.wikipedia.org/wiki/VMDK
https://www.r-studio.com/What-is-file-compression.html
https://www.r-studio.com/What-is-Disk-Partition.html
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Password
Encrypt image

You may protect your image file with a password. Note: If you leave the Encrypt

image option clear this feature will provide a relatively moderate protection
against conventional unauthorized access. If this option is selected, R-Studio will
encrypt the image using the AES-XTS algorithm.
Note: Only files in the RDR format can be password protected and encrypted.

Create scan information
file

If this option is selected, R-Studio will perform drive scan simultaneously with
image creation. See the Drive Scan help page to learn scan options.

Read retries Specifies a value for I/O Tries, or how many times R-Studio will try to read a
bad sector. 
R-Studio treats bad sectors in the following way:
It reads a certain part of drive (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled

with the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio reads again that

part sector by sector, repeating the attempts the specified number of times. If
R-Studio still cannot read a bad sector, it fills the sectors with the specified
pattern. In this case only the bad sectors will be filled with the pattern, but that
extremely slows the drive read process.

For example, if you set Default read retries to 1, a bad sector will be read 2
times.

Pattern to fill bad blocks Specifies a pattern R-Studio will use to fill bad sectors in this image. You may
specify the pattern either in the ANSI or Hex data format.
Note: R-Studio will never ever try to write anything on the drive from which
data is to recover or an image is to create. This pattern fills bad sectors only in
the image.

Drive sector map file
Enable multi-pass
image creation

These options are available only in the Technician/T80+ versions. Read more
about these options in the I/O Monitor and Sector Map files and Multi-pass
imaging help page.

If a remote computer is connected for Data Recovery over Network, the Save Image File dialog box will
appear when you select a place to store the image. You may save it to the local or remote computer.

https://www.R-Studio.com/What-is-AES-XTS-encryption.html
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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.

R-Studio Technician/T80+

Create Image (Additional output folders) dialog box

These options are available only in the Technician/T80+ versions. 
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Additional output folders

Additional output folders Additional output folders where image files will be stored when R-Studio
runs out of space.

Create Image (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio will shut down your computer when
image creation has been completed. 

E-Mail notifications If this check box is selected, R-Studio will inform you about the outcome of
the operation via email. 

> R-Studio will start creating the image, the Progress message showing the progress.

You may change some options during the imaging process. Click the Options button and change them as
necessary/

You may stop the imaging process and then resume it later on. Click the Stop button and the Cancel drive

operation dialog box will appear. Select Stop if yo want to keep the partially created image or Discard if
you don't need this image file.
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To resume the creation of the image for the same object, select the same file name for the image. You'll be
able to create a new image file or continue to create the image for the object.

Resuming image creation

R-Studio will create a new file for every new start of imaging for the .rdi and .vmdk file types.

To process an already created Image, the image file should be opened.

To open an image

1 Click the Open Image button, or

Select Open Image File on the Drive menu

If a remote computer is connected for Data Recovery over Network, the Open Image File dialog box will
appear when you select a place to load the image file from. You may load it from the local or remote
computer.

2 Select the required image file 

> An Image object will appear on the Drives panel

You may perform all data search, scan, and recovery from this image as it were a regular drive/disk object.

Compressed (R-Drive Image compatible) images

Byte-to-byte images
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To close an image

* Select the image and click the Close Image button,

· or control-click the image and select Close Image on the contextual menu

· or select the image and press the F8 key.

To close all image

* Select Close All Images on the Tools menu

A disk (or disks) containing in an image can be connected to the operating system as a device which makes its
content accessible to any program including any other data recovery software.

To connect a disk in an image

1 Control-click the disk in the image on the  Drives panel and select Mount on the contextual menu

> A Virtual disk object will appear on the Drives panel 

and this virtual disk will be available to system in the read-only mode

.
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To disconnect a virtual disk from the system

1 Control-click the virtual disk in the image on the Drives panel and select Unmount on the contextual
menu.

2.2.9 Wiping Objects

Disk objects can be wiped in order to completely destroy its data.

Supported Wipe Algorithms

File wiping is necessary only for files stored on conventional hard drives. Files stored on new SSD storage
devices cannot be effectively wiped out due to the principles of operation of these devices.

Currently R-Studio supports 6 wiping algorithms:

Zeroes The disk object or file is filled with zeroes through 1 pass. The fastest but the least
secure algorithm. Also it does not conceal the fact that the disk or file has been
wiped.

Pseudo-random
numbers

The disk object or file is filled with pseudo-random numbers through 1 pass. A
slower but little bit more secure algorithm than the Zeroes algorithm and it also
conceals to some degree the fact that the disk or file has been wiped.

DoD 5220.22-
M(3)

The disk object or file is wiped using Department of Defense standard 5220.22-
M(3). Provides high-grade data wiping filling the unused space or file with a special
digital pattern through 3 passes This algorithm is very secure, but slow.

DoD 5200.28-
STD(7)

The disk object or file is wiped using Department of Defense standard 5200.28-
STD(7). Provides high-grade data wiping filling the unused space or file with a
special digital pattern through 7 passes. This algorithm is very secure, but very
slow.

Bruce Schneier(7) The disk object or file is wiped using the Bruce Schneier(7) algorithm. The first
pass overwrites the drive with the bit pattern "00", the second with "11", and the
next five with a randomly generated bit pattern. This algorithm is very secure, but
very slow.

Peter Gutmann
(35)

The disk object or file is wiped using the Peter Gutmann's algorithm. Provides high-
grade data wiping filling the unused space or file with a special digital pattern
through 35 passes. This algorithm is military-level secure, but horribly slow.

What algorithm is to choose, depends on your specific needs. All of these wiping algorithms make recovery of
wiped data with any software-based data recover utility impossible. So if you want to protect your information
from a casual snooper, you may safely choose either the Zeroes or Pseudo-random numbers algorithm. The
latter also conceals the fact that you wiped the data.

If you want more security, you need to know the following: 

There are some techniques for recovery of wiped data. These techniques are based on the fact that magnetic
medium on the hard drive's platters "store" some information about previously written data. Such information
cannot be completely removed. Wiped data may be recovered even from mechanically damaged platters. So the
only safe way to completely remove data from a hard drive is to mechanically grind the magnetic medium off the
drive platters or dissolve them in special chemical solvents.  

But in order to recover the wiped data using one of these techniques, a hard drive must be disassembled, its
platters placed in a precise magnetic field measurement system, and the results of such measurement statistically

https://www.r-studio.com/What-is-data-wiping.html
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
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processed. All that is very expensive and requires a very qualified and experienced personnel and a specially
developed equipment. Only a very advanced organization such as a law enforcement or intelligence agency of a
developed nation, or a special high-tech firm can afford this. Moreover, each successive wiping pass makes such
data recovery much and much harder. So, the DoD 5220.22-M(3) clearing and sanitizing standard overwriting the
data with a special pattern through 3 passes is a rather reliable and safe choice for this case.

If you need the ultimate security, use the DoD 5220.22-M(7) clearing and sanitizing standard, the Bruce
Schneier(7), or even the Peter Gutmann (35) wiping algorithms. They render data almost unrecoverable, but they

are extremely slow.

Wiping Disk Objects:

To wipe a disk object,

1 Control-click the disk object in the Device view pane and select Wipe...

> The Wipe an object dialog box will appear.

Wiping Disk Objects

2 Select the desired wiping algorithms and click the OK button.

> R-Studio will start wiping the object.

2.3 Mass File Recovery

Recovery of multiple files

If you need to recover multiple files you may do it through the following steps:

1 Find and mark all the necessary files

Go to the Find and Mark Multiple Files topic for more information

2 Recover all marked files in a single file recovery step

Go to the Recover Multiple Files for more information

3 Create file recovery lists to manually edit the list of files to recovery 

Go to the File Recovery Lists topic for more information
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Memory considerations

R-Studio stores information about found files in computer memory. If there are too many files, R-Studio may
run out of it. To avoid this, you have two options:

Recover all files

If you want to recover data from an entire file system object (a logical disk, partition, partition image, etc.), you
may use the Recover All Files command from the Drive or contextual menu. Right click the object in the Drives

panel to access the contextual menu. A Recover dialog box will appear. Select required restore settings,
including file mask. This command restores unlimited number of files without memory restrictions.

View file information in steps

As soon as R-Studio nearly runs out of memory, a Too many files... message appears. You may temporally
stop file listing and browse through found files. Then you can resume file listing. You also may skip this file section
and continue file listing. 

In all cases, R-Studio keeps information about the entire file structure.

· Find and Mark Multiple Files 
· Recover Multiple Files
2.3.1 Find and Mark Multiple Files

If you need to find and mark many files at once, you may do that in the following ways:

By sorting them by their extensions or creation/modification/accessed time

To sort files by their extensions or creation/modification/accessed time,

* On the Folders panel select the tab

Real File
structure

to display the real file structure of the files/folders

Extensions  to sort the files by their extensions
Creation
Time

to sort the files by their creation time

Modification
Time

to sort the files by their modification time

Accessed
Time

to sort the files by their accessed time

 Other ways to sort files by their extensions or creation/modification/accessed time

· Select the disk on Drives panel, select Open Drive Files Sorted By on the Drive menu, and select the
respective option, 

or
· On the Folders panel, control-click the disk letter and select Show Files Sorted By on the contextual

menu and select the respective option,

> R-Studio will show the sorted files in the Folders and Content panels, showing the path to each file:

Folders panel for files sorted by their extensions

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Disk-Image.html
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Content panel with files/folders sorted by their extensions

To return to the conventional view,

* On the Drives panel, control-click the logical disk, select Open Drive Files Sorted By on the contextual
menu, and select Real File System Structure, 

or

On the Folders panel, select Show Files Sorted By on the Drive menu and select Real File System

Structure

or

Click the Real tab

By finding and marking multiple files using the Find/Mark dialog box

You may find and mark all the files on the entire disk by using Mark matched files in the Find/Mark mode option.
You may specify all the necessary search options and mark all the found files. Please note that each find and
mark/unmark operation is independent from previous ones. That is, if a file matches the search criteria, it will be
marked/unmarked regardless of its previous marked/unmarked state.

For example, if you first mark all doc files, and then all txt files, all doc files remain marked, too. If you then
decide to unmark all files smaller than 2 kB, all doc and txt files will stay marked except those that less than 2
kB.

2.3.2 Recover Multiple Files

If R-Studio while recovering files encounters either an already existing file or file with a broken name, normally it
will stop working and ask you what to do with the file. If you recover multiple files, that may require you answer
a lot of the same questions. You may use Mass File Recovery Options on the Recover dialog box to instruct R-
Studio what to do in those cases for all files.
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Recover (Advanced) dialog box

 Mass FIle Recovery Options

File Already Exists These options instruct R-Studio what to do if there already exists a file with
the same name. 

Extended options If this option is selected, more advanced options become accessible to
process multiple duplicates of the file.

Prompt If this option is selected, R-Studio asks the user what to do for each such file.
It stops file recovery until it receives the answer.

Rename If this option is selected, R-Studio adds a File ID to the file name. If a file
already exists with the same name and that file ID, a number will be added to
th file name and file ID.

Skip If this option is selected, R-Studio skips all new files with the same name.

Overwrite If this option is selected, R-Studio overwrites the existing file with the new
one.

Overwrite Older If this option is selected, R-Studio overwrites the existing file with the new one
if the existing file is older than the new file. The time stamp used is Modified.

Overwrite Smaller If this option is selected, R-Studio overwrites the existing file with the new one
if the existing file is smaller than the new file. The time stamp used is Modified.

Overwrite Bigger If this option is selected, R-Studio overwrites the existing file with the new one
if the existing file is bigger than the new file. The time stamp used is Modified.

Broken File Name These options instruct R-Studio what to do if a file to be recovered appears
to have an invalid name.

Prompt If this option is selected, R-Studio shows the standard Broken File Name

dialog box for each file with a broken file name. It stops file recovery until it
receives the answer.

Rename and change all
invalid symbols to:

If this option is selected, R-Studio changes all invalid characters to the
character specified.

Skip If this option is selected, R-Studio skips all files with broken file names.
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Hidden Attribute These options instruct R-Studio what to do if a file to be recovered appears
to have  the Hidden attribute.

Prompt If this option is selected, R-Studio asks the user what to do with the attribute.
It stops file recovery until it receives the answer.

Remove If this option is selected, R-Studio removes the Hidden attribute from all files.

Keep If this option is selected, R-Studio keeps the Hidden attribute for all files.

Extended options

These options give you more flexible ways to process multiple files with the same name. You may compare
files by time (Modified) and size, and decide what R-Studio should do with those duplicates. If any of the
files has an invalid time, the comparison by time is skipped. In this case, if comparison by size is not  active,
R-Studio goes to the default action..

Recover (Advanced - Extended options) dialog box

Extended advanced file recovery options

First
compare
time
First
compare
size 

These options instruct R-Studio which condition to use first, file time or size.

Compare
time
Compare size

These options instruct R-Studio to enable comparison by time and size..

Actions These selectable actions instruct R-Studio what to do if the condition is met.

Empty
field

If this option is selected, R-Studio skips the condition.

Prompt If this option is selected, R-Studio asks the user what to do for each such file. It stops file
recovery until it receives the answer.

Rename If this option is selected, R-Studio adds a File ID to the file name. If a file already exists with
the same name and that file ID, a number will be added to th file name and file ID.

Skip If this option is selected, R-Studio skips all new files with the same name.

Overwrite If this option is selected, R-Studio overwrites the existing file with the new one.
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Time
conditions

If the Modified time stamp is invalid, R-Studio will skip the comparison.

Equal time Two time stamps are the same.

Older The existing file is older than the new one.i

Newer The existing file is newer than the new one.i

Size
conditions

Equal size Two files have the same size.

Smaller The existing file is smaller than the new one.i

Bigger The existing file is bigger than the new one.i

By default The action R-Studio takes when none of the comparison conditions have been met. That
may happen when the comparison by size is not enabled. 

2.3.3 File Recovery Lists

You may create a file containing a list of files and folder found on a disk/partition. Then such file may be manually
edited to specify files to recover and then loaded back into R-Studio. R-Studio will automatically mark the files
in this list for recovery. Such file lists recovery are very useful, for example, when it is necessary to have such file
lists approved for recovery by someone else who is far away from the computer where R-Studio is running.

You may create file recovery lists for the entire disk or for specific folders. Moreover, you may create a file
recovery list for all files within the disk/folder, or for marked files/folders only.

All versions of R-Studio can create recovery lists in the plain text format with basic functionality. R-Studio
Technician/T80+ can create custom recovery lists in other formats with more advanced options 

Creating a simple recovery list

To create a recovery list

1 For an entire disk, select Export Recovery List on the File menu, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

For a specific folder, right-click the folder and select Export Recovery List on the shortcut menu.

2 Specify the place to save the recovery list and other necessary options on the Export Recovery List
dialog box

Export Recovery List dialog box

Options dialog box

https://www.r-studio.com/What-is-Disk-Partition.html
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Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML
XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio. So, if you

have some files in the recovery list that don't need to be recovered, just delete them from the list. In addition, you
may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.
:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio for Linux processes records in the list consequently. That is, if there are the following lines in the
file,
:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

Loading the edited recovery list

To load a recovery list into R-Studio for Linux,

* Select Import Recovery List from the File menu and select the file, or

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Import Recovery List on the shortcut menu.

> R-Studio for Linux will load the file and mark the files accordingly.

An example of a simple recovery list

As an example, we'll create a simple recovery list, edit it to mark only those files that are to be recovered, and
load it back to mark those files. 
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To create such recovery list

* Mark the necessary folders, right-click the Root folder, and select Export Recovery List on the shortcut
menu.

Right-click the uppermost folder (higher than Root, usually the letter or the name of the disk) and select
Export Recovery List on the shortcut menu.

Export Recovery List

Specify the necessary options and click the OK button.

> R-Studio will save the file.

Structure of a simple recovery list file created by R-Studio
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
Diving/MyPhoto1.jpg
Diving/MyPhoto2.jpg
Diving/MyPhoto3.jpg
Diving/MyPhoto4.JPG
Diving/MyPhoto5.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG
SF/Sea-Lions/IMG_3580.JPG
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SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
SF/IMG_3542.JPG
SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
System Volume Information/
System Volume Information/IndexerVolumeGuid
System Volume Information/WPSettings.dat
Vegas/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
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///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume

Now we need to edit this file to mark for recovery the following folders/files:

1. All files in the root folder;

2. Two files MyPhoto1.jpg and MyPhoto3.jpg in the Diving subfolder;

3. All files in the Diving/Aquarium/ folder;

4. All files in the SF/ folder except the SF/Sea-Lions/ subfolder.

The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

Loading the edited recovery list

When we load this recovery list into  R-Studio for Linux, will see the following results;

The root folder
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The Diving folder

The SF folder

2.4 Volume Sets and RAIDs

R-Studio detects and processes valid hardware volume sets and RAIDs like regular drives/volumes.

R-Studio can analyze and recover data from software volume sets and RAIDs. If a software volume set or
RAID is present in your system, R-Studio detects it, and a Volume sets and RAIDs object appears on the
Drives panel. This object can be searched for files, scanned, and files found on it can be recovered the same way
as from normal drives/volumes.

If, due to hardware failure, a hardware volume set or RAID cannot be accessed, or due to data loss your system
does not recognize a software volume set or RAID, and you know what hard drives were in it, you may create a
Virtual volume set or RAID and process it like a real software volume set or RAID or hardware volume set or
RAID.  

You may find more information on RAID types in our article What is Hardware RAID. 

· Volume Sets, Stripe Sets, and Mirrors

· Basic RAID 4 and RAID 5 Operations
· Working with RAID 6 Presets 
· Working with RAID6 (Double Xor)

· Working with RAIDs with Parity Delays
· Working with Advanced RAID Layouts
· Nested and Non-Standard RAID Levels
· Finding RAID Parameters
· Checking RAID Consistency
· Syntax of a Description File for RAID Configurations
· Description Files for RAID Configurations
· Reverse RAIDs
· Various Disk and Volume Managers
· Connecting Virtual Objects to the System

https://www.r-studio.com/What-is-Hardware-RAID.html
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Creating and saving your own RAID configuration

You may create and save your own RAID configurations for non-standard RAIDs. You may specify Offset,
Block order/size and Row count. See Working with Advanced RAID Layouts for details.

To save your own RAID configuration

1 Select <New> in the Blocks order drop-down list

2 Specify the name for the configuration on the Preset name dialog box.

Preset name dialog box

> The new RAID configuration will be saved

The configurations are stored in the user's RAID layout file. The path and name for this file is specified on the
R-Studio Settings dialog box. If no file is specified, R-Studio will ask you to enter the name.

Loading your RAID configuration 

If there're objects in the Parents tab, the preset will be applied to them. If the Parents tab is empty, R-Studio
will search the disks listed in the Drives tab for the parents in the user's RAID layout file. If the search fails, R-
Studio will show the Reference Parents not found message.

To load your RAID configuration 

* Select your configuration in the Blocks order drop-down list

> The new RAID configuration will be loaded

To edit your own RAID configuration

1 Select <Edit> in the Blocks order drop-down list

2 Select the required configuration on the Edit Block RAID Layout Presets dialog box.

Edit Block RAID Layout Presets dialog box

3 Edit the parameters of the configuration and save it

> The new configuration parameters will be saved.

Turning Disks On-Line and Off-Line on-the-fly

You may turn the objects in the virtual RAID or volume set on-line and off-line by selecting/clearing the
checkbox on the Parents tab. It may be useful, for example, if you need to see which disk is non-actual in a
RAID5. 

Actually, when you turn an object off-line, R-Studio substitutes it with a Missing Disk or Empty Space object.
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Missing Disks

If one partition from a hardware volume set or RAID or software volume set or RAID is absent, due to hardware
failure, for example, you need to add a virtual missing disk in order to correctly re-construct the hardware volume
set or RAID or software volume set or RAID structure. The missing disk should be placed in the same place as
the missing partition. 

Note: R-Studio does not write anything real on the disk. Missing disks are virtual objects that do not affect
actual data on the drive.

To add an Missing disk object 

1 Select a Volume sets and RAIDs object on the R-Studio's Drives panel

2 Control-click in the Parents tab in the right pane and select Add Missing Disk on the contextual menu
or select Add Missing Disk in the Create menu 

> A Missing Disk object will appear in the Parents tab

2.4.1 Volume Sets, Stripe Sets, and Mirrors

To create a Volume set object

1 Click the Create Virtual RAID button and select Create Virtual Volume set

or select the Create Virtual Volume set on the Create menu

> A Virtual Volume set object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

> The Virtual volume set or RAIDs object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

To create a Stripe set object (RAID 0)

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 0 (Stripe set) on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The Block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Block order. You may select it on the Block order drop-down or contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.



R-Studio for Mac Manual98

© 2024 R-Tools Technology Inc.

> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

To create a Mirror set object (RAID 1)

1 Click the Create Virtual RAID button and select Create Virtual Mirror

or select the Create Virtual Mirror on the Create menu

> A Virtual Mirror object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

https://www.r-studio.com/What-is-Disk-Partition.html
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> The Virtual Mirror object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

2.4.2 Basic RAID 4 and RAID 5 Operations

RAID 4 and RAID 5 are much similar. You may create and edit a RAID 4 object the same way as a RAID 5
one. 

To create a RAID 5 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 5 on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

https://www.r-studio.com/What-is-Disk-Partition.html
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Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5 

You also need to specify Block order for virtual RAID 5. You may select it on the Block order drop-down or
contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5. Find a file and preview it.
If the file appears correct, you have created a correct RAID 5 layout. 

If your RAID 5 has an unusual configuration, you may create them manually. See Working with Advanced
RAID Layouts for details.

Parents tab

> The RAID 5 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

https://www.r-studio.com/What-is-Disk-Partition.html
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Creating and saving your own RAID 5 configuration

You may create and save your own RAID configurations for non-standard RAIDs. You may specify Offset,
Block order/size and Row count. See Working with Advanced RAID Layouts for details.

2.4.3 Working with RAID6 Presets

R-Studio allows you to create and process RAID 6 layouts. You may use either presets for several RAID 6
layouts, or use your own custom ones.

R-Studio provides presets for the following RAID 6 layouts::

Reed-Solomon

Left Synchronous
(standard),

Left Asynchronous
(continuous),

Right Synchronous Right Asynchronous

In addition you may create your own RAID 6 configurations.

Creating a RAID 6 object from a preset:

We will use the Reed-Solomon (Left Synchronous (standard)) preset as an example.

To create a RAID 6 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 6/Reed-Solomon on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Parents tab
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Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (Left Synchronous (standard) for our case) for virtual RAID 6. You may
select it on the Blocks order drop-down or contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but it cannot be recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.4 Working with RAID6 (Double Xor) Presets

R-Studio allows you to create and process RAID 6 Double Xor layouts with the following presets:

EVENODD RAID DP X-Code(2) Adaptec 3805

In addition you may create your own RAID 6 configurations.

Creating a RAID 6 (Double Xor) object from a preset:

We will use the EVENODD preset as an example.

To create a RAID 6 (Double Xor) object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Select RAID 6 / Double Xor on the RAID type

3 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 
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Parents tab

Note: Objects should be placed in the same order as they were in the original volume set. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original volume set. 

You also need to specify Blocks order (EVENODD for our case) for virtual RAID 6 (Double Xor). You may
select it on the Blocks order drop-down or contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but they cannot be
recovered.

Note: You may check how correctly you have reconstructed the original volume set or RAID. Find a file
and preview it. If the file appears correct, you have created a correct RAID layout. 

> The Virtual Block RAID object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel. The Description Files for RAID Configurations topic shows the RAID description file
for this RAID configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.5 Working with RAIDs with Parity Delays

R-Studio allows you to create RAIDs with parity delays (any level that allows that). For example, let us create a
RAID 5 the parity delays with the following layout:

· Three disks, 
· Delay=16
· Block size: 16 KB
· Offset: 1088 sectors (544 KB)
· Block order: Left Asynchronous (Continuous)

 Block order table:

A B C

Delay=16

1 1 2 PD
2 3 4 PD
3 5 6 PD
4 7 8 PD
5 9 10 PD
6 11 12 PD
7 13 14 PD
8 15 16 PD
9 17 18 PD

10 19 20 PD
11 21 22 PD
12 23 24 PD
13 25 26 PD
14 27 28 PD
15 29 30 PD
16 31 32 PD
17 33 PD 34

Delay=16
18 35 PD 36
19 37 PD 38
20 39 PD 40
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21 41 PD 42
22 43 PD 44
23 45 PD 46
24 47 PD 48
25 49 PD 50
26 51 PD 52
27 53 PD 54
28 55 PD 56
29 57 PD 58
30 59 PD 60
31 61 PD 62
32 63 PD 64
33 PD 65 66

Delay=16

34 PD 67 68
35 PD 69 70
36 PD 71 72
37 PD 73 74
38 PD 75 76
39 PD 77 78
40 PD 79 80
41 PD 81 82
42 PD 83 84
43 PD 85 86
44 PD 87 88
45 PD 89 90
46 PD 91 92
47 PD 93 94
48 PD 95 96

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
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These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Note: Objects should be placed in the same order as they were in the original RAID 5. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Specify the parity delay number in the Parity delay control on the  Parents tab. 

The number of rows will change to 48. 

If necessary, adjust the First parity parameter

By default, this parameter is set equal to Parity delay. By changing it, you may "shift" the block order table.
For example, when the First parity parameter is set as 1 for the RAID 5 of 3 disks with Parity delay of 3.,
the block order table will be the following:First parity parameter

https://www.r-studio.com/What-is-Disk-Image.html
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5 Select Left Asynchronous (Continuous) on the Block Order Field and click the Apply button on the
Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear on the Drives

panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.6 Working with Advanced RAID Layouts

R-Studio allows you to create and process very complex custom RAID layouts.
Advanced RAID 5

For example, let us create a RAID 5 with the following layout:

· Three disks, 
· Block size: 4 KB
· Offset: 32768 sectors (64 KB)
· Block order:

A B C

1 PD 1 2
2 PD 3 4

https://www.r-studio.com/What-is-Disk-Partition.html
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3 PD 5 6
4 7 PD 8
5 9 PD 10
6 11 PD 12
7 13 14 PD
8 15 16 PD
9 17 18 PD

To create such RAID 5,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID

or select Create Virtual Block RAID on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

https://www.r-studio.com/What-is-Disk-Image.html
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4 Manually enter 9 to Number of rows on the Parents tab

5 Enter the block order in the table on the Parents tab

Use the RAID sequence window to move from one row to another. 

Using the keyboard: arrow keys to navigate, digit and p keys to enter the block order.

Using the mouse: control-click the cell and select the number or parity from the contextual menu. If the
block table is too large, you better use the keyboard to enter the digits. 

Corrections: R-Studio will tell you if some digits are not correct. Navigate to the required cell and enter the
correct value. Use the Delete key to clear a cell. 

Clear the table: Control-click the table and select Clear all on the contextual menu.

6 When you finishes entering the information, click the Apply button on the Parents tab
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> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear on the Drives

panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Advanced RAID 5

Another example is a RAID with the following layout, similar to that used in Mac Pro internal RAID cards with 4
hard drives.

· Four disks, 
· Block size: 512 KB (1024 sectors)
· Offset: 32768 sectors (64 KB)
· Block order:

A B C D A B C D A B C D

PD 1 2 PD 3 4 PD 5 6 PD 7 8

As you see, this layout cannot be fit directly into a standard 2D block order table. Still, it's possible to create
such RAID layout using the RAID Sequence window.

https://www.r-studio.com/What-is-Disk-Partition.html
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To create such RAID,

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID & Autodetect

or select Create Virtual Block RAID & Autodetect on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select RAID 5 on the RAID type

 

These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed.

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order field.

4 Manually enter 3 to Number of rows on the Parents tab and change Block order to Custom

5 Control-click the RAID Sequence window and select Remove All. Manually enter 3 to Number of rows
on the Parents tab and change Block order to Custom

6 Control-click Cell 1 in the block order table and select Create New Sequence. 

7 Control-click Cell 2 in the block order table and select Add to Sequence, do that for Cell 3, too. 

8 Control-click Cell 4 in the block order table and select Create New Sequence. 

9 Control-click Cell 5 in the block order table and select Add to Sequence, do that for Cell 6, too. 

Continue those steps for the rest of the table until the RAID Sequence window will have 4 sequences of 3
disks:

https://www.r-studio.com/What-is-Disk-Image.html
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Sequences window

10 Select the first line in the RAID Sequence window, control-click Cell 1 in the block order table, and
select Parity of Data. 

If any unnecessary sequences appear, control-click them in the RAID Sequence window, and select
Remove.

11 Control-click Cell 2 in the block order table and select 1, do that for Cell 3 selecting 2. 

If any unnecessary sequences appear, control-click them in the RAID Sequence window, and select
Remove.

12 Move to the next sequence in the  RAID Sequence window and repeat the procedure for cells 4, 5, and
6. 

Do that for the rest of the sequences until you fill all cells in the block order table in the Parents tab. 

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear on the Drives

panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

https://www.r-studio.com/What-is-Disk-Partition.html
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You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

Advanced RAID 6 Layout

For example, let us create a RAID 6 with the following layout:

· Five disks, 

· Block size: 64 KB
· Offset: 0
· Block order:

A B C D E

1 RS 1 2 3 PD
2 4 5 6 PD RS
3 8 9 PD RS 7
4 12 PD RS 10 11
5 PD RS 13 14 15
6 PA PA PA PA PA

where 

PD is parity of data;
PA is parity of all;
RS is Reed-Solomon;

Rows from 1 to 5 use two types of error correction: parity of data (xor) and Reed-Solomon. That is, row 1 uses
blocks A1 and E1, row 2 uses blocks D2 and E2, and so on. 

Row 6 is used for error correction for columns. That is, column A uses block A6, column B uses B6, and so on.
Parity of all is used for error correction.

1 Click the Create virtual volume sets or RAIDs button and select Create Virtual Block RAID

or select Create Virtual Block RAID on the Create menu

Check that the Apply changes immediately check box is clear on the Parents tab. This will prevent R-Studio
from trying to start processing the RAID configuration until you specify it completely.

2 Drug the required objects from the Drives pane to the Parents tab and select Custom on the RAID type

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.
These objects may be hard drives, logical disks, or images. Check that the objects are correctly placed. 
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Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

3 Specify the Block size and Offset parameters on the Parents tab

Disregard the Block order parameter.

4 Manually enter 6 to Number of rows on the Parents tab

5 Enter the block order in the table on the Parents tab

You may enter either a block number, or an error correction block of the following types:

PD Parity of data
PA Parity of all
RS Reed-Solomon
U Unknown
I Ignore

Note: You should specify an error correction block only when the correct sequence is selected on the RAID

Sequences window.

Using the keyboard: arrow keys to navigate, digit, and rs, pd, pa, u, i keys to enter the block order.

Using the mouse: control-click the cell and select the number or parity from the contextual menu. If the
block table is too large, you better use the keyboard to enter the digits.
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For the rows:

Select the required row sequence on the RAID Sequences window, select the cell on the RAID table, and
enter the required value. R-Studio automatically generates those sequences when you add RAID parents.

For the columns and arbitrary sequences:

You need to create those sequences and add the respective blocks to it manually. 

To create a sequence: Click Add empty on the RAID Sequences window or select Create New

Sequence on the contextual menu on the Parents tab.

To add a block to a sequence: Control-click the respective cell and select Add To Sequence on the
contextual menu on the Parents tab.

To remove a block to a sequence: Control-click the respective cell and select Remove From Sequence

on the contextual menu on the Parents tab.

6 When you finishes entering the information, click the Apply button on the Parents tab

> The created Virtual Block RAID 1 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on this RAID object, a partition object will appear on the Drives

panel.

https://www.r-studio.com/What-is-Disk-Partition.html
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The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7 Nested and Non-Standard RAID Levels

R-Studio can work with various nested and non-standard RAID levels. Currently, the following RAID levels are
supported:

· RAID10 (1+0)

· RAID1E

· RAID5E

· RAID5EE

· RAID6E
2.4.7.1 RAID10 (1+0)

A RAID 10 (or 1+0) is a stripe of mirrors. Its block order can be represented as:
A B C D

1 1 1 2 2

To create a RAID 10 object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.

https://www.r-studio.com/What-are-Nested-Non-Standard-RAIDs.html
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3 Select RAID 10 on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 10. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 10. 

You also need to specify Block order for virtual RAID 10. You may select it on the Block order drop-down or
contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 10
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 10. Find a file and preview
it. If the file appears correct, you have created a correct RAID 10 layout. 

Parents tab
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> The RAID 10 object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.2 RAID1E

RAID 1E is utilizes both the mirroring and striping: data is striped across all drives, as in RAID 0. Additionally, a
copy of each stripe is stored on a different drive, as in RAID 1. Its block order can be represented as:

A B C

1 1 1 2
2 2 3 3

To create a RAID 1E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

https://www.r-studio.com/What-is-Disk-Partition.html
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the RAID object you want to add the partition to.

3 Select RAID 1E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 1E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 1E. 

You also need to specify Block order for virtual RAID 1E You may select it on the Block order drop-down or
contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 1E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 1E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 1E layout. 

Parents tab



Data Recovery Using R-Studio 121

© 2024 R-Tools Technology Inc.

> The RAID 1E object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.3 RAID5E

RAID 5E (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 3 PD
2 5 6 PD 4
3 9 PD 7 8
4 PD 10 11 12
5 SP SP SP SP

where PD and SP stand for Parity of Data and Spare Part.

To create a RAID 5E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.

3 Select RAID 5E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5E. 

You also need to specify Block order for virtual RAID 5E You may select it on the Block order drop-down or
contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 5E
cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5E layout. 
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Parents tab

> The RAID 5E object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.4 RAID5EE

RAID 5EE (where E stands for Enhanced) is a RAID 5 layout with an integrated hot-spare drive, where the
spare drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D

1 1 2 SP PD
2 4 SP PD 3
3 SP PD 5 6
4 PD 7 8 SP

where PD and SP stand for Parity of Data and Spare Part.

To create a RAID 5EE object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

https://www.r-studio.com/What-is-Disk-Partition.html
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> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.

3 Select RAID 5EE on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 5EE. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 5EE. 

You also need to specify Block order for virtual RAID 5EE You may select it on the Block order drop-down
or contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID
5EE cannot be recovered.

Note: You may check how correctly you have reconstructed the original RAID 5EE. Find a file and preview
it. If the file appears correct, you have created a correct RAID 5EE layout. 
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Parents tab

> The RAID 5EE object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.7.5 RAID6E

RAID 6E (where E stands for Enhanced) is a RAID 6 layout with an integrated hot-spare drive, where the spare
drive is an active part of the block rotation scheme. An example of such RAID layout is in the table below:

A B C D E F

1 RS 1 2 3 4 PD
2 5 6 7 8 PD RS
3 10 11 12 PD RS 9
4 15 16 PD RS 13 14
5 20 PD RS 17 18 19
6 PD RS 21 22 23 24
7 SP SP SP SP SP SP

where RS, PD and SP stand for Reed-Solomon, Parity of Data, and Spare Part, respectively.

https://www.r-studio.com/What-is-Disk-Partition.html
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To create a RAID 6E object

1 Click the Create Virtual RAID button and select Create Virtual Block RAID

or select the Create Virtual Block RAID on the Create menu

> A Virtual Block RAID object will appear on the Drives panel

2 Drag the required partitions from the Drives panel to the Parents tab

 Other ways to add objects

· Control-click the Parents tab and select the required partition from the contextual menu, 
or
· Control-click the partition on the  Drives panel, select Add to RAID on the contextual menu, and select

the RAID object you want to add the partition to.

3 Select RAID 6E on the RAID type

You may either make R-Studio to process your changes immediately or wait until you finish editing the
RAID layout. Select or clear the Apply changes immediately checkbox on the Parents tab. Click the Apply

button to apply the changes when are you through. 

Note: Objects should be placed in the same order as they were in the original RAID 6E. If this order is
incorrect, you must change it by dragging the parents to place them in the correct order. 

Object control buttons

Locate Click this button to locate the selected object in the Drives

panel.

Add Empty Space/Add Missing Disk Click this button to add an empty space or missing disk object
to the RAID

Remove Click this button to remove the selected object from the RAID

Move Up Click this button to move up the selected object in the RAID

Move Down Click this button to move down the selected object in the RAID

Synchronize Offsets Click this button to make the offsets the same for all objects in
the RAID

Reset changes Click this button to return the configuration to the initial state
(after clicking the Apply button or immediately after loading)

The RAID block size and Offset (in sectors) parameters must be set the same as for the original RAID 6E. 

You also need to specify Block order for virtual RAID 6E You may select it on the Block order drop-down or
contextual menu.

If the those parameters are not correct, data on the parents will not be damaged, but files from the RAID 6E
cannot be recovered.
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Note: You may check how correctly you have reconstructed the original RAID 6E. Find a file and preview
it. If the file appears correct, you have created a correct RAID 6E layout. 

Parents tab

> The RAID 6E object can now be processed like regular drives/volumes

If R-Studio detects a valid file system on the newly created RAID object, a partition object will appear on
the Drives panel.

The Description Files for RAID Configurations topic shows the RAID description file for this RAID
configuration.

You also may check the RAID consistency, if necessary. See the Checking RAID Consistency help page
for details.

2.4.8 Finding RAID Parameters

R-Studio can find parameters for RAID 5 and 6. RAID parameters can be found automatically or manually.

The number of disks in the RAID should be between 3 and 32. RAID parameters can be found only when all
original disks (or their images) are present. Even one substitute object in a RAID (like a missing disk) makes
finding RAID parameters impossible.

To find RAID parameters automatically, 

1 Click the Auto Detect button on the Parents tab

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-Disk-Image.html
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> R-Studio will start searching for the RAID parameters and show the most probable one on the RAID
Parameter Detection dialog box

 RAID Parameter Detection dialog box

2 Click the Apply button and R-Studio will change the RAID layout to the selected one on the Parents

tab.

3 Click the Apply button on the Parents tab

>  R-Studio will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

To find RAID parameters manually, 

1 Click the drop-down Auto Detect list on the Parents tab and select Advanced Detection.

2 Specify the necessary detection parameters on the RAID Parameter Detection dialog box and click the
Start detection button

Raid Parameters Detection dialog box

You may change the disk order, offset for disk(s), and enable /disable disks.
Advanced Parameters

Max offset: The area on the disk to find RAID parameters in. 
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Offset search
performance
RAID layouts search
performance

Cumulative parameters that estimates the probability of certain found RAID
parameters. Moving it to the right increases accuracy but slows the process.
Moving it to the left reduces the accuracy but makes the process faster. 

3 Select an offset and click the Click here to find RAID Layouts button on the Raid Parameters Detection
dialog box

RAID Parameters Detection dialog box

You may add your own RAID offsets. Control-click empty space on the Found offsets pane and select Add
Custom offset on the contextual menu and specify the offset individually for every disk.

4 Select a RAID variant on the Found RAID layouts pane and click the Apply button

5 Click the Apply button on the Parents tab

>  R-Studio will use the found parameters for the RAID.

If necessary, you may return to the RAID Parameter Detection dialog box by clicking the Choose Variants

button, and select another RAID layout. 

2.4.9 Checking RAID consistency

You may check RAID consistency (whether the data parity values are valid) for RAID layouts with parity
blocks.

To check RAID consistency,

* Control-click the RAID and select Check RAID consistency... on the contextual menu

> The RAID consistency check window will appear showing the progress. 
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RAID consistency check window

When the check is finished, you may inspect the results.

Block
color
Green Data parity values are valid.
Red Data parity values are not valid.
White 0's

When a mouse pointer hovers over a block, a tooltip will show the sector range within the block and number
of consistent and inconsistent sectors. Double-clicking the block moves it to the upper-leftmost corner and
zooms in the data by 2.

 RAID consistency check controls

Sectors The number of the first sector in the row.

Offset Offset in the data. Enter the address you want to jump to and press the Enter key.

Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.

Previous/Next Moves to the previous/next part of the data.

+/- Zooms into/out of, the data.

2.4.10 Syntax of a Description File for RAID Configurations

You may create and store your own RAID configurations The syntax of those files is similar to that of the XML
language. They are stored in an .xml file specified on the R-Studio Settings.

A number of file examples are shown on the Description Files for RAID Configurations topic.

There are two types of such description files: for RAID presets and custom-created RAID layouts.

RAID preset configuration file

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2" parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>
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Custom-created RAID configuration file example

<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
            <Block id="D5">14</Block>
            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>
            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>
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File structure

File header

The file starts with a standard  XML header:
<?xml version="1.0" encoding="utf-8"?>

Section RAIDList
<RAIDList>

It can contain any number of the <RAID> sections and requires a closing element </FileTypeList>.

Section structure example: 
  <RAIDList>
    <RAID [attributes]>
      ...
    </RAID>
    ...
    <RAID [attributes]>
      ...
    </RAID>

Section RAID

This section describes each RAID layout.

It must contain at least one <Table> and <Parents> sections and can contain one block <Sequences>..
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2" parityDelay="1">
        <Parents>
            
        </Parents>
        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>
</RAIDList>

Attributes:
blocksize <u32> Required The block size of the RAID in bytes
name <string> Optional The name of the RAID layout
rows <u16> Required The number of rows in the RAID layout table.
type <u16> Required The type of the RAID preset. The following types are

supported:
1: RAID0 (Stripe set)
2: RAID10
3: RAID1E
4: RAID4
5: RAID5
6: RAID5E
7: RAID5EE
8: RAID6 / Reed-Solomon Encoding
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9: RAID6E / Reed-Solomon Encoding
10: RAID6 / Vertical Xor Encoding
256: Custom Raid Table
If the RAID type parameter contradicts to the RAID table,
the RAID table always prevails.

order <u16> Required/Optio
nal

The RAID sub-type. For example, order="2" means Left
Asynchronous for RAID5 layouts. Any value for the custom
RAID layouts will be ignored. 

parityDelay <u16> Required The Parity delay parameter.

Section structure example:
<RAID blockSize="65536" rows="6" type="256">
        <Parents>

        </Parents>

        <Table>

        </Table>
        <Sequences>

        </Sequences>
    </RAID>

Section Parents

This section describes the RAID parents. It contains the <Parent> elements of the RAID.

Section structure example:
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="3"/>
        </Parents>

Element Parent

The element specifies the parent of the RAID.

Attributes:
comp <string> Required/O

ptional
The file-container with the parent object.

name <string> Required The object name of the RAID parent.
offset <u16> Required is

not 0
The offset value in bytes

size= <u16> Required The object size in bytes
order <u16> Required The order of the RAID object

Section Table

This section describes the RAID layout table. It contains the <Block> elements which number is a product of
two attributes in the <RAID> section: <parents> x <rows>.



R-Studio for Mac Manual134

© 2024 R-Tools Technology Inc.

Section structure example:
  <RAIDList>
    <RAID name="example" parents="2" rows="2" blocksize="16777216">
      <Table>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
        <Block [attributes]> ... </Block>
      </Table>
    </RAID>
  </RAIDList>

Element Block

The element specifies the block number in the RAID layout table (a positive integer number) or an error
correction block of the following types:

· PD or ParityOfData

· PA or ParityOfAll

· RS or ReedSolomon

· U or Unknown

· I or Ignore

Any other value is treated as Unknown.

Attributes:
id <string> Required The alpha-numerical identifier of the block in the RAID layout

table. The element in the 3-rd column of the 2-nd line is
designated as C2. AA is used after letter Z, and so on.

sequence <string> Optional The numerical identifier for non-default sequences.

Section Sequences

This section describes the non-default data checksum sequences used to preserve data integrity. It is not
necessary to explicitly list default sequences (the table rows). Sequences can contain any number of the
<Sequence> elements. 

Section structure example:
  <RAIDList>
    <RAID name="example" parents="4" rows="4" blocksize="16777216">
     <Parents>
     
     </Parents>
      <Table>
        ...
      </Table>
      <Sequences>
        <Sequence [attributes]> ... </Sequence>
        ...
        <Sequence [attributes]> ... </Sequence>
      </Sequences>
    </RAID>
  </RAIDList>
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Element Sequence

The element contains the list of the RAID blocks belonging to that sequence. The elements are separated by a
space .

Attributes:
id <u16> Required The sequence identifier.

Element example:

See the RAID configuration file example.

Comments
<!-- Comment string -->

An XML standard string for a comment.

2.4.11 Description Files for RAID Configurations

Below are description files for RAID examples described in the Volume Sets and RAIDs chapter. The syntax
of them is described in the Syntax of a Description File for RAID Configurations topic.

StripeSet

The stripe set layout is described in the Volume Sets, Stripe Sets, and Mirrors topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="StripeSet" rows="2" type="1" order="7" parityDelay="1">
        <Parents>
            <Parent comp="RAID0Disk1.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="1"/>
            <Parent comp="RAID0Disk2.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="2"/>
        </Parents>
    </RAID>
</RAIDList>

Basic RAID 5

The RAID layout is described in the Working with Basic RAID 4 and RAID 5 Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5" rows="3" type="5" order="2" parityDelay="1">
        <Parents>
            <Parent comp="RAID5Disk1.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="1"/>
            <Parent comp="RAID5Disk2.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="2"/>
            <Parent comp="RAID5Disk3.dsk" name="Promise1+0 JBOD1.10" size="40060321792" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID 5 with parity delays

The RAID layout is described in the RAID5 with Parity Delays Operations topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="16384" name="RAID5HP" rows="48" type="5" order="2" parityDelay="16" firstParity="16">
        <Parents>
            <Parent name="RAID5HPDisk1.bin" offset="557056" size="941359104" order="1"/>
            <Parent name="RAID5HPDisk2.bin" offset="557056" size="941359104" order="2"/>
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            <Parent name="RAID5HPDisk3.bin" offset="557056" size="941359104" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="4096" name="RAID5Complex" rows="9" type="256">
        <Parents>
            <Parent name="RAID5CDisk1.bin" offset="16777216" size="941359104" order="1"/>
            <Parent name="RAID5CDisk2.bin" offset="16777216" size="941359104" order="2"/>
            <Parent name="RAID5CDisk3.bin" offset="16777216" size="941359104" order="3"/>
        </Parents>
        <Table>
            <Block id="A1">XorOfData</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="A2">XorOfData</Block>
            <Block id="B2">3</Block>
            <Block id="C2">4</Block>
            <Block id="A3">XorOfData</Block>
            <Block id="B3">5</Block>
            <Block id="C3">6</Block>
            <Block id="A4">7</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">8</Block>
            <Block id="A5">9</Block>
            <Block id="B5">XorOfData</Block>
            <Block id="C5">10</Block>
            <Block id="A6">11</Block>
            <Block id="B6">XorOfData</Block>
            <Block id="C6">12</Block>
            <Block id="A7">13</Block>
            <Block id="B7">14</Block>
            <Block id="C7">XorOfData</Block>
            <Block id="A8">15</Block>
            <Block id="B8">16</Block>
            <Block id="C8">XorOfData</Block>
            <Block id="A9">17</Block>
            <Block id="B9">18</Block>
            <Block id="C9">XorOfData</Block>
        </Table>
    </RAID>
</RAIDList>

Advanced RAID 5

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="524288" name="RAID_MacPro" rows="3" type="256">
        <Parents>
            <Parent name="RAID_MAC_ProDisk1.bin" fs="NTFS" offset="16777216" size="941359104" order="1"/>
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            <Parent name="RAID_MAC_ProDisk2.bin" offset="16777216" size="941359104" order="2"/>
            <Parent name="RAID_MAC_ProDisk3.bin" offset="16777216" size="941359104" order="3"/>
            <Parent name="RAID_MAC_ProDisk4.bin" offset="16777216" size="941359104" order="4"/>
        </Parents>
        <Table>
            <Block id="A1" sequence="1">XorOfData</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1" sequence="2">XorOfData</Block>
            <Block id="A2">3</Block>
            <Block id="B2">4</Block>
            <Block id="C2" sequence="3">XorOfData</Block>
            <Block id="D2">5</Block>
            <Block id="A3">6</Block>
            <Block id="B3" sequence="4">XorOfData</Block>
            <Block id="C3">7</Block>
            <Block id="D3">8</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 B1 C1</Sequence>
            <Sequence id="2">D1 A2 B2</Sequence>
            <Sequence id="3">C2 D2 A3</Sequence>
            <Sequence id="4">B3 C3 D3</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID 6 Reed-Solomon (Left Synchronous (Standard)) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6RS" rows="5" type="8" order="1" parityDelay="1">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
    </RAID>
</RAIDList>

RAID6 (Double Xor) Preset

The RAID layout is described in the Working with RAID 6 Presets topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID62X" rows="4" type="10" order="1" parityDelay="1">
        <Parents>
            <Parent name="RAID62X1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID62X2.bin" size="941359104" order="2"/>
            <Parent name="RAID62X3.bin" size="941359104" order="3"/>
            <Parent name="RAID62X4.bin" size="941359104" order="4"/>
            <Parent name="RAID62X5.bin" size="941359104" order="5"/>
            <Parent name="RAID62X6.bin" size="941359104" order="6"/>
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        </Parents>
    </RAID>
</RAIDList>

Advanced RAID 6

The RAID layout is described in the Working with Advanced RAID Layouts topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6Complex" rows="6" type="256">
        <Parents>
            <Parent name="img1.bin" size="941359104" order="1"/>
            <Parent name="img2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="img3.bin" size="941359104" order="3"/>
            <Parent name="img4.bin" size="941359104" order="4"/>
            <Parent name="img5.bin" size="941359104" order="5"/>
        </Parents>
        <Table>
            <Block id="A1">ReedSolomon</Block>
            <Block id="B1">1</Block>
            <Block id="C1">2</Block>
            <Block id="D1">3</Block>
            <Block id="E1">XorOfData</Block>
            <Block id="A2">4</Block>
            <Block id="B2">5</Block>
            <Block id="C2">6</Block>
            <Block id="D2">XorOfData</Block>
            <Block id="E2">ReedSolomon</Block>
            <Block id="A3">8</Block>
            <Block id="B3">9</Block>
            <Block id="C3">XorOfData</Block>
            <Block id="D3">ReedSolomon</Block>
            <Block id="E3">7</Block>
            <Block id="A4">12</Block>
            <Block id="B4">XorOfData</Block>
            <Block id="C4">ReedSolomon</Block>
            <Block id="D4">10</Block>
            <Block id="E4">11</Block>
            <Block id="A5">XorOfData</Block>
            <Block id="B5">ReedSolomon</Block>
            <Block id="C5">13</Block>
            <Block id="D5">14</Block>
            <Block id="E5">15</Block>
            <Block id="A6" sequence="1">XorOfAll</Block>
            <Block id="B6" sequence="2">XorOfAll</Block>
            <Block id="C6" sequence="3">XorOfAll</Block>
            <Block id="D6" sequence="4">XorOfAll</Block>
            <Block id="E6" sequence="5">XorOfAll</Block>
        </Table>
        <Sequences>
            <Sequence id="1">A1 A2 A3 A4 A5 A6</Sequence>
            <Sequence id="2">B1 B2 B3 B4 B5 B6</Sequence>
            <Sequence id="3">C1 C2 C3 C4 C5 C6</Sequence>
            <Sequence id="4">D1 D2 D3 D4 D5 D6</Sequence>



Data Recovery Using R-Studio 139

© 2024 R-Tools Technology Inc.

            <Sequence id="5">E1 E2 E3 E4 E5 E6</Sequence>
        </Sequences>
    </RAID>
</RAIDList>

RAID10 (1+0)

The RAID layout is described in the RAID10 (1+0) topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID10" rows="1" type="2" order="7" parityDelay="1">
        <Parents>
            <Parent name="RAID10-1.bin" size="941359104" order="1"/>
            <Parent name="RAID10-2.bin" size="941359104" order="2"/>
            <Parent name="RAID10-3.bin" size="941359104" order="3"/>
            <Parent name="RAID10-4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID1E

The RAID layout is described in the RAID1E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID1E" rows="2" type="3" order="1" parityDelay="1">
        <Parents>
            <Parent name="RAID1EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID1EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID1EDisk3.bin" size="941359104" order="3"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5E

The RAID layout is described in the RAID5E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5E" rows="5" type="6" order="1" parityDelay="1">
        <Parents>
            <Parent name="RAID5EDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EDisk2.bin" size="941359104" order="2"/>
            <Parent name="RAID5EDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EDisk4.bin" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID5EE

The RAID layout is described in the RAID5EE topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID5EE" rows="4" type="7" order="1" parityDelay="1">
        <Parents>
            <Parent name="RAID5EEDisk1.bin" fs="NTFS" size="941359104" order="1"/>
            <Parent name="RAID5EEDisk2.bin" size="941359104" order="2"/>
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            <Parent name="RAID5EEDisk3.bin" size="941359104" order="3"/>
            <Parent name="RAID5EEDisk4.bin" fs="NTFS" size="941359104" order="4"/>
        </Parents>
    </RAID>
</RAIDList>

RAID6E

The RAID layout is described in the RAID6E topic.
<?xml version="1.0" encoding="UTF-8"?>
<RAIDList version="1">
    <RAID blockSize="65536" name="RAID6E" rows="7" type="9" order="1" parityDelay="1">
        <Parents>
            <Parent name="RAID6E1.bin" size="941359104" order="1"/>
            <Parent name="RAID6E2.bin" fs="NTFS" size="941359104" order="2"/>
            <Parent name="RAID6E3.bin" size="941359104" order="3"/>
            <Parent name="RAID6E4.bin" size="941359104" order="4"/>
            <Parent name="RAID6E5.bin" size="941359104" order="5"/>
            <Parent name="RAID6E6.bin" size="941359104" order="6"/>
        </Parents>
    </RAID>
</RAIDList>

2.4.12 Various Disk and Volume Managers

R-Studio can work with objects created by various disk and volume managers. Currently, the following
managers are supported:

· BitLocker Drive Encryption

· Windows Dynamic Disks

· Windows Storage Spaces

· Apple RAIDs

· Apple CoreStorage/FileVault/Fusion Drive Volumes

· Linux mdadm RAIDs

· Logical Volume Manager (LVM and LVM2)

R-Studio can automatically recognize and add their physical components, component images, or the user can
manually add the components when their data is damaged so severely that R-Studio cannot recognize them. 

In addition, R-Studio can work with various virtual disk and disk image formats.
2.4.12.1 BitLocker Drive Encryption

BitLocker Drive Encryption, or BitLocker, is a data protection feature introduced by Microsoft since
Windows Vista. It implements some hard/software measures to encrypt either USB external flash drives or
internal system SSD/HDD devices. You may read more about BitLocker Drive Encryption on the Microsoft
site or Wikipedia.

There are following encryption methods (protectors in the Microsoft terms) that can be utilized in the BitLocker
protection:

· A TPM/TPM+PIN chip

· A USB key (a flash drive containing a .bek file)

https://www.r-studio.com/What-is-Disk-Image.html
https://learn.microsoft.com/en-us/windows/security/operating-system-security/data-protection/bitlocker/
https://learn.microsoft.com/en-us/windows/security/operating-system-security/data-protection/bitlocker/
https://en.wikipedia.org/wiki/BitLocker
https://en.wikipedia.org/wiki/Trusted_Platform_Module
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· A user's password (not to confuse with a user's logon password) / recovery key

These methods can be used either individually or as a combination thereof. If they are used as a combination,
knowing the decryption information for only one method is enough to unlock the device.

R-Studio can unlock devices encrypted with BitLocker provided that all the necessary information is known. 

BitLocker ToGo

This is the method used to lock external removable devices. The password or a recovery key is necessary to
know to unlock the device. A recovery key may be in the printed form or contained in a file. A name of such a
file has the following pattern: BitLocker Recovery Key 600397A9-48AA-4DE4-B775-C71EB130EA1B.txt
, where the last characters is the BitLocker volume identifier. That file contains the BitLocker volume identifier
and a recovery key.

To unlock a BitLocker ToGo device,

1 Locate the device and double-click the BitLocker partition.

BitLocker ToGo

2 Enter the password or recovery key and click the Unlock button.

BitLocker ToGo
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> R-Studio will unlock the volume

BitLocker ToGo

BitLocker System Drive Encryption

This is the method used to lock internal system drives. 

Depending on what methods are used, the following information is necessary to know to unlock the drive.

· A recovery key in the printed form or in a file. A name of such a file has the following pattern: BitLocker
Recovery Key FDA7B96C-635E-45AA-BE63-00C3DB3771EE.txt , where the last characters is the
BitLocker volume identifier. That file contains the BitLocker volume identifier and a recovery key.

· A password used to start the preboot process. It shouldn't be confused with the password for the user's
logon. 

· An external USB flash drive containing its .bek file. Note that Windows sets System and Hidden attributes
for such files and Windows doesn't show such files by default. 

To unlock a system drive with a BitLocker partition,

1 Locate the device and double-click the BitLocker partition.

BitLocker System Drive Encryption
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2 Enter the password or recovery key and click the Unlock button.

BitLocker System Drive Encryption

If you have the .bec file, click the Unlock by key file button and load the file.

> R-Studio will unlock the volume

BitLocker System Drive Encryption

TPM/TPM+PIN modes

Only in registered R-Studio Technician/T80+ versions.

If only the TPM/TPM+PIN hardware was used to encrypt the partition, you must have either the FVEK (Full
Volume Encryption Key) or VMK (Volume Master Key) data. Obtaining these keys is a very hard task, only
quite advanced forensic professionals can do that using specialized hardware. Sometimes it may be possible to
extract a FVEK from memory dumps and/or hibernation files, but this is still not a trivial process. 

If you have FVEK or VMK data, click the Advanced button, select the key type of the data, enter the key or
load a file with the key.
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BitLocker TPM/TPM+PIN modes

R-Studio will unlock the volume.

You may also save and load encryption information from a BitLocker Encryption volume.
2.4.12.2 Windows Dynamic Disks

R-Studio supports dynamic disks, including Windows software RAIDs, mirrors, and spanned volumes. When
R-Studio detects components from such dynamic disks, it assembles them accordingly. 

Windows dynamic disks (RAID5)

R-Studio automatically detects components form dynamic disks and creates those dynamic disks automatically.
At the same time, R-Studio gives access to the parents of the dynamic disks (hard drives and images).

Windows dynamic disks (RAID5) in R-Studio for Mac

Also, R-Studio automatically detects inconsistent components of dynamic disks and marks them accordingly.

https://www.r-studio.com/What-is-Windows-Dynamic-Disks.html
https://www.r-studio.com/What-is-Software-RAID.html
https://www.r-studio.com/What-is-Disk-Image.html
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Windows dynamic disks (RAID5) with unsynced parent

R-Studio shows the components of the selected dynamic disk on its LDM Components tab. 

LDM Components tab

R-Studio shows broken dynamic disks in pink. 

Broken dynamic disks in R-Studio

The LDM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken dynamic disk. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the dynamic disk in blue. 
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Adding a component manually

You may immediately switch to the dynamic disk configuration that R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows dynamic disks with manually added components in blue:

Dynamic disks with added components in R-Studio

2.4.12.3 Windows Storage Spaces

Windows storage spaces is a new storage technology, introduced in Windows 8 and Windows Server 2012, that
allows the user to combine various (not always similar) hard drives into a kind of a RAID or compound volume.
First, the hard drives are combined into a storage pool, then several storage spaces with striping (similar to
RAID0), mirroring (similar to RAID1), and parity (similar to RAID5) can be created in that storage pool. You
may read more about storage pools and spaces in the Microsoft's Storage Spaces: FAQ

When drives from a storage pool are connected to a Windows computer, it automatically detects them and
assembles storage spaces accordingly. 

R-Studio supports Windows Storage Spaces created by Windows 8/8.1 and Windows 10/Threshold
2/Anniversary/Fall Creators updates.

When Windows storage spaces use caching, R-Studio can process both the cache and the storage space itself
simultaneously greatly increasing chances for successful recovery of deleted files. For SSD (Solid State Device)
media, bypassing the cache may be the only available option to recover lost files.

https://www.r-studio.com/What-is-Windows-Storage-Spaces.html
http://windows.microsoft.com/en-us/windows-8/storage-spaces-pools#
https://www.r-studio.com/What-is-Solid-State-Device-SSD.htm
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Storage spaces in Windows

Storage pools and spaces can be managed using the Storage Spaces item in the Windows Control Panel.

Storage spaces in Windows

R-Studio detects disks (or their images) from storage pools and creates storage pools and spaces automatically.
At the same time, R-Studio gives access to the parents of the storage spaces (hard drives and images)

https://www.r-studio.com/What-is-Disk-Image.html
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Storage spaces in R-Studio

If recognized parents of a storage space, including disk images, are added to R-Studio later, it automatically
adds them to their respective storage space.

When an automatically created storage space is selected, R-Studio highlights its components. 

R-Studio shows the components of the selected storage space on its WSS Components tab. 

WSS Components tab

R-Studio shows broken storage spaces in pink. 
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Broken storage spaces in R-Studio

The WSS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken storage space. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the storage space in blue. 

Adding a component manually

You may immediately switch to the storage space configuration that  R-Studio believes most probable by
clicking the Reassemble button.

R-Studio shows such storage spaces in blue:

Storage spaces with added parents in R-Studio
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2.4.12.4 Apple RAIDs

macOS can create several software RAIDs from disks connected to a Mac computer: RAID1 (Mirror set),
RAID0 (Stripe set), and Concatenated disk set. 

Apple RAID0 example

R-Studio detects components of Apple RAID sets and creates their virtual RAIDs automatically. At the same
time, R-Studio gives access to the individual components of the Apple RAID sets (hard drives and images).

Apple RAIDs in R-Studio

When an automatically created Apple RAID is selected, R-Studio highlights its components. It also highlights the
Apple RAID that macOS may itself create from the same components. 

R-Studio shows the components of the Apple RAID on its MacOS Components tab. 

https://www.r-studio.com/What-is-Disk-Image.html
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MacOS Components tab

R-Studio shows broken Apple RAIDs in pink. 

Broken Apple RAIDs in R-Studio

The MacOS Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken Apple RAID. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the Apple RAID in blue. 

Adding a component manually

You may immediately switch to the Apple RAID configuration that  R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows Apple RAIDs with manually added components in blue:
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Apple RAIDs with added members in R-Studio

2.4.12.5 Apple CoreStorage/FileVault/Fusion Drive Volumes

The macOS operating system has the following disk management systems:

FileVault, is a disk encrypted utility;

Fusion Drive is an Apple's hybrid drive technology;

CoreStorage is a logical volume management system. 

R-Studio supports all these technologies and can unlock their encrypted volumes (hard drives and images) using
either their passwords or recovery keys.

CoreStorage/FileVault

Locked CoreStorage Volume in R-Studio

To unlock the volume

1. Control-click the encrypted volume and select Unlock encrypted drive on the contextual menu.

2. Enter the password/recovery key on the Unlock encrypted drive dialog box

> R-Studio will unlock the volume

Unlocked CoreStorage Volume in R-Studio

https://www.r-studio.com/What-is-Apple-FileVault.html
https://www.r-studio.com/What-is-Apple-Fusion-Drive.html
https://en.wikipedia.org/wiki/Core_Storage
https://www.r-studio.com/What-is-Disk-Image.html
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If the volume is partially encrypted, R-Studio can recognize which part is encrypted and which isn't. It will
provide a correct access to the unencrypted and encrypted parts of the volume, provided that the correct
password is entered.

Partially encrypted volume

R-Studio Technician/T80+

In addition to the password, it’s possible to enter other decryption data. Click the Advanced… button and enter
available data.

Unlock encrypted drive: Advanced

This data is usually very hard to obtain and only very advanced institutions can recover it from actual hardware.

Data recovery from deleted or damaged APFS volumes

When macos deletes an APFS volumes, it also wipes out all decryption information from its APFS container. In
this case even knowing the password won’t help. Still, there’s a trick that may help to open a deleted or
damaged encrypted volume.

Let’s us have a hard drive with an APFS container with 3 APFS volumes:

APFS container and its volumes
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One of them has been deleted and R-Studio cannot unlock (decrypt) it:

APFS container with a deleted APFS volume

But if we have an image of the disk’s previous state, we can extract the necessary encryption information from
that image.

Load the image and double-click the existing volume. Click the Advanced… button instead of entering its
password.

Export of encryption information

Click the Export crypto context... button and save a file with this information. Then click the Close Image button
to unload the image.

Then double-click the APFS-1 volume and click the Advanced button.
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APFS container with a deleted APFS volume

Click the Load and apply crypto context… button

Loading the encryption information

and load the file generated from the image.

Select the required information type (a password for our case), enter the data, and click the Unlock button.
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Unlocking the APFS volume

Note that the password will be explicitly shown.

R-Studio will open files on the volume.

Apple Fusion Drive (with installed macOS)

R-Studio detects components of Apple Fusion Drive and creates virtual Fusion Drives automatically. At the
same time, R-Studio gives access to the individual components of the Fusion Drives (hard drives and images).

Fusion Drive in R-Studio

When an automatically created Fusion Drive  is selected, R-Studio highlights its components.

R-Studio shows the components of the Fusion Drive on its APFS Fusion Components tab. 

Fusion Drive Components tab
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R-Studio shows broken Fusion Drive s in pink. 

Broken Fusion Drive in R-Studio

The Fusion Drive Components tab also allows you to manually disconnect or connect the components, for
example, if they are such damaged that R-Studio cannot recognize them as parts of a broken Fusion Drive.
Select the object from the drop-down box and click the Connect button. R-Studio displays the objects it
recognizes as the components of the Fusion Drive in blue. 

Adding a component manually

You may immediately switch to the Fusion Drive configuration that  R-Studio believes most probable by clicking
the Reassemble button.

R-Studio shows Fusion Drive with manually added components in blue:

Fusion Drive with added members in R-Studio
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Apple Fusion Drive (without installed macOS)

Fusion Drive in R-Studio

When an automatically created Fusion Drive  is selected, R-Studio highlights its components.
2.4.12.6 Linux mdadm RAIDs

mdadm is a Linux utility used to manage and monitor software RAID devices.

R-Studio supports such devices and when drives from a mdadm RAID are connected to a Mac computer, it
automatically detects them and assembles mdadm RAIDs accordingly. 

Linux mdadm RAIDs

R-Studio detects components from mdadm RAIDs and creates those RAIDs automatically. At the same time,
R-Studio gives access to the components of those RAIDs (hard drives and images).

mdadm RAIDs in R-Studio

If recognized components of a mdadm RAID, including disk images, are added to R-Studio later, it
automatically adds them to their respective mdadm RAID.

When an automatically created mdadm RAID is selected, R-Studio highlights its components. 

R-Studio shows the components of the mdadm RAIDs on its mdadm Components tab.

https://www.r-studio.com/What-is-mdadm-RAIDs.html
https://www.r-studio.com/What-is-Disk-Image.html
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mdadm Components tab

R-Studio shows broken mdadm RAIDs in pink. 

Broken mdamd RAIDs in R-Studio

The mdadm Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken mdadm RAID. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the mdadm RAID in blue. 

Adding a component manually

You may immediately switch to the mdadm RAID configuration that  R-Studio believes most probable by
clicking the Reassemble button. 

R-Studio shows such mdadm RAIDs in blue:
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mdadm RAIDs with added components in R-Studio

2.4.12.7 Linux LVM/LVM2

Linux LVM is a logical volume manager for the Linux OS that manages disk drives and other data storage
devices. Using it, It is possible to create single logical volumes on several physical disks, add and replace them in
a running system, resize logical volumes, create various RAID configuration, and so on. You may read more
about Linux LVM in our article: What is Logical Volume Manager (LVM).

LVM volume example

R-Studio automatically detects disks from LVMs and creates their virtual volumes automatically. At the same
time, R-Studio gives access to the components of the virtual LVM volumes (hard drives and images).

LVM Volumes in R-Studio

If recognized components of an LVM volume, including disk images, are added to R-Studio later, it
automatically adds them to their respective LVM volume.

When an automatically created LVM volume is selected, R-Studio highlights its components. 

R-Studio shows the components of the LVM volume on its LVM Components tab. 

https://www.r-studio.com/What-is-Logical-Volume-Manager-LVM.html
https://www.r-studio.com/What-is-Disk-Image.html
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LVM Components tab

R-Studio shows broken virtual LVM volumes in pink. 
Broken LVM volumes in R-Studio

The LVM Components tab also allows you to manually disconnect or connect the components, for example, if
they are such damaged that R-Studio cannot recognize them as parts of a broken LVM volume. Select the
object from the drop-down box and click the Connect button. R-Studio displays the objects it recognizes as the
components of the LVM volume in blue. 

Adding a component manually

You may immediately switch to the LVM volume configuration that  R-Studio believes most probable by
clicking the Reassemble button. 

R-Studio shows such virtual LVM volumes in blue:
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LVM volumes with added components in R-Studio

2.4.13 Connecting Virtual Objects to the System as Virtual Drives

Technician version only.

Virtual objects created in the Device view pane of R-Studio can be connected to the system as read-only 
virtual drives. Such virtual drives become accessible to the system and to other programs. Moreover, such virtual
drives remain connected after R-Studio has been closed.

To connect a virtual object as a read-only virtual drive to the system

1 Control-click the virtual object and select Mount on the contextual menu.

> A read-only virtual drive will appear on the Drives panel

And in the system  (Disk Utility) as a physical drive
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And this virtual disk becomes accessible to the system and other programs.

To disconnect a virtual drive

1 Control-click the virtual drive on the Drives panel and select Unmount on the contextual menu.

2.5 Data Recovery over Network

This chapter explains how to perform data recovery operations over network.

R-Studio has network capabilities that allow the system administrator, using its computer, to recover files on any
computers accessible over network. 

R-Studio supports the TCP/IP protocol and any protocol supported in Microsoft Network.

R-Studio Agent must be installed on computers where files are to be recovered. This free service program gives
R-Studio access to local disks on remote computers over network. 

You should always disable a firewall and/or antivirus software on the both computers. As an alternative,
advanced users may tune them to allow R-Studio and R-Studio Agent to communicate via network.

All data transmitted over network are encrypted with a strong algorithm for data security. Restoring data over
network is very much the same as that on a local computer.

· R-Studio Agent
· Data Recovery over Network
· Connecting over the Internet

2.5.1 R-Studio Agent

R-Studio Agent is a program that provides R-Studio with an access to the drives of a network computer. It
should be installed and properly registered on the computer which drives are to be accessed. R-Studio Agent
has versions for the following PC operating systems:

· Mac OS
· Windows
· Linux

and there is R-Studio Agent Emergency that can be used to start a computer from which you are going to
recover data that cannot start other way due to a file system crash, for example. Please, note that you need to
use R-Studio Emergency as an emergency agent if you want to start a Mac computer. 

R-Studio can work equally with all versions of R-Studio Agent and access computers run under Windows,
Mac OS, and Linux.

You must have enough rights on the remote computer to install and run R-Studio Agent.
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2.5.1.1 R-Studio Agent for Mac

You need to have an administrative account on the Mac computer to start R-Studio Agent for Mac.

R-Studio Agent should be installed on a network computer to enable R-Studio access to its drives. R-Studio
Agent should be registered.

If, due to file system crash, the network computer where you are going to recover your data cannot start, you
may use R-Studio Agent Emergency to start the computer.
To start the R-Studio Agent for Mac and access its main panel, 

1 Go to the Application folder, double-click R-Studio Agent for Mac, and enter the account password

> The main panel will appear. You may view its log

R-Studio Agent for Mac main panel

To configure R-Studio Agent, 

1 Select Preferences on the R-Studio Agent menu

2 Specify required parameters on the R-Studio Agent Preferences dialog box and click the OK button

R-Studio Agent Preferences dialog box

 R-Studio Agent Preferences

Password: Enter a password to obtain access to this computer from a network.

Re-Enter: Re-enter the password. 

Incoming connection preferences

Enable incoming
connections

If this option is selected, R-Studio Agent will accept incoming connections.

Port port for incoming connections

Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.

Subnet Mask specifies subnet mask of the network from which this computer can be accessed.

> R-Studio Agent will now run with the specified parameters
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Connecting from R-Studio Agent for Mac to R-Studio.

To establish a connection from R-Studio Agent for Mac to R-Studio, 

1 Run the R-Studio Agent for Mac and select Connect from the Tools menu

2 Enter the necessary information on the Connect to R-Studio dialog box and click the Connect button.

Connect to R-Studio dialog box

Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio is
running.

Port Specify the port set on the R-Studio Connect to Remote

Computer dialog box.

Password Specify the password set on the R-Studio Connect to Remote

Computer dialog box.

> R-Studio Agent for Mac will connect to the computer where R-Studio is running and it will show the

hard drive and logical disk structure of the remote computer.way as that on a local computer.
2.5.1.2 R-Studio Agent for Windows

Attention Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 users: R-Studio Agent should be installed
under an administrator account. 

When installed, R-Studio Agent starts automatically and runs as a service. To configure it, R-Studio Agent
should be started again manually. 

 The following switches are available:
-? evokes a help screen;
-install installs R-Studio Agent as a service
-remove removes R-Studio Agent services
-console starts R-Studio Agent as a console application

Started without a switch, R-Studio Agent runs as a GUI application and its icon appears on the taskbar tray. In
this mode, it can be configured and its log may be viewed. 

Simply connect to the remote computer providing a desired password for R-Studio Agent in the Connect to

Remote Computer dialog box. R-Studio checks if there is R-Studio Agent running on this computer. If not, a
Can't connect... message will appear. 

Click the Yes button, and R-Studio will remotely install R-Studio Agent.
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Attention Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 users: R-Studio Agent may be remotely
installed over a network from a computer running Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10
to another computer running Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10. To do so, you must
have administrator accounts on both computers.

To access the R-Studio Agent main panel, 

1 Click its tray icon

> The main panel will appear. You may view its log

R-Studio Agent main panel

To configure R-Studio Agent, 

1 Right-click its tray icon and select Configure 

2 Specify required parameters on the Please configure R-Studio Agent dialog box and click the OK
button

Please configure R-Studio Agent dialog box

 R-Studio Agent Options

Password: Enter a password to obtain access to this computer from a network.

Re-Enter: Re-enter the password. 

Accepted Protocols

Pipes supported by Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 only. To improve
security, this option should be disabled.

TCP/IP supported by any network OS.

Port port for incoming connections

Accepted IP Addresses

IP Address specifies addresses from which this computer can be accessed.

Subnet Mask specifies a subnet mask of the network from which this computer can be accessed.

> R-Studio Agent will now run with the specified parameters
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2.5.1.3 R-Studio Agent for Linux

You need to have the root privileges to run R-Studio Agent for Linux.

Unlike R-Studio Agent for Windows and R-Studio Agent for Mac, R-Studio Agent for Linux is a console application and
should be run in the Terminal. You also need to mark it as an executable before start.

When it is started for the first time, R-Studio Agent for Linux asks for its configuration.

R-Studio Agent for Linux Configuration dialog box

 R-Studio Agent for Linux Options

Specify password
for incoming
connection

Enter a password to obtain access to this computer from a network.

Confirm password
for incoming
connection

Re-enter the password for confirmation. 

Specify IP
address... 

Specifies addresses and a subnet mask from which this computer can be accessed.
Enter 0 to allow connections from any address.

Specify TCP/IP Port
for listening

A TCP/IP port for incoming connections. Press Enter for the default one [3174].

Don't pay much attention to the warning about "unregistered demo version". If necessary, you'll be able to
register R-Studio Agent for Linux through R-Studio.

You may see the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
show_config .

R-Studio Agent for Linux Configuration dialog box

You may change the current configuration by starting  R-Studio Agent for Linux with the command rsagent --
configure .

Connecting from R-Studio Agent for Linux to R-Studio.

To establish a connection from R-Studio Agent for Linux to R-Studio, 

1 Run the R-Studio Agent for Linux and press Enter
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2 Enter the necessary information

Connect to R-Studio dialog box

> R-Studio Agent for Linux will connect to the computer where R-Studio is running and it will show the

hard drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.

2.5.2 Data Recovery over Network

Generally, data restoring over network is very much the same as that on a local computer. 

R-Studio Agent should be running on the network computer where data are to be recovered. 

Read the Connecting over the Internet topic to learn how to establish connection between R-Studio and R-
Studio Agent over the Internet.

To connect to a remote computer

1 Click the Connect to Remote button, or

Select Connect To Remote on the Drive menu

2 Specify the name or IP address of the remote computer where data are to be recovered in the
Computer: field

Connect to Remote Computer dialog box

The Port should coincide with the port specified for the R-Studio Agent.

The Password: field is for the password of R-Studio Agent running on the remote computer. If you want to
see the entered password, control-click the field and select Show password on the contextual menu.

Note: If the remote computer is started with R-Studio Agent Emergency, leave this field blank.
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> R-Studio will connect to the remote computer and show its hard drive and logical disk structure of the

remote computer below the device/disk structure of your local computer

It can be processed the same way as that on a local computer.

When R-Studio connects to the remote computer, it check if R-Studio Agent is present and its password.
If there is no R-Studio Agent installed, R-Studio may try to remotely install it. See the R-Studio Agent
topic for details.

Recover dialog box

When the Recover dialog box appears, you may select whether you want to save recovered files on the local
or remote computer. Saving recovered files on a remote computer may be useful when the remote computer
has a healthy disk because you do not have to transfer files over network. It may be an external USB hard
drive, for example.

When R-Studio connects to the remote computer, it check if R-Studio Agent is present and its password.
If there is no R-Studio Agent installed, R-Studio may try to remotely install it. See the R-Studio Agent
topic for details.

2.5.3 Connecting over the Internet

R-Studio and R-Studio Agent can be connected over the Internet. The connection can be made either using IP
addresses or DNS names. 

If hosts where R-Studio and R-Studio Agent are running have public IP addresses the connection can be made the
same way as for the local network, except that the IP address or DNS name should be explicitly specified in the
Computer filed the Connect to Remote Computer dialog box

If either (or both) of the hosts are on private networks behind NATs and firewalls and do not have public IP
addresses, the corresponding ports should be opened or forwarded. In addition, connection should be made
either only from R-Studio or from R-Studio Agent.
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Connection directions

* Both R-Studio and R-Studio Agent have public IP addresses (no NAT/firewall) or the ports on the

NAT/firewall are forwarded/opened.

A connection can be made either from R-Studio or from R-Studio Agent.

* R-Studio is behind a NAT and R-Studio Agent has a public IP address or the ports on its NAT/firewall are

forwarded/opened.

A connection should be made from R-Studio.

https://www.r-studio.com/What-is-NAT.html
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* R-Studio has a public IP address or the ports on its NAT/firewall are forwarded/opened and R-Studio Agent

is behind a NAT.

A connection should be made from R-Studio Agent.

* Both R-Studio and R-Studio Agent are behind NATs/firewalls.

No connections are possible.

Connection from R-Studio Agent to R-Studio

R-Studio settings

If a connection is to be made from R-Studio Agent to R-Studio, R-Studio should be set to accept connection
on the Connect to Remote Computer dialog box. 
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Connect to Remote Computer dialog box

Select Wait connection from remote computer, and specify options for incoming connections.

 R-Studio Incoming Connection Options

Password: Enter a password to obtain access to this computer from a network.

IP Address specifies addresses from which this computer can be accessed.

Subnet Mask specifies subnet mask of the network from which this computer can be accessed.

Port port for incoming connections.

R-Studio will wait for an incoming connection.

Waiting for remote connection dialog box

Connecting from R-Studio Agent to R-Studio.

(See the R-Studio Agent for Mac or R-Studio Agent for Linux help page to learn how to establish
connections from those R-Studio Agent versions).

To establish a connection from R-Studio Agent to R-Studio, 

1 Select  Connect to on the Tools menu.

2 Enter the necessary information on the Connect to R-Studio dialog box and click the Connect button.

Connect to R-Studio dialog box
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Connect to R-Studio settings

Server Specify the DNS name or IP address of the host where R-Studio is
running.

Port Specify the port set on the R-Studio Connect to Remote

Computer dialog box.

Password Specify the password set on the R-Studio Connect to Remote

Computer dialog box.

> R-Studio Agent will connect to the computer where R-Studio is running and it will show the hard

drive and logical disk structure of the remote computer.

It can be processed the same way as that on a local computer.
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III R-Studio Technician/T80+

R-Studio Technician/T80+ Demo can perform all data recovery actions except saving recovered files greater
than 256 KB and multi-pass imaging.

The R-Studio T80+ version requires an active internet connection to run and register. You may read more about
R-Studio T80+ in our article R-Studio T80+ - A Professional Data Recovery and Forensic Solution for Small
Business and Individuals Just for US$1/day.

R-Studio Technician has additional controls on its main panel. 
R-Studio Main Technician/T80+ panel

Start runtime image

Click this button to start runtime imaging of the selected
object.

(Technician/T80+ versions only)

I/O Monitor

Click this button to open I/O Monitor.

This chapter covers features that available only in the R-Studio Technician/T80+ versions.

https://www.r-studio.com/pro-data-recovery-and-forensic-for-small-business.html
https://www.r-studio.com/pro-data-recovery-and-forensic-for-small-business.html
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· Multitasking
· Additional Recovery Options
· Hidden Devices
· File Information
· Symbolic Link Processing
· Custom Recovery Lists
· Drive Copy Wizard
· File Maps
· I/O Monitor and Sector Map files
· Runtime Imaging
· Multi-pass Imaging
· Reverse RAIDs
· Working with the Third-Party Hardware
· Forensic Mode
· Some other information about R-Studio Technician/T80+ is shown on the following pages:

· R-Studio Settings

· Drive Scan

· Images

· BitLocker Drive Encryption

· Apple CoreStorage/FileVault/Fusion Drive Volumes

· Connecting over the Internet

· Supported Virtual Disk and Disk Image Formats

3.1 Multitasking

R-Studio Technician can perform several tasks simultaneously. For example, you can simultaneously recover
files from one disk, create an image of another disk, and scan a loaded image. The number of simultaneously
running tasks depends on the system performance: CPU power, RAM size, free space on the disks, data transfer
speed, and so on.

When, for example, 3 tasks are simultaneously running, R-Studio Technician will mark them with a special
rotating sign in its Device view pane. In this example, these 3 tasks are file recovery from a logical disk
(partition), hard drive image creation, and scanning of an image of a hard drive.



R-Studio for Mac Manual176

© 2024 R-Tools Technology Inc.

Three tasks running

It also shows a list of running tasks. You may switch to the required task by clicking it. The progress bar at
the bottom show the overall progress of all tasks.
Each task runs independently in its own tab, has its own I/O Monitor, and can be independently controlled: 

File recovery
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Image creation

Image scan

When all tasks have been completed, R-Studio Technician will show their results with special marks.
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All task completed

These marks will disappear when the corresponding tabs are opened. 

3.2 Additional Recovery Options

R-Studio Technician has additional Recovery options.

Recover (Additional Output Folders) dialog box



R-Studio Technician/T80+ 179

© 2024 R-Tools Technology Inc.

Additional Output Folders

Additional Output Folders Additional output folders where recovered files will be stored when R-
Studio Technician/T80+ runs out of space.

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

Recover (Post Actions) dialog box

Post Actions Options

Shutdown the computer on
task completion

If this check box is selected, R-Studio Technician/T80+ will shut down
your computer when file recovery has been completed. The program will
warn you if any option on the Advanced tab is set to Prompt.

E-Mail notifications If this check box is selected, R-Studio Technician/T80+ will inform you
about the outcome of the operation via email. 

3.3 Hidden Devices

R-Studio Technician/T80+ can hide unnecessary devices on the Device View pane. Most likely, they may be
system drives and drives connected to save recovered data. Hiding those devices doesn't prevent R-Studio
Technician/T80+ from saving recovered and service files on them.



R-Studio for Mac Manual180

© 2024 R-Tools Technology Inc.

No hidden devices

To hide unnecessary devices,

1 Go to Settings and then to the Hidden Devices tab, mark all devices you want to hide,

Hidden Devices tab

and restart R-Studio Technician/T80+.
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> Only necessary devices will be visible

Necessary devices

You may make hidden devices visible once again on the Hidden Devices tab.

Hidden Devices tab
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3.4 File Information

R-Studio Technician shows much more information about files than R-Studio does. 

Info about a file with good chances
for recovery

Info for a file with below average
recovery chances

More information

Click this button to pin the file information. This
panel will show the information about the "pinned"
file regardless of the current selected file.

Click this button to copy all this information

Click this button to select the file you want to go
to. 

Click this button to close all the information. 

Overlapping files Shows the list or files that may occupy the same
disk sectors. You may click the file id to see
information about this file.
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Regions Shows the list of sectors occupied by the file and
corresponding overlapping files. You may click a
sector number open the sector in the built-in
Hexadecimal editor.

Examples of file information on other file systems

File info on an NTFS file system Info for a file on an Ext file system

File info on an APFS file system Info for a file on an XFS file system

https://www.r-studio.com/What-is-XFS.html
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3.5 Symbolic Link Processing

Enter topic text here.

R-Studio Technician/T80+ give its users more control over symbolic links processing.

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

Symbolic Links dialog box

Symbolic Links

Symbolic links display settings

Don't show symbolic links by default
(Technician version)

If this option is selected, R-Studio Technician/T80+ hides all
symbolic links by default. Only real objects will be visible. You
may make them visible by clearing the Hide symbolic links option on
the Mask dialog box.

Show folder symbolic links as links to
their targets, without target content
(Technician version)

Only links to their target will be shown in the right pane
(Contents). They target content can be reached by clicking those
links.

Symbolic links recovery options

For all options:

When both the symbolic link and its target are selected for
recovery, both the symbolic link and its target will be recoveredl.

When only the target is selected fore recovery, only the target will
be recovered. 

Link conversion (Default) 

Only a symbolic link is selected for
recovery:

The selected symbolic link will be recovered as its target.

If both a symbolic link and its target
are selected for recovery:

If both a symbolic link and its target are selected for recovery,
both the target and its symbolic link will be recovered. The file

https://www.r-studio.com/What-are-Hard-Soft-Links.html
http://en.wikipedia.org/wiki/Symbolic_link
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path in that symbolic link will be converted from absolute to
relative. Example: If the object C:\ProgramData\Documents is
a symbolic link to C:\Users\Public\Documents, it will be
converted to a symbolic link to ..\Users\Public\Documents.
Therefore, the symbolic link will point to its object regardless of
the place to which the object has been recovered.

Recovery as it is (Technician version)

Only a symbolic link is selected for
recovery:

The symbolic link will be recovered as a symbolic link which may
contain a path to a nonexistent object.

If both the symbolic link and its
target are selected for recovery, the
absolute link will remain as the
original absolute symbolic link.

If both the symbolic link and its target are selected for recovery,
the file path in that symbolic link will remain unchanged. 
Example: 
The place to store recovered data: D:\Recovered Files. 
The object to recover: C:\Users\Public\Documents
The symbolic link: C:\ProgramData\Documents
After recovery:
The recovered object: D:\Recovered
Files\Root\Users\Public\Documents

The recovered symbolic link: D:\Recovered

Files\Root\ProgramData\Documents pointing to C:

\Users\Public\Documents.
Therefore, if someone tries to enter to the symbolic link, the
system will open the object C:\Users\Public\Documents,
rather than recovered D:\Recovered

Files\Root\Users\Public\Documents.
Usually a recovered target has a new path, therefore its recovered
absolute links will point to a wrong place, or to a non-existent
object.

The Data Recovery Topics topic explains processing of symbolic links recovery in more detail.

3.6 Custom Recovery Lists

The R-Studio Technician/T80+ versions can create more advanced recovery lists.

Export Recovery List options

Export the entire folder/file tree
Export marked file/folder names
Export file/folder names

Specifies which file and folder names will be exported. 

File format:

A file format for the recovery list.
Only text format is available for the standalone and corporate versions.
R-Studio Technician/T80+ can create custom recovery lists in other
formats with more advanced options 
The following formats are available for R-Studio Technician/T80+
version:
Plain Text
HTML



R-Studio for Mac Manual186

© 2024 R-Tools Technology Inc.

XML
JSON
CSV

File name: Specifies a file name of the recovery list. 

Editing the file recovery list

All files without any marks in the recovery list will be marked when the list is loaded into R-Studio. So, if you

have some files in the recovery list that don't need to be recovered, just delete them from the list. In addition, you
may use the following marks to specify some options 

:+ Mark the file, or the folder, all its files, and subfolders within the folder.
:* Mark the file, or the folder and its files, don't mark subfolders in the folder.
:- Unmark the file, or the folder, its files, and subfolders in the folder.
:= Unmark the file or the folder and its files, dont unmark subfolders in the folder.
:! Provide the information on the file. (R-Studio Technician/T80+ only)

 R-Studio for Linux processes records in the list consequently. That is, if there are the following lines in the
file,
:+Files_to_Recover\
:-Files_to_Delete\File_2.jpg

the file File_2.jpg won't be marked for recovery, while for the lines
:-Files_to_Recover\File_2.jpg
:+Files_to_Recover\

file File_2.jpg will be.

A simple recovery list for reference

Structure of a simple recovery list file created by R-Studio
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
Diving/Aquarium/
Diving/Aquarium/20190822_100644.jpg
Diving/Aquarium/20190822_101620.jpg
Diving/Aquarium/20190822_102526.jpg
Diving/Aquarium/20190822_103830.jpg
Diving/Aquarium/20190822_104333.jpg
Diving/MyPhoto1.jpg
Diving/MyPhoto2.jpg
Diving/MyPhoto3.jpg
Diving/MyPhoto4.JPG
Diving/MyPhoto5.jpg
SF/
SF/Sea-Lions/
SF/Sea-Lions/IMG_3493.JPG
SF/Sea-Lions/IMG_3535.JPG
SF/Sea-Lions/IMG_3542.JPG
SF/Sea-Lions/IMG_3579.JPG
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SF/Sea-Lions/IMG_3580.JPG
SF/Sea-Lions/IMG_3581.JPG
SF/Sea-Lions/IMG_3589.JPG
SF/IMG_0869.JPG
SF/IMG_0873.JPG
SF/IMG_0890.JPG
SF/IMG_1739.JPG
SF/IMG_3460.JPG
SF/IMG_3461.JPG
SF/IMG_3476.JPG
SF/IMG_3478.JPG
SF/IMG_3479.JPG
SF/IMG_3480.JPG
SF/IMG_3481.JPG
SF/IMG_3493.JPG
SF/IMG_3535.JPG
SF/IMG_3542.JPG
SF/IMG_3579.JPG
SF/IMG_3580.JPG
SF/IMG_3581.JPG
SF/IMG_3589.JPG
SF/IMG_3590.JPG
SF/IMG_3591.JPG
SF/IMG_3592.JPG
SF/IMG_3593.JPG
SF/IMG_3594.JPG
SF/IMG_3595.JPG
SF/IMG_3596.JPG
SF/IMG_3608.JPG
SF/IMG_3627.JPG
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

If such recovery list is created from an entire logical disk/partition, it will contain several virtual folders. For
example, they'll have the following structure for an NTFS partition.
System Volume Information/
System Volume Information/IndexerVolumeGuid
System Volume Information/WPSettings.dat
Vegas/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG
///m/$Extend/
///m/$Extend/$Deleted/
///m/$Extend/$RmMetadata/
///m/$Extend/$RmMetadata/$Txf/
///m/$Extend/$RmMetadata/$TxfLog/
///m/$Extend/$RmMetadata/$TxfLog/$Tops
///m/$Extend/$RmMetadata/$TxfLog/$TxfLog.blf
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///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000001
///m/$Extend/$RmMetadata/$TxfLog/$TxfLogContainer00000000000000000002
///m/$Extend/$RmMetadata/$Repair
///m/$Extend/$ObjId
///m/$Extend/$Quota
///m/$Extend/$Reparse
///m/$AttrDef
///m/$BadClus
///m/$Bitmap
///m/$Boot
///m/$LogFile
///m/$MFT
///m/$MFTMirr
///m/$Secure
///m/$UpCase
///m/$Volume

HTML format

This is a default format of recovery lists for the R-Studio Technician/T80+ version. It allows its users to supply
their customers with the recovery lists with the easiest way to edit. 

Export Recovery List dialog box for the HTML format

HTML Options dialog box

You may export the default HTML template and edit it to adapt it for your own purposes. 

When the customer loads an HTML recovery list in their browser, they can mark files they want to recover, and
export their names into the final recovery list in the plain text format.



R-Studio Technician/T80+ 189

© 2024 R-Tools Technology Inc.

HTML Recovery list in a browser

You may compare this list with the edited simple recovery list.

  An exported recovery list 

:# Version = 1
:# Sort = by real 
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/Aquarium/20190822_100644.jpg
:! Id=3866625
Diving/Aquarium/20190822_101620.jpg
:! Id=3932161
Diving/Aquarium/20190822_102526.jpg
:! Id=3997697
Diving/Aquarium/20190822_103830.jpg
:! Id=4063233
Diving/Aquarium/20190822_104333.jpg
:! Id=4128769
Diving/MyPhoto1.jpg
:! Id=2883585
Diving/MyPhoto3.jpg
:! Id=3014657
SF/IMG_0869.JPG
:! Id=4915201
SF/IMG_0873.JPG
:! Id=4980737
SF/IMG_0890.JPG
:! Id=5046273
SF/IMG_1739.JPG
:! Id=5111809
SF/IMG_3460.JPG
:! Id=5177345
SF/IMG_3461.JPG
:! Id=5242881
SF/IMG_3476.JPG
:! Id=5308417
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SF/IMG_3478.JPG
:! Id=5373953
SF/IMG_3479.JPG
:! Id=5439489
SF/IMG_3480.JPG
:! Id=5505025
SF/IMG_3481.JPG
:! Id=5570561
SF/IMG_3493.JPG
:! Id=5636097
SF/IMG_3535.JPG
:! Id=5701633
SF/IMG_3542.JPG
:! Id=5767169
SF/IMG_3579.JPG
:! Id=5832705
SF/IMG_3580.JPG
:! Id=5898241
SF/IMG_3581.JPG
:! Id=5963777
SF/IMG_3589.JPG
:! Id=6029313
SF/IMG_3590.JPG
:! Id=6094849
SF/IMG_3591.JPG
:! Id=6160385
SF/IMG_3592.JPG
:! Id=6225921
SF/IMG_3593.JPG
:! Id=6291457
SF/IMG_3594.JPG
:! Id=6356993
SF/IMG_3595.JPG
:! Id=6422529
SF/IMG_3596.JPG
:! Id=6488065
SF/IMG_3608.JPG
:! Id=6553601
SF/IMG_3627.JPG
:! Id=6619137
MyPhoto6.JPG
:! Id=4194305
MyPhoto7.JPG
:! Id=4259841
MyPhoto8.JPG
:! Id=4325377
MyPhoto9.JPG
:! Id=4390913

A manually edited plain text recovery list
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The edited simple recovery list

The final simple recovery list will be the following:
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
:= Diving/
:+ Diving/Aquarium/
:+ Diving/MyPhoto1.jpg
:+ Diving/MyPhoto3.jpg
:+ SF/
:- SF/Sea-Lions/
MyPhoto6.JPG
MyPhoto7.JPG
MyPhoto8.JPG
MyPhoto9.JPG

Plain text format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the plain text format

You may compare two versions of the same plain text recovery list:

An advanced text recovery list

This is an advanced version of the recovery list described on the Recovery List page.
:# Version = 1
:# Sort = by real
:# PathDelim = /
:# CaseSensitive
:# Drive = type:"Volume"; size:"1048576000"; label:"ntfs test"; fs:"NTFS"; 
:# Parent = type:"Drive"; size:"1048576000"; serial:"2cca54405a8d3a89"; firmware:"2.00"; product:"01gb i-disk"; vendor:"c-one"; 
Diving/
:! Id=4000000260001
:! Flags=directory
:! Created=2023-04-04 11:10 PM
:! Modified=2023-04-05 01:16 AM
:! Accessed=2023-04-27 08:58 PM
:! MFT number=38
:! Parent MFT number=5
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Diving/Aquarium/
:! Id=4000000270001
:! Flags=directory
:! Created=2023-04-04 11:10 PM
:! Modified=2023-04-05 08:31 PM
:! Accessed=2023-04-27 08:58 PM
:! MFT number=39
:! Parent MFT number=38

Diving/Aquarium/20190822_100644.jpg
:! Id=3b0001
:! Size=5.49 MB (5,760,305 Bytes)
:! Created=2023-04-05 08:27 PM
:! Modified=2020-08-05 08:34 PM
:! Accessed=2023-04-05 08:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682782 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000410001] MyPhoto7.JPG
:! sector 682782 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [500000000420001] MyPhoto8.JPG
:! sector 1282304 size: 5.49 MB (5,760,305 Bytes) / first data
    :! other files:  [500000000410001] MyPhoto7.JPG
:! MFT number=59
:! Parent MFT number=39

Diving/Aquarium/20190822_101620.jpg
:! Id=3c0001
:! Size=5.75 MB (6,030,395 Bytes)
:! Created=2023-04-05 08:27 PM
:! Modified=2020-08-05 08:47 PM
:! Accessed=2023-04-05 08:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682784 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000420001] MyPhoto8.JPG
:! sector 682784 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [500000000430001] MyPhoto9.JPG
:! sector 1293560 size: 5.75 MB (6,030,395 Bytes) / first data
    :! other files:  [500000000420001] MyPhoto8.JPG
:! MFT number=60
:! Parent MFT number=39

Diving/Aquarium/20190822_102526.jpg
:! Id=3d0001
:! Size=4.92 MB (5,163,217 Bytes)
:! Created=2023-04-05 08:27 PM
:! Modified=2020-08-06 04:10 AM
:! Accessed=2023-04-05 08:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
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:! Regions (sector size=512B):
:! sector 682786 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000430001] MyPhoto9.JPG
:! sector 682786 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [500000000440001] IMG_3493.JPG
:! sector 1478800 size: 4.92 MB (5,163,217 Bytes) / first data
    :! other files:  [500000000430001] MyPhoto9.JPG
:! MFT number=61
:! Parent MFT number=39

Diving/Aquarium/20190822_103830.jpg
:! Id=3e0001
:! Size=5.41 MB (5,674,169 Bytes)
:! Created=2023-04-05 08:27 PM
:! Modified=2020-08-06 04:10 AM
:! Accessed=2023-04-05 08:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682788 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000440001] IMG_3493.JPG
:! sector 682788 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [500000000450001] IMG_3535.JPG
:! sector 1488888 size: 5.41 MB (5,674,169 Bytes) / first data
    :! other files:  [500000000440001] IMG_3493.JPG
:! MFT number=62
:! Parent MFT number=39

Diving/Aquarium/20190822_104333.jpg
:! Id=3f0001
:! Size=6.36 MB (6,673,935 Bytes)
:! Created=2023-04-05 08:27 PM
:! Modified=2020-08-06 04:13 AM
:! Accessed=2023-04-05 08:27 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682790 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000450001] IMG_3535.JPG
:! sector 682790 (offset: 176 ) size: 104 Bytes / resident
    :! other files:  [500000000460001] IMG_3542.JPG
:! sector 1642440 size: 6.36 MB (6,673,935 Bytes) / first data
    :! other files:  [500000000450001] IMG_3535.JPG
:! MFT number=63
:! Parent MFT number=39

Diving/MyPhoto1.jpg
:! Id=2c0001
:! Size=2.56 MB (2,682,000 Bytes)
:! Created=2023-04-05 01:16 AM
:! Modified=2009-04-29 01:52 PM
:! Accessed=2023-04-05 01:16 AM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682752 (offset: 80 ) size: 72 Bytes / resident
:! sector 682752 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [5000000002d0001] MyPhoto2.jpg
:! sector 2036600 size: 2.56 MB (2,682,000 Bytes) / first data
:! MFT number=44
:! Parent MFT number=38

Diving/MyPhoto2.jpg
:! Id=2d0001
:! Size=1.75 MB (1,830,252 Bytes)
:! Created=2023-04-05 01:16 AM
:! Modified=2009-04-29 01:53 PM
:! Accessed=2023-04-05 01:16 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682754 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [5000000002e0001] MyPhoto3.jpg
:! sector 682754 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [5000000002e0001] MyPhoto3.jpg
:! sector 2041840 size: 1.75 MB (1,830,252 Bytes) / first data
:! MFT number=45
:! Parent MFT number=38

Diving/MyPhoto3.jpg
:! Id=2e0001
:! Size=1.73 MB (1,816,964 Bytes)
:! Created=2023-04-05 01:16 AM
:! Modified=2009-04-29 01:53 PM
:! Accessed=2023-04-05 01:16 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682756 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [5000000002f0001] MyPhoto4.JPG
:! sector 682756 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [500000000300001] MyPhoto5.jpg
:! sector 1683624 size: 1.73 MB (1,816,964 Bytes) / first data
    :! other files:  [5000000002f0001] MyPhoto4.JPG
:! MFT number=46
:! Parent MFT number=38

Diving/MyPhoto4.JPG
:! Id=2f0001
:! Size=880.15 KB (901,269 Bytes)
:! Created=2023-04-05 01:16 AM
:! Modified=2009-04-29 01:54 PM
:! Accessed=2023-04-05 01:16 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
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:! sector 682758 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000310001] IndexerVolumeGuid
:! sector 682758 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [500000000310001] IndexerVolumeGuid
:! sector 2045416 size: 880.15 KB (901,269 Bytes) / first data
    :! other files:  [500000000300001] MyPhoto5.jpg
:! MFT number=47
:! Parent MFT number=38

Diving/MyPhoto5.jpg
:! Id=300001
:! Size=3.13 MB (3,286,883 Bytes)
:! Created=2023-04-05 01:16 AM
:! Modified=2009-04-29 02:13 PM
:! Accessed=2023-04-05 01:16 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682760 (offset: 80 ) size: 72 Bytes / resident
    :! other files:  [500000000320001] IMG_0201.JPG
:! sector 682760 (offset: 176 ) size: 90 Bytes / resident
    :! other files:  [500000000320001] IMG_0201.JPG
:! sector 1687176 size: 3.13 MB (3,286,883 Bytes) / first data
    :! other files:  [500000000310001] IndexerVolumeGuid
:! MFT number=48
:! Parent MFT number=38

SF/
:! Id=4000000290001
:! Flags=directory
:! Created=2023-04-04 11:10 PM
:! Modified=2023-04-05 07:36 PM
:! Accessed=2023-04-27 08:58 PM
:! MFT number=41
:! Parent MFT number=5

SF/Sea-Lions/
:! Id=40000002a0001
:! Flags=directory
:! Created=2023-04-04 11:10 PM
:! Modified=2023-04-05 12:03 AM
:! Accessed=2023-04-27 08:58 PM
:! MFT number=42
:! Parent MFT number=41

SF/Sea-Lions/IMG_3493.JPG
:! Id=440001
:! Size=4.75 MB (4,985,023 Bytes)
:! Created=2023-04-05 12:02 AM
:! Modified=2009-06-06 05:50 AM
:! Accessed=2023-04-05 12:02 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
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:! Regions (sector size=512B):
:! sector 682800 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004c0001] IMG_0873.JPG
:! sector 682800 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000004c0001] IMG_0873.JPG
:! sector 682800 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004c0001] IMG_0873.JPG
:! sector 1043832 size: 4.75 MB (4,985,023 Bytes) / first data
    :! other files:  [5000000004b0001] IMG_0869.JPG
:! MFT number=68
:! Parent MFT number=42

SF/Sea-Lions/IMG_3535.JPG
:! Id=450001
:! Size=3.55 MB (3,718,479 Bytes)
:! Created=2023-04-05 12:02 AM
:! Modified=2009-06-06 05:55 AM
:! Accessed=2023-04-05 12:02 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682802 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004d0001] IMG_0890.JPG
:! sector 682802 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000004d0001] IMG_0890.JPG
:! sector 682802 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004d0001] IMG_0890.JPG
:! sector 1076608 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [5000000004c0001] IMG_0873.JPG
:! MFT number=69
:! Parent MFT number=42

SF/Sea-Lions/IMG_3542.JPG
:! Id=460001
:! Size=3.92 MB (4,110,749 Bytes)
:! Created=2023-04-05 12:02 AM
:! Modified=2009-06-06 05:57 AM
:! Accessed=2023-04-05 12:02 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682804 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004e0001] IMG_1739.JPG
:! sector 682804 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000004e0001] IMG_1739.JPG
:! sector 682804 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004f0001] IMG_3460.JPG
:! sector 1109376 size: 3.92 MB (4,110,749 Bytes) / first data
    :! other files:  [5000000004e0001] IMG_1739.JPG
:! MFT number=70
:! Parent MFT number=42

SF/Sea-Lions/IMG_3579.JPG
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:! Id=470001
:! Size=3.92 MB (4,109,345 Bytes)
:! Created=2023-04-05 12:02 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:02 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682806 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004f0001] IMG_3460.JPG
:! sector 682806 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000500001] IMG_3461.JPG
:! sector 682806 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000500001] IMG_3461.JPG
:! sector 1142144 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [5000000004f0001] IMG_3460.JPG
:! MFT number=71
:! Parent MFT number=42

SF/Sea-Lions/IMG_3580.JPG
:! Id=480001
:! Size=3.35 MB (3,510,477 Bytes)
:! Created=2023-04-05 12:03 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:03 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682808 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000510001] IMG_3476.JPG
:! sector 682808 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000510001] IMG_3476.JPG
:! sector 682808 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000510001] IMG_3476.JPG
:! sector 1207680 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [500000000500001] IMG_3461.JPG
:! MFT number=72
:! Parent MFT number=42

SF/Sea-Lions/IMG_3581.JPG
:! Id=490001
:! Size=4.09 MB (4,285,353 Bytes)
:! Created=2023-04-05 12:03 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:03 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682810 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000520001] IMG_3478.JPG
:! sector 682810 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000520001] IMG_3478.JPG
:! sector 682810 (offset: 272 ) size: 80 Bytes / resident
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    :! other files:  [500000000530001] IMG_3479.JPG
:! sector 1240448 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [500000000520001] IMG_3478.JPG
:! MFT number=73
:! Parent MFT number=42

SF/Sea-Lions/IMG_3589.JPG
:! Id=4a0001
:! Size=4.44 MB (4,651,043 Bytes)
:! Created=2023-04-05 12:03 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:03 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682812 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000530001] IMG_3479.JPG
:! sector 682812 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000540001] IMG_3480.JPG
:! sector 682812 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000540001] IMG_3480.JPG
:! sector 1273216 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [500000000530001] IMG_3479.JPG
:! MFT number=74
:! Parent MFT number=42

SF/IMG_0869.JPG
:! Id=4b0001
:! Size=3.53 MB (3,698,659 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-05-30 09:13 PM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682814 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000550001] IMG_3481.JPG
:! sector 682814 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000550001] IMG_3481.JPG
:! sector 682814 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000550001] IMG_3481.JPG
:! sector 1305984 size: 3.53 MB (3,698,659 Bytes) / first data
    :! other files:  [500000000540001] IMG_3480.JPG
:! MFT number=75
:! Parent MFT number=41

SF/IMG_0873.JPG
:! Id=4c0001
:! Size=5.61 MB (5,881,104 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-05-30 09:15 PM
:! Accessed=2023-04-05 07:35 PM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682816 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000560001] IMG_3493.JPG
:! sector 682816 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000560001] IMG_3493.JPG
:! sector 682816 (offset: 272 ) size: 16 Bytes / resident
    :! other files:  [500000000570001] IMG_3535.JPG
:! sector 682816 (offset: 312 ) size: 80 Bytes / resident
    :! other files:  [500000000570001] IMG_3535.JPG
:! sector 1338752 size: 5.61 MB (5,881,104 Bytes) / first data
    :! other files:  [500000000560001] IMG_3493.JPG
:! MFT number=76
:! Parent MFT number=41

SF/IMG_0890.JPG
:! Id=4d0001
:! Size=5.40 MB (5,663,358 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-05-30 09:47 PM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682818 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000580001] IMG_3542.JPG
:! sector 682818 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000580001] IMG_3542.JPG
:! sector 682818 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000580001] IMG_3542.JPG
:! sector 1371520 size: 5.40 MB (5,663,358 Bytes) / first data
    :! other files:  [500000000570001] IMG_3535.JPG
:! MFT number=77
:! Parent MFT number=41

SF/IMG_1739.JPG
:! Id=4e0001
:! Size=4.07 MB (4,266,181 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-03 08:59 PM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682820 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000590001] IMG_3579.JPG
:! sector 682820 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000590001] IMG_3579.JPG
:! sector 682820 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005a0001] IMG_3580.JPG
:! sector 1404288 size: 4.07 MB (4,266,181 Bytes) / first data
    :! other files:  [500000000590001] IMG_3579.JPG
:! MFT number=78
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:! Parent MFT number=41

SF/IMG_3460.JPG
:! Id=4f0001
:! Size=4.38 MB (4,593,453 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 03:58 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682822 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005a0001] IMG_3580.JPG
:! sector 682822 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000005b0001] IMG_3581.JPG
:! sector 682822 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005b0001] IMG_3581.JPG
:! sector 1469824 size: 4.38 MB (4,593,453 Bytes) / first data
    :! other files:  [5000000005a0001] IMG_3580.JPG
:! MFT number=79
:! Parent MFT number=41

SF/IMG_3461.JPG
:! Id=500001
:! Size=3.91 MB (4,102,032 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 03:58 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682824 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005c0001] IMG_3589.JPG
:! sector 682824 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000005c0001] IMG_3589.JPG
:! sector 682824 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005c0001] IMG_3589.JPG
:! sector 1502592 size: 3.91 MB (4,102,032 Bytes) / first data
    :! other files:  [5000000005b0001] IMG_3581.JPG
:! MFT number=80
:! Parent MFT number=41

SF/IMG_3476.JPG
:! Id=510001
:! Size=3.92 MB (4,114,595 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 04:02 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682826 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005d0001] IMG_3590.JPG
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:! sector 682826 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000005d0001] IMG_3590.JPG
:! sector 682826 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005e0001] IMG_3591.JPG
:! sector 1535360 size: 3.92 MB (4,114,595 Bytes) / first data
    :! other files:  [5000000005d0001] IMG_3590.JPG
:! MFT number=81
:! Parent MFT number=41

SF/IMG_3478.JPG
:! Id=520001
:! Size=4.74 MB (4,968,784 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 04:03 AM
:! Accessed=2023-04-05 07:35 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682828 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005e0001] IMG_3591.JPG
:! sector 682828 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000005f0001] IMG_3592.JPG
:! sector 682828 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005f0001] IMG_3592.JPG
:! sector 1568128 size: 4.74 MB (4,968,784 Bytes) / first data
    :! other files:  [5000000005e0001] IMG_3591.JPG
:! MFT number=82
:! Parent MFT number=41

SF/IMG_3479.JPG
:! Id=530001
:! Size=4.28 MB (4,484,110 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 04:03 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682830 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000600001] IMG_3593.JPG
:! sector 682830 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000600001] IMG_3593.JPG
:! sector 682830 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000600001] IMG_3593.JPG
:! sector 1600896 size: 4.28 MB (4,484,110 Bytes) / first data
    :! other files:  [5000000005f0001] IMG_3592.JPG
:! MFT number=83
:! Parent MFT number=41

SF/IMG_3480.JPG
:! Id=540001
:! Size=4.28 MB (4,491,209 Bytes)
:! Created=2023-04-05 12:05 AM
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:! Modified=2009-06-06 04:03 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682832 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000610001] IMG_3594.JPG
:! sector 682832 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000610001] IMG_3594.JPG
:! sector 682832 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000620001] IMG_3595.JPG
:! sector 1633664 size: 4.28 MB (4,491,209 Bytes) / first data
    :! other files:  [500000000610001] IMG_3594.JPG
:! MFT number=84
:! Parent MFT number=41

SF/IMG_3481.JPG
:! Id=550001
:! Size=3.38 MB (3,541,845 Bytes)
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-20 10:00 PM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682834 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000620001] IMG_3595.JPG
:! sector 682834 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000630001] IMG_3596.JPG
:! sector 682834 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000630001] IMG_3596.JPG
:! sector 1666432 size: 3.38 MB (3,541,845 Bytes) / first data
    :! other files:  [500000000620001] IMG_3595.JPG
:! MFT number=85
:! Parent MFT number=41

SF/IMG_3493.JPG
:! Id=560001
:! Size=4.75 MB (4,985,023 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:50 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682836 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000640001] IMG_3608.JPG
:! sector 682836 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000640001] IMG_3608.JPG
:! sector 682836 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000640001] IMG_3608.JPG
:! sector 1699200 size: 4.75 MB (4,985,023 Bytes) / first data
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    :! other files:  [500000000630001] IMG_3596.JPG
:! MFT number=86
:! Parent MFT number=41

SF/IMG_3535.JPG
:! Id=570001
:! Size=3.55 MB (3,718,479 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:55 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682838 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000650001] IMG_3627.JPG
:! sector 682838 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000650001] IMG_3627.JPG
:! sector 682838 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000400001] MyPhoto6.JPG
:! sector 1731968 size: 3.55 MB (3,718,479 Bytes) / first data
    :! other files:  [500000000650001] IMG_3627.JPG
:! MFT number=87
:! Parent MFT number=41

SF/IMG_3542.JPG
:! Id=580001
:! Size=3.92 MB (4,110,749 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:57 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682840 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000610001] IMG_3594.JPG
:! sector 682840 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000420001] MyPhoto8.JPG
:! sector 682840 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000430001] MyPhoto9.JPG
:! sector 1764736 size: 3.92 MB (4,110,749 Bytes) / first data
    :! other files:  [500000000410001] MyPhoto7.JPG
:! MFT number=88
:! Parent MFT number=41

SF/IMG_3579.JPG
:! Id=590001
:! Size=3.92 MB (4,109,345 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:05 AM
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:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682842 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000370001] IMG_0390.JPG
:! sector 682842 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000380001] IMG_0391.JPG
:! sector 682842 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000450001] IMG_3535.JPG
:! sector 1797504 size: 3.92 MB (4,109,345 Bytes) / first data
    :! other files:  [500000000440001] IMG_3493.JPG
:! MFT number=89
:! Parent MFT number=41

SF/IMG_3580.JPG
:! Id=5a0001
:! Size=3.35 MB (3,510,477 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682844 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000470001] IMG_3579.JPG
:! sector 682844 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000620001] IMG_3595.JPG
:! sector 682844 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000480001] IMG_3580.JPG
:! sector 1830272 size: 3.35 MB (3,510,477 Bytes) / first data
    :! other files:  [500000000460001] IMG_3542.JPG
:! MFT number=90
:! Parent MFT number=41

SF/IMG_3581.JPG
:! Id=5b0001
:! Size=4.09 MB (4,285,353 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 05:59 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682846 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004a0001] IMG_3589.JPG
:! sector 682846 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000003b0001] 20190822_100644.jpg
:! sector 682846 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000003c0001] 20190822_101620.jpg
:! sector 1863040 size: 4.09 MB (4,285,353 Bytes) / first data
    :! other files:  [500000000490001] IMG_3581.JPG
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:! MFT number=91
:! Parent MFT number=41

SF/IMG_3589.JPG
:! Id=5c0001
:! Size=4.44 MB (4,651,043 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682848 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004c0001] IMG_0873.JPG
:! sector 682848 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000330001] IMG_0211.JPG
:! sector 682848 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000340001] IMG_0250.JPG
:! sector 1895808 size: 4.44 MB (4,651,043 Bytes) / first data
    :! other files:  [5000000004b0001] IMG_0869.JPG
:! MFT number=92
:! Parent MFT number=41

SF/IMG_3590.JPG
:! Id=5d0001
:! Size=4.67 MB (4,899,941 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 07:35 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682850 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000350001] IMG_0283.JPG
:! sector 682850 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000360001] IMG_0389.JPG
:! sector 682850 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004e0001] IMG_1739.JPG
:! sector 1928576 size: 4.67 MB (4,899,941 Bytes) / first data
    :! other files:  [5000000004d0001] IMG_0890.JPG
:! MFT number=93
:! Parent MFT number=41

SF/IMG_3591.JPG
:! Id=5e0001
:! Size=4.08 MB (4,280,042 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
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:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682852 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004f0001] IMG_3460.JPG
:! sector 682852 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000003d0001] 20190822_102526.jpg
:! sector 682852 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000003e0001] 20190822_103830.jpg
:! sector 1961344 size: 4.08 MB (4,280,042 Bytes) / first data
    :! other files:  [500000000630001] IMG_3596.JPG
:! MFT number=94
:! Parent MFT number=41

SF/IMG_3592.JPG
:! Id=5f0001
:! Size=5.04 MB (5,285,211 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682854 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000510001] IMG_3476.JPG
:! sector 682854 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000520001] IMG_3478.JPG
:! sector 682854 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000390001] IMG_3694.JPG
:! sector 1994112 size: 5.04 MB (5,285,211 Bytes) / first data
    :! other files:  [500000000500001] IMG_3461.JPG
:! MFT number=95
:! Parent MFT number=41

SF/IMG_3593.JPG
:! Id=600001
:! Size=4.74 MB (4,969,442 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682856 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000530001] IMG_3479.JPG
:! sector 682856 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000540001] IMG_3480.JPG
:! sector 682856 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000003f0001] 20190822_104333.jpg
:! sector 2026880 size: 4.74 MB (4,969,442 Bytes) / first data
    :! other files:  [5000000003a0001] IMG_3699.JPG
:! MFT number=96
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:! Parent MFT number=41

SF/IMG_3594.JPG
:! Id=610001
:! Size=4.69 MB (4,917,237 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682858 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000640001] IMG_3608.JPG, [500000000320001] IMG_0201.JPG
:! sector 682858 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000640001] IMG_3608.JPG, [500000000320001] IMG_0201.JPG
:! sector 682858 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000002e0001] MyPhoto3.jpg
:! sector 973080 size: 4.69 MB (4,917,237 Bytes) / first data
    :! other files:  [500000000550001] IMG_3481.JPG
:! MFT number=97
:! Parent MFT number=41

SF/IMG_3595.JPG
:! Id=620001
:! Size=5.09 MB (5,338,697 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682860 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000560001] IMG_3493.JPG
:! sector 682860 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000570001] IMG_3535.JPG
:! sector 682860 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000580001] IMG_3542.JPG
:! sector 1174920 size: 5.09 MB (5,338,697 Bytes) / first data
    :! other files:  [500000000300001] MyPhoto5.jpg
:! MFT number=98
:! Parent MFT number=41

SF/IMG_3596.JPG
:! Id=630001
:! Size=4.93 MB (5,174,072 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:00 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
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:! Regions (sector size=512B):
:! sector 682862 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005a0001] IMG_3580.JPG
:! sector 682862 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000650001] IMG_3627.JPG
:! sector 682862 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005b0001] IMG_3581.JPG
:! sector 1437064 size: 4.93 MB (5,174,072 Bytes) / first data
    :! other files:  [500000000590001] IMG_3579.JPG
:! MFT number=99
:! Parent MFT number=41

SF/IMG_3608.JPG
:! Id=640001
:! Size=5.01 MB (5,257,021 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:01 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Below Average (Integrity OK, Beginning overwritten by existing file)
:! Regions (sector size=512B):
:! sector 682864 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000005d0001] IMG_3590.JPG
:! sector 682864 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000005e0001] IMG_3591.JPG
:! sector 682864 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000005f0001] IMG_3592.JPG
:! sector 1673352 size: 5.01 MB (5,257,021 Bytes) / first data
    :! other files:  [5000000005c0001] IMG_3589.JPG
:! Overlapping files=[500000000320001] IMG_0201.JPG
:! MFT number=100
:! Parent MFT number=41

SF/IMG_3627.JPG
:! Id=650001
:! Size=3.48 MB (3,651,691 Bytes)
:! Flags=deleted
:! Created=2023-04-05 12:05 AM
:! Modified=2009-06-06 06:02 AM
:! Accessed=2023-04-05 12:05 AM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Integrity OK, Unfragmented)
:! Regions (sector size=512B):
:! sector 682866 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000002c0001] MyPhoto1.jpg
:! sector 682866 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000002d0001] MyPhoto2.jpg
:! sector 682866 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000002f0001] MyPhoto4.JPG
:! sector 1837136 size: 3.48 MB (3,651,691 Bytes) / first data
    :! other files:  [500000000600001] IMG_3593.JPG
:! MFT number=101
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:! Parent MFT number=41

MyPhoto6.JPG
:! Id=400001
:! Size=1.07 MB (1,123,560 Bytes)
:! Created=2023-04-04 11:13 PM
:! Modified=2009-04-29 01:54 PM
:! Accessed=2023-04-04 11:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682792 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000460001] IMG_3542.JPG
:! sector 682792 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000470001] IMG_3579.JPG
:! sector 682792 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000470001] IMG_3579.JPG
:! sector 938624 size: 1.07 MB (1,123,560 Bytes) / first data
    :! other files:  [500000000460001] IMG_3542.JPG
:! MFT number=64
:! Parent MFT number=5

MyPhoto7.JPG
:! Id=410001
:! Size=842.76 KB (862,983 Bytes)
:! Created=2023-04-04 11:13 PM
:! Modified=2009-04-29 01:55 PM
:! Accessed=2023-04-04 11:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682794 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000480001] IMG_3580.JPG
:! sector 682794 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000480001] IMG_3580.JPG
:! sector 682794 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [500000000480001] IMG_3580.JPG
:! sector 971392 size: 842.76 KB (862,983 Bytes) / first data
    :! other files:  [500000000470001] IMG_3579.JPG
:! MFT number=65
:! Parent MFT number=5

MyPhoto8.JPG
:! Id=420001
:! Size=997.99 KB (1,021,937 Bytes)
:! Created=2023-04-04 11:13 PM
:! Modified=2009-04-29 01:55 PM
:! Accessed=2023-04-04 11:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682796 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [500000000490001] IMG_3581.JPG
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:! sector 682796 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [500000000490001] IMG_3581.JPG
:! sector 682796 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004a0001] IMG_3589.JPG
:! sector 1004160 size: 997.99 KB (1,021,937 Bytes) / first data
    :! other files:  [500000000490001] IMG_3581.JPG
:! MFT number=66
:! Parent MFT number=5

MyPhoto9.JPG
:! Id=430001
:! Size=3.37 MB (3,533,017 Bytes)
:! Created=2023-04-04 11:13 PM
:! Modified=2009-04-29 01:56 PM
:! Accessed=2023-04-04 11:13 PM
:! File type=JPEG Digital Camera
:! Recovery chances=Good (Existing file)
:! Regions (sector size=512B):
:! sector 682798 (offset: 80 ) size: 48 Bytes / resident
    :! other files:  [5000000004a0001] IMG_3589.JPG
:! sector 682798 (offset: 152 ) size: 90 Bytes / resident
    :! other files:  [5000000004b0001] IMG_0869.JPG
:! sector 682798 (offset: 272 ) size: 80 Bytes / resident
    :! other files:  [5000000004b0001] IMG_0869.JPG
:! sector 1036928 size: 3.37 MB (3,533,017 Bytes) / first data
    :! other files:  [5000000004a0001] IMG_3589.JPG
:! MFT number=67
:! Parent MFT number=5

Other recovery list formats

You may export recovery lists in the following formats:

XML format

Export Recovery List dialog box for the XML format

JSON format

Custom recovery lists in the text format contains more information about files than simple recovery lists.
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Export Recovery List dialog box for the JSON format

CSV format

Custom recovery lists in the text format contains more information about files than simple recovery lists.

Export Recovery List dialog box for the CSV format

CSV Options dialog box

3.7 Drive Copy Wizard

You may copy any object in the Drives panel to any other object, if there is enough space on the target one.

Before Copy object to... becomes enabled on the Create menu, you need to enable writing.

To enable writing,

1 On the R-Studio main panel, select the R-Studio menu, then Preferences, and select Enable Write on

the Settings dialog box.

> The Copy object to... will be enabled on the Create menu.

Now objects can be copied.

While the objects are being copied, you may change some parameters and view the I/O monitor on the Object
Copy Progress dialog box.
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Depending on the objects to copy and your tasks, you may do:

Binary (byte to byte copy)

An exact copy of the source object (or a part thereof) to the destination device (from its beginning or a specified
offset). Any object may be copied to any object this way.

To perform a binary copy of an object,

1 Select Copy object to... on the Create menu
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2 Select a source and destination objects on the Drives Copy Wizard panel and click the Continue button

Drives Copy Wizard

3 Select Binary (byte to byte) copy on the Copy Options dialog box, specify copy options, and click the
Continue button

Copy options dialog box

 Copy options

Source

Copy whole object Select this option if you want to copy the entire source object to the destination one

Copy range Select this option if you want to copy a part of the source object

Offset Specify the offset from which the source object data will be copied to the destination
object

Size Specify the size of the source object data which will be copied to the destination
object

Destination

Offset Specify the offset on the destination object to which the source object data will be
copied
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3 View the copy task settings on the Drives Copy Wizard and click the Done button

Drives Copy Wizard

or click the Go Back button to edit the copy parameters

> R-Studio will start copying data from the source object to the destination one.

You may close the wizard by pressing the Esc key.

Smart partition copy

Only partitions can be copied with this option to other partitions or empty spaces. You may change some
parameters of the the copied partition(s) on the destination drive.

To perform a smart partition copy of a partition,

1 Select Copy object to... on the Create menu

2 Select source and destination partitions on the Drives Copy Wizard  panel and click the Continue
button

Drives Copy Wizard

https://www.r-studio.com/What-is-Disk-Partition.html
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3 Select Smart partition copy on the Copy Options panel, specify copy options, and click the Continue
button

Copy options dialog box

 Copy options

Destination

Copy without
stretching 

Select this option if you want to copy the partition exactly to the destination place

Copy to: Select this option if you want to change some parameters of the copied partition on
the destination place

Free space before Specify how much space will be left empty before the start of the copied partition

Partition size Select this option and specify the new size of the copied partition

Partition type
Primary (Active)/
Primary/Logical

Specify the type of the partition to be copied. Do not change this setting unless you
have serious reasons to do so.

https://www.r-studio.com/What-is-free-disk-space.html
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3 View the copy task settings on the Drives Copy Wizard and click the Done button

Drives Copy Wizard

or click the Go Back button to edit the copy parameters

> R-Studio will start copying data from the source partition to the destination place.

You may close the wizard by pressing the Esc key.

Smart drive copy

Only  whole drives  can be copied with this option to other drives. You may change some parameters of the
copied drives.

1 Select Copy object to... on the Create menu

2 Select source and destination hard drives on the Drives Copy Wizard  panel and click the Continue
button

Drives Copy Wizard
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3 Select Smart drive copy on the Copy Options panel, specify copy options, and click the Next button

Copy options dialog box

 Copy options

Copying mode

Copy all partitions
onto original places

Select this option if you want to copy all partitions to their original places.

One partition after
another

Select this option if you want to copy the partitions one after another preserving their
space. If there is empty space between the partitions, it will be omitted. Otherwise it
is similar to Copy all partitions onto original places.
If Fixed active partition is selected, the original offset/size of the active partition will be
preserved (in case the loader has links to it).

Expand/Shrink
partition to whole
disk

Specify this option if you want to proportionally expand/shrink the selected partitions
to occupy the entire target drive. 
If Fixed active partition is selected, the original offset/size of the active partition will be
preserved (in case the loader has links to it).
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3 View the copy task settings on the Drives Copy Wizard and click the Finish button

Drives Copy Wizard

or click the <Back button to edit the copy parameters

> R-Studio will start copying data from the source hard drive to the destination one

You may close the wizard by pressing the Esc key.

3.8 File Maps

R-Studio can show file maps. Control-click  the file and select Map of file in their contextual menu.

File Map
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3.9 I/O Monitor and Sector Map Files

These features greatly improves working with failing drives for R-Studio.

I/O Monitor

I/O Monitor allows you to inspect the process of drive input/output operations in real time. When R-Studio
performs a disk operation the I/O Monitor button becomes active.

Click this button, and the I/O Monitor will appear.

I/O Monitor

You may also start I/O Monitor from the contextual menu and progress dialog boxes during various drive
operations.

Sector Map Files

Sector map files are files that contain information about conditions of drive sectors, which may be good, bad,
slow, and unstable. R-Studio estimates chances for successful file recovery basing on these files and avoiding
unnecessary attempts to read bad sectors. Sector map files are crucial for multi-pass imaging.

R-Studio creates its own sector map files or can import such files created from other disk imaging programs.
Currently R-Studio supports sector map files from HDDSuperClone and DDRescue. 

To open, save or clean a sector map file for an object,

* Control-click the object and select Open Sector Map, Save Sector Map, or Clean Sector Map,
respectively, on the contextual menu.

You may look at the graphical representation of the loaded sector map by starting I/O Monitor.

Sector Map 

https://www.r-studio.com/What-is-a-Sector-Map-File.html
http://www.hddsuperclone.com/sitev1/
http://www.gnu.org/software/ddrescue/
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3.10 Runtime Imaging

Runtime imaging is image creation for a drive object performed simultaneously with other data read operations
from this drive. When R-Studio reads data from a certain area of the source (a drive, partition, or region), it
writes the data to the target which can be either a dedicated drive or an image file. When the data from this area
is needed again, R-Studio reads it from the target rather than the source thus reducing access to the source. This
is very important for faulty or unstable drives which health may be constantly deteriorating during data recovery
operations. 

R-Studio also creates a sector map file during runtime imaging.

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-a-Sector-Map-File.html
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To start runtime imaging of an object,

using a plain image file

1 Select a drive object on the R-Studio's Drives panel and click the Start Runtime Image button, 

or control-click the object and select Set Runtime Image on the contextual menu.

Runtime imaging

Select Plain or another image type in the Image type field, specify the file name and path for the image and
sector map files, and click the OK button. Don't select the VMDK image file unless you can disable writing to
the drive later. Cloning to a physical drive is not recommended because Windows can write some data to the
drive corrupting the imaged data when the image has been completed and runtime imaging is over.

Plain image file requires immediate allocation of disk space equal to the object size, whereas VMDK image

file is growing gradually upon imaging progress.

> R-Studio will turn on runtime imaging.

Runtime imaging
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Select the object and click the Stop Runtime Imaging button or this item in the contextual menu to turn runtime
imaging off.

using a physical drive

1 Select a drive object on the R-Studio's Drives panel and click the Start Runtime Image button, 

or control-click the object and select Set Runtime Image on the contextual menu.

Runtime imaging

Select Physical drive in the Image type field, specify the name and path for the sector map file, and click the
OK button.

Note: all data on the drive will be destroyed. 

> R-Studio will turn on runtime imaging.

Runtime imaging

Select the object and click the Stop Runtime Imaging button or item in the contextual to menu turn runtime
imaging off.
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R-Studio stores the information about runtime configurations and asks the users whether they want to keep

runtime imaging or discard it during its startup.

Runtime imaging

and this configuration will appear in R-Studio.

Runtime imaging

Completing Runtime Image

You may complete the runtime image without browsing through the entire file system on the disk.

1 Select the object being imaged and click the Complete Runtime Image button, 

or control-click the object and select Complete Runtime Image on the contextual menu.

Runtime imaging

> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button.
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> R-Studio will complete the creation of the runtime image.

If the runtime image has not been completed, you may resume it next time you start runtime imaging.

Runtime imaging

Creating runtime image for individual files

You may create a runtime image containing only individual files rather than all data on the disk.

1 Establish a runtime imaging for the disk with the files, open the disk, mark the files, and click the Save
marked to runtime image button.

or control-click on the right pane, and select Save Marked to Runtime Image on the contextual menu.

Runtime imaging
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> The Complete Runtime Imaging dialog box will appear.

Runtime imaging

Select the necessary parameters of multi-pass imaging and select the OK button.

> R-Studio will complete the creation of the runtime image.

You may open such images as regular ones. 

Runtime imaging

Such image contains information about the entire file system, but if a non-imaged file is opened, it'll contain
only zeros.

3.11 Multi-pass Imaging

Multi-pass imaging is a process of image creation through several passes (phases). Each phase reads data from
different areas of a hard drive, starting from areas with good sectors then going to slow sector areas and finishes
with bad sector areas. This approach maximizes the amount of data that can be recovered from a failing drive
and reduces it chances to fail during this process. 

https://www.r-studio.com/What-is-Disk-Image.html
https://www.r-studio.com/What-are-Bad-Sectors.html
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Phase 1. Copying most good data from the drive

In this phase, R-Studio reads data from drive by sector blocks, or groups of consecutive drive sectors read in
one go. The phase is performed in several steps.

Step 1. R-Studio reads data from the drive until it runs into a block with bad or slow sector(s). Then it drops
that block and jumps to another area until it finds a block with no bad or slow sectors. Then it continues reading
data until it runs into another bad or slow block, and the process repeats. When this step is finished, most good
data from the hard drive has been read, and R-Studio has detected the front blocks (edges) of bad and slow
sector areas.

Step 2. R-Studio finds the rear edges of bad sector areas. It reads the skipped area from its rear end backwards
until it runs into a block with a bad sector. Then R-Studio jumps to another bad sector area and the process is
going on until all bad sector areas have been processed. When this step is finished, some good data from the
hard drive has been read, and R-Studio has detected the rear edges of bad sector areas.

Step 3. R-Studio reads data from slow sector areas. It does that much the same way as for bad sector areas. 
When this step is finished, good data from slow sectors on the hard drive has been read, and R-Studio has
detected the rear edges of slow sector areas.

Step 4. R-Studio finds the rear edges of bad sector areas in slow sector areas. When this step is finished, some
new good data from slow sectors on the hard drive has been read, and R-Studio has detected the rear edges of
all bad sectors within slow sector areas.

Step 5. R-Studio tries to read all skipped sector blocks. This is done without skipping bad sector blocks and
checking read speed against minimum I/O rate.

When Phase 1 is completed, R-Studio has read most of readable data and detected front and rear edges of all
bad sector areas.

R-Studio tries to read the rest of data in the next phases, and does that sector by sector (rather than blocks).

Phase 2. Trimming

R-Studio detects the front and rear sectors of bad sector areas. When this step is finished, some new good data
from bad sector areas has been read, and R-Studio has detected the front and rear sectors of all bad sector
areas.

Phase 3. Scraping

R-Studio tries to read data from bad sector areas sector by sector.

Phase 4. Retrying (mostly optional)

R-Studio tries to read data from bad sectors through several attempts. 

You may read more about this process in our article Multi-pass imaging in R-Studio

To create an image through multi-pass imaging,

1 Select an object on the R-Studio's Drives panel and click the Create Image button

 Other ways to create the image

· Select the object and select Create Image on the Drive menu

http://www.r-studio.com/Multipass-imaging-damaged-drives.html
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or
· Control-click the selected object and select Create Image File on the contextual menu

2 Specify image options, a file name, and destination for the image on the Create Image dialog box and
click the OK button

Create Image (Bad sector processing) dialog box

Bad sectors processing options

Image filename Specifies the name and path for the image file

Image type: Compressed image (R-Drive Image compatible): If this option is selected,
R-Studio will create an image file which can be compressed, split into several
parts, and password-protected. This image file is fully compatible with the
images created by R-Drive Image, but incompatible with the previous versions
of R-Studio.
Byte by byte image: If this option is selected, R-Studio will create a simple exact
copy of the object.
VMDK (ViMware Virtual Machine Disk) image: If this option is selected, R-Studio
will create an image of the VMware virtual disk type. Available in the Corporate,
Technician, and T80+ license.
Some other image formats are also available in the Technician, and T80+
licenses. You may read more about these formats in the Supported Virtual Disk
and Disk Image Formats page.

Drive sector map file A file with the sector map of the object to image. Optional for the RDI image
type, mandatory for the byte-by-byte and VMDK image types.

Enable multi-pass
image creation

Turns multi-pass imaging on and off.

Data to process All data: All data on the disk will be imaged.
Existing files only (FS bitmap): Only the disk's area where existing files reside will
be imaged.
Unused clusters only: Only the disk's free space will be imaged.

http://en.wikipedia.org/wiki/VMDK
https://www.r-studio.com/What-is-a-Sector-Map-File.html
https://www.r-studio.com/What-is-free-disk-space.html
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You may image the existing files first and then unused clusters. 

Perform reading in
reverse order if
possible

Switches the direction of all phases/steps to reverse.

Minimum skip size Minimum size of drive area to skip when a bad sector is encountered.

Maximum skip size Maximum size of drive area to skip when a bad sector is encountered.

Number of retries
(Retrying phase)

The number of read attempts in the Retrying phase.

Disable imaging phases Multi-imaging phases that can be skipped.

> R-Studio will start creating the image, the Progress message showing the progress.

Multi-pass imaging progress dialog box

You may change operation parameters during image creation. Click the Options button and change them
accordingly. 

Drive Options tab
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Multi-pass imaging options tab

Post Actions tab

3.12 Reverse RAIDs

Reverse RAIDs is a technique that is reverse to creating virtual RAIDs. When creating a reverse RAID, the data
from a real object is decomposed into virtual parents.Then data on those virtual parents can be processed like on
real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

· Reverse RAID of an Object
This technique can be used to decompose data on a single volume into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

· Reverse RAID of a RAID
This technique can be used to re-construct data on individual RAID disks when data on physical disks is
corrupted, but can be recovered using RAID redundancy. A missing disk is an example of this case. Or if there
are bad sectors scattered over the physical disks but the overall RAID integrity remains. Then the data can be
copied to physical hard drives to create a healthy RAID.

Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

https://www.r-studio.com/What-are-Bad-Sectors.html
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3.12.1 Reverse RAID of an Object

This technique can be used to decompose data on a single object into virtual parents. Then such virtual parents
can be processed like on real objects. They can be viewed, edited, imaged, copied to physical drives, etc.

Suppose you have an image of a former RAID 6 (Reed-Solomon) and you wand to re-create data on individual
disks from that RAID 6. You can do that by creating a reverse RAID of an  image. 

Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a disk image (or other disk object),

1 Control-click the disk object on the Drives panel and select Create Reverse RAID on the contextual
menu.

> The Reverse parents will appear on the Drives panel

Initially, the reverse RAID is set to its default values as RAID 5 on the Parents tab.

2 Adjust RAID parameters on the Parents tab, as necessary. 

https://www.r-studio.com/What-is-Disk-Image.html
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You need to add one reverse parent, change RAID type, and adjust RAID offset .

> Process the appeared reverse parents  on the Drives panel as real objects.

These parents can be imaged, viewed/edited, etc.

3.12.2 Reverse RAID of a RAID

This technique can be used to re-construct data on individual RAID disks when data on physical disks is
corrupted, but can be recovered using RAID redundancy.

Suppose you have a RAID 5 with one missing hard drive and you need to reconstruct data on that disk. You can
do that by creating a reverse RAID for it and then copy data from that missing disk to a real one, or to an image. 

Note: Many controllers write their own metadata to disks to recognize that the disks belong to certains RAIDs.
Without that metadata they won't see those RAIDs. You have to write that metadata manually.

To create a reverse RAID of a RAID with a missing disk,

1 Create a virtual RAID 5 of the existing hard drives or their images

Add a missing disk to the Parents tab.

https://www.r-studio.com/What-is-Disk-Image.html
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If necessary, read the Basic RAID 4 and RAID 5 Operations and Volumes Sets and RAIDs help pages for
details. 

2 Control-click the Virtual Block Raid on the Drives panel and select Create Reverse RAID on the
contextual menu.

> The Reverse parents will appear on the Drives panel

These parents may be processed as real objects, they can be imaged, viewed/edited. For your case the
missing disk can be copied to a hard drive in the Drive Copy Wizard.
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Note: The reverse parents contain the data that should be on the RAID parents, according to its layout,
while RAID parents contain actual data, that may be corrupted. 

3.13 Working with the Third-Party Hardware

The Technician version of  R-Studio can work together with third-party hardware developed for in-depth data
recovery. Currently, the following devices are supported:

· DeepSpar Disk Imager™

3.13.1 DeepSpar Disk Imager™

Currently only the Windows version of R-Studio can work with DeepSpar Disk Imager™ directly. R-Studio
versions for Mac and Linux can load and process its images.

DeepSpar Disk Imager™ (DDI) is an HDD imaging device specifically built for data recovery from hard
drives with hardware issues. It greatly increases imaging speed, accuracy, and integrity of data retrieved from
such drives. 

The main features that DDI provides when working with hard drives are the following: 

· Direct low-level access to a hard drive bypassing the computers BIOS.
· Disabling specific drive read/write heads.
· Disable SMART subsystem, Bad Sector Reallocation, and Read Look-Ahead
· Read sector timeout controlled by Software/Hardware/PHY drive reset commands
· Bit level analysis of corrupted data to filter out the read-write channel noise
· Fully customizable multi-pass imaging

And many more others an advanced disk imager must have. You may learn more about DDI on its vendor site:
DeepSpar Disk Imager™.

Viewing the drive map

A drive map shows the conditions for individual disk sectors. You may see which sectors are OK, bad, or
unstable. 

http://ww.deepspar.com/products-ds-disk-imager.html
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To view the drive map, 

* Control-click the required hard drive/partition and select Show drive map... on the contextual menu,

> The drive map will appear in the right tab.

 Drive map controls

Sectors The number of the first sector in the row.

Offset Offset in the data. Enter the address you want to jump to and press the Enter key.

Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.

Previous/Next Moves to the previous/next part of the data.

+/- Zooms into/out of, the data.

To see more detailed information about a particular sector range, right click the corresponding rectangle and

select Information on the contextual menu.

Click the Open in Hex Editor button to open the selected block in the Text/hexadecimal editor.

Viewing the file map

A file map shows the conditions for individual file sectors. You may see which sectors are OK, bad, or unstable. 

To view the file map, 

* Control-click the required file and select Map of file... on the contextual menu,

> The file map will appear in the lower pane.

 Drive map controls

Sectors The number of the first sector in the row.

Offset Offset in the data. Enter the address you want to jump to and press the Enter key.

Sectors/Bytes/KB... Specifies the dimension of the data in the Offset field.

Previous/Next Moves to the previous/next part of the data.

+/- Zooms into/out of, the data.

To see more detailed information about a particular sector range, right click the corresponding rectangle and

select Information on the contextual menu.

Click the Open in Hex Editor button to open the selected block in the Text/hexadecimal editor.

3.14 Forensic Mode

Note: This feature is available for the Technician/T80+ version of R-Studio only!

When this mode is enabled, R-Studio will generate a forensic data collection audit log that can be presented at
court hearings. This log includes information about a hardware configuration on which the forensic data collection
takes place and MD5 for recovered files.

Note: A new log will be generated each time the hardware configuration is changed (a drive is connected/?
disconnected, an external USB device is connected/?disconnected, etc)

https://www.r-studio.com/What-is-a-Computer-Forensic-Analysis.html
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To enable this feature,

* Select Enable Forensic Mode on the Main tab of the Settings dialog box.

The Forensic Log tab will appear on the Recover dialog box.

Forensic Log tab

Enter the required information on this tab and then go to the other tabs of the  Recovery dialog box.

While file recovery, R-Studio will create forensic data collection audit log in the specified folder. Below is an
example of such log.
******************************** Forensic Data Collection Audit Log ********************************

R-Studio

**************************************** Drives Information ****************************************

- Drive Number 0 ---------------------------------
* Drive Type [256 bytes]: Computer,Local Computer
* Name [30 bytes]: Local Computer
* OS [38 bytes]: macOS 12.5.1 (x64)
* System [136 bytes]: 4 x Intel(R) Core(TM) i5-4308U CPU @ 2.80GHz, 2800 MHz, 8192 MB RAM



R-Studio for Mac Manual236

© 2024 R-Tools Technology Inc.

- Drive Number 1 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [54 bytes]: APPLE SSD SM0128F UXM2JA1Q
* OS Object [24 bytes]: /dev/rdisk0
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 113GB (236978176 sec)
* Logical Sector Size [4 bytes]: 512B
* Physical Sector Size [4 bytes]: 4KB
* GPT Disk GUID [74 bytes]: b839dd82-9ebb-4993-b3eb-32cef2e1fbe3
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: APPLE
  * Product [64 bytes]: SSD SM0128F
  * Firmware [16 bytes]: UXM2JA1Q
  * Serial Number [32 bytes]: S1K3NYCG105755
+ IDE Properties [8 bytes]: 
  * Size [44 bytes]: 113GB (236978176 LBA)
  * Logical Sector Size [8 bytes]: 512
  * Physical Sector Size [10 bytes]: 4096
  * Device Type [8 bytes]: SSD
  * Interface [38 bytes]: SATA 3.0, 6.0 Gb/s
  * Interface Speed [18 bytes]: 6.0 Gb/s
  * Standard [18 bytes]: ATA8-ACS
  * Features [70 bytes]: S.M.A.R.T., AAM-, LBA48, NCQ, TRIM
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 2 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [70 bytes]: APPLE HDD HTS541010A9E662 JA0AB5D0
* OS Object [24 bytes]: /dev/rdisk1
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 931.5GB (1953525168 sec)
* Logical Sector Size [4 bytes]: 512B
* Physical Sector Size [4 bytes]: 4KB
* GPT Disk GUID [74 bytes]: 81ac843d-494a-4443-a3e4-c90ecd2dceea
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: APPLE
  * Product [64 bytes]: HDD HTS541010A9E662
  * Firmware [16 bytes]: JA0AB5D0
  * Serial Number [32 bytes]: J88000EZKDM0TD
+ IDE Properties [8 bytes]: 
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  * Size [50 bytes]: 931.5GB (1953525168 LBA)
  * Logical Sector Size [8 bytes]: 512
  * Physical Sector Size [10 bytes]: 4096
  * Device Type [36 bytes]: HDD 2.5" 5400 RPM
  * Interface [38 bytes]: SATA 2.6, 3.0 Gb/s
  * Interface Speed [18 bytes]: 3.0 Gb/s
  * Standard [18 bytes]: ATA8-ACS
  * Features [56 bytes]: S.M.A.R.T., APM, LBA48, NCQ
* Bus Type [4 bytes]: SerialATA-II

- Drive Number 3 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [40 bytes]: Apple APFSContainer
* OS Object [24 bytes]: /dev/rdisk2
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: Apple
  * Product [64 bytes]: APFSContainer
* Bus Type [4 bytes]: Virtual

- Drive Number 4 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Removable Disk
* Name [34 bytes]: XinTop XT-U33502
* OS Object [24 bytes]: /dev/rdisk3
* Size [8 bytes]: 111.7GB (234441648 sec)
* Logical Sector Size [4 bytes]: 512B
* GPT Disk GUID [74 bytes]: e7c6f76c-fea1-4c24-b3bf-485549b9df6f
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
# Partition Layout Sector Size [4 bytes]: 512B
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: XinTop
  * Product [64 bytes]: XT-U33502
  * Serial Number [32 bytes]: 20210507
* Bus Type [4 bytes]: USB

- Drive Number 5 ---------------------------------
* Drive Type [256 bytes]: Physical Drive,Disk
* Name [40 bytes]: Apple APFSContainer
* OS Object [24 bytes]: /dev/rdisk4
* Size [8 bytes]: 111.5GB (234031968 sec)
* Logical Sector Size [4 bytes]: 4KB
# I/O Retries [4 bytes]: Default
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+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
+ Device Identification [8 bytes]: 
  * Vendor [32 bytes]: Apple
  * Product [64 bytes]: APFSContainer
* Bus Type [4 bytes]: Virtual

- Drive Number 6 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [26 bytes]: Macintosh HD
* Mount Points [4 bytes]: /
* OS Object [32 bytes]: /dev/rdisk2s5s1
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 7 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [6 bytes]: VM
* Mount Points [38 bytes]: /System/Volumes/VM
* OS Object [28 bytes]: /dev/rdisk2s4
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 8 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [16 bytes]: Preboot
* Mount Points [48 bytes]: /System/Volumes/Preboot
* OS Object [28 bytes]: /dev/rdisk2s2
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
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  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 9 ---------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [14 bytes]: Update
* Mount Points [46 bytes]: /System/Volumes/Update
* OS Object [28 bytes]: /dev/rdisk2s6
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 10 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [40 bytes]: Macintosh HD - Data
* Mount Points [42 bytes]: /System/Volumes/Data
* OS Object [28 bytes]: /dev/rdisk2s1
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 11 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [20 bytes]: APFS-Test
* Mount Points [38 bytes]: /Volumes/APFS-Test
* OS Object [28 bytes]: /dev/rdisk4s1
* Size [8 bytes]: 111.5GB (234031968 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 111.5GB (234031968 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 12 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
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* Name [8 bytes]: EFI
* OS Object [28 bytes]: /dev/rdisk0s1
* Size [8 bytes]: 200MB (409600 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: 8cee8193-135c-4241-8b27-0cd0765bc75f
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096

- Drive Number 13 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [18 bytes]: Customer
* OS Object [28 bytes]: /dev/rdisk0s2
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 112.8GB (236568496 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 112.8GB (236568496 sec)
* GPT Partition GUID [74 bytes]: a60a40fb-71e5-4858-aa6b-d3dc7d1e590f
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096

- Drive Number 14 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [8 bytes]: EFI
* OS Object [28 bytes]: /dev/rdisk1s1
* Size [8 bytes]: 200MB (409600 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: d3e176ed-1af0-4b98-9b24-d92be8c9a28d
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
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  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: SerialATA

- Drive Number 15 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [28 bytes]: Macintosh_HD2
* OS Object [28 bytes]: /dev/rdisk1s2
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 931.3GB (1953115488 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 931.3GB (1953115488 sec)
* GPT Partition GUID [74 bytes]: 527abab6-d06a-4c4e-a57a-c38fb621f602
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: SerialATA

- Drive Number 16 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [18 bytes]: Recovery
* OS Object [28 bytes]: /dev/rdisk2s3
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 17 --------------------------------
* Drive Type [256 bytes]: Volume,Disk
* Name [26 bytes]: Macintosh HD
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* OS Object [28 bytes]: /dev/rdisk2s5
* R-Studio Driver [12 bytes]: IOKit
* Size [8 bytes]: 1.01TB (2189683984 sec)
* Logical Sector Size [4 bytes]: 4KB
* Partition Size [8 bytes]: 1.01TB (2189683984 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 4096
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: Virtual

- Drive Number 18 --------------------------------
* Drive Type [256 bytes]: Volume,Removable Disk
* Name [8 bytes]: EFI
* OS Object [28 bytes]: /dev/rdisk3s1
* Size [8 bytes]: 200MB (409600 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: 79730f0b-3579-4ab2-9947-e96892315160
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: USB

- Drive Number 19 --------------------------------
* Drive Type [256 bytes]: Volume,Removable Disk
* Name [22 bytes]: Untitled 2
* OS Object [28 bytes]: /dev/rdisk3s2
* Size [8 bytes]: 111.5GB (234031968 sec)
* Logical Sector Size [4 bytes]: 512B
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 111.5GB (234031968 sec)
* GPT Partition GUID [74 bytes]: 0c6388f0-1bdb-476f-a1d5-faea580a87af
# I/O Retries [4 bytes]: Default
+ Drive Control [8 bytes]: 
  # Maximum Transfer [4 bytes]: 131072
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  # I/O Block Size [4 bytes]: 512
  # Buffer Alignment [4 bytes]: 4096
* Bus Type [4 bytes]: USB

- Drive Number 20 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [42 bytes]: EFI System Partition
* Size [8 bytes]: 200MB (409600 sec)
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: 8cee8193-135c-4241-8b27-0cd0765bc75f
* GPT Type GUID [256 bytes]: UEFI System Partition, c12a7328-f81f-11d2-ba4b-00a0c93ec93b
* GPT Partition Name [42 bytes]: EFI System Partition
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)

- Drive Number 21 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [18 bytes]: Customer
* Size [8 bytes]: 112.8GB (236568496 sec)
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 112.8GB (236568496 sec)
* GPT Partition GUID [74 bytes]: a60a40fb-71e5-4858-aa6b-d3dc7d1e590f
* GPT Type GUID [256 bytes]: APFS Container, 7c3457ef-0000-11aa-aa11-00306543ecac
* GPT Partition Name [18 bytes]: Customer
# Partition Layout Sector Size [4 bytes]: 512B

- Drive Number 22 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [42 bytes]: EFI System Partition
* Size [8 bytes]: 200MB (409600 sec)
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: d3e176ed-1af0-4b98-9b24-d92be8c9a28d
* GPT Type GUID [256 bytes]: UEFI System Partition, c12a7328-f81f-11d2-ba4b-00a0c93ec93b
* GPT Partition Name [42 bytes]: EFI System Partition
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
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  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)

- Drive Number 23 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [28 bytes]: Macintosh_HD2
* Size [8 bytes]: 931.3GB (1953115488 sec)
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 931.3GB (1953115488 sec)
* GPT Partition GUID [74 bytes]: 527abab6-d06a-4c4e-a57a-c38fb621f602
* GPT Type GUID [256 bytes]: APFS Container, 7c3457ef-0000-11aa-aa11-00306543ecac
* GPT Partition Name [28 bytes]: Macintosh_HD2
# Partition Layout Sector Size [4 bytes]: 512B

- Drive Number 24 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [42 bytes]: EFI System Partition
* Size [8 bytes]: 200MB (409600 sec)
* Partition Offset [8 bytes]: 20KB (40 sec)
* Partition Size [8 bytes]: 200MB (409600 sec)
* GPT Partition GUID [74 bytes]: 79730f0b-3579-4ab2-9947-e96892315160
* GPT Type GUID [256 bytes]: UEFI System Partition, c12a7328-f81f-11d2-ba4b-00a0c93ec93b
* GPT Partition Name [42 bytes]: EFI System Partition
+ FAT Information [8 bytes]: 
  * FAT Bits (12,16,32) [4 bytes]: 32
  * Cluster Size [4 bytes]: 512B (1 sec)
  * First Cluster Offset [8 bytes]: 3.09MB (6332 sec)
  * Root Directory Cluster [4 bytes]: 2
  * First FAT Offset [8 bytes]: 16KB (32 sec)
  * Size of One FAT Table [8 bytes]: 1.53MB (3151 sec)
  * Number of FAT Copies [4 bytes]: 2
  # Active FAT copy [4 bytes]: Auto
  * Sector Size [4 bytes]: 512B
  * Major Version [1 bytes]: 0
  * Minor Version [1 bytes]: 0
  * Volume Size [8 bytes]: 200MB (409600 sec)

- Drive Number 25 --------------------------------
* Drive Type [256 bytes]: Partition
* Name [30 bytes]: APFS Container
* Size [8 bytes]: 111.5GB (234031968 sec)
* Partition Offset [8 bytes]: 200MB (409640 sec)
* Partition Size [8 bytes]: 111.5GB (234031968 sec)
* GPT Partition GUID [74 bytes]: 0c6388f0-1bdb-476f-a1d5-faea580a87af
* GPT Type GUID [256 bytes]: APFS Container, 7c3457ef-0000-11aa-aa11-00306543ecac

- Drive Number 27 --------------------------------
* Drive Type [256 bytes]: Volume Set
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* Name [44 bytes]: APFS Fusion Container
* Size [8 bytes]: 1.01TB (2189683984 sec)

- Drive Number 28 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [20 bytes]: APFS-Test
* Mount Points [38 bytes]: /Volumes/APFS-Test
* Size [8 bytes]: 111.5GB (234031968 sec)
+ APFS Information [8 bytes]: 
  * Volume GUID [74 bytes]: c70d7407-cf78-46b6-a905-f3853133c7c8
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 4469145
  * Last Write Time [8 bytes]: 8.9.2022 21:10:1

- Drive Number 29 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [40 bytes]: Macintosh HD - Data
* Mount Points [42 bytes]: /System/Volumes/Data
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116810840
  * Last Write Time [8 bytes]: 8.9.2022 21:10:4

- Drive Number 30 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-07-234145.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116098391
  * Last Write Time [8 bytes]: 7.9.2022 20:41:45

- Drive Number 31 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-08-160444.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116201418
  * Last Write Time [8 bytes]: 8.9.2022 13:4:44

- Drive Number 32 --------------------------------
* Drive Type [256 bytes]: APFS Volume
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* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-08-203916.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116777113
  * Last Write Time [8 bytes]: 8.9.2022 17:39:16

- Drive Number 33 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-08-213917.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116787894
  * Last Write Time [8 bytes]: 8.9.2022 18:39:18

- Drive Number 34 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-08-223922.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116797931
  * Last Write Time [8 bytes]: 8.9.2022 19:39:22

- Drive Number 35 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [132 bytes]: Macintosh HD - Data-com.apple.TimeMachine.2022-09-08-234107.local
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [10 bytes]: Data
  * Volume GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 116807413
  * Last Write Time [8 bytes]: 8.9.2022 20:41:7

- Drive Number 36 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [16 bytes]: Preboot
* Mount Points [48 bytes]: /System/Volumes/Preboot
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [16 bytes]: Preboot
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  * Volume GUID [74 bytes]: 5e853f43-e5ec-4179-bbd3-2f2704b39f0c
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 190606
  * Last Write Time [8 bytes]: 22.8.2022 21:49:11

- Drive Number 37 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [18 bytes]: Recovery
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [18 bytes]: Recovery
  * Volume GUID [74 bytes]: 91ae079f-05a4-4502-a04d-fe0e95186448
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 273581
  * Last Write Time [8 bytes]: 22.8.2022 21:33:59

- Drive Number 38 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [6 bytes]: VM
* Mount Points [38 bytes]: /System/Volumes/VM
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [6 bytes]: VM
  * Volume GUID [74 bytes]: 0c95f3c3-f381-4547-b503-0a28f03fab4e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 524550
  * Last Write Time [8 bytes]: 8.9.2022 17:33:47

- Drive Number 39 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [26 bytes]: Macintosh HD
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [14 bytes]: System
  * Volume GUID [74 bytes]: cb3e0faf-3835-4536-9538-5fd6ee406e20
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 3764255
  * Last Write Time [8 bytes]: 8.9.2022 17:33:49

- Drive Number 40 --------------------------------
* Drive Type [256 bytes]: APFS Volume
* Name [196 bytes]: Macintosh HD-com.apple.os.update-E64B3CD15985B90FDC72FFBC9FFB352590E652026671C1695E4EA97D9050DD14
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [14 bytes]: System
  * Volume GUID [74 bytes]: cb3e0faf-3835-4536-9538-5fd6ee406e20
  * Volume Group GUID [74 bytes]: f5444926-a963-3427-855b-6d02f99de54e
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 5345741
  * Last Write Time [8 bytes]: 22.8.2022 21:33:55

- Drive Number 41 --------------------------------
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* Drive Type [256 bytes]: APFS Volume
* Name [14 bytes]: Update
* Mount Points [46 bytes]: /System/Volumes/Update
* Size [8 bytes]: 1.01TB (2189683984 sec)
+ APFS Information [8 bytes]: 
  * Volume Role [14 bytes]: Update
  * Volume GUID [74 bytes]: 5337792e-3873-44d4-9550-83d1d26c72ab
  * Block Size [4 bytes]: 4KB (8 sec)
  * Used Blocks [8 bytes]: 2767
  * Last Write Time [8 bytes]: 8.9.2022 17:34:4

****************************************************************************************************

-------------------------------------------- Session 1 ---------------------------------------------
START Date / Time of Collection: 2022-09-09 00:16:11

Case Name: Steven v. Christofer
Case Number: 28-S-0205-CR-85763
Operator / Investigator Name: J.F. Lewson

Source drive:Sector Modification Date    MD5                                 SHA-1                                   SHA-256                                                         File Name
 28                 2022-09-08 22:00:20  Root
 28                 2022-09-08 22:46:03  Root/.fseventsd
 25                 2022-09-08 22:46:03  1af4a4275ce2ce213551464090bb3a2e    14922cd82a44901815d3a1f4c46ce0737ac13ae3 e8180aed8949092d48a1fbfd0c2b9712a8dd9869bf679d3e125173e7f255b0ba Root/.fseventsd/000000000054e8e1
    DATA: DATA (Non-Resident)
         43094336-43094351
 25                 2022-09-08 22:46:03  13936109592cac255892bbe90f2d5d81    cabbcfcfe9f58929b8e176a17038bbb218ff50bb 2b060753e203d6875484ee341975c17da27a7bfacfb00389ec4768dd141d62be Root/.fseventsd/000000000054e8e2
    DATA: DATA (Non-Resident)
         43094352-43094359
 25                 2022-09-08 22:46:03  f93b29aa809faae03d1632a519fedc7c    2574e0615b7a325916a2753fde9db534ff24d280 a4ed37466423b5ac9f1a18fd97facbd8fe219adb0e875dcbd1dd2f96d00f807e Root/.fseventsd/fseventsd-uuid
    DATA: DATA (Non-Resident)
         7313512-7313519
 28                 2022-09-08 21:58:43  Root/.Spotlight-V100
 28                 2022-09-08 21:58:43  Root/.Spotlight-V100/Store-V2
 28                 2022-09-09 00:09:52  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC
 28                 2022-09-08 22:00:32  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache
 28                 2022-09-08 22:00:32  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000
 28                 2022-09-08 22:00:32  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000
 28                 2022-09-08 22:06:46  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000
 25                 2022-09-08 22:06:46  556c368d59e706d470c957e798ad8b8f    842c630607a0be943771bce23c88010b1c3824bf 2166da5e42ca5fd47aa3c6a1e91d55564328cd02612c381cb2323007bde7f2fa Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/144.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         43089280-43089319
    com.apple.decmpfs: MACOS_DATA (Resident)
         3659142
    DATA: DATA (Non-Resident)
         0-34
 25                 2022-09-08 22:00:32  2da67d2f5b3f8c181a5e3461f12d2234    4560acac40f8456e6d0c7162c9be19f0623236c3 ea6996055da6affcc9173e15a2852ce23cd621ac1e1e81116819501d15580423 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/147.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         8514976-8515039
    com.apple.decmpfs: MACOS_DATA (Resident)
         3660076
    DATA: DATA (Non-Resident)
         0-35, 36-57
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 25                 2022-09-08 22:00:32  356319619aee55d6a122363d5188b2cc    acb0df7b9871f1f8a38753fde77f3b36b6620260 596c9fe58d1036a2e73dfcaa4afb08e24374ce919f2e26f5c0a41c54b1e2c9a4 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/148.txt
    DATA: DATA (Non-Resident)
         8514944-8514975
 25                 2022-09-08 22:00:32  90ff0d6d9698ebbbddf412e4a6120cc9    29ce2429007353556c22084f45702a6dba385c40 01dede51e49648cbc715b55f476036d0f2f15151f0717e46d9f141fc7ec36053 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/149.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         8567472-8567495
    com.apple.decmpfs: MACOS_DATA (Resident)
         3660076
    DATA: DATA (Non-Resident)
         0-2, 3-5, 5-7, 8-10, 11-13, 13-15, 16-18, 18-20, 20-22, 22-23
 25                 2022-09-08 22:00:32  4af42d4bfc5bf840bb449021f4fddb7c    7d6c4df1a91ab772b367ef92b9526249bd2ebd4b 3ea93e5acbe8c84c71da0caba89425be92c4230fc242d58c709317ded358c0a2 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/151.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         8515040-8515047
    com.apple.decmpfs: MACOS_DATA (Resident)
         3658893
    DATA: DATA (Non-Resident)
         0-3, 3-5
 25                 2022-09-08 22:00:32  ac3a4692d90b01f65a4cf9c74ba6367f    f7f810ca43f81365f04b54c5e0c4ec1e396835a3 7a41026107b1066052e6c41a39d020e568d99979380705cf2e03a96b08fe8dc4 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/152.txt
    DATA: DATA (Non-Resident)
         8515048-8515071
 25                 2022-09-08 22:00:46  abad9948c3fba719ed9755630350b1e3    f94f078a4db8246c1245daa2756056fa25f6a9e7 9c3d2581db105b7735f5def2571e5d31783f99c614300324f2cabd3e8b767c01 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/153.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10141088-10141119
    com.apple.decmpfs: MACOS_DATA (Resident)
         3657014
    DATA: DATA (Non-Resident)
         0-3, 4-7, 7-10, 10-13, 13-16, 17-19, 19-21, 21-23, 24-26, 26-27
 25                 2022-09-08 22:00:46  e67c7618bac03e4a14b95cb3a1684c9c    6d8f7e3caa96bbfc51811c0b7610fbee14b34ac1 183a2e226261c818dffd0e541863977c1a349392d37fe5bfd794ba733846b10a Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/154.txt
    DATA: DATA (Non-Resident)
         10141072-10141087
 25                 2022-09-08 22:00:46  c18f56f9da1e49cc56df0c085f691f5d    c9a9828a32905bff6231fe25a5d28530d4ba808e cf201de624f9711fe6bf030efe0bd4511e9d9a23ee11ba08a05590e05ea94b65 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/155.txt
    DATA: DATA (Non-Resident)
         10141048-10141071
 25                 2022-09-08 22:00:47  efd79ddcdb8a9ee3ab199e79673087fb    d4fd662e55669abc8010edd8935b7ac3116d4bd4 5cc775466890b0a87f6ed93d2bdb7d6d171637537fcf68ceaac1ad0a31d0325c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/156.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10141144-10141183
    com.apple.decmpfs: MACOS_DATA (Resident)
         3657013
    DATA: DATA (Non-Resident)
         0-35
 25                 2022-09-08 22:00:46  262060a3e1367c9ac932cd99fee9fe0a    8845bd681f2a6e8e935c25567bd4e2ffd2590a00 da0fbca69114d95074fa2b367407355abd3fa2c4df5c34969be4422c92ab312c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/164.txt
    DATA: DATA (Non-Resident)
         10141120-10141143
 25                 2022-09-08 22:00:47  e9c7f33b2c803bf703f2d8729d3504f3    450f983e3a7ab6d987acd6ce0ac89ddb13660d86 276cab69af2c0f602506038b000aeeb4ad7a4569fe1a9cf3a77e290b0c02f739 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/165.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10141184-10141191
    com.apple.decmpfs: MACOS_DATA (Resident)
         3657012
    DATA: DATA (Non-Resident)
         0-2, 2-3
 25                 2022-09-08 22:00:46  6922bd5028c11c15e0e7e1e56c5ec18e    5633ec1a2503112e39346ca720767f719d4cc376 ee7fb94c396cf4b9f1a4bbebb8d7e951d1aa3d06270c452b0dab242bf347996d Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/166.txt
    DATA: DATA (Non-Resident)
         10141192-10141207
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 25                 2022-09-08 22:00:46  c23d6ee6de607a5b122bc932cdcaa981    1e6ba5ccda591150ea1df8a8a2aec260949237c5 5a2ef469e3d0603696272319a7b8c73142def70116c49d90a7a3db112e0cb084 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/167.txt
    DATA: DATA (Non-Resident)
         10141208-10141231
 25                 2022-09-08 22:00:47  b7b098deca62ff106c8886d14764d03e    79b2c035da36c0b42312f7b352a5fa59b737e5a4 02291b4c0399e8a24328e194d5336aa4aa35597a26504577763ed5e7e1aa0e01 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/169.txt
    DATA: DATA (Non-Resident)
         10141232-10141247
 25                 2022-09-08 22:00:47  2cc0171d42663cd68aa458a2330fd317    0540233a0bb27c10182b355f491446538add3b46 2d3d20c6d9db8bf4f2e23a8894726642f3116dc397c6d189a086076553779c21 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/171.txt
    DATA: DATA (Non-Resident)
         10141248-10141271
 25                 2022-09-08 22:00:48  bc321e21c0bf2cbc674f98c172cd1505    7fff5867df176091f320f1ab33915a1c4b425667 12c3dd7ae42b81ae39982e0590643d50945dcc4c3b087b9fe27cb85af92a93da Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/172.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10141272-10141279
    com.apple.decmpfs: MACOS_DATA (Resident)
         3657011
    DATA: DATA (Non-Resident)
         0-2, 2-3
 25                 2022-09-08 22:00:47  460142c26d1636f09481f1fbf316102b    ee63ad060ea7a91907b32184ec1e21c04e2124f1 619c63a3864688c8d5266eb9898eebc10b7f77097c3b267060502625377715ce Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/173.txt
    DATA: DATA (Non-Resident)
         10141280-10141303
 25                 2022-09-08 22:00:48  3e1da65c9eb5c151d767cf79bbbd5f01    34992850f5c569d72f543a7e7a5210c283124ac2 6688da8a7194b3217b0b0ea1ba54bfece288ded908e66a6231687c00854ecc6c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/178.txt
    DATA: DATA (Non-Resident)
         10141312-10141319
 25                 2022-09-08 22:00:47  ef107ae30cd2faf7500fdcbcb58ae7fc    65d64109331d88e8a80af887e12ecf7a9d1d5319 f81101e024671d05c42dd16687383d0b909b1868a407dc5898e43d1177a1d399 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/179.txt
    DATA: DATA (Non-Resident)
         10141304-10141311
 25                 2022-09-08 22:00:48  4c3552b2b45c8142fb78230a249788ce    eaef2e4875b36d6a53f8a81a41a33787102e47bc 7963a1629c4fba669a6bd134f02b384c9644aefa0ce5312ad51e110ea9d9e8fa Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/180.txt
    DATA: DATA (Non-Resident)
         10141320-10141327
 25                 2022-09-08 22:00:48  d59410ad642ffe938628813d4229b13d    a9db9e7d9652a92368459a53b8307dd7df58cb4c d1ea3d7af88647f8709d7d5011b03caa47c9b9ceccc31f0346177c441dcc90b1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/181.txt
    DATA: DATA (Non-Resident)
         10141328-10141335
 25                 2022-09-08 22:00:48  ac459f514105e4500fd8320425585dc9    98116162586eb838694f9a7efd45ecdba3b2c3c6 758b68f5629d4892eea72c1ae4585505a96eddc45aa1c8a9da2ae18595df24a1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/182.txt
    DATA: DATA (Non-Resident)
         10141336-10141343
 25                 2022-09-08 22:00:48  dc3a1ddcab841495c42d2ccde2ecb7eb    405cbca0f0c0982ea7968766aa5698ef9c7e0f67 ea27c5084aba4429fbea3c3482fe7ae918a74c454693512fccfa87e80ab782fb Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/184.txt
    DATA: DATA (Non-Resident)
         10141344-10141351
 25                 2022-09-08 22:00:49  24e341a5d293790b7413c6046ed9cc1e    025d45eda5553c9b49ec4c9ee91c590857304fc3 14a225bb8b69246328676aec5cde4195f64827b9f520294318defd88cec61285 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/186.txt
    DATA: DATA (Non-Resident)
         10499320-10499327
 25                 2022-09-08 22:00:49  acd0b43cd246f085923cf0e62e820042    710db5192372220477bda87d57cb83b2cd8fcda9 550bb110795cf1ece92a446b4fe883ea90d23bc97b357009426ee905c3d15845 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/187.txt
    DATA: DATA (Non-Resident)
         10499328-10499335
 25                 2022-09-08 22:00:49  b6af99868cbe42e4b77e9860848a2f6a    902d286085510e161792e5c2c4bbcd09933d0868 c2102d90dddc06860b9597d192c8a8cda01781b9573e71c60c879e26d908ca1a Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/188.txt
    DATA: DATA (Non-Resident)
         10499336-10499343
 25                 2022-09-08 22:00:49  40e2c610319e1396ee9dd40cc8c3af2b    1e890abd428931cb4bec36d4260f31079dcad877 f9cf0e2a510eb9eae95450d78ee8723611f3b6ad211486e0b22b901e42afd0f1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/189.txt
    DATA: DATA (Non-Resident)
         10499344-10499351
 25                 2022-09-08 22:00:49  af479c53a1e532d2e496ed785608eafd    a93ea0b7944455cf632686e9aa63fd2b811003b7 c1072be86ff094abc3bbc80786ca912e5d52be4e494d35cb7db0fb07db8da3d2 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/194.txt
    DATA: DATA (Non-Resident)
         10499352-10499375
 25                 2022-09-08 22:00:50  a726f1b050823eb2f3734e4c3ff0cd30    969e7cd968a9770d4a2394097ddc13aafad4220d e3221d3cefb1cabd0bef8c0649b46ec7b0b9a93efb3cc17a1266783b1826467a Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/195.txt
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    DATA: DATA (Non-Resident)
         10499376-10499399
 25                 2022-09-08 22:00:51  5ccce027044a0df26e27c9bc4b19114b    ef88f142bd3450d075c7a9e5f2201ec67ad4c60a 2d53728554c4cadb7cf1c79083df83b3b1fde0ee9d05424e93a8c56a2ea02ce3 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/196.txt
    DATA: DATA (Non-Resident)
         10499440-10499455
 25                 2022-09-08 22:00:52  014d7346f8fa99ece5904d993c3b9c51    590b35de3bdb4d5c708af2a6a025593798902480 45519c1889256f7369038a8b1cfed9e96324b8edea144da2354a2233fe5d7b86 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/197.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10499456-10499463
    com.apple.decmpfs: MACOS_DATA (Resident)
         3659775
    DATA: DATA (Non-Resident)
         0-2, 2-3
 25                 2022-09-08 22:00:51  c2613cb057383d3beb410d5907072d2f    ce66c81aad33964c3fddfcd75e27df45f44aa270 c78269d22a258395bddfee06610bcadc00eeeaf05a6440d9afb5058b24fc33a9 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/199.txt
    DATA: DATA (Non-Resident)
         10499400-10499423
 25                 2022-09-08 22:00:51  97e8a2c9bdd8cdae7e68068027e27f9e    ae867b0e7ee9acff3ddcb579c49c2cb563560187 b835f9347c51d6208d6edf104e5a8a2e884c8e29a9bf185bc090bcda1f63cec0 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/200.txt
    DATA: DATA (Non-Resident)
         10499424-10499439
 25                 2022-09-08 22:00:52  15707949e58cda88fed9e3e8fd0d6d47    cef186e2a314c9fb75e79b1cdeb44a6295b1cacf 90eb4cfc4bbd8bda2ccfdf3dfd955a98b69edbc3335b979414eb965841dc8dcc Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/201.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10499464-10499471
    com.apple.decmpfs: MACOS_DATA (Resident)
         3659774
    DATA: DATA (Non-Resident)
         0-2, 2-3
 25                 2022-09-08 22:00:51  9d18874bd46ad1071f4f417409f81c28    df9bb6359630bebda1b7c6ef1f67c9e4ac412a7a d2124955b7ef8cef894e164bc86b3d48b4d9561e2bd7ea18fdb4ab41566f862a Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/202.txt
    DATA: DATA (Non-Resident)
         10499472-10499495
 25                 2022-09-08 22:00:51  7295cdcfb1589d65641f4f2829110fa0    cde85ddde182bbf12918e892cc459b43b5c90462 ed84055e86947bdd05645f6aeb26f81615523913f425b428048df3257ae7b708 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/208.txt
    DATA: DATA (Non-Resident)
         10499496-10499503
 25                 2022-09-08 22:00:52  82771a9d66d9101d0a3d2ec95745fc13    4dcecbca460935c6b6a2aa96c876ce095a0b8c6e 574059f807e899d533d19c60b787d531767fb68ea3825cccfb903c7d752c0bc1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/209.txt
    DATA: DATA (Non-Resident)
         10499504-10499511
 25                 2022-09-08 22:00:52  89b7f84c5ce1ba862c25559bfc97ca3f    89260bd31e1723b7b2bd553f262110c5dcc47c87 be3cede89aaf45c74fc14c9520c79458fbab2e4376354d3bf4a858d98b40bb59 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/210.txt
    DATA: DATA (Non-Resident)
         10499512-10499519
 25                 2022-09-08 22:00:52  72f9e078858c846f72f317e372d89724    4cc56010c6d7c7ab62b454453cda95f3bc7c9dc1 b60949ce2b8d1cc5a59ef06fe4da7b409e3e3c98e6be52c5342973962be0985d Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/211.txt
    DATA: DATA (Non-Resident)
         10499520-10499527
 25                 2022-09-08 22:00:54  556c368d59e706d470c957e798ad8b8f    842c630607a0be943771bce23c88010b1c3824bf 2166da5e42ca5fd47aa3c6a1e91d55564328cd02612c381cb2323007bde7f2fa Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/218.txt
    com.apple.ResourceFork: MACOS_DATA (Non-Resident)
         10857984-10858023
    com.apple.decmpfs: MACOS_DATA (Resident)
         3659772
    DATA: DATA (Non-Resident)
         0-34
 25                 2022-09-08 22:00:53  656c8c7ac1dbd4175e05dc484e6c5d62    91c03f4eedc01cca9a87143fbe507db77535fb03 30ebb94c51aeb4e145271a7e6a6bcfaba013896da0460892a686aae2c79d6a72 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cache/0000/0000/0000/219.txt
    DATA: DATA (Non-Resident)
         10857976-10857983
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.assisted_import_post
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.assisted_import_pre
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.corespotlight
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 28                 2022-09-08 22:00:26  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.health_check
 25                 2022-09-08 22:00:26  c4e0d2509011c8ed1dc6b7837395556f    70ec896fa15d449564615b3b73e447bdab002809 9b2d233b99aead34ed72171ef89fa377bb475a8ec33dfb1885b4bfaa772fdded Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.health_check/journal.1
    DATA: DATA (Non-Resident)
         7922344-7922351
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live_priority
 28                 2022-09-08 22:10:49  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live_system
 25                 2022-09-08 22:10:49  c078e4f28252dd21cc095557df7e10ca    cacfa2624671d9dff4b8cdb9fe8bcfdf7a25cbcb 025a066248bd6ff3e292b6812cae6884c77b3a2b00fd8e4f4b286c44e17275fb Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live_system/journal.1
    DATA: DATA (Non-Resident)
         43092888-43092895
 28                 2022-09-08 22:10:49  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live_user
 25                 2022-09-08 22:10:49  cf8b97ff91a88509dfb71b3e886467e7    3eaa52132ab5f53c0958a28d26fe0ddd5e0201eb 63f0748548d342bfeffd39229a15d299eb3dd679c14c87b475ea9a65fee8124b Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.live_user/journal.1
    DATA: DATA (Non-Resident)
         43092880-43092887
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.migration
 28                 2022-09-08 21:58:44  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.migration_secondchance
 28                 2022-09-09 00:09:42  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.repair
 28                 2022-09-08 21:58:45  Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journals.scan
 25                 2022-09-09 00:09:52  78ecd243884cea622481ee663fc6c286    ed816531015fb1070d986015f4dbad79d01467a7 40315dc77b4d3cc3a6db16dab43072e1a5db6418a45a05728cef55297d0b5878 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/.store.db
    DATA: DATA (Non-Resident)
         7340896-7340935, 7341208-7341239, 43092904-43092967
 25                 2022-09-09 00:09:42  a43c4057656a87b73ecbe45688fa754f    c123ab298133f29ff95ee17ff6e7d28d9871e7fc ae034d5d595e2538c31b95a26803aa0d37a354bddaa460190208788907dbe943 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.directoryStoreFile
    DATA: DATA (Non-Resident)
         7342088-7342215
 25                 2022-09-08 22:10:49  05c3f670d5eef252939ecd1c07d91322    21ca9c0440a6baa8e7b3c44902e9538e2714561e ffcbcf0a1d69db0b62cd608790bc1f9bbcab4c88a8b3f4868712f100796132f6 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.directoryStoreFile.shadow
    DATA: DATA (Non-Resident)
         7342512-7342519
 25                 2022-09-08 21:58:46  8f0f05e65021ccf77960958a9039e4f5    26b769ec5cd2810ed0ee72aba5fd3da2d7f9eeff 7606276ff97f4d78bf903873d086bb768472370eae5aecb0de56dcad3f4541f1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexArrays
    DATA: DATA (Non-Resident)
         7341952-7342079, 7342224-7342231
 25                 2022-09-08 21:58:45  85c62e3cae77aa28a6f63aaa9e7bcc4c    d28751cf441fa7b176f373a3bcb725f1776f6c83 c072a8300ffd7e0d3399a3ee0117a6536707c7d190d17058c1d1009cd7ef8c2e Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexBigDates
    DATA: DATA (Non-Resident)
         7340096-7340103
 25                 2022-09-08 21:58:46  7dea362b3fac8e00956a4952a3d4f474    05fe405753166f125559e7c9ac558654f107c7e9 af5570f5a1810b7af78caf4bc70a660f0df51e42baf91d4de5b2328de0e83dfc Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexCompactDirectory
    DATA: DATA (Non-Resident)
         7342520-7342527
 25                 2022-09-08 21:58:46  a3ce32d674242ae4474c6063f2e348cd    36f9b7d0c0cf1a1a63e6140c7a5872b0820d3427 563270169ca37636bca783e67df0451e08906569b8124ed569d0a1f14bab4201 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexDirectory
    DATA: DATA (Non-Resident)
         7341928-7341935
 25                 2022-09-08 21:58:45  610877ce04dc199237813ad5a7952eef    aa109f1fbd403d6ce8b1a31069e5d66ab83fc63e 32b9a6d89c12a471f081798bbf0c5ec105fbc3ff941657f074e0155d82380a3b Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexGroups
    DATA: DATA (Non-Resident)
         7341816-7341823
 25                 2022-09-08 22:10:50  d117ef6fcdf53e87ab58a410a5b62d7b    8074bac56befe285cd61bac45ae18c945c712c24 c352eb65d8db00c99b994a98e7c43cb0da067b5f2da37792f8ba6ee5c1794917 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexHead
    DATA: DATA (Non-Resident)
         7342504-7342511
 25                 2022-09-08 21:58:46  7bea485739dabdca61c3f6f93528dd1c    95f2a5b22f213fb1e26acfc0a2b006a14ebbd9b1 c571327cb01ac1de6972713cbf6cc1fc3c2cab8b581ee0bc3fe6d8b56963fd5b Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexIds
    DATA: DATA (Non-Resident)
         7340032-7340039
 25                 2022-09-08 21:58:46  f1d3ff8443297732862df21dc4e57262    9069ca78e7450a285173431b3e52c5c25299e473 df3f619804a92fdb4057192dc43dd748ea778adc52bc498ce80524c014b81119 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexPositions
    DATA: DATA (Non-Resident)
         7342488-7342495
 25                 2022-09-08 21:58:46  c90df404704fefdc5a8f1be1b4340b5f    3732cddbfb6ccfdfffda0375b8b34c88232ae59f af2e6cf63311ebb6cd16ab35384ebe986efd554aad581e7e8201534e7f966972 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.indexPostings
    DATA: DATA (Non-Resident)
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         7342480-7342487
 25                 2022-09-08 22:10:49  c4103f122d27677c9db144cae1394a66    1489f923c4dca729178b3e3233458550d8dddf29 96a296d224f285c67bee93c30f8a309157f0daa35dc5b87e410b78630a09cfc7 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.shadowIndexGroups
    DATA: DATA (Non-Resident)
         7341488-7341495
 25                 2022-09-08 22:10:49  03024f43cdd1c25630489b3055de4572    be69f43efca2ee1abb9d0914d7062e983bb78b4e 387033c34fb14b260ba3e070676825ae2e1b02d5bae0ba639afce6b099412e09 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.shadowIndexHead
    DATA: DATA (Non-Resident)
         43093112-43093119
 25                 2022-09-08 21:58:46  d2f6a4fd9f5a7b9618ea234f8df12ea7    5602729d6d309b267c562ce6c11cda3354f58092 16cccc34bb9cd9966cfe5b55976705421cd67cac9316c6aa5e5d8759165f1526 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/0.shadowIndexHead
    DATA: DATA (Non-Resident)
         7342496-7342503
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cab.created
 28                 2022-09-09 00:09:42  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Cab.modified
 25                 2022-09-08 21:58:45  52f7ac4bf92074028077df61d1db6826    6a0d493a72be8f9d7ce013afbd8c2742f9d44762 7350f72128cf80902b5bf02501d80fc9216b825cd10fecee2038269722d9a437 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-1.map.buckets
    DATA: DATA (Non-Resident)
         7341176-7341183
 25                 2022-09-08 21:58:45  04c0b5d3bebb9dec43f4bc705fa2c901    f2019a025db2d3cb142b4afda50af782fc463696 6ed29507f894ffc5a122c27829fdffe0261418c8dc4cc9febcac38a7b343b941 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-1.map.data
    DATA: DATA (Non-Resident)
         7341160-7341167
 25                 2022-09-09 00:09:53  160a021f3205fde79adcaae770c31c43    0a1e78e4acbbe62f7e2b6c994b7c5940456421cb bc80b11c44c62948cbe94382e7a58a1d2df5002e4235f1548b792f2641826f15 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-1.map.header
    DATA: DATA (Non-Resident)
         7340856-7340863
 25                 2022-09-08 21:58:45  f03f49d651468380cda969fc3c3a99b6    65c627fd2eefdb1470bb07eb303c1b3b3a8f14a9 28f7a442b806542a00a647f73cfa285821abd45422c065d1f1f3c09f839ce1b9 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-1.map.offsets
    DATA: DATA (Non-Resident)
         7341168-7341175
 25                 2022-09-08 22:02:24  02446bd8639cf9d243d4a628412f4392    15450949891f9f7ad94a9000e8eafe3cfd6522ee b60f99378079bb66fdad8e73b5692985baf6f3aa39b1a9fb02e15504631b6198 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.buckets
    DATA: DATA (Non-Resident)
         34985712-34985727
 25                 2022-09-08 22:01:11  0f6d5d503d0f1684c6c3f5f43033e43e    9a039bbaa65e0e43657319c73813e556c2381e6e 485a2eaa1353cd74ea987f69fc2341c2b25433f7c2da42581143c00a67990d93 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.buckets
    DATA: DATA (Non-Resident)
         12292128-12292143
 25                 2022-09-08 21:58:45  02446bd8639cf9d243d4a628412f4392    15450949891f9f7ad94a9000e8eafe3cfd6522ee b60f99378079bb66fdad8e73b5692985baf6f3aa39b1a9fb02e15504631b6198 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.buckets
    DATA: DATA (Non-Resident)
         34985712-34985727
 25                 2022-09-08 22:05:33  43164790061f026aa24382195640d651    34c7ea6d309edc0eaec3c41e1abf3bc4dbf1a7ad a5d0a23695bcfb748ff7ba7def1a206c0698e507bdc37095a7abcfbdf3fa57b1 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.data
    DATA: DATA (Non-Resident)
         7341184-7341191, 7342552-7342559, 8418768-8418775, 11216160-11216167, 14080400-14080407, 34985728-34985735, 40315336-40315343
 25                 2022-09-08 22:10:50  bdf75e8752c011ccfe0bf6f5188908d7    ed53207c8520ec026b04170e7907088503f37f3d 1d23bda45e6a027069d1eb4c51431c6d2fa7ee51bdb9ceab5bf37fe47112c850 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.header
    DATA: DATA (Non-Resident)
         7340864-7340871
 25                 2022-09-08 22:05:33  be9fd3f083f292292e5a2cb8049995cf    6c25da02c69f874d9121d376c32fbbcf4dcbdd34 c02775470ec1ac3a385c7eea4d67b319372cee48ba537c4f12d7b10d25079d5e Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-2.map.offsets
    DATA: DATA (Non-Resident)
         7341192-7341199, 40315328-40315335
 28                 2022-09-08 21:58:44  620f0b67a91f7f74151bc5be745b7110    1ceaf73df40e531df3bfb26b4fb7cd95fb7bff1d ad7facb2586fc6e966c004d7d1d16b024f5805ff7cb47c7a85dabd8b48892ca7 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-3.map.buckets
    DATA: DATA (Non-Resident)
        
 25                 2022-09-08 21:58:44  afe904447712c4f997a3e54cd9b3a4a7    004c42b0084414939640f17298387f9befa47866 f0c500e2401e1aee33d11ae25ae14e574820fbdb1731670af1888f88f3c17794 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-3.map.data
    DATA: DATA (Non-Resident)
         7342544-7342551
 25                 2022-09-08 21:58:44  c67d1dfe2d91f38ed0862b00a2671c42    466aa53adf13ef7f29086b0dae490ab6e31ba4c0 44da6f68bfe933da047cee98571eb180fbe51756ce5648088c42db455fa5ab30 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-3.map.header
    DATA: DATA (Non-Resident)
         7340872-7340879
 25                 2022-09-08 21:58:44  620f0b67a91f7f74151bc5be745b7110    1ceaf73df40e531df3bfb26b4fb7cd95fb7bff1d ad7facb2586fc6e966c004d7d1d16b024f5805ff7cb47c7a85dabd8b48892ca7 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-3.map.offsets
    DATA: DATA (Non-Resident)
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         7342536-7342543
 25                 2022-09-08 21:58:45  31ed29ba96327fe671dd9635266a43e0    7ac6f148639dddbbed8c555528f209c8d7f8a023 a25f16ec6f4380730253fba1652a0eaaccbed40be8d744c5d37748ccde66f718 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-4.map.buckets
    DATA: DATA (Non-Resident)
         7341776-7341783
 25                 2022-09-08 21:58:45  7fb065023cc00671d27540204982a747    db0d0a3799f88f68586c7d386714929fa6e57a8e fc9a4634034b21362f004cd9b1eb6949c88a5d25c6c165ed05eb82136eaecdf9 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-4.map.data
    DATA: DATA (Non-Resident)
         7341760-7341767
 25                 2022-09-08 22:10:50  edc974b57468b0728883597f36bbc390    4117c952c08df35c0d00c3b8b6a601e096433688 913dcfed82a39828b5f433834714de07a12fa68125237ddac50a9015d30d7ca4 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-4.map.header
    DATA: DATA (Non-Resident)
         7340880-7340887
 25                 2022-09-08 21:58:45  6e4854f142889c7ee174f25bafae1f7c    e4fadd8fd7ad2d94fd2b11f5b36c0942b2f7be8a 84da9ef8ab3564da811cd0c0647868efe260d3540aeba5b2fd7e0eb857cdefdb Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-4.map.offsets
    DATA: DATA (Non-Resident)
         7341768-7341775
 25                 2022-09-08 21:58:45  e037f4001795f81cb62246033a596cad    67ca018aaed6adc89e65cf7d95bd088d5fd0ecde 63c00a6b10f1bdbce9937acb484f2a9b0f4f6f48121462248f86eaeec20be563 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-5.map.buckets
    DATA: DATA (Non-Resident)
         7341800-7341807
 25                 2022-09-08 21:58:45  4a99c9df718acdf59fe4a3232bc135f9    5f7929ccf0e3a44ff1a922465b00e4f37371877c 09c43d9a07ddf5d20607ee4bc0207d81fdf0038f1778447f718d0e03a3b45e9e Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-5.map.data
    DATA: DATA (Non-Resident)
         7341784-7341791
 25                 2022-09-08 22:10:50  a209b2b6921631425d337b3ea80161d0    23bb6f6e58a0c783696d584f9e02fa049055990a 16949e2d254b1359678f63a7483a9dbca87e3a41dab5992c4a9027a1c3f711bf Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-5.map.header
    DATA: DATA (Non-Resident)
         7340888-7340895
 25                 2022-09-08 21:58:45  f95b964328d04de4330df914d271d912    436ef884796e0da715a34cb2b5777d54e6ba4971 8a8eeb21fb82ec965cec2a9488a1d3cb0c8e465a3e53a096b2a9674e18f77eaf Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/dbStr-5.map.offsets
    DATA: DATA (Non-Resident)
         7341792-7341799
 25                 2022-09-08 22:10:50  cdd79e88bcaeac04808dcddb731fecd7    0da6eb4e0dc6d2d806e0981f8cd6324bf30e9dd6 feac450efddc812be457d5bb2575b6896b255e978d6e84e03dd3a97aa532e1a0 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/indexState
    DATA: DATA (Non-Resident)
         7313520-7313527
 25                 2022-09-08 22:06:15  64712265762f3c6b4230f5241ed72148    520a0c24ca20c7396f01167c9b5b21867c873c8e 61ed546f41834a5d1a3db370772eb15b9bd4384a9f8d4c9e84356384666bc010 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journalAttr.1
    DATA: DATA (Non-Resident)
         7342576-7342583
 25                 2022-09-09 00:09:53  d8f3a9a3ddff1b219dc49acd90352089    e5a04c7a5f570e7d53372f36de66928a15c8f955 22776ddeea36a8f237c15d98e64c232b1be4e43a190f94630cd45cdaaabb4a49 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journalAttr.2
    DATA: DATA (Non-Resident)
         7340064-7340079
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/journalExclusion
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/Lion.created
 25                 2022-09-09 00:09:42  1818dac1b16adcdaf4b971bcacc7f018    83ccc3be78f5d0284ba16e04417a894cbbbbaeb9 5bb42d2f12ffb3e3ffed26deb1693c2b95ae096e8ec36c654358cc487a043e58 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.directoryStoreFile
    DATA: DATA (Non-Resident)
         7340720-7340847
 25                 2022-09-08 22:10:49  dde25d3d42da2e43852ca275da5f6cc3    49938ce067b5534699d5b5133db0c295800c410c 53a4183273e8c4901114cf83c637238b11b45dc9f50765cabcbf559ad3f454ad Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.directoryStoreFile.shadow
    DATA: DATA (Non-Resident)
         7341656-7341663
 25                 2022-09-09 00:09:42  8e381fe71c2ffc86c6f6e6563d66c5af    9ebd03fc2d66db531df8474990512ec22fda564e 7d6f7fae8849f3581c76eeef835b52ce3e7a516ba64cc2db96fdcb445c645d33 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexArrays
    DATA: DATA (Non-Resident)
         7340592-7340719, 43089320-43089575
 25                 2022-09-09 00:09:42  b788d18203297bc51d2bf25a91d0deb5    46b3fd6ca210085ac2e97b62706aa8e251aeebb0 ccd8654a722d11146a7306372651e6da7f42f99eb884235e9e4608a535d23bd6 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexBigDates
    DATA: DATA (Non-Resident)
         7340504-7340535
 25                 2022-09-09 00:09:42  fc197aa19e17dbd16804f4f328504dad    f597b49edfc9d7e141d2fb36a22f2519ef85b31f 63687f85d261c8b8824b61727fc86b2e63c26ecc30b0667a468af8ff559a7c8c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexCompactDirectory
    DATA: DATA (Non-Resident)
         7341256-7341263
 25                 2022-09-09 00:09:42  30584cfd20e57509a9f7bef35fac93ea    c65ed28462ae81e2aaf7772214b928b32d0ff9a4 38bc588b861b4003f46154e13c0a10bd11bb59a3d67775a3e3dbea7a260c3f9f Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexDirectory
    DATA: DATA (Non-Resident)
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         7340568-7340591
 25                 2022-09-09 00:09:42  88a5672b67fea934af10b134b9068a88    094ea41285b6aad97e75e741d1b43ccb23e8366a f6fdd54763b655cafd6519907b63ab0cde64b558422df899850c9597d407b9aa Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexGroups
    DATA: DATA (Non-Resident)
         7342592-7342599
 25                 2022-09-09 00:09:43  734acfe747c61281af75f3d309ec98c4    79045bdcaaf98464eb2812a77c75a49f0ff0a4fa f71854fc8d9c5e3ec4a95299c7cfe4e5b8fb505bbfb36bf845f737b019daad67 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexHead
    DATA: DATA (Non-Resident)
         7341264-7341271
 25                 2022-09-09 00:09:42  b1984f18d595f76efdec299dae5d9e46    1bb298d3e9da4d91244155ca80cde3758d7c8758 09137c6c36fe757854ab73610e407e8adcd2cabcf3a50ca4110c75d540a0a4c2 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexIds
    DATA: DATA (Non-Resident)
         7340440-7340503
 25                 2022-09-09 00:09:42  374fa3390ab89c531994ca5b1f71b901    4efc01876f514fcefe1510dc6f22b17a87912c3c fce3ff86763f8404ccf1df7e8759f4e6d0a8e07f78e2277eb6022203ef8353c5 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexPositions
    DATA: DATA (Non-Resident)
         43092864-43092871, 43090824-43092863
 25                 2022-09-09 00:09:42  940ec92fa2c7e996fb44b9b15a1567e3    d41463ceee230a643248473bb10451cc7272970c 643da5e39ffc91977089e4e38de26cdab547e37eefafa5fe085b991b5b204174 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexPositionTable
    DATA: DATA (Non-Resident)
         7340552-7340567, 43090072-43090567
 25                 2022-09-09 00:09:42  df9ed984babccad049b5e7f7c09add07    c1d623a0c3e7f5d5445798101ba2133a32279020 b9c8864f0f715aa396f5df7a77e63519d8dfbfd8bb90273edcbff3354eb33bdc Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexPostings
    DATA: DATA (Non-Resident)
         43090816-43090823, 43090568-43090815
 25                 2022-09-09 00:09:42  cc9edfd3f936ae6ed6d779d48896eef1    ccf4740bdd7755e331348db6d06db1af2072c587 05d90e65bc8a512d0310ce67cbcb7b940712d8db4180c81ed765af128102a78c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexTermIds
    DATA: DATA (Non-Resident)
         7340536-7340551, 43089576-43090071
 28                 2022-09-08 22:10:50  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexUpdates
 25                 2022-09-08 22:10:49  b80954bd4df2155c1de50d94d6a8c363    49eb0b54f95b36103b841c00ba9e53e11f8e914d 9048b6663acb4b9afda879c1dc6091bc8be2975c300d70d8c7864e998c1278aa Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexUpdates
    DATA: DATA (Non-Resident)
         43092872-43092879
 28                 2022-09-08 21:58:45  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.indexUpdates
 25                 2022-09-08 22:10:49  8e381fe71c2ffc86c6f6e6563d66c5af    9ebd03fc2d66db531df8474990512ec22fda564e 7d6f7fae8849f3581c76eeef835b52ce3e7a516ba64cc2db96fdcb445c645d33 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexArrays
    DATA: DATA (Non-Resident)
         7341520-7341655, 43093912-43094159
 25                 2022-09-08 22:10:49  7d2d5fca80364273fb07d5820a76fef4    ef4862c8fb031cd58eba3b882589e445c7e1f0e2 35be322d094f9d154a8aba4733b8497f180353bd7ae7b0a15f90b586b549f28b Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexCompactDirectory
    DATA: DATA (Non-Resident)
         43093896-43093903
 25                 2022-09-08 21:58:45  69c1753bd5f81501d95132d08af04464    b0aa4b549f325cca9c9dfa6ce1bd6072aeaeac71 d86e8112f3c4c4442126f8e9f44f16867da487f29052bf91b810457db34209a4 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexCompactDirectory
    DATA: DATA (Non-Resident)
         7341848-7341855
 25                 2022-09-08 22:10:49  f226ecc8234e23c3d02633c5e525e43e    a34536ec4de4def295a71252e2d430abed2f9707 55b86f9778754a9a5f05740bd9ee9d08333df48f432af62952b4eeadc9db01af Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexDirectory
    DATA: DATA (Non-Resident)
         43093904-43093911
 25                 2022-09-08 21:58:45  d27aea7f3368cbf32422a92d0f172b5d    d182ac1ee4a46102fd0bed401d40152e8f1b7e3d f80817ae1293ef180a275f03e1a5de579d9e8fa4016dd08c142066e0775bace6 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexDirectory
    DATA: DATA (Non-Resident)
         7341856-7341863
 25                 2022-09-08 22:10:49  5f43fb76c6ad814e59f1daac8a9fc858    90677f86d454d9682889c6f073541a616f957c42 ada929c19b3a7891102c65c757b1bd0dac28eef28aae988340ee1cb9d66241cd Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexGroups
    DATA: DATA (Non-Resident)
         7341664-7341671
 25                 2022-09-08 22:10:49  9a9d53f24a94ff976e9e9dedbe7010ff    0343cbbf3f14a94fa374f8477837e044ee775e02 dfc43e773062ab15daf488608f437736d95bfb7c51f1950b37d4b78142219d7b Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexHead
    DATA: DATA (Non-Resident)
         43093120-43093127
 25                 2022-09-08 21:58:45  04473ed15016a707f941eb37dd4dfb89    4e5e43b277ce9610ee2ab31e2ca668e5935ee6c4 60cf1cb3c95e7d9ebe551e36014b09aff1bec61afe7959e38f10e29f3714a870 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexHead
    DATA: DATA (Non-Resident)
         7341840-7341847
 25                 2022-09-08 22:10:49  f55f63cd645c398758dbeadd219f6757    a5ba0d225d53ad29c9ee16f13ef6accf24b64952 18d9db8c52678d1ffd290ec4b8abfba9029c3466492d4a06c6a3637a8d1902a8 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexPositionTable
    DATA: DATA (Non-Resident)
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         43093512-43093775
 25                 2022-09-08 22:10:49  1ba9604adf198eaf1cbe60b8e5970913    7a7a3b2a6ca8005dfd40652df02148decef8803c 6d7f7ad088132d15478a26ea627ef15d579b4f35cabd214c13883a9459e607ba Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/live.0.shadowIndexTermIds
    DATA: DATA (Non-Resident)
         43093128-43093391
 25                 2022-09-09 00:09:42  342dbe0685b41e0d3f88fa168762bb94    597622ae1267d0d13aa482a89a1dea2f82fffd89 06f4d8cad86b14c72623fadc5433587078e720a2e7f44f0000a3cc24b7bd9990 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/reverseDirectoryStore
    DATA: DATA (Non-Resident)
         7340968-7341095
 25                 2022-09-08 22:10:49  22258f2dd8b18798cc871e8ec82f4e4a    b7a698d72b3b9e7a48f8814ae26b03940dc80781 a9cf43cd365831b7ef061ac009dd35bbc8150eaaf809243f44f5822d677037a3 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/reverseDirectoryStore.shadow
    DATA: DATA (Non-Resident)
         7341312-7341319, 43093104-43093111
 25                 2022-09-08 22:10:50  25daad3d9e60b45043a70c4ab7d3b1c6    0e356ba505631fbf715758bed27d503f8b260e3a 47dc540c94ceb704a23875c11273e16bb0b8a87aed84de911f2133568115f254 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/reverseStore.updates
    DATA: DATA (Non-Resident)
         43094304-43094311
 25                 2022-09-08 21:58:45  25daad3d9e60b45043a70c4ab7d3b1c6    0e356ba505631fbf715758bed27d503f8b260e3a 47dc540c94ceb704a23875c11273e16bb0b8a87aed84de911f2133568115f254 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/reverseStore.updates
    DATA: DATA (Non-Resident)
         7341880-7341887
 25                 2022-09-08 22:46:03  38539fe36a3b769e583f408651ef0690    a881eb4d6bfa7b0167a37b0950a8555f8999dd29 b84a3fc40df4a7db3241b43f2668c4ee1bfaaec17811bcba06145954e2ab030d Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/shutdown_time
    DATA: DATA (Non-Resident)
         43094328-43094335
 25                 2022-09-08 22:16:49  a404b479659fec858c4c83ee2dae5af5    6368c4503aaa33c733a3264a18117426f8f4993b 7e32a2248e0a5579b7af717d5a549fcdde038b63e18d782d84a4c8111fffc6ff Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/shutdown_time
    DATA: DATA (Non-Resident)
         43094312-43094319
 25                 2022-09-08 22:10:49  aeab4da419d2d7d9557a767b69636af5    a8e7a9e808c02a87c8b9f6534d5c4305b8020ef5 9adb6a846ee1353c9183f2e418b3b708b710a5c04986fdec1ed50b6f90cd983c Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/shutdown_time
    DATA: DATA (Non-Resident)
         43092896-43092903
 25                 2022-09-08 21:58:46  36927412bd722b23be608823fd0808df    2aabc3cc0dd9f588bbec768dcdd3547aa9859eb8 d1f40624db278945d3c5b4a07b243c1447cca1244e4c4fb1b635f9fd659062b3 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/shutdown_time
    DATA: DATA (Non-Resident)
         7341888-7341895
 25                 2022-09-08 22:10:50  544f270df3499abdcb1fb81d6222fe67    111073a90e6497e7c4b7d0dc5375636026e5333d 3b04e82d76ff2e04387a476869066c11ffa55ea4d73ee9af9d7123cc7d7f0abc Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/store.db
    DATA: DATA (Non-Resident)
         7340848-7340855, 7340936-7340967, 7341280-7341311, 43093040-43093103
 25                 2022-09-08 22:10:50  30a771fb83c2f5000a74d41689f19c76    9508e90548b0440a4a61e5743b76c1e309b23b7f fb50dc0717ff266cf9baf82b1ce7a1c2ef6d9247859680b11a19fb7077f5f222 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/store.updates
    DATA: DATA (Non-Resident)
         43094296-43094303
 25                 2022-09-08 21:58:45  30a771fb83c2f5000a74d41689f19c76    9508e90548b0440a4a61e5743b76c1e309b23b7f fb50dc0717ff266cf9baf82b1ce7a1c2ef6d9247859680b11a19fb7077f5f222 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/store.updates
    DATA: DATA (Non-Resident)
         7341872-7341879
 25                 2022-09-08 21:58:44  f2dd0dedb2c260419ece4a9e03b2e828    0aaf76f425c6e0f43a36197de768e67d9e035abb 26b25d457597a7b0463f9620f666dd10aa2c4373a505967c7c8d70922a2d6ece Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/store_generation
    DATA: DATA (Non-Resident)
         7341104-7341111
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.Cab
 28                 2022-09-08 22:10:49  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.journals.live_system.retire.1
 28                 2022-09-08 22:10:49  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.journals.live_user.retire.393
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.Lion
 25                 2022-09-08 22:10:49  414e154032380933dd36ca56a217ead0    a78f9e6d47552bce08e0f658c57bb44e70931e93 a8651e1c88f86f43872da900324eff9dbbf3a9c775cca0fea665731cccb18ca8 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.loc
    DATA: DATA (Non-Resident)
         43092968-43093031
 25                 2022-09-08 21:58:45  8096b00ef112413d9b90dbfb056fcbae    2fdce95f63936f5b13e9d640da58ed60ab656458 aea3529e20b0eb0cbc7198ba0a8f8552dca40bac2766d97ed4149686c3b11f79 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.loc
    DATA: DATA (Non-Resident)
         7341808-7341815
 25                 2022-09-09 00:09:52  8fdd6a6bbc1a5aedcea2b12ba7ed679c    018fd309d0e8997809dfa8920b1865f324afa2e9 4110d25a2a2a8547f6432a82c8325c624070fc6ac0981b4c1a8549072c7d37e8 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.state
    DATA: DATA (Non-Resident)
         7340080-7340087
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 25                 2022-09-09 00:09:43  174c2f4a5b32d2ea3c0c9b3be912db77    fcab60f65f68e22b7f326a99b3efb6a2ef2ea947 6af95d12f9be79c103f95b17aa2d902fdd551326498f421bca7a6e44f5ce62ca Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.state
    DATA: DATA (Non-Resident)
         7340056-7340063
 25                 2022-09-08 22:10:49  d49cbad07db828dd49e66c2e61fc323b    2f0f81062f9cf359dd492f4b9dceedf7b312f343 153100a03e8c57620d987d27da74fdfcc56c22f18888f0615a1d471ff538f3b5 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.state
    DATA: DATA (Non-Resident)
         43093032-43093039
 25                 2022-09-08 22:10:49  dd69f94854aac0364ad0eeb2b556ffc2    be517add7afba6acf11a739ea53da404ff7fe9ff 7772b444db65c12f95e8fe3a912d6287394d4bab92db6e81c4320d6f8fcf7b72 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.state
    DATA: DATA (Non-Resident)
         43094288-43094295
 25                 2022-09-08 22:00:30  d35452777ea04b7c05777caff473771f    b86f1291602c6db6fc0f29a1b9ea96344c6096ad ec81f3e2ea734ab8d49795dd98fce20ad2d7fd14c1acec6cb08889b4ccc1299e Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.spotlight.state
    DATA: DATA (Non-Resident)
         8418760-8418767
 28                 2022-09-08 21:58:44  d41d8cd98f00b204e9800998ecf8427e    da39a3ee5e6b4b0d3255bfef95601890afd80709 e3b0c44298fc1c149afbf4c8996fb92427ae41e4649b934ca495991b7852b855 Root/.Spotlight-V100/Store-V2/3FCDA7BE-A427-4EB1-A387-7879ABD9AEBC/tmp.Star
 25                 2022-09-09 00:09:42  3bff3605f109fae4cd07e26dcc68cc41    29d4a8b8e612c52fedec3737a072aab9cc85bb00 0849c8e1995bcd39e900d5e90bc0d2a4c6855adeee38d33d88de050409237a17 Root/.Spotlight-V100/VolumeConfiguration.plist
    DATA: DATA (Non-Resident)
         7340040-7340055
 25                 2022-09-08 21:58:44  ac8b6b78551823f4f648b850dc6c4a64    2bddfba2b2174823971b0a316f9d704b2b9e6106 dc3a1182c6be7c4ed2c70766a983ce032c4c832bf20e5bd9a4c0d83f34d48e24 Root/.Spotlight-V100/VolumeConfiguration.plist
    DATA: DATA (Non-Resident)
         7341112-7341127
 28                 2022-03-03 22:07:11  Root/Documents
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Calc-files
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Calc-files/ods-files
 25                 2020-04-07 02:21:52  b1eb4cc9101bcb86c0042231f898f0ae    8e5da7978ebe26604b5f556ec2d20a4ce1176ff1 4d226d7f3c0e1c874f0aaf772f9a5cf9bed2c7d982906a4a0314c206cbc4bb35 Root/Documents/OpenOffice-files/Calc-files/ods-files/.DS_Store
    DATA: DATA (Non-Resident)
         7441648-7441663
 25                 2020-04-07 02:18:30  eab006354c7cf4e1fd3772afd0643672    bfc7b3368a46a640c3145646b0dfad10bb89f096 4709af13b6dbaf11feab0750bc2a3734eab9a94e184bd7f736805adcb02ac368 Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_10.ods
    DATA: DATA (Non-Resident)
         7441616-7441647
 25                 2020-04-07 02:20:50  94790aeb545e806ea9cf161f6ae2697f    152a13f940c2dfa4530b1b022897cb3dbd0cb45b edb79e7965f6b61722f1c6427200e4ba44692e573b2f2f8cd210f356aed7f3c9 Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_1000.ods
    DATA: DATA (Non-Resident)
         7441696-7441799
 25                 2020-04-07 02:19:48  000389561d71032e79411613d73f01f5    3e9fdd1b26eed17f40e98a0f8d13af11decdf951 b668e04c130d51d023531482c8067b5232284decdf54760c6ae431e3718388c3 Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_50.ods
    DATA: DATA (Non-Resident)
         7441664-7441695
 25                 2020-04-07 02:21:44  28aa35b07f4a28f4f001e28f277dd1be    f9dfcafc3e9b6c1c15a949ab9150b8e7d599f1d6 069ad480df6dba6de101188dc126f688127206932d98f02149eb390b6e8f2928 Root/Documents/OpenOffice-files/Calc-files/ods-files/file_example_ods_5000.ods
    DATA: DATA (Non-Resident)
         7441800-7442175
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Calc-files/oxlsx-files
 25                 2020-04-07 02:31:06  c763a032a1999d42934abebc25fc6a83    07c1d02aa03ae7768dfb88445bff68e9c32c2264 208fef9240237b668cbb927255a8f204e6ab808a68701ffe72bf3ca85e4d13e1 Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/.DS_Store
    DATA: DATA (Non-Resident)
         7441168-7441183
 25                 2020-04-07 02:25:50  f893b7290b96905f0776e0e1cb4b91c4    d80a4175a6a2767b61fe8e2b33774bd211b6a934 ab82e943104f1edfa17b58595b4221c02ddf93aa4056fa630473de192f85d1fe Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_10.xlsx
    DATA: DATA (Non-Resident)
         7441600-7441615
 25                 2020-04-07 02:30:28  be99eeaa2e2aa77ecb4d7b9eeff44cb4    1aad45945f99a02383e168e339a20d38999491b6 cd6583c0aa16dde7342c4dc5483987edf173d7378ce946ded7383bbf4b5990ba Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_100.xlsx
    DATA: DATA (Non-Resident)
         7441184-7441207
 25                 2020-04-07 02:30:10  2280cba8bea0ded6bf9c428939f9cb32    4aee4fe0add47392f508fef28af3f5c02a9eb4a2 59da4d0e97a54c462fcf34268b14a4214ef324da368712a0a32678c976e89484 Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_50.xlsx
    DATA: DATA (Non-Resident)
         7441584-7441599
 25                 2020-04-07 02:30:42  980e7a175ea67333379753a788d331e5    c90c1841006b8da26e69636596c7a8e5fcc26ec6 0d66f10f1b76f620d69e4054eeab6669f2e64b0b2fa5e3365101027aa5b657e7 Root/Documents/OpenOffice-files/Calc-files/oxlsx-files/file_example_OXLSX_5000.xlsx
    DATA: DATA (Non-Resident)
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         7441208-7441583
 25                 2020-04-07 02:23:14  db42bc048678d194bda93124fcc1e359    9f7137c6703b51cd78a797b56b5f2a2e7c8b83ea 433476459c23ba979ab467ce4c310e29a40e3b9a8d68dd63467b503ddc4cdf23 Root/Documents/OpenOffice-files/Calc-files/.DS_Store
    DATA: DATA (Non-Resident)
         7441152-7441167
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files/Excel-files
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files
 25                 2020-04-07 02:13:48  7901a6038143aa293bff65c1dcc564a9    13c30d142999708f8b0f3b71bce35c1c91304032 ad75eff3191cbb4e3215b25ce1733f062f474ff6aa242db82de391eada0f114e Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/.DS_Store
    DATA: DATA (Non-Resident)
         7431480-7431495
 25                 2018-10-19 21:12:18  01a42d82b4e2e143876cc0afea4883ed    3cc9264c3a5569c08abfb9ee343dba1bf96f1b3d be198ae04df0476e6a8153e4b396da05c9badef729f87f1abbb626f8bfae8491 Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/file_example_XLS_10.xls
    DATA: DATA (Non-Resident)
         7432936-7432975
 25                 2018-10-19 21:14:00  efcb6e746de385a6ba15f9e697503f4c    96451e09d24aacaab7c00292316020ecd8090dbf 8562df19f14cb945b769a0812fb1afd5acd9e349f0cdd71150282202d71319ee Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/file_example_XLS_100.xls
    DATA: DATA (Non-Resident)
         7431496-7431567
 25                 2018-10-19 21:14:56  f9773bf0bd611c8a9107140956b3881f    7a538e2ca18bb7cb0c2fb0130767012f7acd9019 d3107cae4af0231540887be840135ec03763d83926c2900fb76aead0226787ca Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/file_example_XLS_1000.xls
    DATA: DATA (Non-Resident)
         7432976-7433279
 25                 2018-10-19 21:13:24  b3df6dd6764416491f51415c4ccf1aaf    eea1bebb11f6beab8f38bc2b1705dbf598bcbfa6 a7beba6217ffa60c9e79f0310d024a74cbaf363d7b884d214178e413e758b68e Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/file_example_XLS_50.xls
    DATA: DATA (Non-Resident)
         7431424-7431479
 25                 2018-10-19 21:15:24  ecb548b885ec5cf6f6e38ece80fa5f2e    5ddffe520563c9b9c26a7c297c99b2e896e891d0 bc8d33d7033eb858dd63ae4882d4381fb9fe85c0740fd41efb9a309fca9e366f Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xls-files/file_example_XLS_5000.xls
    DATA: DATA (Non-Resident)
         7431568-7432935
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files
 25                 2020-04-07 02:16:34  8f9765363a3610383bbafb7ed7e8928c    075e8f3a721f3d733c20e897c3e9db0c907322b7 9320252c62acfa865ebd315c1597d767f9ebc16ea410bff7e3d2e479bdcde088 Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/.DS_Store
    DATA: DATA (Non-Resident)
         7430744-7430759
 25                 2018-10-19 21:16:16  bd5ec17de931c601b3231fdb4eac6db6    2a647da6430913fa47cfd7874721f0832bb91f52 584bd2879378c518796f4422f8ed41c971798e76c5ee58c307fc3d40adb03eaa Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/file_example_XLSX_10.xlsx
    DATA: DATA (Non-Resident)
         7431288-7431311
 25                 2018-10-19 21:17:58  43cb8b1c3ede97eaeb779d0bc7d03710    41360a2a5d2f8a2aaacd2ae503ea754fc33d93f4 97e004974d26f04bf7bf960d5b4e33f2f59a81d79e95526804f5b570f819eacb Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/file_example_XLSX_100.xlsx
    DATA: DATA (Non-Resident)
         7431256-7431287
 25                 2018-10-19 21:18:46  513e4fac7ff88720001864d1a350ed1c    87e9c39ea24c1949cca6f68ff42cdb8208c32a13 14fed5fcf63206d7f5bd275058b7d79184ce187b062fcdab5d9ff77b4ea19502 Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/file_example_XLSX_1000.xlsx
    DATA: DATA (Non-Resident)
         7431312-7431423
 25                 2018-10-19 21:16:44  775654d96ef34c95ce1a60e9606977e9    1954ba25e67edc407955203d21aeb8c3a99d272f e40aeadfebe57e3be87ac46260ad09ec1c4c030b95eef2af767382d0fe79198a Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/file_example_XLSX_50.xlsx
    DATA: DATA (Non-Resident)
         7430760-7430783
 25                 2018-10-19 21:19:10  ea38c0c454aa508b5909161bd8260918    e566e8c34a723ad44431cc3f0fdbf3bce18410e5 acbd5c728f2738a70f59c245c961eb8122d59aa07b7debdc7d348efe472b650b Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/xlsx-files/file_example_XLSX_5000.xlsx
    DATA: DATA (Non-Resident)
         7430784-7431255
 25                 2020-04-07 02:31:14  52d71be9d0971685678823c546b72eff    1930f5ed939a35965802a508afb3865810e7e0af 8ffc5293b616b558264fdb2277fb6a8d032ebecaf6b678b491ddcfdef1a3f9f2 Root/Documents/OpenOffice-files/Microsoft-files/Excel-files/.DS_Store
    DATA: DATA (Non-Resident)
         7430720-7430743
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files/Word-files
 28                 2022-03-03 22:07:13  Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files
 25                 2020-04-07 02:12:42  34b20ad44b5d33cc3401b0ca1c9c55ad    236a6271d535ea5149eca9fe73e939900968c019 9cc166b17367418d3af128bd74ae79c7b0a20c0a1fd19c4d458c1834897905db Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/.DS_Store
    DATA: DATA (Non-Resident)
         7422312-7422327
 25                 2018-10-19 21:10:24  759cbcd3d7c574ec4de97222bc407665    1308c158c06c9050ffa3f0f5898a5ccf4a94c8c7 3fbfda0b36c4edc4b4d48ec5c0425ced04ed15c6e3891495201a7289533a2ce2 Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/DOCFile_500kb.doc
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    DATA: DATA (Non-Resident)
         7423312-7424319
 25                 2018-10-19 21:20:26  35176f9b7f521954445100e5df74dee9    5aee31c3f490b421e75548ea713a6755818980db f907aadb6b9b38c8e19eaf44aa11796051eeac35d0d2115246449da98f1137f7 Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-doc_100kB.doc
    DATA: DATA (Non-Resident)
         7424320-7424527
 25                 2018-10-19 21:20:00  bb8c0ad499fc64837a45154a27e07734    1e09acf84e23e9eddb152f812354785e2f7cd159 2bcd9c011678a8aa7045a6485bef7872c4295fbb6c2467cc29135ffcc769457b Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-doc_1MB.doc
    DATA: DATA (Non-Resident)
         7424528-7426543
 25                 2018-10-19 21:21:18  e16fb51cef336edf2c19d065ef49a662    15bfff84aea3602cd0ec81bd7ac9789a969c3528 41f65cf10d9b0b42d12307a46b66ae632e6d883e067db5959969822780823d7a Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Doc-files/file-sample-doc_500kB.doc
    DATA: DATA (Non-Resident)
         7422328-7423311
 28                 2022-03-03 22:07:14  Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files
 25                 2020-04-07 02:12:42  0717f9af8c983c9af7d5fb9d311ab163    0ce1f83b661658d58caee54b75ede278a30e0927 359246310af6c9ff8c7192b637ae949a8c388f1c9b684d46c1ea013d4fcafffb Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/.DS_Store
    DATA: DATA (Non-Resident)
         7426792-7426807
 25                 2018-10-19 21:11:20  96d043aabc6bdad1046db4c47aa7a3a8    7705c94a188ecebd1be2f68f70687b1ef7360d21 9383ce8098236174683cefab77cbddfe8cc17d8656b4e87281e783ce55b76d52 Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/DOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         7428896-7429583
 25                 2018-10-19 21:22:34  0815c2eb26ab3ad59fab1ccba9d18fd0    20898f28011ae05f5062e09690b292ed13fbbf20 acd7fe4a7ee20c77b48489be5b9dbad8a850a2b29af721c912f6993e238b5471 Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-docx_100kB.docx
    DATA: DATA (Non-Resident)
         7426544-7426791
 25                 2018-10-19 21:21:56  9a1485d3bca8dd88cb67f248c0144d0b    0dcff5af4a39b3d57e964ead8a004636c3a276f4 98983b17e3562d015ac1c1a6f9d9971090303c04d0d70d6729416d376385eb2b Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-docx_1MB.docx
    DATA: DATA (Non-Resident)
         7426808-7428895
 25                 2018-10-19 21:23:10  183a5dc1a099e3c8c0b54c6aa52d64b7    1266501c54bdea72f239925138a61a62a9f8b2ba ff010e8d024e80c14901ea9ac618f253862667e7a69f69b070002cbc74df9f58 Root/Documents/OpenOffice-files/Microsoft-files/Word-files/Docx-files/file-sample-docx_500kB.docx
    DATA: DATA (Non-Resident)
         7429584-7430719
 25                 2020-04-07 02:44:02  8b1836fc208a9ab78cb95bc0d00b6256    c6f205d3920442756681d4bc1c3091dae0b69466 5dba5fad9c2bf25ea40190fb34594641a66e44d4fd40a7cabf9ea11862e6246a Root/Documents/OpenOffice-files/Microsoft-files/Word-files/.DS_Store
    DATA: DATA (Non-Resident)
         7422296-7422311
 25                 2020-04-07 02:44:32  b6e071bf10615607b95d544a2022d187    199662a8e3916924b81b13ac8ae705f3c581cec9 c988d303b52f36214ce9464a07df2dbf114b6820971eddd987668e89bb0167a6 Root/Documents/OpenOffice-files/Microsoft-files/.DS_Store
    DATA: DATA (Non-Resident)
         7422280-7422295
 28                 2022-03-03 22:07:14  Root/Documents/OpenOffice-files/Writer-files
 28                 2022-03-03 22:07:14  Root/Documents/OpenOffice-files/Writer-files/odocx-files
 25                 2020-04-07 02:33:22  70b4b7f69342042902032114b234fa03    79bfe4ccde5838e150a0f236b9c7478104b9cd09 2dd6ea9aef467ef368f7024e22ae3ea03d3e4f73949c0e1ee7cb055779c596a7 Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-odocx_100kB.docx
    DATA: DATA (Non-Resident)
         7438216-7438359
 25                 2020-04-07 02:36:02  e579cd58b1ac23749e4251835bc0f610    e8d59c3b4ea9f4c08c4e59031736a578d728dff6 1c0f9edf45a390e0d279a1d10da038e374b515cef3e5c077c8bae99e3dd4a5cc Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-odocx_1MB.docx
    DATA: DATA (Non-Resident)
         7439232-7441135
 25                 2020-04-07 02:36:58  0a64c077c83153e159aa45906220ff3e    ca27738f86b01900b3b94e19bd99003fb47a5c80 05100d4633bff3a8809b8b075ecbb7e9dd22f94148307faabad972ee8c8307d7 Root/Documents/OpenOffice-files/Writer-files/odocx-files/file-sample-odocx_500kB.docx
    DATA: DATA (Non-Resident)
         7437312-7438215
 25                 2020-04-07 02:34:46  f1dbf4f7ad95d39ccc0f877d9b887afa    c6b1149ecbd1303d75868e19643e61c60a822808 fb723512f7f3f166cb0013f3160d98b648719f08bc6dcde7db5043277cb1ca85 Root/Documents/OpenOffice-files/Writer-files/odocx-files/ODOCXFile_500kb.docx
    DATA: DATA (Non-Resident)
         7438360-7439231
 28                 2022-03-03 22:07:14  Root/Documents/OpenOffice-files/Writer-files/odt-files
 25                 2020-04-07 02:43:34  d4c494a030d81983196866482a5597fe    46aa85342a8d01ae27ea91965ce088813a4410ed 8fcb878c093e2f4652b632bb347b3f69db28ece431801b9651b3809b47ff16e4 Root/Documents/OpenOffice-files/Writer-files/odt-files/.DS_Store
    DATA: DATA (Non-Resident)
         7433296-7433311
 25                 2020-04-07 02:40:22  c3e2b9d976977ec25d6347ed02673120    c913470ca428305f83c37c34a17cdf79903a3248 455b56ea7a3bd759f917b8e3a3d16b567f10ada93c8202ddee8945db150bf810 Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_100kB.odt
    DATA: DATA (Non-Resident)
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         7436544-7436791
 25                 2020-04-07 02:42:34  5f1e8dfdac3fc3133511a75f26001854    7a26c32e318fa96d08c4515122c197e7bf7397ba 23a5d871d288d0b5bd3a65747e2dc6bba4689a9c67ccf8e609e8d8ce9af74336 Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_1MB.odt
    DATA: DATA (Non-Resident)
         7433312-7435407
 25                 2020-04-07 02:41:24  324dd4fe1e621090a5dfe7e0c7680050    c070a68cce81d1058838a5438a91c3a6bff11fa5 de09f89e254cc5ecc388ba278cf2f224067e9fbc9c64ae3009adf565fcc798c6 Root/Documents/OpenOffice-files/Writer-files/odt-files/file-sample-odt_500kB.odt
    DATA: DATA (Non-Resident)
         7435408-7436543
 25                 2020-04-07 02:43:30  b45be240cb18dda2cd78caee72891837    06bb21bd6ffd5eae59034e4cf9533076ccb68bb5 ed39112cdf37ddc805e39b9edb033fd97dcce179831c1392a2a59e46f85a0796 Root/Documents/OpenOffice-files/Writer-files/odt-files/ODTFile_500kb.odt
    DATA: DATA (Non-Resident)
         7436792-7437311
 25                 2020-04-07 02:37:14  14a0ca21163393f57c739e278f95dfde    cc80e712df7b497601fb5ab86c23f4d6ebd8db0c b4c09d792b41a04e369df0ccdd202eba89a11c9f1530a62be60183379cd85335 Root/Documents/OpenOffice-files/Writer-files/.DS_Store
    DATA: DATA (Non-Resident)
         7433280-7433295
 25                 2020-04-07 02:35:00  229601a0b29ad34773e4891161a14e2b    e0a791be31e35348bac1d6840e27e8e47c730f98 2c6a0a942b9466457708117adfecb2408b24b214cd595fd00a850a8cca2a8d26 Root/Documents/OpenOffice-files/.DS_Store
    DATA: DATA (Non-Resident)
         7441136-7441151
 28                 2022-03-03 22:07:14  Root/Documents/pdf
 25                 2018-10-19 21:31:10  cafaa4fe6206c58f5dec13c3ea9d0371    7ed087345df3071191fbb455470a4ae8e4b423e7 2a42cd96488ebc2e8fd807008726dee7ab1709c007fa9abe8affbc5843591bb0 Root/Documents/pdf/file-sample-pdf_100kB.pdf
    DATA: DATA (Non-Resident)
         7413144-7413663
 25                 2018-10-19 21:28:32  f75c9215162661abdd9cd1aa11d792e6    06dcbad6d7184b39925fb0a19f55b4a9ce3f297b 0da983da280865ec4ef11497f7ae9a3322d36b88a12b419e90109774ae50d40f Root/Documents/pdf/file-sample-pdf_1MB.pdf
    DATA: DATA (Non-Resident)
         7413664-7416031
 25                 2018-10-19 21:30:08  23d2d7627d3edbc66586726cbd4225b1    34d580da967fbc3ba1bc54e59da11b7183afffb6 0dce6c42b677f621d5f8ac8abbfad0ed7d69e7e18e1f328c9276453e2b57680b Root/Documents/pdf/file-sample-pdf_500kB.pdf
    DATA: DATA (Non-Resident)
         7381832-7383247
 25                 2018-10-19 22:05:42  2cea8c95dc5f5db6065f704068292867    6628857689d03f6e0b52cdaef20c9be4f17d0f79 5e147079d557fe26de3dbdf0c5c7aab4ac18ec13d4e31bea320d1167475dae0c Root/Documents/pdf/large_pdf.pdf
    DATA: DATA (Non-Resident)
         7383248-7413143
 25                 2018-10-19 21:49:28  4bfa34445fe5e92cee0d4be1c4b6afbd    4c166dd5ad455053664bb095fbed5238f5a17a68 1284a8bd83fa65802aa0ee0d7ca77a008c6db18cbd288f1b1f1319aae703fa4a Root/Documents/pdf/PDFFile_500kb.pdf
    DATA: DATA (Non-Resident)
         7379240-7381831
 25                 2018-06-22 21:08:58  b05a97e064cc54b99daba53bde958d58    31249aec7b1e9dd55828b296f3626c5654071860 b0e8e10fc34b366dfa1709719cd737745581fb277a82509a60518cb5e6c8ddfc Root/Documents/easychair.docx
    DATA: DATA (Non-Resident)
         7347048-7351519
 25                 2013-06-26 19:00:34  0a4ffa384ae31d33a801acc0e1746e65    f09aedad237560fe3fc2d255d39520923cab91f2 6387b9576f369e587e7c810df976b29ededf8c4f7e3f1d6662b7ccd78dc4a521 Root/Documents/Mac_mini_Early2009_UG.pdf
    DATA: DATA (Non-Resident)
         7416032-7422279
 25                 2013-06-26 18:58:10  12ab314eb73a4a938bed3d6550da0ff2    22b0141246f4f5c7cf20171645c0f8de596cb35a eada5fecc16cb98c28c54b080319ff79eb20b62a313ed4b6ba5c254a4a3ede7e Root/Documents/Mac_mini_Intel-based_Mid2007_UserGuide.pdf
    DATA: DATA (Non-Resident)
         7442176-7443927
 25                 2013-06-26 18:56:34  bcb1278d0441dd482bc9aafb57abe8a6    790de86e64018a72d48b97ed9281d9bbe036d728 b9aa929d68b88288d49fa4850143e18120c67d55c81c8733e605a639637cdb7c Root/Documents/Mac_mini_Intel_User_Guide.pdf
    DATA: DATA (Non-Resident)
         7342616-7347047
 25                 2018-10-19 22:04:44  9bc47b9f8c3ddc76f98b888d29d58dc8    ca2d122f689a98ca752fdbe0414e6296dcff8c68 18ca6866a60efd06455338739bed02ed3a60bbe8e9cd5e8688b7877aa2a11ef6 Root/Documents/MyDoc1.docx
    DATA: DATA (Non-Resident)
         7351520-7379239
 25                 2016-08-09 16:43:30  cbe35c8518717402622e37fe748e08b3    028f8ea45432e9b87e45693847d0b6c068b3096d 4868c01d946e0ab00fb2af3bb186ead65ff41d82817f8cc210e254cb115f494a Root/Documents/Test_Arch.zip
    DATA: DATA (Non-Resident)
         7443928-7450887
 28                 2022-03-03 22:07:16  Root/Music
 28                 2022-03-03 22:07:16  Root/Music/Andre_Rieu
 25                 2016-06-05 16:40:10  a44be999d6682d18644da916cc3a5569    545dca6e41229c13c8ea51930b809c1155ba1ae8 1ca04432f8cc56e7e11d13f9a4a930dda67d2756c68040bd280bbc6307854b2a Root/Music/Andre_Rieu/Andr_Rieu-Air_On_A_G_String_Johann_Sebastian_Bach_(mp3.cc).mp3
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    DATA: DATA (Non-Resident)
         7861312-7874119
 25                 2016-06-05 16:39:14  babfb3a12071e9207803c707f0ea4da9    19c0fc620469b9f709a9e5f41358cc9f77935133 9a61b7a900bce729eab4c964ebfdac730e656e0b4206741d09f8b1ea9ce0d34a Root/Music/Andre_Rieu/Andr_Rieu-Ballade_Pour_Elise_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7874120-7882167
 25                 2016-06-05 16:39:10  d4d8f39e2b3c8df8c62b363284524e7c    3eea72aa9277fee3f8af60fbcb7b47929339190c aa0def648856d03145be5428ef6e00461ceab3b93c56c33d4559e98c46a4971f Root/Music/Andre_Rieu/Andr_Rieu-Barbero_de_Sevilla_F_garo_-_Largo_Al_Fact_tum_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8105000-8119791
 25                 2016-06-05 16:39:14  0f83a6b9df6c1c8768ff7a5466789eb2    77dd488fc42dce156f172e9e5557c2f4ed51cc83 88ff016fb6208004ad2b77d58c0b58ca54fcaa1d76a0c58c9030bc554977496a Root/Music/Andre_Rieu/Andr_Rieu-Clavelitos_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8051224-8058271
 25                 2016-06-05 16:40:02  e76773c030362550b84955ddb47bc7db    bfd4ac01e34c51d4bd852ff38b63c2001e8fd151 3e7e0a37558c0578d8333b6f4e10f09d0518065a12065f22d11a91ef388b9abf Root/Music/Andre_Rieu/Andr_Rieu-Funiculi_Funicula_isp._Mario_Lanza_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7893384-7900703
 25                 2016-06-05 16:39:52  36f69d719447f30f50290692ae1ba58a    cf6c96a7051dbc35fd6c67239e94db3f657082db 2d5f4b5ab667f46ceda5d6ecde00da34928f393b601d23d43dd661437db76a23 Root/Music/Andre_Rieu/Andr_Rieu-Greensleeves_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7992168-8006335
 25                 2016-06-05 16:39:14  f33002bfcfdff30eca4937b2fa02e7b4    2913a18636137a730ee80459472f1890342bfac1 2fdbac3252e9b287a4db3441b4f0cd6ec55dcf26f1488c37bc17c69cbd0a417d Root/Music/Andre_Rieu/Andr_Rieu-Romantic_Paradise_Live_in_Italy_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8085992-8087519
 25                 2016-06-05 16:40:24  afdf9b6627e3ee2a87027fe4037b684a    9c63c3b09f44b182b4cc95980b2e4c06429a0a33 d7d259fb9aea96c6016bd0a2cce50a63a84344d5ca87ea98df496b4d697fbc60 Root/Music/Andre_Rieu/Andr_Rieu-Suite_for_Jazz_Orchestra_No._2_Vals_No._2_Dmitry_Shostakovich_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8008776-8017527
 25                 2016-06-05 16:39:46  95412d5402c21407a4f1fedf4976a019    a5e5dac46a0e6669836e8f74fb36f19e7dab4167 6d0a3e7cef78acd51b5fd4402aa8d2f9e691e1666e154a58fda31050874f9a38 Root/Music/Andre_Rieu/Andre_Rieu-All_Men_Shall_Be_Brothers_From_Beethoven_s_9th_Symphony_Live_In_Dublin_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8170912-8180127
 25                 2016-06-05 16:40:08  a0c6ca644336e199bdd47941f90273cb    76d44494e624dd4740115081c055bf9e471b6aa4 f68153eaec5a9d70b3902d84d7ade66266a3495b125a8805d4ef4f0ec44fdf61 Root/Music/Andre_Rieu/Andre_Rieu-Andante_-_Piano_Concerto_No._21_-_Elvira_Madigan_Mozart_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8189504-8217231
 25                 2016-06-05 16:39:24  1349bee844c598e63840776a8672c7b9    45c0ec96e6a7ea035e011a76e6efcd9b749c43f5 e8ec4dac74ef09da945f22715ad4de103374e725961d0ad36f4f5db42d6f6444 Root/Music/Andre_Rieu/Andre_Rieu-Bella_Tarantella_Love_inVenice_2014_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8139184-8151399
 25                 2016-06-05 16:39:12  7d8c170fdef0f9be95ebb3eb8ff5c351    872e0e6c8c382dda836901f58d666e2e07895a15 27649a6813d82823912829120b9225f81cae99c3152fa545b074f53fb76aad33 Root/Music/Andre_Rieu/Andre_Rieu-C.Orff._Fortuna_imperatrix_mundi_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7851336-7861311
 25                 2016-06-05 16:40:14  b2d52b23a778f12d5ecd3dd17cefac21    f03a5694e19238f4a6d361b700f958ff62e69f64 e631522504fa6d6f73809bfbe7a6218a55b7ccec7bb17676785a1b8d17b09583 Root/Music/Andre_Rieu/Andre_Rieu-Carnival_of_Venice_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7900704-7922319
 25                 2016-06-05 16:39:28  6ed3f80daa58010724c6522a1c8599b8    6f81fa64c5902341f43c2937f0df73f5fc436d56 2d5575b49ef97e53966ebd96bccbb3373cb397d6a25faa306b0a294cfc830ef8 Root/Music/Andre_Rieu/Andre_Rieu-Cielito_Lindo_Meksikanskaya_narodnaya_pesnya_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7846848-7851335
 25                 2016-06-05 16:39:34  5df7c88018a4a90877e37f5146b64ba4    bf1e81b6e750a7e0209fd50b8b63df0d118e8c1f 0c86737d7209b8b3591b18ce125f04eed7e2ad356909a9eab72e6c79b951d5c5 Root/Music/Andre_Rieu/Andre_Rieu-Concierto_De_Aranjuez_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7957336-7968479
 25                 2016-06-05 16:39:10  e1469291b0a0383d587c8783a206679b    606a92c5f170a172c0bdeac2bdb07170e3a680d7 abebd5f9a4c397e6ea404e8b2a2bb002a6f89b45403e6af7d456d275b1c59f28 Root/Music/Andre_Rieu/Andre_Rieu-Einzug_der_Gladiatoren_nemeckij_marsh_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8119792-8129895
 25                 2016-06-05 16:39:26  24edae723208ebb53fa9a70c6235d174    7cae4dc4e4c21b5ccc9feacf63ce1e50007abe55 6b957574e65f2f23369e4c57affcc6bc8afbc0bef486c9cbfcb4ae82d0f3c78d Root/Music/Andre_Rieu/Andre_Rieu-Einzugsmarsch_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7882168-7893383
 25                 2016-06-05 16:39:16  4214e0582e22356faa3006f593c31521    648429f6f343f3b6fa1c5befd1fa17e1dbd359e6 0ca50844f96980e2ebc420da7319dba1b399a562a57b19436c40ea64906f5fcc Root/Music/Andre_Rieu/Andre_Rieu-Francuzskij_kankan_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8045120-8051223
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 25                 2016-06-05 16:39:30  6f867a4b657fcb11eb1590b93f6121af    2a44513002d45228f4b477c0a6fd8b7011d14006 2407979c0e2c55845565cfce09b5141e0c00df7e7355e7ae29b063d7df9064cd Root/Music/Andre_Rieu/Andre_Rieu-Heigh-Ho_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8006336-8008775
 25                 2016-06-05 16:39:12  9da23d67db029b0a2aba65a902977ee7    f4427b8ce2d37fe2d94726a760b55565e0060beb b955ebeff0f774c7cab342a71e978b20767797fffbcb8fb6ebc9a223eee81e6e Root/Music/Andre_Rieu/Andre_Rieu-I_Hear_The_Sound_Of_Cymbals_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7944504-7957335
 25                 2016-06-05 16:40:20  04f2d1fdff801d2ebe6df0f29a18e619    ae5ef67f8fdee64c69cdfbcb53367450e2525201 234ef05b32baaed3d91a60f77b5c3728eed21fff34c5c8110c5d07a57f38247a Root/Music/Andre_Rieu/Andre_Rieu-Jackety_Sax_Benny_Hill_Theme_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8038144-8045119
 25                 2016-06-05 16:40:20  3a8b983d9b22d2cf58714f94272085a2    d8888d6e7698e19dd06f88ae0c52132e808322c9 7eae251302dfbec1381e645c1feb6fb81a3bfb40dd378c835fd7082be83b227e Root/Music/Andre_Rieu/Andre_Rieu-Kalinka_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7980688-7992167
 25                 2016-06-05 16:40:06  ed26972ec518840247f114119e032cb9    954750d662eec3f4f7469c7dc86dfb6caac47852 43ce97c1e7f4358484b18cbfcf5046e4a9fff92378f63603a4d4d1251a3c8c25 Root/Music/Andre_Rieu/Andre_Rieu-Main_Title_The_Godfather_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8129896-8139183
 25                 2016-06-05 16:39:44  90d6ced1e8a5012ba917d1049cb86d83    c8563a0a974c53b5a410522f68392c92230997fc 9fe1e61c05e2c3815df1a7b4f2933b8fd3d8fac85f21cee97bb890259c2268cb Root/Music/Andre_Rieu/Andre_Rieu-Marche_De_Radetzky_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8162112-8170911
 25                 2016-06-05 16:40:22  16c30e0592019ff78261b8ace757d93c    26c8510995f161358ca9a623cc6830ec0f3bb7f0 0926727b89c24ec0837ec080a9fcd6dca7977568a0c4cdae2f0bdfdde21588ce Root/Music/Andre_Rieu/Andre_Rieu-Moonriver_from_Breakfast_At_Tiffany_s_Henry_Mancini_violin_cover_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8180128-8189503
 25                 2016-06-05 16:40:22  16c30e0592019ff78261b8ace757d93c    26c8510995f161358ca9a623cc6830ec0f3bb7f0 0926727b89c24ec0837ec080a9fcd6dca7977568a0c4cdae2f0bdfdde21588ce Root/Music/Andre_Rieu/Andre_Rieu-Moonriver_from_Breakfast_At_Tiffany_s_Henry_Mancini_violin_cover_(mp3.cc) (1).mp3
    DATA: DATA (Non-Resident)
         8252896-8262271
 25                 2016-06-05 16:39:22  9f2fa86941e53af861f58a20fe4ca3a0    048dae683de9566f2444750ce4e18a59b2f14b39 3adba60be7fc3f52ff992361feb663af28ab74f5ff475616368b6d69ba4605b4 Root/Music/Andre_Rieu/Andre_Rieu-O_Sole_Mio_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8237728-8252895
 25                 2016-06-05 16:39:08  7a4d0e64b2e59713d8372bc8c33a413f    6eb557504149913d0642d0a355fb57c2a168af78 650857fb1cbacbe2984478823d857c4c49055302e375039a389112f314ce28bf Root/Music/Andre_Rieu/Andre_Rieu-Sabre_Dance_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8087520-8094615
 25                 2016-06-05 16:40:26  85af6129badd4d015270a811c686b5ed    fa8560286a78c9fb2476223d241dabfc080ac585 72454419c59109188499bf8f20f94988ab0f6feec1ef0b083cf0b3d481919e0f Root/Music/Andre_Rieu/Andre_Rieu-Second_Waltz_Shostakovich_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8094616-8104999
 25                 2016-06-05 16:39:38  d8f4430b58e89bfbca7e04d9c8c1ae85    ed606770fb935d2c7da8cec4634ae25cf6251bc0 258c0d8334a22f8cfe48cfa4f407faa4911a86e6dc0159eed3943989efc5aeb2 Root/Music/Andre_Rieu/Andre_Rieu-The_Blue_Danube_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7922352-7944503
 25                 2016-06-05 16:39:34  526ac06ad6e99e345c605e8ee5308765    a26404f1a20c22fb35c1f2e1a789689e16503f05 3f19694235113ab6393a3e3b9e7a7c0bff2c34de5f5a23b1946f19dbc44b2522 Root/Music/Andre_Rieu/Andre_Rieu-The_Gypsy_Baron_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8217232-8237727
 25                 2016-06-05 16:39:42  5e069942912410b0a2b9a07393c5bca8    1d9a975521d5841a4096be46b52cea589a3b996a d3ed442842ec32249c32fd65368878a1d3ffb0b6796c5a7fe23ba072c9b13792 Root/Music/Andre_Rieu/Andre_Rieu-The_Stars_And_Stripes_Forever_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8151400-8162111
 25                 2016-06-05 16:39:30  620bf7a865780b1d6f5357af14d91ad5    7634bcf96204d17693e4616ae29abad6499624b6 6a06815b8af9bfb97b6f6363c4f818439b69b22dd25dfd77fee199125fe00c79 Root/Music/Andre_Rieu/Andre_Rieu-Thunder_And_Lightning_Polka_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         7968480-7980687
 25                 2016-06-05 16:39:16  c9cf9053c04806485687e3cc0c26fef2    56258d0bc0e87ebea17ec4f918166e2387711f1e 350efbb5f6dd944682942dd6e88bfbd4cf1c60104bcd95a172067ac32e9538c6 Root/Music/Andre_Rieu/Andre_Rieu-Tiritomba_Love_inVenice_2014_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8027992-8038143
 25                 2016-06-05 16:39:18  e9f2e7b7ec1b375bf8409bbb63c0c1d3    516710c7d6977e5654ba350b12e3619d2272ad3b 61b1e1ed2daec5f1244624145ccd81aba6efa16a5f38bcf150ddba1c78deff21 Root/Music/Andre_Rieu/Andre_Rieu-Valse_Neige_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
         8017528-8027991
 25                 2016-06-05 16:40:02  5f5e765df138f0d8695d567bd6ba7ebf    4a7d04e3579fcd2a5a95d890264fa507b1de62cb 9940e93f8931702e4f68baea39708e3b3a7f2fa3e7fef0060d60ca2158616b8c Root/Music/Andre_Rieu/Andre_Rieu-Viennese_Waltz_(mp3.cc).mp3
    DATA: DATA (Non-Resident)
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         8058272-8085991
 28                 2022-03-03 22:07:28  Root/Music/Barry_Sisters
 25                 2013-10-19 00:58:26  ca8ecbaf0d6dc35e2633236cdd4fd3a3    7bd6f803814c58ef522cd3ff8a894ed0ca154bfa 0ff94b864e65320d8059654c503843df15f2edc91768e6d5821c557c845215e5 Root/Music/Barry_Sisters/Barry_Sisters-Ketsele_Baroyges.mp3
    DATA: DATA (Non-Resident)
         7657816-7663375
 25                 2013-10-19 00:25:14  2cac595c471dbc63b18f64d7402e5a47    48db9c5251b72973949dcf6cc0696bb3e42bc916 b1518592e55d37fd09cb91b3d1a9e66b49dc0b72cc673f189b5ad18ee75f664a Root/Music/Barry_Sisters/Barry_Sisters-L'Chaim.mp3
    DATA: DATA (Non-Resident)
         7717624-7724247
 25                 2013-10-19 00:14:20  ab3e597a143beb7cca18afabe6b2cf05    0bea492a98c11c131dcae40348a47e2fb68d33d3 b81c2fbc0e859c621194bcf7a25cffb4726452e5d0c8ca864e03f00188e71c96 Root/Music/Barry_Sisters/Barry_Sisters-Tum_Balalaika.mp3
    DATA: DATA (Non-Resident)
         7694120-7700695
 25                 2013-10-19 01:14:54  93faf50fbbb3852820fd0af9304d981e    dc99e2890538319da9a264eb59a0400b7e4faa6b 4bb557581d0a2209c20e156357e008fad23b9c22307941c4d2304cb481a28c66 Root/Music/Barry_Sisters/Barry_Sisters-Vaybele_a_Tsnie.mp3
    DATA: DATA (Non-Resident)
         7663376-7669759
 25                 2013-10-19 00:51:52  665e256b848c6932d601ba9c7a69d71a    b7d4ce6579d8ecd957ff0c14651de2bdf2292796 e98e2fe701aadbb80ac154396492411124619eae88ded655d8d1f77bfb575116 Root/Music/Barry_Sisters/Barry_Sisters-Yidl_Mitn_Fidl.mp3
    DATA: DATA (Non-Resident)
         7700696-7717623
 25                 2013-10-19 00:06:18  ebc7efe7222437cea77bbb756ae20b66    09241e9a275c0c2d05ea04fb984fe05af985d8ec 920841b083ac3a3783c057428cf447576d9b2eda5bf0a20efee56e70c30d2e4f Root/Music/Barry_Sisters/Barry_Sisters_Chiribim_Chiribom.mp3
    DATA: DATA (Non-Resident)
         7743520-7749727
 25                 2013-10-19 01:20:22  d835c7abf97c3739e3ad3a2943e3bbe5    011f89ba643ce150000bf5db3d5f1d25d93f0293 f9eda23a76b4fe6ad41117ae5fbb18e914fc400fa01533c39b1eee1e7ff2409b Root/Music/Barry_Sisters/Bublitshki_Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         7734096-7743519
 25                 2013-10-19 00:28:36  d8cdf8cfd4419fbb70c7f5df347f6890    1fe23a26be467f59c14703cbeeb580ed5de3a5c9 bc0052be54f9175bb0e590aac8ecf1dcf4ba7587c263cf9fca6bc8ccc0feb3dc Root/Music/Barry_Sisters/Hava_Nagila-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         7669760-7677639
 25                 2013-10-19 00:41:54  675c2e035c953df83bc6dd245966ff8e    30d3a38b8b4f55bd67a82035c42d0a304c1db394 f16175bc9c26f9fe3fc8d8b8a497eef3d29f6642372a9472cf33e805cf4c8882 Root/Music/Barry_Sisters/Hevenu_Shalom_Aleihem-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         7650688-7657815
 25                 2013-10-19 13:03:04  8cff6cb8a834d5a0e00366853c2ed8bd    494933f834d9c170f0a3aff602c2093a8e62ae13 bd0271ca25d8f9c6c58bb13c6bb8b7dd478bc1255da5cb427e3a1d836dc11db4 Root/Music/Barry_Sisters/Papirosn_Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         7724248-7734095
 25                 2013-10-19 00:37:44  c928185e9da6fd4bb10b64b5b578552f    32fcebb494330a3fff73fdc9675c4c8057f3cd00 3e8a99fa1a7f6e3eabf64d155b1e57f3006a9f7847f21e798642b3a445339a93 Root/Music/Barry_Sisters/Vi_iz_dus_geseleh-Barry_Sisters.mp3
    DATA: DATA (Non-Resident)
         7677640-7694119
 28                 2022-03-03 22:07:31  Root/Music/Electric_Lgcht_Orchestra
 28                 2022-03-03 22:07:31  Root/Music/Electric_Lgcht_Orchestra/Time_1981
 25                 2005-04-07 14:11:40  e56b81d6e95ba198ba13f55a6c94d9d6    1f7b7dd059fe88dd1373c218ca3fdcd549f32758 348646f1fa7fd3f99d595b68a33c90f2ec43d0a439d1bbb2768c06f47ffae21a Root/Music/Electric_Lgcht_Orchestra/Time_1981/01. PROLOGUE .mp3
    DATA: DATA (Non-Resident)
         7531632-7535103
 25                 2005-04-07 14:11:40  e183a3f026acbfaf8e4c8c9997c03721    8bb96b64b57214247bc90c129cf363ac14f29a3b f7d0d08f9116c4279f07c753763b89aa4415afd102b3235ab4e8f3caaadc55e7 Root/Music/Electric_Lgcht_Orchestra/Time_1981/02. TWILIGHT .mp3
    DATA: DATA (Non-Resident)
         7573088-7580687
 25                 2005-04-07 14:11:40  e71574ae3bdb6a6d39a777b63f98c261    ea5a27d3abbe6dad451b8d5fcab8e2ed20916918 6f1ae25b46b334a0814a39f0176879857d32beca920d546573e80f60a89d3b1d Root/Music/Electric_Lgcht_Orchestra/Time_1981/03. YOURS TRULY, 2095.mp3
    DATA: DATA (Non-Resident)
         7561264-7573087
 25                 2005-04-07 14:11:40  1a5112f377cacd6d35e093d47c52fcc0    7b5b697381584a2cb6e6c32199d563c7807019ef 9be8d830897a6e8ed2bfd9f4f3196e8a5c32862667cfc049cce196aa7fcb0561 Root/Music/Electric_Lgcht_Orchestra/Time_1981/04. TICKET TO THE MOON .mp3
    DATA: DATA (Non-Resident)
         7499496-7511095
 25                 2005-04-07 14:11:40  f9d68c6e0468aed135415687d65e41a6    bd2292b32c41c9d04b8c64e80162c37a14377986 32f769043c203cd172d4595c79e043e650b48b218e0c7187c7c53576272d98e9 Root/Music/Electric_Lgcht_Orchestra/Time_1981/05. THE WAY LIFE'S MEANT TO BE .mp3
    DATA: DATA (Non-Resident)
         7535104-7548199
 25                 2005-04-07 14:11:40  75d6f8ea67e56aff2c37a7355c311c81    55a5fea075d9c791b07109450e3f80f3c36ad700 dec7a546e447a06e821bfae76d56842886a66e524a49e27126593b9c0fb806dc Root/Music/Electric_Lgcht_Orchestra/Time_1981/06. ANOTHER HEART BREAKS .mp3
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    DATA: DATA (Non-Resident)
         7488808-7499495
 25                 2005-04-07 14:11:40  f20ca468c271d565a9cf8a2b5dc00064    ff4c2759b70f49cbe7926aacccf1da736f3dc5c6 644040723a1cd11e09a7bf8e4d8cd88cd30716b9679ae9884af9583dd6744e44 Root/Music/Electric_Lgcht_Orchestra/Time_1981/07. RAIN IS FALLING.mp3
    DATA: DATA (Non-Resident)
         7589912-7600911
 25                 2005-04-07 14:11:40  9f71d12c63e3c3df2a343ad6f7949e1e    7517b6d91b71bf3e4a52ac33ca78ea99951f1d76 2ce95099a194b20d8e64d8ed79ab4e61ecbc784b6695e3af431a7e9dcd92bad7 Root/Music/Electric_Lgcht_Orchestra/Time_1981/08. FROM THE END OF THE WORLD .mp3
    DATA: DATA (Non-Resident)
         7580688-7589911
 25                 2005-04-07 14:11:40  13521f054f7d59ba7cab3df7da45257e    ca176095f3b9164be65daba5f2a97f695f40dd07 0a943aaa8f0318db5db96170499523f8890de0a788885943adba75efd7db8af6 Root/Music/Electric_Lgcht_Orchestra/Time_1981/09. THE LIGHTS GO DOWN .mp3
    DATA: DATA (Non-Resident)
         7521624-7531631
 25                 2005-04-07 14:11:40  c05d2969d001899b4a175a4e68c2fecb    9294e29e1f30e28f23922416b5a908a3109bb9d5 1790a250729eb139b25d588de3f53834b8f2f7cd2928125784b0df8aeb3a892b Root/Music/Electric_Lgcht_Orchestra/Time_1981/10. HERE IS THE NEWS .mp3
    DATA: DATA (Non-Resident)
         7511096-7521623
 25                 2005-04-07 14:11:40  4a6ac89638420964737bcd597e12f667    ca4fbdc19d85bb999c0bc1299f57f25a690ae3a4 4a47e924470a26a57ebb89b947cfdc9eb96477838050fea459aaa01544a8aa8d Root/Music/Electric_Lgcht_Orchestra/Time_1981/11. 21ST CENTURY MAN .mp3
    DATA: DATA (Non-Resident)
         7600912-7612631
 25                 2005-04-07 14:11:40  1b3bb20062656046700d2356c66978e6    e985fc4780e2f3ce001ba44e6cadaff8df4b4bab 0089088cb3062cbfa50f8d414ecb68c5c94f9d9aec77966fae55a154553f7f5c Root/Music/Electric_Lgcht_Orchestra/Time_1981/12. HOLD ON TIGHT.mp3
    DATA: DATA (Non-Resident)
         7552512-7561263
 25                 2005-04-07 14:11:40  6553cefc73c2eb9c974d65d9e100ce63    a63cf43e4e070796a1e0f5636585ef855e647226 5b78807b8012ed28af78845c00244a3ae6575e8afaf280d0c3184de600d55541 Root/Music/Electric_Lgcht_Orchestra/Time_1981/13. EPILOGUE.mp3
    DATA: DATA (Non-Resident)
         7548200-7552511
 28                 2022-03-03 22:07:35  Root/Music/Ennio Morricone
 25                 2001-08-17 01:00:00  e9d6556f18f45fcc506d99d17ca3010d    885dbda70b153885ad660dd3f87f0ecbcc7d21d4 554c109bf97dcfca8d5bbc27d255dc2e963ca7430056105fc3538529ccdaed38 Root/Music/Ennio Morricone/Ennio Morricone-A Gun for Ringo.mp3
    DATA: DATA (Non-Resident)
         7792000-7796383
 25                 2001-08-17 01:00:00  4b2bcfafa655751e0be9aad58d32df98    a8183fbb98ddca996fd50fdc7437c5bdfef48540 f54573a8c38b12641a9a9db40ba85ddfa0ec67103e3967d5f45e7f97fe9971f7 Root/Music/Ennio Morricone/Ennio Morricone-C'Era Una Volta Il Trenino.mp3
    DATA: DATA (Non-Resident)
         7824560-7831551
 25                 2001-08-17 01:00:00  cc03b5901e0950ed7f6fce239c53f387    97a6202ed8a5a7613a5d92b8670654fef60c802f d77bd85c9a96cc1ba4a3f091499a725910552ad4a2b7df1ee78412d09f5d0934 Root/Music/Ennio Morricone/Ennio Morricone-Chi Mai.mp3
    DATA: DATA (Non-Resident)
         7831552-7839943
 25                 2001-08-17 01:00:00  8242372bc075979a755f5ebc64b1c0f0    bd4b071c45c321ae859e6fa1bc29a8c6408982a2 d92f7501ae994e95527fdd1e6e3d721c206466f1271e6a27a1b0a0196b23b14c Root/Music/Ennio Morricone/Ennio Morricone-Cockey'S Song.mp3
    DATA: DATA (Non-Resident)
         7816464-7824559
 25                 2001-08-17 01:00:00  167926ceb7f39e1707f1514fb44ac9b8    bb942a68678bf29a9e0d847e5e644bfe43471a96 7cc3f790f6f420158a51bfc20c7b23e468259b9b09d664f6effa116b242112ca Root/Music/Ennio Morricone/Ennio Morricone-Farewell to Cheyenne.mp3
    DATA: DATA (Non-Resident)
         7799720-7804655
 25                 2001-08-17 01:00:00  9ce646a5049fdd19bee62c84eabebd5a    95d1260f50f41efb91474471f0111428979bbf41 ec42a38484cc6fd4fc83eee6471d01115db77bf174c586d8b4edca7b06b8a387 Root/Music/Ennio Morricone/Ennio Morricone-For A Few Dollar.mp3
    DATA: DATA (Non-Resident)
         7804656-7809287
 25                 2001-08-17 01:00:00  6704adff61e44c1f7daa9ce2baabbab0    051a4ae5d60171a60c6074a2fb36621fcaeaf211 d4b43c1f5371386e9f1b7dae44f7de1dbe8d9ad78da0b2a9ad6a85da6a8c02f7 Root/Music/Ennio Morricone/Ennio Morricone-Goodbye Colone.mp3
    DATA: DATA (Non-Resident)
         7796384-7799719
 25                 2001-08-17 01:00:00  df47b2ebadac3343ef63ba820f567d55    21c4de7b3fb30bd0093cab0c8f19d7aeea3cf10a c24c1a09c7dda361b870b14634ae7d73ee8d8032ed9edf9dc11335ecce8ef580 Root/Music/Ennio Morricone/Ennio Morricone-Le Vent, Le Cri.mp3
    DATA: DATA (Non-Resident)
         7772344-7787271
 25                 2001-08-17 01:00:00  dd654b0d7aadbd4ed5aa2f07f601d54d    db453dc07334b16e5cd0dec60a1c2fc89ffa30df 54bde5e91c19478763fd4a20947a573ffda7a217832e596849967eeb7bfddeb8 Root/Music/Ennio Morricone/Ennio Morricone-March of the macgregors.mp3
    DATA: DATA (Non-Resident)
         7787272-7791999
 25                 2001-08-17 01:00:00  f2857800c13a4eb3d2c196093921f56b    bfcc6fbcef98f95d5ec1c0774157de3b20335f0c 9c2c7fa2afebd245606977bfb5b47dcf966099fee8edada864245eba72655468 Root/Music/Ennio Morricone/Ennio Morricone-Once Upon A Time In America.mp3
    DATA: DATA (Non-Resident)
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         7809288-7816463
 25                 2001-08-17 01:00:00  66ead755183f910d14aeb071b1b0a906    250c0430cad1a773f2bc950312ce2447109827e6 5f6e0777093692d2c79dd756154fccd87de7216cdfa745376cee1dfad28cb49d Root/Music/Ennio Morricone/Ennio Morricone-Once Upon A Time In The West.mp3
    DATA: DATA (Non-Resident)
         7839944-7846847
 25                 2001-08-17 01:00:00  f8c04ca99abc731f691dac5d1258c623    50a4f21dc3daa70a9d5474bca6cbd1b2fcc5069e cd81f63dba683d5a7be2a10a67a5c953a67ceb62f4f5c60972103fae64924410 Root/Music/Ennio Morricone/Ennio Morricone-Overture a fistful of dollars.mp3
    DATA: DATA (Non-Resident)
         7766840-7772343
 25                 2016-04-29 00:51:04  678be5fa10fd689690b47a63b8091549    8a196fde7b67298c6f65f44b17a74a318218c748 c0fba9eb8cd60edf592efde7a94c273083a20f55fa5e7349781bbae8605025d3 Root/Music/ CONFEDERATE_SONG_TO_ARMS_IN_DIXIE.mp3
    DATA: DATA (Non-Resident)
         7470224-7474527
 25                 2016-04-29 01:12:34  cb2a01e7a4de030627a8bd11330853a4    55d40b7ca48373cc59e03b2614a0005731d5de62 605c872d2891b98875f39782521e108538dc511464535a89a76b786b48348c81 Root/Music/derek-warfield-the-southern-wagon.mp3
    DATA: DATA (Non-Resident)
         8275816-8284119
 25                 2016-04-29 01:14:02  d09612ad1b02eb2f89ce0f7cb54687b0    72d986512c390254a289a02ea36c1a6b10ff7cd8 9c783ba314837f59174f2a3713327f92fdc0cb4de41643bd23ab8717a3887989 Root/Music/derek-warfield-the-wearing-of-the-grey.mp3
    DATA: DATA (Non-Resident)
         7612632-7622735
 25                 2016-04-29 00:46:58  31cce7cada7d6e1250024562038f851f    d7bbd1e78ad71bb930cc00b809ea08ae7d3f8c06 48ef762818c7e36088ed5ca27c8d0f725ee0ea16860cae92cc810b5161495de0 Root/Music/Im_a_good_old_rebel.mp3
    DATA: DATA (Non-Resident)
         7474528-7488807
 25                 2016-04-29 00:36:44  698ab247141b7ee08376ca4bdc107614    324362db1940e541cb85932aabba5335b6d39051 2c23952b20f4187c39d0fd1a78ff32d49c6d217d49eb3f60d45d2643a24121a7 Root/Music/johnny-cash-cry-cry-cry.mp3
    DATA: DATA (Non-Resident)
         7759928-7766839
 25                 2016-04-29 00:32:14  24d2f32b70c8720297b4683e45526d53    e0dd254f7b546f3e11ce1e9a09f58570c361dd19 7adc7fe757bc7cdef0fe354b0bb8d78a22c192f8c4a52c177d9a025297e213a5 Root/Music/johnny-cash-san-quentin.mp3
    DATA: DATA (Non-Resident)
         7450888-7458287
 25                 2016-04-29 00:38:28  ea34e906ad80d8c007b228d64f43325d    61c9e3055c945058176152d9e3173f90a9f4c37b fd4d14e4c536ced737fddd3c9503c4d6fe2fa2b15a797bffce2a822b6edbdb01 Root/Music/Johnny_Cash-I_Got_Stripes.mp3
    DATA: DATA (Non-Resident)
         7622736-7628615
 25                 2016-04-29 00:29:20  012ff60673c13ee257122f7c89ccc8a1    3bc32eb8195628611ebb11ecfe891b5ec974d3e5 63c6eb80644401b50f6056ccfa6bba2b28acd50354de27ab94ec7b2bb3838a35 Root/Music/Johnny_Cash-Man_in_Black.mp3
    DATA: DATA (Non-Resident)
         8262272-8275815
 25                 2016-04-29 00:22:18  59d71c51254e6a34ec2b56bd24215f0e    ae45fd4e2ae3f49d99703e42ab4098eb971d2454 1c48623249bf89e918b06169d6e6ff08f5d9902ec744762dd99d040f690348c1 Root/Music/Johnny_Cash-THE_GENERAL_LEE.mp3
    DATA: DATA (Non-Resident)
         7628616-7635495
 25                 2016-04-29 00:35:10  59f3006e9f2f718ab75f7373e92bbd12    bffb06aa970738517061f1358e318e5cc78273c6 5f7d1a6b32d4f316ac05b41e91b6a2752a860338cb7c09850c5d92a3ce897472 Root/Music/johnny_cash_ghost_riders_in_the_sky.mp3
    DATA: DATA (Non-Resident)
         7458288-7465327
 25                 2016-04-29 00:44:04  5286083472934c6997889b1384dd750a    f3eb5f4e78bfca1a1e4718c83a1e3b7a8efa946f e02aa2f29274a73d1d4580cb00f5bc6f4166ca87427e0d8a4558ffea3e7fc1bf Root/Music/Stonewall_Jacksons_Way.mp3
    DATA: DATA (Non-Resident)
         7646264-7650687
 25                 2016-04-29 00:58:38  aec6b3e9c714bdb1472d21aad613006a    e0c8ab1280482e428a65286e156a3287274fdb3e d3b8e261c2afb6b0989e6a2d83205ea06603345ad3b336447d68ace48e697af7 Root/Music/The_Bonnie_Blue_Flag.mp3
    DATA: DATA (Non-Resident)
         7749728-7759927
 25                 2016-04-29 00:16:20  85c29de2ac785e0f2453e0b86334ef54    d5b2bc5822e324b4e943e076e6075aab8314cb56 a9070f9bc811a4174461542046a71870a99a84c5d05dee4452bcb1ce24f72a91 Root/Music/THE_BONNIE_BLUE_FLAG-1861.mp3
    DATA: DATA (Non-Resident)
         7635496-7646263
 25                 2016-04-29 00:17:10  6cb3521e4ab602c95a09a61348545cfe    3bdeb449dc5dbf5508e097b41a91d85c8a02df3f c56dbe344b96a59932a0049378a6c591d19d189948ea0fd1e3b33dfd2ff6e7d4 Root/Music/Yankee_Doodle.mp3
    DATA: DATA (Non-Resident)
         7465328-7470223
 28                 2022-03-03 22:07:40  Root/Photos
 28                 2022-03-03 22:07:40  Root/Photos/Diving
 25                 2009-04-29 13:52:42  1be9257a5f5816119a1ee7932f277709    b164610273e1684806c4cfdfb087dd6bb9c45ae4 de7eee26d1a8ef8b8f7098ca323d635bc2f2e2ec3260a8e7cdb9afee41d679aa Root/Photos/Diving/MyPhoto1.jpg
    DATA: DATA (Non-Resident)
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         9318464-9323703
 25                 2009-04-29 13:53:22  96d4bd523d897cb9b71d81b9703e7361    d4688bb699075afc0892b2a044eb42367c934c3e 7c0cb8fc34246a7711cf0e0ea56589fafdc204a911d20fe60ec23f516ca6a859 Root/Photos/Diving/MyPhoto2.jpg
    DATA: DATA (Non-Resident)
         9327256-9330831
 25                 2009-04-29 13:53:58  bb6bbeaad2b8ef9c9abe4648de3a5999    cdfcfb3779a3a208af1f7643914dce53632588c4 6030e056aa02221686bf6e6a32cfa7abff8a1401c28b43d57eab23a2aa1fc5f2 Root/Photos/Diving/MyPhoto3.jpg
    DATA: DATA (Non-Resident)
         9323704-9327255
 25                 2009-04-29 13:54:20  beb944c66d0c83a708fe1c69011a5d42    4a9ebcece6a0c3a780f6e9852e065f2ce7d625a0 2b6598767763c096a1ec8161fd98ad00c878a514e91224e74598774e1285d00e Root/Photos/Diving/MyPhoto4.JPG
    DATA: DATA (Non-Resident)
         9337256-9339023
 25                 2009-04-29 14:13:38  55bef019410f8bcd10731a46fa250909    35fa0050b34ec540b6f9facd24d01d31094f8bc4 c343fee6083774eeabe36c0e4496de4af942ec99ac3f454c675cef28cf6f9552 Root/Photos/Diving/MyPhoto5.jpg
    DATA: DATA (Non-Resident)
         9330832-9337255
 28                 2022-03-03 22:07:41  Root/Photos/Helsinki
 25                 2007-07-25 11:14:30  28b5e80d00c5c1e44547e944319f2fc4    6cffe5d309990d77989a119859d4f353f0e0169a 2622f7b32f509b200ac78787efd194133f8d36000fc739d22f0dad47a606e7b4 Root/Photos/Helsinki/Helsinki 005.jpg
    DATA: DATA (Non-Resident)
         8302592-8304823
 25                 2007-07-25 11:14:36  0985e9acf3eed9f6efdc54f6444a890c    8409c041c31a8eb3023994ed1b8f49781abf32cd 477aa2e3af10f4bc3715b20d37e89e52692450827b65563ff2223cc54d763287 Root/Photos/Helsinki/Helsinki 007.jpg
    DATA: DATA (Non-Resident)
         8308512-8311175
 25                 2007-07-25 11:14:38  6c0f93298d0e48ba408f661bfc2236e6    6fa4cc63ea595337398e2edb7f070860cd510b03 8cfc04cb423aa7bfdaac2580107e4dc2a5d05544848ea3de7c8c2fd22519390f Root/Photos/Helsinki/Helsinki 008.jpg
    DATA: DATA (Non-Resident)
         8378672-8381735
 25                 2007-07-25 11:14:40  eb17a6b5efad44800ce7d7d83c69eff6    ea0ca44a349338d6c4776c6a96fb7829316d9041 b83b385bf8de8d8457ffa0b8ae5e6adb625fc9153ffab29bae8afda438cb516c Root/Photos/Helsinki/Helsinki 009.jpg
    DATA: DATA (Non-Resident)
         8381736-8384447
 25                 2007-07-25 11:14:54  52a5aadcbfcaf383d1a0297bac0fb533    7faad9d693e98fad561813e6d4257fc34ef214fb 77cfcae9196c54e0a33116bfc6659e33835bae5ade4aa19a71f3a64fdd943b04 Root/Photos/Helsinki/Helsinki 014.jpg
    DATA: DATA (Non-Resident)
         8299224-8302591
 25                 2007-07-25 11:14:56  ff01a8fcc0828e06a441d6da9d971b25    ae1fd253e25c59f3825809fc18055c7a84dde7ff 78dd23b664150bbfcedb1a8146c8b6db6e00b6839ba9f3e7b5c064d61740fe77 Root/Photos/Helsinki/Helsinki 015.jpg
    DATA: DATA (Non-Resident)
         8295968-8299223
 25                 2007-07-25 11:15:00  b7fd46830da4a1c74c0dca5be70fcdfd    b550ecd95a731e7fe45cf52b43676883409773c9 08447b4529b38472248673ee2ebb2e9f24958cbd662bf53680fe5bb43f647846 Root/Photos/Helsinki/Helsinki 016.jpg
    DATA: DATA (Non-Resident)
         8293024-8295967
 25                 2007-07-25 11:15:14  42cd2c12e0f30c16eaa5e32791ea2865    e6d0da7d265e116f8a7988070b2a8296798f2d91 df4725a0326e39af256d3a49cc83e4d4d435f121ac79a1a26eb1177060031040 Root/Photos/Helsinki/Helsinki 020.jpg
    DATA: DATA (Non-Resident)
         8373032-8378671
 25                 2007-07-25 11:15:56  8364499c7c8615c153efece95eb08384    2465309940f8a58182b4ed088bef7665d6b35159 84c973bf92e484c4f56575d929df42fb4ffffa275d9d1558a57d5618eec4a3be Root/Photos/Helsinki/Helsinki 036.jpg
    DATA: DATA (Non-Resident)
         8370096-8373031
 25                 2007-07-25 11:15:58  21f868c3943b06282bb955cd9acf182b    7957e9ea9347cb656f160cb053034817a52d803a 5716a3e5ee831b4df017e0eccd9df6a4b082c330d23ed134ca8859cbff65e00c Root/Photos/Helsinki/Helsinki 037.jpg
    DATA: DATA (Non-Resident)
         8367624-8370095
 25                 2007-07-25 11:16:04  5e0825fd4b9ea941bc183b07ee53b30b    10f84ba2a8812560d8b9f840046c1228cc47482a 34c4ad4320904766be78eb8a5c6041ad0dd63a8c6796730ac99f6e6d7ff375c1 Root/Photos/Helsinki/Helsinki 039.jpg
    DATA: DATA (Non-Resident)
         8304824-8308511
 25                 2007-07-25 11:16:26  f60112a20189a34ded555d744fc995cd    2031d955a59fb5bbeaac6c5d02f34e55134791be 9fde08acebe4cb7e8dc5708a7d088791a25530418c9a35c9117da43c03a3013e Root/Photos/Helsinki/Helsinki 046.jpg
    DATA: DATA (Non-Resident)
         8353760-8357655
 25                 2007-07-25 11:16:54  6bdc1d3560757979d5a8c74499703fca    d3734dd78b1dc1d7aa80e7a37c052a64e90b7161 86abc31897dd528e0d2bfbe7adbe0cf13c750f0a335cff560bd9809ee30200ec Root/Photos/Helsinki/Helsinki 055.jpg
    DATA: DATA (Non-Resident)
         8336632-8340687
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 25                 2007-07-25 11:16:58  eab027d27180b03de7e2545824918f50    a7840875a34c7b006c79a13f2cf4c97a8db83f84 587323db9e818f483b1f6dff3720e3c94db08a508d93473ac6c82f43dd2448d9 Root/Photos/Helsinki/Helsinki 056.jpg
    DATA: DATA (Non-Resident)
         8343480-8348719
 25                 2007-07-25 11:17:40  fe959fdcae31e90b0fdb0a3982e59b79    74a2b387cd3326b645d66c1219ab2104d4f10d25 7d23a5b29e990e1f4310f53f432e73dd89001a511fa0a8672214e7ab2ab86bb8 Root/Photos/Helsinki/Helsinki 068.jpg
    DATA: DATA (Non-Resident)
         8332240-8336631
 25                 2007-07-25 11:17:52  048ac817b294fcbd35226d924dd6403e    136b336c3532deca6c127d208732db730c3632d4 7b835006d4c1d9f5785f1a784cb86d2be8f47cef5e697df057dd918070c417db Root/Photos/Helsinki/Helsinki 072.jpg
    DATA: DATA (Non-Resident)
         8328816-8332239
 25                 2007-07-25 11:17:54  2b62227eb196f862d1cf457a5ddac5cc    347e84f14e2e129a591d2d522e81297d4d4c7522 779fc6198aab07b47c7164961b9fe7fd337e52d4ef113689abaa1f31c264a1bb Root/Photos/Helsinki/Helsinki 073.jpg
    DATA: DATA (Non-Resident)
         8325944-8328815
 25                 2007-07-25 11:17:56  890e90a5a7abb2d1a27392229808b4c2    5acbac453876602bcb7faaba6914248a0d872608 36274f507db46efa766e15f0a461fe5a28ed10826a281b4b96e9df0711564baf Root/Photos/Helsinki/Helsinki 074.jpg
    DATA: DATA (Non-Resident)
         8311176-8314287
 25                 2007-07-25 11:18:02  d39d9a42c01b2108540103ce2f788520    21dfc2b20479ee49c336da51cf587e72012b5bcf 495dd2dc8a6d2604529975e79572ae86d42014b3e05ce342606fcfb234afa2f6 Root/Photos/Helsinki/Helsinki 076.jpg
    DATA: DATA (Non-Resident)
         8317336-8320623
 25                 2007-07-25 11:18:04  8e8492d1199d9009f051056b7e87f6d0    7a03c9c26fac9c90861e698647b473f0a2a1b0dc 68029f074e36d150bec089850c56c82d5e372763c6cebedf3f471d637a92aa68 Root/Photos/Helsinki/Helsinki 077.jpg
    DATA: DATA (Non-Resident)
         8320624-8323535
 25                 2007-07-25 11:18:06  883494b431679f7f9d39ea7d1ceb157c    50bc8c009c7c51b4616d27a1617facb6fe328fd1 5928276ed054d2e97359345c2ba204ce53fe1cae4357100ef71dfe1aa3a023ca Root/Photos/Helsinki/Helsinki 078.jpg
    DATA: DATA (Non-Resident)
         8362664-8365231
 25                 2007-07-25 11:18:08  f47cd4b931c58d5c6afd085467ceed91    b08393e2e176e342a02d3faa0ddd920cad62c021 d4169e76e48b21e828783e426a4fe722ee4be7070ee164802fe941b43819e2bf Root/Photos/Helsinki/Helsinki 079.jpg
    DATA: DATA (Non-Resident)
         8359904-8362663
 25                 2007-07-25 11:18:12  6d75cc9c722568437c5e8794412248b6    13fa2483785d35170cc086691f4394650f91a418 ca5a0e3e2d3e675605bf3eaf97c2bfaa7aa543f26b21f168275aa41eb6411580 Root/Photos/Helsinki/Helsinki 080.jpg
    DATA: DATA (Non-Resident)
         8340688-8343479
 25                 2007-07-25 11:18:14  9796e28ed4fa1a498fb0d4a88d54271a    597df2450fcb9a316a6ff38d73019d7d3a61fefc e368ca4f127fadca31ca967bbc4e0c053b545155864d65fdb12172ccdbc041d1 Root/Photos/Helsinki/Helsinki 081.jpg
    DATA: DATA (Non-Resident)
         8348720-8351495
 25                 2007-07-25 11:18:32  4c313faa0ef5e45095fbbfb9df12ba3b    701e94358467ab51eeb285128eab7b14c5a991e4 a113063e2a5139328035dfb08a1e90e1e28a547ce3d4596e1d1d2ade4a8018a3 Root/Photos/Helsinki/Helsinki 087.jpg
    DATA: DATA (Non-Resident)
         8365232-8367623
 25                 2007-07-25 11:18:34  2b19644cde41ead9a90607ddefbd9baf    bdd733f02ffa868959fd0211032d6743924ca0a0 f2e739d955a2257d9b5cee24b3748e28ab6303ae314c5ebd5007426f3cdef87f Root/Photos/Helsinki/Helsinki 088.jpg
    DATA: DATA (Non-Resident)
         8323536-8325943
 25                 2007-07-25 11:18:36  726690c9daec4197326eefa1c43aeea9    029b8a8f3e152b12ad93fc24d007dbd0c4e4795b 9ba48d14266e1e0b3e0ef70e5784a948729ead0873ea22487a97a4d4107c24df Root/Photos/Helsinki/Helsinki 089.jpg
    DATA: DATA (Non-Resident)
         8314288-8317335
 25                 2007-07-25 11:18:38  0c72be139e24115e6c158746f68cc331    10b55785fbb2dd271d493be3602a5f5547b252f4 a4e27da775a445947ae3609332aa8685a67de31c62d8057cc9499e26bd70d1d2 Root/Photos/Helsinki/Helsinki 090.jpg
    DATA: DATA (Non-Resident)
         8357656-8359903
 25                 2007-07-25 11:18:40  f85c8796fa3172ddb8bdaa6cccb10a53    1567805661f1d053fa4d53957d6d9893e1efd7ab 246697b1731a42e45c1526217fd9aac2ba85cc0d29970c6179e94a87f7ed03ae Root/Photos/Helsinki/Helsinki 091.jpg
    DATA: DATA (Non-Resident)
         8351496-8353759
 28                 2022-03-03 22:07:44  Root/Photos/NY
 25                 2009-05-24 18:43:16  77b5b122cd1b05c2af50cd0836f9b985    31a3271a5d1b054dc69992580d32f26a8adb9383 47fa5a2e0ef322ddc7018a13324c80ea39dfda762d844de8de680b358b088044 Root/Photos/NY/IMG_0201.JPG
    DATA: DATA (Non-Resident)
         9258792-9265511
 25                 2009-05-24 19:25:48  a09054f3aceefb09a45ca4478b43640e    05311785bee82da2d04a7b83d8fa4108d48a7f84 401d1499cd59ec7ffc8e215baeaffea2c1d752a60df93783a6c328dc3373b1a4 Root/Photos/NY/IMG_0211.JPG
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    DATA: DATA (Non-Resident)
         9265512-9274447
 25                 2009-05-24 20:58:56  a343458fad6b045f9d77c6fb646f71ce    dd2bbbb4381c49130a9ad450252f0b8c849cfaa2 860249189d3d69279458b6b3f41b2839fde01df255c81ceaf3c2ce13a4104a2c Root/Photos/NY/IMG_0250.JPG
    DATA: DATA (Non-Resident)
         9283136-9292207
 25                 2009-05-25 01:21:14  c29ac1f58994cb46c53a56f46fdde5b5    a8f5e6e7eafc146e3e868eaadf38cc9f0c28ebfe d97b2373efdab0df6877c8637749310b0c11310081e1830eac7e630232a21b8c Root/Photos/NY/IMG_0283.JPG
    DATA: DATA (Non-Resident)
         9274448-9283135
 25                 2009-05-25 22:07:46  f8d65215fe542da63bdee82868e0fe9a    f9eabae61c6d18c1ad3c5dc2d45b1a0a01e6d09a fc31eadca0b68f19c6ba0be9c8ec51ec87e2fb0e718dc2ace60e257883a6162b Root/Photos/NY/IMG_0389.JPG
    DATA: DATA (Non-Resident)
         9251000-9258791
 25                 2009-05-25 22:15:24  f145c400d3ed9e69557851c522320a56    3f56ea39f77f1fd9b18dc2041f51baa61504103f 7b4c77c6dad37857ec7fd82e960db64e4c842d05cfc72115b7d439942f8d051f Root/Photos/NY/IMG_0390.JPG
    DATA: DATA (Non-Resident)
         9310720-9318463
 25                 2009-05-25 22:15:32  b603d9b3aff85c5f62a9e8091f2dc916    b496ea7f8aa7ed6e5b4c893225ae3912fc8a0970 1028b54e45ac0d610863a8e8a3448c7a428518e96b517ba9170aa5eea7cfd0eb Root/Photos/NY/IMG_0391.JPG
    DATA: DATA (Non-Resident)
         9292208-9300535
 25                 2009-06-06 23:01:08  94ca44fd6bcad151e18159393fc0e71c    0b9a0d4d357d9236ac8dbc2d09b3e4792c934a14 c8a4056f1e11d6d4041bf97db5cb37c102f9117e36009a723881f809cb84c881 Root/Photos/NY/IMG_3694.JPG
    DATA: DATA (Non-Resident)
         9239144-9250999
 25                 2009-06-06 23:11:32  35df6163f8b1154b535bb185aced2d56    01f1be100762c5d175ec75eb8333079551f29c00 fc71d8ebcc188ba26d3e07a28da5ddf89078606d20d84f4922412ef8a5aac283 Root/Photos/NY/IMG_3699.JPG
    DATA: DATA (Non-Resident)
         9300536-9310719
 28                 2022-03-03 22:07:47  Root/Photos/PNG
 25                 2016-08-09 16:29:56  0e20c4014a80419756af6b3618d894d4    dfeb1486ddb64d89b56426847dc945d40a7413fe 7392ae31589eeb672798620f5fa6f5776a67c7aa7494c455e509df324e915a09 Root/Photos/PNG/DSC00398.png
    DATA: DATA (Non-Resident)
         8699176-8705815
 25                 2016-08-09 16:29:56  50a39ae6bdde09570419e04899e861ca    7d9a673c484ae32fa631bc03bdf3f3c5c670524f 957f4fa27af2dbbc6b4d5156a8151a6222093e8dad15a7c53559c118fe8443ef Root/Photos/PNG/DSC00400.png
    DATA: DATA (Non-Resident)
         8734136-8738943
 25                 2016-08-09 16:29:58  07a975f0d121d5710e9e0678c9f08a5d    d15beaa4483bda7879642f452a76a5f9d0e5a2ec aabc57174e53dd3af315c336720dfef22fdaee6ece52bfc59a8e36ed09cd31a6 Root/Photos/PNG/DSC00401.png
    DATA: DATA (Non-Resident)
         8705816-8711367
 25                 2016-08-09 16:29:58  1cfea16f1e3b86b9d85ec43a1c146405    c78d1c40f4579c7c8a98d9cd6629083a48c42a03 51415fb98f758a51ec6fd914cf6b57b9d34fd3564f61b05a57df7376f038b536 Root/Photos/PNG/DSC00402.png
    DATA: DATA (Non-Resident)
         8656616-8661935
 25                 2016-08-09 16:29:58  f39301a4119a7e8b83f8bb9573675cb7    1bd0dc7373246658aa02cd49846f51b9cb4baa85 f5cc938586b14de903d81f20d3948c41ceb47ccbb4bc8062899f750371d5ff85 Root/Photos/PNG/DSC00403.png
    DATA: DATA (Non-Resident)
         8688120-8699175
 25                 2016-08-09 16:29:58  2b6dd7410024c29335480e4b01ecf6bf    8b76cfdfc2c4bc8ccfef9bfa859e0a7d798bdc25 e1ef35ccca901231062b8d831a77e703819a931a5e63e0c23761754798e3e44b Root/Photos/PNG/DSC00409.png
    DATA: DATA (Non-Resident)
         8789800-8795807
 25                 2016-08-09 16:29:58  831472853caf70e4279eb9b10fb95502    946d4e88d33b732e7ebf9e4a76ba8eac5d5efbab 3f124d3163afa23b01b70667de6c4eb8ae56763bca0def60a74f24f7c9eb434c Root/Photos/PNG/DSC00410.png
    DATA: DATA (Non-Resident)
         8533056-8539335
 25                 2016-08-09 16:30:00  554ec19309cce9e77234673957d843a6    4487afbe76ff4de2a255a2cf1b3c428c46ac0fe1 1ada79bc031064a27353aea69860a3edd9bcfc6eadbcc9af2c115cad419cc275 Root/Photos/PNG/DSC00411.png
    DATA: DATA (Non-Resident)
         8580208-8586951
 25                 2016-08-09 16:30:00  bbbfa1afbe6caf6d20727636eca423c6    11b5983ecb84b0fd177be00e6319d2598d0e577e 9374fb21b2c7126dfc5f7101471baffff849998d9eb42796a280c448ba95ba68 Root/Photos/PNG/DSC00412.png
    DATA: DATA (Non-Resident)
         8649640-8656615
 25                 2016-08-09 16:30:00  d6596d9f439081baed836fa0c8a28a8e    15c0b00e68f538c8d5ef69b2bc27e9362a8dd439 4cdcf050e903d1daa38d87b04855c7419e44409165d2ea41381c7cb122d3b257 Root/Photos/PNG/DSC00413.png
    DATA: DATA (Non-Resident)
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         8586952-8594495
 25                 2016-08-09 16:30:00  3980b368079e048f6f8eed6d218f1456    97d2ce7c74dfd4a07f6b162b69b822945e50413d 073a2f3e47a5092e8877a46b441a3f95eaa73d1e7558c746ca833b87dadc1013 Root/Photos/PNG/DSCN0108.png
    DATA: DATA (Non-Resident)
         8635776-8649639
 25                 2016-08-09 16:30:00  3af85c982fdaee46f578fcec569f037e    36a556ffd3c56988dcec87a15b61c0a916132be3 c412553bcb7e21e6cf15e377873ee80738a6b6f9990b4e84fd7fa9b1db44a95f Root/Photos/PNG/DSCN0109.png
    DATA: DATA (Non-Resident)
         8594496-8605119
 25                 2016-08-09 16:30:02  c1ac17a6c98f27fbeac401359f14b515    e6b6186c29e38ea7dbda9ba4b8c242732d4b2241 3bb72a8e56f4f4f36760fd9256a366690650f54f8202d789bde31af8535fad46 Root/Photos/PNG/DSCN0113.png
    DATA: DATA (Non-Resident)
         8778744-8789799
 25                 2016-08-09 16:30:02  03d72084aa58d9ce060595bcfe0257a7    973a861c8388d4caac711f847005e944edb50d13 b2ce7f5ec69b5418bc723a160f4cc8780a9d3184efb2d3de220d0cb848cb6c33 Root/Photos/PNG/DSCN0116.png
    DATA: DATA (Non-Resident)
         8750584-8762567
 25                 2016-08-09 16:30:02  a066c510d6c6ae3227d4f675abe5b0f1    b2ae56bbcbd1962ba46802878e67b96dcf384673 1344199eda7438278493240159d4547186da9e9f485480bf7b435f4184a12835 Root/Photos/PNG/DSCN0117.png
    DATA: DATA (Non-Resident)
         8738944-8750583
 25                 2016-08-09 16:30:04  d5dfe820657d381ad10740edc4536a67    6b7e5f77db5bbacb5a5516ab6bbe20e19b928d48 3bd8b74067d514bd306318489cbbfd056aaa25a7cdf19e888198e35e56259e37 Root/Photos/PNG/DSCN0121.png
    DATA: DATA (Non-Resident)
         8615928-8635775
 25                 2016-08-09 16:30:04  9a667f59d860a11fb4a0bda9f6fdf0d6    9a6cc2c151aae01c03fe955fa44b5e1e482d5ce7 7759c44a7b384eb1c5bd0e351bfd91a7a839f1ac4bfa7ab813ae5c48514a2bc3 Root/Photos/PNG/DSCN0124.png
    DATA: DATA (Non-Resident)
         8661936-8665815
 25                 2016-08-09 16:30:04  2c08bc733d7461eeac2b1a9af2b9f360    dc4fe2772c7392aa184a9f83fd9a34114024f5ef af0c4ab532fca75fa8f84b80a0d7fd6b3d9593f531ea989ba84b8b7f94d6a3b7 Root/Photos/PNG/DSCN0125.png
    DATA: DATA (Non-Resident)
         8665816-8676391
 25                 2016-08-09 16:30:04  0a5e03889a84d667baabdd3094e61025    ec6077f5b83a2f683c82a7279511a6478fe98f91 f85747e4ca8289fd1ef0c96fddd7aaddf70b3733c2a91054f762968ce8ee6942 Root/Photos/PNG/DSCN0129.png
    DATA: DATA (Non-Resident)
         8762568-8772479
 25                 2016-08-09 16:30:06  5ee9282489f0903303703bb5d77d439a    d5da1618ec1281d2e48e8f74fdce2e1eab40576e b5be34d6680d6ea87ae54801dbb57cb720b2bd872dcfc527a8550c895c03727b Root/Photos/PNG/DSCN0131.png
    DATA: DATA (Non-Resident)
         8676392-8688119
 25                 2016-08-09 16:30:06  9e953995ca786148098b427656a60e35    090f7c89de46092ea19b3b0a0f8b93300bbf0dc6 46d66ae03cdb2566c5893391e2c8cdd3f8402914bdd635cc9def0d46c7bfb23d Root/Photos/PNG/DSCN0132.png
    DATA: DATA (Non-Resident)
         8729384-8734135
 25                 2016-08-09 16:30:06  cfe7fe275b90861aa58433e1aaada445    84afbdceb6f06bc5fd4ef5ae58a7417357d2b5fb 5edfd80300f07e45c8484d52c005afe83c00b56df1e56f3387ae2047120c4729 Root/Photos/PNG/DSCN0133.png
    DATA: DATA (Non-Resident)
         8711368-8729383
 25                 2016-08-09 16:30:08  ca234fe6fa2fc56916c1450e9fcc891a    f62c36132b14d9afa36d1a2927cb4c5f2bba9705 7462ead43cbfbee4df6e1673ccc2d08800641de9b32f905f0f85dd7196a916f6 Root/Photos/PNG/DSCN0135.png
    DATA: DATA (Non-Resident)
         8605120-8615927
 25                 2016-08-09 16:30:08  2c386dda664658d66050e7cfd9d869fd    7ca02cbaab88968b2b30e34b2d1e81cd9fe0b8a4 d219ab0e123d60887b31202dae8c68045518346d90511b86d3c908c763b58b2a Root/Photos/PNG/DSCN0136.png
    DATA: DATA (Non-Resident)
         8567496-8580207
 25                 2016-08-09 16:30:08  b2b1be511998f2e630475d164efa0c3d    1482b7550f5f958eb62e5c3a77a13b594d33695f 7d580fccd6dfb31cca059dfd4032ec4793de0acba9c3ba89ac63fc3724f5b4fc Root/Photos/PNG/DSCN0138.png
    DATA: DATA (Non-Resident)
         8772480-8778743
 25                 2016-08-09 16:30:10  28c3d52822bcd0eb7123a20f9d0f71a0    0add9ad208f1878ee29f26f74746591c81377934 ae8696cbc2e7427fa257d6760471a8aa8255f6c17e5ade05c8c83874e8c765da Root/Photos/PNG/IMG_0301.png
    DATA: DATA (Non-Resident)
         8539336-8567471
 25                 2016-08-09 16:30:12  f5e5a8ad113cf60301cc3038738018df    db903a727602dca3f285d4c837bb7b04591dd260 229324830ef256de4a568105244876dc6cb38c7fcbc883b23d1ceb599c10d529 Root/Photos/PNG/P1000075.png
    DATA: DATA (Non-Resident)
         8458312-8480991
 25                 2016-08-09 16:30:12  dbc0c95df4c2b4a16fd5d653a03e3a03    3fde4c2902804033cfc33f70292b5e840b649917 f257c37d5437b8f38c33d97f2df239fb07990af33080676d5721a798c3fcd268 Root/Photos/PNG/P1000076.png
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    DATA: DATA (Non-Resident)
         8515072-8533055
 25                 2016-08-09 16:30:14  a3df8bed38651d33eac4b21dd6a001e5    20c969a51774ada67c4488028b73fe5db1883ef7 9475b205dded40cc9b42d5c9a5ac75021fba4c068f4e1aa5f984e4b42930a1b5 Root/Photos/PNG/P1000077.png
    DATA: DATA (Non-Resident)
         8493088-8514943
 25                 2016-08-09 16:30:14  7262d86f98a816ac5aa19d5000fdaa38    ca5a2244d3bdea722af50db79459d4f56ac29aea 19265744bc50cc6ebdb7dd30c358d350d589827ce088da6b12a73d7bcc6b8415 Root/Photos/PNG/P1000078.png
    DATA: DATA (Non-Resident)
         8814088-8835751
 25                 2016-08-09 16:30:16  20f2266bc91a926c0af8fb8890b39cdd    a3d919d08dfae21239593898960b415f4fcad938 c8fa689c01b91841af197ff442ba4aefb5673021bdcc4e9cfd9e40504ac381df Root/Photos/PNG/P1000079.png
    DATA: DATA (Non-Resident)
         8835752-8857511
 25                 2016-08-09 16:30:16  b3943271dec5e1d6f8f98ce41195a573    9fa3da99f4a4ca7c1370f8c91d4789e3d6de658d 60bacec13cd11f0b094df945f9024bff7b916d8491cb3219085c7d1e22322bfc Root/Photos/PNG/P1000080.png
    DATA: DATA (Non-Resident)
         8892544-8913943
 25                 2016-08-09 16:30:18  399f7ca061e54f792c0842ddb75abe08    f70bd20e4ae6d08da136889d32d066f6fdf17089 fe0f4d8b2cb268cd92235375fcb5df2445c27498c663ee64f3e84a5d97931246 Root/Photos/PNG/P1000081.png
    DATA: DATA (Non-Resident)
         8857512-8879191
 25                 2016-08-09 16:30:18  badbc4166c959a41bc77820f2c1aa5ac    24d11bd0f46e9598a4a5a09e7c2c250f4c0190f1 fb9a16f920b54863194096ebdc384445f0fb82d3cdbf1224607fa46b6f72a6f2 Root/Photos/PNG/P1010289.png
    DATA: DATA (Non-Resident)
         8418776-8441343
 25                 2016-08-09 16:30:20  3699a09b4d90e3e0466d2e025ac71f38    db77c0005f5554eeb928a28e642c20b1c1c19459 424a8ae233c30ce4931ef37b5d76c6c335261af36b76af9bcb2e82e2e67a4c7a Root/Photos/PNG/P1010292.png
    DATA: DATA (Non-Resident)
         8879192-8892543
 25                 2016-08-09 16:30:20  9c8dfa6629ca4056b66ba70df36b6155    3014b48f9d129411703968c62347a6741bde31da 397078f5d412f0dadf993efbbc6fc986e107bbef03a8e88a59f26d62ee629833 Root/Photos/PNG/P1010296.png
    DATA: DATA (Non-Resident)
         8795808-8814087
 25                 2016-08-09 16:30:22  449a39e60fb73cd06792eb33702e3fd2    7aa3459012435f09a2abfe5d2aaee35beea20e8b 70c8b6f17dfe2770bd089fc1c837863743d638b991eaf382713adb536cd14338 Root/Photos/PNG/P1010299.png
    DATA: DATA (Non-Resident)
         8441344-8458311
 25                 2016-08-09 16:30:22  ee784f441db80e795a4f50a5ed06bc31    f544a576568271f1a70995fe83bdc6926351b954 9d17e3ea583d57ca7d2b2abaa7b0f676a098d0e2e8508085eee3dd0df639f32e Root/Photos/PNG/P1010302.png
    DATA: DATA (Non-Resident)
         8384448-8396799
 25                 2016-08-09 16:30:24  9b2ee5928e602ec7610cad42538a2ea7    c8a6797e0898840a416b40a71facdc991badd151 b3520b16941b9a6a82db76978bad29faed5bd1af715f9f8d0a9511e830e51c39 Root/Photos/PNG/P1010304.png
    DATA: DATA (Non-Resident)
         8480992-8493087
 25                 2016-08-09 16:30:24  1bfbd10558bb2dd12cadfd3032b78572    fec0d4502b9ff0d5b892e00edb5f8a7a391f79f2 af314883ec48e419f8dfdf653c212be1dd9664af4f1fce7dd6bd56becf925b1e Root/Photos/PNG/P1010316.png
    DATA: DATA (Non-Resident)
         8396800-8418759
 28                 2022-03-03 22:08:01  Root/Photos/SF
 25                 2009-05-30 21:13:46  be7dba7a3fff3748f1f438b728b279a4    3cc2043ed0f732f71cf92f505fafb9e8282925e2 9249d50a8d9054d2bc182f1504f085621c8db30e7fd3081b5dfd83f5d9890c3a Root/Photos/SF/IMG_0869.JPG
    DATA: DATA (Non-Resident)
         9028816-9036039
 25                 2009-05-30 21:15:56  999611c3e27def28c94708e9b6203db8    34b2fda8e0db1bdee804c403574e0e067e07cb13 71f3335d6e50b888d6f80b57c2408921466623ef90d1a6f33b6c5e8a775573d1 Root/Photos/SF/IMG_0873.JPG
    DATA: DATA (Non-Resident)
         9109336-9120823
 25                 2009-05-30 21:47:26  ca72b6c55f22a45908b24cbd8bf29a56    4a6f4ab37a9caa41ba1b8f5b97d81b4c157d9d20 84b973d5bafd5fa96a9c62130536c457d0f67e77db155e41f819a83d13867d52 Root/Photos/SF/IMG_0890.JPG
    DATA: DATA (Non-Resident)
         9080824-9091887
 25                 2009-06-03 20:59:04  bfa7e431bf44e036bd8c6f77179e7543    c501d565c9570983c7be391ad6c4175c23d8e077 e77e31291d871816c80055edee4ad8c650617c58f4dcd55b9492b8e5a07742ca Root/Photos/SF/IMG_1739.JPG
    DATA: DATA (Non-Resident)
         9145856-9154191
 25                 2009-06-06 03:58:08  1854c9f44cc66810600f955e7e57bdb1    4f878ac70788a0b2942afe7449bb2b13adac23f5 e4503c9868e27b7a333e69624fe3b7d62e2ca932e1990fd96d0fc22102111c4d Root/Photos/SF/IMG_3460.JPG
    DATA: DATA (Non-Resident)
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         9120824-9129799
 25                 2009-06-06 03:58:26  6f2ac54948b5b30ce16e477c66e111ce    6fc0971621d0185a8364b15518eceb79d39b4d9e acafd581b254a3c004a962a13f4cf37197819770b7b8b45d12315d7f74f8f243 Root/Photos/SF/IMG_3461.JPG
    DATA: DATA (Non-Resident)
         9129800-9137815
 25                 2009-06-06 04:02:50  2a052e493fbcd7cdd55a850a611cc445    442be0bacc541cfd913bfd9322b6fd453359f39d da4c8a85efc46392dba681825a0a4eecd9a6a3d1d0f33b233638d89ea5ff981a Root/Photos/SF/IMG_3476.JPG
    DATA: DATA (Non-Resident)
         9137816-9145855
 25                 2009-06-06 04:03:22  44652638deef4f478e07706566550c61    b4393152bedf73c7c5df083b42ff7843d4602f67 b5e555ca283d8ed1b765f12312f87c3c311ef157dd8bfbbe6f1392dabbb770f1 Root/Photos/SF/IMG_3478.JPG
    DATA: DATA (Non-Resident)
         8946648-8956359
 25                 2009-06-06 04:03:42  3872c8067f88768007a636d612c3650e    d32f3acf3b3deeb86916106fa7d9c4537979d9eb e9af47c22716e1d660cf85cb51b096a331f74f6f630fda53e941e3fb61000e96 Root/Photos/SF/IMG_3479.JPG
    DATA: DATA (Non-Resident)
         8956360-8965119
 25                 2009-06-06 04:03:48  035c6628e8d5bbed6287bb85cf6022b2    aa888343c7b2cc0b633cec47a12ac1b984f7ea99 17475eae12901a87325a745dd90adae4565f5de89f122c72a6bb64bf6de96304 Root/Photos/SF/IMG_3480.JPG
    DATA: DATA (Non-Resident)
         8928128-8936903
 25                 2009-06-20 22:00:56  e41f63dcb998da55a02dd60fa505bcdc    a0abbb34ddd702d6497978d1f48c92aff7f7cf31 02f936f3ba9a24f0fce9c3fa840780d36bf7eb6b01671312c085aa4c54b43ddb Root/Photos/SF/IMG_3481.JPG
    DATA: DATA (Non-Resident)
         8921208-8928127
 25                 2009-06-06 05:50:22  22e77e0803b18803256074b4c252bd88    6f562ec7317481dff469c03a3e6390f9c370f00d 036c2c5dd5e4b22b3894b3a45dd6bec0da5ca5330b3d0031c40a4e32af2634de Root/Photos/SF/IMG_3493.JPG
    DATA: DATA (Non-Resident)
         8936904-8946647
 25                 2009-06-06 05:55:56  1300d583c82fe612dd57d3ad910a9486    0e57692faeabc7845441bd30ac282f2cb83f29f1 6f6f10a14c50635a84a63fefcc97845831f0dbd5f78d54e6b16589462f825926 Root/Photos/SF/IMG_3535.JPG
    DATA: DATA (Non-Resident)
         8913944-8921207
 25                 2009-06-06 05:57:38  8b1353ff9495552a19b0bfeec5394247    1f4fe5885358892353a875c06b616c9cfe14d81b 69b90255a3a0f893a3e7565c69f0cec869ed2bce143fda09e4c1ffc99a6c00f6 Root/Photos/SF/IMG_3542.JPG
    DATA: DATA (Non-Resident)
         8983928-8991959
 25                 2009-06-06 05:59:32  cefa4e580592809baf1c00cefacd93f0    7c871f52b0f04cd6ceb2e6bce43164157eef6234 965587104c3492b03b42fca3c7f84ddadcf789462f1b0d46bb972b3d6466bba0 Root/Photos/SF/IMG_3579.JPG
    DATA: DATA (Non-Resident)
         9052888-9060919
 25                 2009-06-06 05:59:40  9143872d4928619a667153c4ed3a303c    11cdcf422af6bfda3857dfa92b38eb9095c9d242 4e8e53a15940b4c9aa50be4bb088aabfe42734e5b31259f750d0fa1db4f0b1e7 Root/Photos/SF/IMG_3580.JPG
    DATA: DATA (Non-Resident)
         9011840-9018703
 25                 2009-06-06 05:59:48  a545a740177ead5214943f35115e2d84    1897045c018a11183ab3acf9e4ba123e666508f1 6fed1d2964c18f82e7d5ea8f5d3077c09a56d8536359cdd81147299abce60b47 Root/Photos/SF/IMG_3581.JPG
    DATA: DATA (Non-Resident)
         8965120-8973495
 25                 2009-06-06 06:00:18  74896797a5afc74f9d257c087a2d7637    407583fd0347dfa12f33662d334d230facd3b02d 4a825f744198f83421b6a61bb96e5bce642f3256bfc16178e674e3ddb5a42eed Root/Photos/SF/IMG_3589.JPG
    DATA: DATA (Non-Resident)
         9100248-9109335
 25                 2009-06-06 06:00:22  191bf4eac6e4bec6779e857609448a0c    1f9531e936ae6efdf1328c4b55e22640860e2f98 e872c99ba38c4110b6175cd3cf1e5e7fd7efbb7ce3062d96ab6c5eaa140323ab Root/Photos/SF/IMG_3590.JPG
    DATA: DATA (Non-Resident)
         9071248-9080823
 25                 2009-06-06 06:00:22  d8b25a6d107fa25e67c01fd1691a840a    ea92863dc37bf6d1c9d2c8f29f16424c4f768bf6 18a4871a2a3fbadb0d29653d8588b4fb32e41b9a3c6637279279384675f12dd7 Root/Photos/SF/IMG_3591.JPG
    DATA: DATA (Non-Resident)
         9091888-9100247
 25                 2009-06-06 06:00:22  be2a41a0f6c956b0a9105cbc81366a86    6f62e8ea9a06e82a63f796eb532be7ecdeebfd49 b68f3bad91756a3e13652c6195c2884b7867f2a13cab485ce2cb779ac36f7754 Root/Photos/SF/IMG_3592.JPG
    DATA: DATA (Non-Resident)
         9060920-9071247
 25                 2009-06-06 06:00:26  482bfbc2665903526f3bb328d70bcc68    61deca50b2413161e868a249afd24fa696f4cb33 fafd55132f1cc69b75470ea0c745d694240e7184b46af5c4896a0bd741f28c60 Root/Photos/SF/IMG_3593.JPG
    DATA: DATA (Non-Resident)
         9036040-9045751
 25                 2009-06-06 06:00:30  157a7a625ea640ff216ef35c01b20740    69d556d9d0b24e42803719f268abacb8a9b13312 428284f5eb2a1955514beaff192dc352276b4ff2630f8c45418a361be6194c9d Root/Photos/SF/IMG_3594.JPG
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    DATA: DATA (Non-Resident)
         9002232-9011839
 25                 2009-06-06 06:00:32  b36d08d7fddeae5a02bf023c82f6ce6a    9e42ca16ed3796bf4e5999a2984a0b02b16e0c11 3f26880ee0c4a655f47b60537967f1c4343884a8641c21ccb6f217a51298b4e9 Root/Photos/SF/IMG_3595.JPG
    DATA: DATA (Non-Resident)
         8973496-8983927
 25                 2009-06-06 06:00:34  298393890a37472a688a82e7bbc13ec7    03c15b242f3f0b7c82bae05898db3ad4bcd912cb 84a890dd1d913c5daccd41689890c1156ab5d45f36e34563f0c018bd145579b1 Root/Photos/SF/IMG_3596.JPG
    DATA: DATA (Non-Resident)
         9018704-9028815
 25                 2009-06-06 06:01:28  af118fa168b1e768805bab011ed79ec3    9b25a5144660578d6cc32f6ea8c363460cf3f683 f0f404ce95f1b8b1e78a1d396f3bcaebb675663ea1f1456de1fd929580a5f4a1 Root/Photos/SF/IMG_3608.JPG
    DATA: DATA (Non-Resident)
         8991960-9002231
 25                 2009-06-06 06:02:36  84013837a9cd3be6cd35dd5afb77099b    946ed167cd548dcf48f35ee0990010941789cece dd15a8d44aae3e54207f8cb5f0f4f214f0676b882f596d41009a03f2f6a72546 Root/Photos/SF/IMG_3627.JPG
    DATA: DATA (Non-Resident)
         9045752-9052887
 28                 2022-03-03 22:08:08  Root/Photos/Vegas
 25                 2009-05-28 07:46:20  0f5cb6b4dc609659f4ce7e5a1c4c01aa    fca842cc27792be149e0186d246d9d9c40c28ecf 5b38b41aaa5e3ecf533862027673b0d4179cbcc3fdfd44e99aa2d701b4025a6e Root/Photos/Vegas/IMG_0510.JPG
    DATA: DATA (Non-Resident)
         9154192-9162631
 25                 2009-06-20 13:42:42  c5497d040ee9ca74aacb1a627584620b    5b0a9e275afe04aee280915acb838038dbc72eab 1cfb5f3818b7930f31a8e63762a5652badd4a1e58977f5954e2bac8507d1d71b Root/Photos/Vegas/IMG_0516.JPG
    DATA: DATA (Non-Resident)
         9171136-9179655
 25                 2009-05-28 07:55:54  be3c022f27e9b50f54fde9ed2926716d    e9b1ad5e0e40903ed58448dbf90701db4ff4f4bc 0ee032b760e54100eb1fc9db986ef972a23094fb7b94edd1907f94d52a0ca3b5 Root/Photos/Vegas/IMG_0525.JPG
    DATA: DATA (Non-Resident)
         9179656-9187303
 25                 2009-05-28 07:59:50  0d30cbcb374dc62be046953738a90523    df8f55969022328fb652f8141b41321bf855deb3 c57233f22715b0a50cbd90e2b48acda7aaab245a8c31bc9a45aaff16373d9675 Root/Photos/Vegas/IMG_0539.JPG
    DATA: DATA (Non-Resident)
         9162632-9171135
 25                 2009-05-28 08:00:44  277f3865011837bc68612c72eb9a2691    b6e63a75c77639cdade2a42ca29d8eebb1e5023f 613c9c7ee324ae96857260ba9e56a1d3145de5ab368331035854a555c7cefa5e Root/Photos/Vegas/IMG_0541.JPG
    DATA: DATA (Non-Resident)
         9231464-9239143
 25                 2009-05-28 08:04:54  77acf0f1d75d65cbb59329f3253e4030    6a4fd9123679ffcfdf3e0aa00a8ab81946bcba8f 6fa349225b5fd265133ff2bd8b5d780154bfe47bd1ee00c754181fe10dbd90fa Root/Photos/Vegas/IMG_0542.JPG
    DATA: DATA (Non-Resident)
         9223760-9231463
 25                 2009-05-28 08:05:02  960983bce3dfa5e34935b215f0e018ce    31a3b17c2f0b01d6924ca2c0bb82c25f1aa76de3 b52a36769aa422b741ef739e8f8bc5fe7b820e31bbc0954f5a07f028c4c8973b Root/Photos/Vegas/IMG_0543.JPG
    DATA: DATA (Non-Resident)
         9216792-9223759
 25                 2009-06-20 13:42:24  06ce765c697ea92ab4782b4696174512    f3dcfcfc2e2ddd9a76ac0d172c1ee07c62beec8a b2b195f7a62c89e5b1f9b45c3016a5e53b90b3cb8e4d6ad517d1c05b5750d0fe Root/Photos/Vegas/IMG_0545.JPG
    DATA: DATA (Non-Resident)
         9194360-9202231
 25                 2009-06-20 13:42:18  b2f292f1694c9d12f2b100abec8e252d    039efc71f61ac6816f7d53f0cecabf6a64b8122d c10eecef25e4a6d7650e4c239df01192e5c700b24b8bf275768bb8de3d881cae Root/Photos/Vegas/IMG_0547.JPG
    DATA: DATA (Non-Resident)
         9210272-9216791
 25                 2009-05-28 08:09:00  f7960866200a1f52ee74a46ebcd9761e    f09b4b253fdaa5bdcf8b425111492d1ece716488 3184ac48cc4db4822d2df1ef5539e413473705fa478aa1d467eb0fcd21ee182c Root/Photos/Vegas/IMG_0550.JPG
    DATA: DATA (Non-Resident)
         9202232-9210271
 25                 2009-05-28 08:09:10  4ac853b049966e9cee7e7cdf9894eb9c    30e71ec78c93e590083c26222afecfcb377766d6 5043a207a823a52d556a2532bd92e3c104941793efb1e7cbc417baa2451b72ab Root/Photos/Vegas/IMG_0551.JPG
    DATA: DATA (Non-Resident)
         9187304-9194359
 25                 2009-04-29 13:54:46  3feacbf5dd9afc05143f12a55f0536f0    acf18fc7824c46e2107113e28438a1a7f3d5364c 501d7f5876228466260bcf200bed3e71fbf362f9f7f5601cf45ff8b7e3dd792e Root/Photos/MyPhoto6.JPG
    DATA: DATA (Non-Resident)
         9339024-9341223
 25                 2009-04-29 13:55:06  22bf64446fcd3a630ab17bf839de6e7d    6e023a946c407fb59b2b96216f46b6d0e7f4081d d317be69a99418cd6c1aa628837db02537b04cd2c0549099e2f5edc7f4361c40 Root/Photos/MyPhoto7.JPG
    DATA: DATA (Non-Resident)
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         9341224-9342911
 25                 2009-04-29 13:55:30  cb4bed7e6405a90b65cd80ccbec04928    6581e5cc10659704ea5d98b81a7a326ab9640a26 94f3d3b0877947b05a4e4a6be15f9caa590ff9a9dbc3984b65bf5ea9760758d8 Root/Photos/MyPhoto8.JPG
    DATA: DATA (Non-Resident)
         8291024-8293023
 25                 2009-04-29 13:56:50  2abc60a295d7e3eaa91cb7ad92efc788    52de9551e8710d6978e525194b8e9cd3a44ea992 20141717c1bfbf42901603843fdd360a56ed64af6865fdc61197ec48fc89807b Root/Photos/MyPhoto9.JPG
    DATA: DATA (Non-Resident)
         8284120-8291023
 28                 2022-03-03 22:08:10  Root/Video
 28                 2022-03-03 22:08:10  Root/Video/Avi
 28                 2022-03-03 22:08:46  Root/Video/Avi/Cops_Season_24_HDTV
 25                 2016-06-06 08:18:26  7f0357f25d88e1369c8dc1acd0aed663    317dd884a8bc77e96e7fd1656e4aed35d077b0da a48313a5f5756abd792ba5fa1da6e92f9caf0a7511435e2f5dcfce5250bea41a Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E01.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         15153544-15511559
 25                 2016-06-06 08:19:24  8dd47bbfb3420f7ff4b0b101e8cad36b    1fd74b806f952314abfecea3fbd56b0560ebb315 72a952dc62b83d078327a25c5e0d81e6027e684238c7b1bcf02c1c29e8f097ef Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E02.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         14080408-14437799
 25                 2016-06-06 08:19:42  e389377f24ca35cc802aa90d821a246d    3f4c33408ad18287d5f1dca0b474c208748c7002 8622c265f0c0533bd756b0b45fdbf661c23370c093c8a708b14a503238a2ad9f Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E03.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         11574840-11932863
 25                 2016-06-06 08:12:38  5e828eea4a7d198d5d029eb6a5fd8a97    5f696a6568215a658415bbf736098166253c7bd2 ce10df567443f9c8211655bf9c62071d636dd5106f334efbbf22d57b62e0a256 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E04.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10858024-11216159
 25                 2016-06-06 08:17:44  409e0f6332db4c12da861cd3cab5ae14    6d21926f26bd26e3730274b37ad69731219c29f5 e8b357b3f488e04276a2f1dfd9147e8f1b73e4a5a4ad7854abebb1e6a83fc379 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E05.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         14795712-15153543
 25                 2016-06-06 08:18:58  b55ee3db70b62f883db5573a5746e4d1    08c309ee65b69c1a937f447b9b45e95055ad422e e39d39283cd4fbee2a5e4e59dba6751c4b2be36eedfaf0ad4d2b3e904867dd9d Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E06.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         13007272-13364895
 25                 2016-06-06 08:17:06  1febb45222f9f114e88c533c36f8f29b    b1656a3eb4766af43e31b46defb3827be551bfde 42513d7f9738dd06077f8e2636cdb6852aa852bc67316cbbc45b6bec5cff69c9 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E07.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         12650056-13007271
 25                 2016-06-06 08:16:18  0ecf424d46e619cd1d09bce2dae5b570    a15b481e4083022254c0ff9aa85f369782a7c87b 7240d9aed4d0129139f9d817bd1beb140f2c46b226e77570f083387e54a04ebd Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E08.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         15869552-16227311
 25                 2016-06-06 08:17:14  88b3f03a9e20f9b2310dde6cd0296fca    b839c39d53c22c5e8a46cda745f0c90ac86ac38d 2b61dad5b94d79f8b0e202db5dc30f5a581f1093b588a16354701419aaeb6ebb Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E09.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10141352-10499319
 25                 2016-06-06 08:19:18  de1cf8808dff26c1b4398220a8913dd1    139ad01952126d3294c49e4f2258168462f4b61d 3a70dfd2993d0ae572855aa7a20847d58a0e8823fba77e0e136a9a2a92b0bb6e Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E10.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         12292144-12650055
 25                 2016-06-06 08:16:50  216bdd9f74a00a7a9b4383e2e655ef58    47bdb9493dc69f0aff6c38536f3100cca3c6c3f3 ed4d42a3c4162a16da28f21d85a2dfb53b0f07fe005b9012e573717fef70af59 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E11.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         13364896-13722703
 25                 2016-06-06 08:17:34  51bf22c8ed46f23cd1efde24952d305e    a090ee7373d093cf91ee3afa42decbbdf5f43d6a 72d917ebda33cc238fa1bcada877f7949ff460105e7467d2c314a63fd1224740 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E12.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         14437800-14795711
 25                 2016-06-06 08:19:32  ac81e8b5472ca54054c8e57b6e69b1b0    bdb5963313cf1cdcbd9d7ae2e66daf8b669000d6 eae261da6d61b544dc42c8843ab4752496fb4869fcbff869baa9f62ea47b9ee7 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E13.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         11216168-11574839
 25                 2016-06-06 08:16:28  8d99cfc73a09a48825a276375bfad763    735aa03db094173277fb702ef0c7d96bdc8e11c2 052e121628b631a3154d04a2b30774340fdaf0e4593b9b751187f867b2c433e3 Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E14.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         11932864-12292127
 25                 2016-06-06 08:18:52  6c498108cd539cb1b05c813b8e91893d    843e634c0def9751870c8bbe5087be478211d62b 42d916b97a81a2147ef5e03a9e07dab0e6db4d6b148693492644f539ebbf1cdc Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E15.HDTV.XviD.avi
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    DATA: DATA (Non-Resident)
         13722704-14080399
 25                 2016-06-06 08:18:10  0e418b50264b2bb748f031e1250de762    b6a7edd6909b1ff6e5d6e85b6cd3734a8ddff4ef 9286b40a34a4fae19a24117c179cca4f4493f54341dc66fa2255e49eb209c1ab Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E16.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         15511560-15869551
 25                 2016-06-06 08:19:08  65fe333f28d8c5f27d21a2445d95fa91    f6ed23e660b1f8559e5f7151ee16cd583e3fc353 344d36ce2ecefe1d3676197f247dca485e37be2282a469aa2fb2a219907d737e Root/Video/Avi/Cops_Season_24_HDTV/Cops.S24E17.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         10499528-10857975
 25                 2016-06-06 08:18:18  514b0659f98a3c45202f1cc8a125fe61    1ba85643445ac825a4d4a5281020d6f82b5bc69a b99c92603b97699ed7aa10a4e7f21fbd92a4cd8688a4083e33e8a4c54049aaba Root/Video/Avi/Cops.S24E18.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         16616128-16974239
 25                 2016-06-06 08:18:12  0e6f2a5dea0e8a1e4dd33ad2c99395cb    9a0b653b3820ba4dd0d78ae94d0da524ff62567a 133cccd202e162aa8f52cbf289351dcb3414d78cfb82945ae49233b4d245d907 Root/Video/Avi/Cops.S24E19.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9785232-10141047
 25                 2016-06-06 08:18:38  f3704970997f2eb8af3fb9dd2691f7d0    580ca470463e58d4b29eba6471081910b7b4ebfc 3544a68251c3b273675eae72431be23a3971057c6c18292bf69f71cd5b42590f Root/Video/Avi/Cops.S24E20.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         9426848-9785231
 25                 2016-06-06 08:18:48  ba81e0c6597f2e3898535fb78ffa0ccb    7f537260ad18099950dcc69964de66ceb45fe176 3797d035d4b503fa1c8b05153790ed1371394b7d549589219955d75c77abedbd Root/Video/Avi/Cops.S24E21.HDTV.XviD.avi
    DATA: DATA (Non-Resident)
         16974240-17331143
 25                 2016-06-06 08:19:38  f61d04146b1f1e8404b1a16e9adfab5e    306ebaddaa2d57688f4e5888cf5363da207e3f28 ad0d94c09fb496f2f2177c0d6de71ac3d8f2188c1631676ed713acd251b3f406 Root/Video/Avi/Cops.S24E22.HDTV.x264.mp4
    DATA: DATA (Non-Resident)
         16227312-16616127
 28                 2022-03-03 22:10:48  Root/Video/Flv
 25                 2010-01-06 01:11:42  d2ef7350396693de9389e8b39774b4d7    31920aa00dc386e8d2e1889f80c7b170560d349c 38a0753248b06cfca4ceeb4bc67198214216bdd2313e0d8cc3ee641471054766 Root/Video/Flv/Better_than_me_flv.flv
    DATA: DATA (Non-Resident)
         17331144-17347239
 28                 2022-03-03 22:10:48  Root/Video/M4V
 25                 2012-08-22 18:36:44  968139c8f965b32be629b5eddac23382    3d4ab462a46e985f61e55d3d293598ae658179e9 d84d38f3792764ab30e3d735da22c5977920c92a0339d46055d5710b40e008bc Root/Video/M4V/general_hospital_fall_2008_promo_(hq)_m4v.m4v
    DATA: DATA (Non-Resident)
         34985736-34987727
 28                 2022-03-03 22:10:48  Root/Video/Mov
 25                 2015-10-11 17:33:14  53bd8bd63f73df2e647b20ac336b5184    3847624df92163b5857177e06fccfc01f09655c6 4b5af7cae10bd584f7ffcfd7c6a690a8df6f12bf4a5d54e83fdcec6d44d6ae8d Root/Video/Mov/FILE0031.MOV
    DATA: DATA (Non-Resident)
         37651640-40315327
 25                 2015-10-11 17:48:14  4d0737f26d565e7ade41c1eeff0e7cae    9a11b89381fc546c638eb8cbdfb1a1f4b892348e 0afc907c0ae3aa8f6ee9a35ec2f863650872a30f9dcc3cb72391f856b7124370 Root/Video/Mov/FILE0032.MOV
    DATA: DATA (Non-Resident)
         34987728-37651639
 28                 2022-03-03 22:12:34  Root/Video/MP4
 25                 2010-11-30 21:58:20  3e3661d0dc6f16a5d416791614623e9e    3d41e5063b1c5b1a4f659c669a2016873578c3c2 553fcee0ff4df6eefc45024c334ff2ddda887031c2d2ce75d64f8a0cc28365f1 Root/Video/MP4/mp4 Haiti_can_succeed,_but_not_without_your_help_(Former_US_president_Bill_Clinton).mp4
    DATA: DATA (Non-Resident)
         17583976-17760279
 25                 2015-09-19 03:52:24  f9d18db99b4d4f3d5d8f7ecda07a283a    3f30923a876e075e0c5735d095fafc71798a5a8f d055ab546e6c24517aeaadc8217b3a56443baf902230c7a41235f6402770e4c0 Root/Video/MP4/VID_20150918_215223.mp4
    DATA: DATA (Non-Resident)
         18349760-18554783
 25                 2015-09-19 04:00:20  b970ad6b6fc339a639a747d43279fc24    226dd51746a2765ebfeb7e58a61d5f43ee8cfcf3 0e2d63dc86db96e93cb84e61724699bce08aa1f68ca17216e98355800ead5038 Root/Video/MP4/VID_20150918_220020.mp4
    DATA: DATA (Non-Resident)
         17760280-18096719
 25                 2015-09-20 18:31:20  050863ea63873886856c1850f89b2872    15e1a4f4ed00ae657cc4892959e2d161d011b84f 64e86ce37f11c639c102721be53d58f6f42302056fc183a701c7cbd6696a0f38 Root/Video/MP4/VID_20150920_123120.mp4
    DATA: DATA (Non-Resident)
         18096720-18349759
 28                 2022-03-03 22:12:53  Root/Video/MPEG
 25                 2016-08-06 21:50:24  8661e7edc04aa49accced6da2520decc    0b7c023cd7f19445e78f11a5d3d4c2058196e307 63a8045b7ee6345adec7079e0e18fe89656e0cb188eb34712614e9b539f89740 Root/Video/MPEG/Mpeg_Video.mpeg
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    DATA: DATA (Non-Resident)
         9342912-9426847
 28                 2022-03-03 22:12:55  Root/Video/MTS
 25                 2015-08-05 13:44:42  28264a21f4babe4c26fd9422ecce8066    ddd8c7b7717e0c0374d50af851a499b9ec11e428 fdaf9826c0bb27005d60b611857f6ac4d81191cfcdd63519343f7d4192208491 Root/Video/MTS/00026.MTS
    DATA: DATA (Non-Resident)
         17377000-17567463
 25                 2013-03-20 18:16:48  c8813d64f8e33e4e41c773d188ce6f62    cd6dae3c9a31db7f02d18bfa8fa493d85b64e64b 1cfbb5d3d93c7725f06a388d93490e112427c640db705dfe90036c98c6db4820 Root/Video/MTS/00140.MTS
    DATA: DATA (Non-Resident)
         17347240-17360871
 25                 2013-03-20 18:16:20  40566a6585ba0440175eed119a32a32a    95776ef4d52ea51062c472ce744de1ef075bdf2f 34cf55b950cbce275ddc1ecad2e9fc0821e4b664d23eeb3270059b3e6e8d0c4e Root/Video/MTS/00168.MTS
    DATA: DATA (Non-Resident)
         17360872-17376999
 25                 2013-03-20 18:15:22  90b17b9d8b04d14b2a72aa1a7ea2c6c8    19ddc6147e3f8d9c628c83cf33525cc859423c00 fbf55ea6c3b86c666c79caaf5c1386eebede4f02b8b70c7c91610effaf874ddc Root/Video/MTS/00346.MTS
    DATA: DATA (Non-Resident)
         17567464-17583975
 25                 2016-06-05 19:36:08  d6b0ce497e569371b94e19fea48355cd    37fbacb48c80859f47024f2382d9880be633477b b08522bb8e9d63c86c290a8c7032f3097fc78db704ea1d54eaaa75934c29de46 Root/Video/The.Lincoln.Lawyer.2011.1080p.BluRay.x264.DTS-FGT.mkv
    DATA: DATA (Non-Resident)
         18554784-34985711
 25                 2022-09-08 22:00:25  878872a0818c4431aa4260f71053236a    345d6f892ffe54f152e9729ebcc55dca7dc7d708 9d368782955688954fb50b80ecc0be3a7c4897574cce09596fda7cf81916523f Root/.DS_Store
    DATA: DATA (Non-Resident)
         7922320-7922343
    com.apple.FinderInfo: MACOS_DATA (Resident)
         3659179
 25                 2012-11-03 21:10:08  9565cf6684e2858bda872890a32cc671    da8c56c8b989ed9c2b42057ac657257520cfe661 beedd667813a9279426cfa769cb39f53156080fe78e73803dcb3206978985b04 Root/Blue Skies (1946) 104 min.Fred Astaire.Bing Crosby.Irving Berlin.Musical.avi
    DATA: DATA (Non-Resident)
         40315344-43079367
    com.apple.lastuseddate#PS: MACOS_DATA (Resident)
         3660133
 25                 2013-06-26 18:58:10  12ab314eb73a4a938bed3d6550da0ff2    22b0141246f4f5c7cf20171645c0f8de596cb35a eada5fecc16cb98c28c54b080319ff79eb20b62a313ed4b6ba5c254a4a3ede7e Root/Mac_mini_Intel-based_Mid2007_UserGuide.pdf
    DATA: DATA (Non-Resident)
         43079368-43081119
    com.apple.lastuseddate#PS: MACOS_DATA (Resident)
         3660132
    com.apple.quarantine: MACOS_DATA (Resident)
         3660132
 25                 2005-08-06 17:04:54  59262f761288b9fd5f1306a80aa25ddb    95f732edc568a3563de4f2fa4410b4b488a9778e d1205b011a0139b8a9c8fcc15ca227a72c7ef575828ff99d747021ebbab04fca Root/P1000075.JPG
    DATA: DATA (Non-Resident)
         43081120-43085311
    com.apple.lastuseddate#PS: MACOS_DATA (Resident)
         3660132
    com.apple.quarantine: MACOS_DATA (Resident)
         3660126
 25                 2005-08-06 17:06:04  33e7439162b60fc39c701fe1d40cdde7    fef0d28922959512f5766b22867100583a83ea27 7645c7b66336c420372c6f4e4b8f3c1d9cf14cff36d6599b54587b8f8a8827e8 Root/P1000076.JPG
    DATA: DATA (Non-Resident)
         43085312-43089279
    com.apple.lastuseddate#PS: MACOS_DATA (Resident)
         3660126
    com.apple.quarantine: MACOS_DATA (Resident)
         3660124

END Date / Time of Collection: 2022-09-09 00:27:44
----------------------------------------------------------------------------------------------------
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IV Text/Hexadecimal Editor

Any object visible by R-Studio can be viewed and edited in the Text/Hexadecimal Editor. It is also able to
parse the data and represent data according to various data patterns. You may also create your own patterns to
parse data.

Note: Data alteration is available on the Technician/T80+ and Corporate versions only.

You may turn numerical indexes for objects to distinguish them better.

· Viewing and Editing Objects 

· Navigating through an Object

· Data Copy

· Files and Sectors

· Creating Custom Patterns

· Pattern Example I

· Pattern Example II

R-Studio Features
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs
Data Recovery over Network
Technical Information and Troubleshooting
R-Studio Emergency
R-Studio Agent Emergency

4.1 Viewing and Editing Objects

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!
Or you may completely lose all your data.

Before you can physically write anything on a disk, you need to enable writing.

To enable writing,

1 On the R-Studio main panel, select Enable Write on the Tools menu

> The Editable: status will change to Yes from Read Only.

Now the object can be edited.

To view/edit an object,

1 Control-click the object and select View/Edit on the contextual menu, or

Select the object and select View/Edit on the File menu
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> A Text/hexadecimal Editor panel will appear

 R-Studio Text/Hexadecimal editor

Data Parsed According to the Selected Pattern Object Properties
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Object Sector Mapping Data Shown as Various Digits

Binary view

Text view

Find Results
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List of Bookmarks

Text/hexadecimal Editor status 

Previous Pattern

Click this button to go to the previous
pattern.

Next Pattern

Click this button to go to the next
pattern.

Save Changes

Click this button to save changes.

Code pages

Turns supported code pages on/off.

Autoflow

Click this button to turn autoflow on.

Panel view options
You may set which panels and bars to enable/disable.

 To enable/disable:

ANSI data Select/clear ANSI on the View menu

OEM data Select/clear OEMr on the View menu

UNICODE data Select/clear UNICODE on the View menu

UNICODE+ data Select/clear UNICODE+ on the View menu

Toolbar Select/clear Toolbar on the View menu

Toolbar Button Text Select/clear Toolbar Button Text on the View menu

Properties View Select/clear Properties View on the View menu

Sectors View Select/clear Sectors View on the View menu

Data Interpreter
View

Select/clear Data Interpreter View on the View menu

Template View Select/clear Template View on the View menu

Bookmarks View Select/clear Bookmarks View on the View menu

Find Results View Select/clear Find Results View on the View menu

2 View the information and make necessary changes

Select Enable Write on the Tools menu if you want to save changes.
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Viewing

There are up to four tabs showing the data in different representations. Actual number of tabs depends on the
object and property being viewed/edited.
Std Exact attribute data. If the attribute is compressed, R-Studio decompresses it prior to

showing.
Unlimited Exact attribute data + free space of last cluster. If the attribute is compressed, R-Studio

decompresses it prior to showing.
Direct Actual data written on the disk. If the attribute is not compressed, it coincides with the Std

representation.
Allocation Resident part of the attribute.

You may view data in 4 various code pages: ANSI/OEM/UNICODE/UNICODE+ by s witching on/off the
respective code pages in the Code pages buttons or select the appropriate code pages on the View menu.

Patterns or Templates

You may select a pattern according to which the data will be parsed and shown in the parsed data pane. The
Data Interpreter shows the data selected on the Template pane in various representation.

You may find the next or previous data that matches the pattern signature on the disk. Control-click the right
pane of the editor and select either Find Template Signature Next or Find Template Signature Previous

on the contextual menu. You may also select these items on the Edit menu.

You may also create your own patterns to parse data from various objects. 

Navigating

Text/hexadecimal Editor gives you various ways to navigate through an object. See the Navigating
through an Object for more details.

Data Copy

Text/hexadecimal Editor gives you various ways to copy selected data navigate in an object. See the Data
Copy for more details.

Filling an area with a pattern

To fill an area with a pattern, select Fill on the Edit menu, and specify the pattern and area on the Fill dialog
box.

Fill dialog box

 Fill options

Fill pattern

HEX Field for the pattern to fill the area in the hexadecimal representation

ANSI Field for the pattern to fill the area in the ANSI encoding

OEM Field for the pattern to fill the area in the OEM encoding

https://www.r-studio.com/What-is-free-disk-space.html


Text/Hexadecimal Editor 281

© 2024 R-Tools Technology Inc.

UNICODE Field for the pattern to fill the area in the UNICODE encoding

Fill range

From (hex) Field for the start position of the area to fill with the pattern

To (hex) Field for the end position of the area to fill with the pattern

3 Click the Save Changes button to save the changes, or

· Select Save Changes on the Edit menu

> Viewer/Editor will save the changes on the object

YOU MUST BE ABSOLUTELY SURE OF WHAT AND WHERE YOU ARE WRITING!

Or you may completely lose all your data.

Selecting and saving an area in the Viewer/Editor

You may select an area in the Viewer/Editor panel and save it as a file. 

To select and save an area in the Viewer/Editor panel,

1 Control-click the beginning of the selection and select Select From on the contextual menu.

2 Control-click the end of the selection and select Select To on the contextual menu

 Other ways to select an area

·  Select Select... on the Tools menu and specify an area to select on the Select dialog box,
or
· Click the start point of the area and drag the mouse cursor to its end.

If you need to select an entire object, select Select All on the Tools menu

Select dialog box

2 Select an appropriate item in the Tools menu to save the data in a required format and specify its file
name

Select: 
Save to Binary File... to save the data in the binary format (default extension is .bin)
Save to Hexadecimal
File

to save the data in the binary format (default extension is .hex)

on the Tools menu.

If you select an existing file, R-Studio will ask you if you want to append or overwrite the file.
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If a remote computer is connected for Data Recovery over Network, the Save as... dialog box will
appear when you select a place to save the data. You may save it to the local or remote computer.

> Viewer/Editor will save the data in the file

Loading data from an external file

You may load a data from a file and overwrite an area of the object opened in the Viewer/Editor panel. 

To load binary data from a file and overwrite an area of the object opened in the Viewer/Editor

panel,

1 Select an area to overwrite and select Load from File... on the Tools menu

If a remote computer is connected for Data Recovery over Network, the Open as Binary File dialog box
will appear when you select a place to open the data file from. You may open it from the local or remote
computer.

2 Select the necessary file and load the data.

> The area in the Viewer/Editor will be overwritten with the new data.

4.2 Navigating through an Object

Navigating

You may quickly move to a particular part of the object. To move to a particular part of the object being
viewed/edited, enter the required offset in the Go to Offset field between the buttons.

 Type an offset to which you want to go. You may select between bytes and sectors. See the
Data Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/hexadecimal Editor , you may select data representation for that file.

 

You may also use the Go To Offset dialog box to go to a specified place in the object. Click the Offset field
on the Status bar. You may also use this dialog box to copy the offset.

Go To Offset dialog box
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 Go To Offset options

From: Jump / offset direction. For example, if you need to find the offset from the object
end for a selected byte, switch to the End (backward) option.

HEX / DEC Switch between the hexadecimal and decimal data representation.

Range Range of values that can be entered.

dec / hex: Alternative data representation. 

Offset: Flat data offset (without separation between the sector and offset in the sector).

Sector / offset Data offset represented as a sector and offset in the sector.

Go! /OK buttons The Go! button moves the cursor to the specified positions, but the Go To Offset

dialog box remains open. The OK button closes the dialog box after moving the
cursor. 

Searching

To search for a particular string, click the Find, Find Next, or Find Previous buttons or the same items on
the Edit menu, and specify the string on the Search dialog box.

Search dialog box

 Search options

Not Equal Search for the place which content is not equal to the string. For
example, the first byte not equal to 00 or FF.

Search for

HEX Field for the string to search for in the hexadecimal
representation

ANSI Field for the string to search for in the ANSI encoding

OEM Field for the string to search for in the OEM encoding

UNICODE Field for the string to search for in the UNICODE encoding

Match case Select this check box to make the search case-sensitive

Search area

From current position Select this check box to start search from the current position
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From start position Select this check box to start search from the beginning of the
object

From Address Select this check box and specify the range in which the search
is to be carried out

Search position

Exhaustive search Select this check box to search the entire object

Search at offset Select this check box and specify the sector offset from which
the search will start

Reverse Select this check box to start the search in the reverse direction

Find all Select this check box to search for all instances of the string to
search. Search results will be shown in the Find Results pane.

Text/hexadecimal Editor will show the search progress.

Search results are shown on the Find Results pane. You may easily move to the required found item by
clicking the item.

Features of the Not Equal option

Suppose we have an object which first 3 consecutive sectors start with:
Sector1   FILEAAAAA..............................................
Sector2   FILEBBBBB..............................................
Sector3   NOTAFILE...............................................

And the search string is Not Equal FILE.
If the Exhaustive search option is selected, the Text/hexadecimal Editor will stop at the first A character in
Sector1.
If the Search at offset=0 option is selected, the Text/hexadecimal Editor will stop at the N character in
Sector3.

Bookmarking

You may create bookmarks to easily move to those places. Control-click the cursor on the place you want
to bookmark and select Toggle Bookmark on the contextual menu. The list of bookmarks appears in the
Bookmark pane. You may easily move to the required bookmark by clicking it in the list.

You may control bookmarks on the Edit menu.

4.3 Data Copy

Text/hexadecimal Editor gives you various ways to copy selected data navigate in an object. 
Data selected in Text/hexadecimal editor
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Depending on what column you have control-clicked, the following commands are available in the contextual
menu:

When control-clicking any column
Copy Editor Display

Data pasted into a text editor

When control-clicking any column
Copy as File Signature

Data pasted into a text editor

When control-clicking the Binary
data column
Copy as "Binary data"

Data pasted into a text editor

When control-clicking the ANSI
column
Copy as "ANSI"

Data pasted into a text editor

When control-clicking the
UNICODE column
Copy as "UNICODE"

Data pasted into a text editor

4.4 Files and Sectors

You may see which file is written on a particular sector. To do so:

1 Enumerate files on a logical disk on the Drives panel.

2 Go to the tab of that logical disk and select Show Files in HexEditor on the Files menu.

3 Return to the Drives panel and select View/Edit on the contextual menu. 

> R-Studio will show a file that belongs to a particular section.
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File in a sector

4.5 Creating Custom Patterns

You may create your own patterns yourself.

An example of a commented pattern parsing an AVI file.
The syntax of pattern description is similar to that of the XML language. The folder where the files should be
placed is specified on the Main tab of the Settings dialog box.

Pattern structure

Pattern header

Each pattern starts with a standard header
<?xml version="1.0" encoding="utf-8"?>

Section template

Each pattern starts with a section giving to the pattern a name that will be shown in the parsed data pane.

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<template name="AVI File LIST">
........

</template>

Section signature 

Attributes:
align <positive integer> Specifies if the data structure address is aligned (i.g., by  a sector: 512)

This section contains elements field with hex-codes of the signature. The attribute offset  specifies their
offset from the start of the record. Field length is equal to the number of hex-codes.

Example:

<signature align="1">
<field offset="0">46 49</field>
<field offset="2">4c 45</field>

</signature>

Section section 

Such sections contain all expressions and operations needed for the pattern to parse the data. A section name is
shown in the parsed data pane. In fact, sections are virtual objects used to group logically connected fields.
Sections can be nested.

The main section is not shown in the parsed data pane.
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Section contain elements field which are actual data objects. field names are shown in the parsed data pane
with their values. 

Attributes:
name Specifies the pattern name shown in the parsed data pane

Example:

<section name="JUNK">
 ....
</section>

List of All Objects in Patterns

Data types (in field)

· integer 
Sub-types:

int8 

int16 

int32 

int64 

uint8 

uint16 

uint32 

uint64 

uintX

Attributes: 

endian: (be | le | system) Optional.  Default: system.
base: (decimal | hex | octal) Optional. Specifies data representation. Default: decimal.
as-offset: <expression> Optional. Specifies that this field is an offset and its value should be evaluated using

the expression. A special variable this returns the value of  this field.
purpose: (offset | rsector |sector | cluster | rcluster) Optional. Specifies the type of the as-offset expression result . If this attribute is

present, the attribute  is necessary if the offset value should differ from the value of
this field (variable this ).
 rsector and rcluster  are offsets relative to the absolute position of the pattern
beginning.

assigned-template: <TemplateName> Specifies the pattern name linked with this field. Ignored if the as-offset or
purpose attributes are not specified.

var: <Name> Optional. Specifies the name under which the value of this field can be accessed in
expressions.

· binary 
Attributes: 

display-encoding: (hex | binary) Optional. Default: hex. 
size: <bytes> Mandatory.

· char 
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Attributes: 

size: <bytes> Mandatory. 
codepage: (ansi |

oem | utf8 | utf16) 
Optional. Specifies which codepage is used. Default: ansi.

· filetime 
Shows time in the Win32 format (64 bits)

· unixtime 

Shows time in the Unix format (seconds from 01/01/1970)

· filetime 

Shows time in the DOS format (date: hiword, time: loword)

· bits 

Attributes: 

size: <bytes> Mandatory. 
pos: <comma separated list of bit positions> Mandatory. Specifies bit positions in a data block.

Commands

· goto 

Specifies a jump to a specified offset (either absolute or relative one)

Attributes: 

address: <expression> Specifies an absolute address to jump to.
offset: <expression> Specifies a relative offset to jump by.

One and only one of the attributes should always be specified.

· if 

Evaluates a condition specified in the test attribute and, if the condition is true, reads fields specified in this
tag.

Attribute: 

test: <expression> Sets a condition to test against.

· repeat 

Reads the fields specified in the tag until the exit condition is equal to 0 or specified times

Attributes: 

count: <expression> <expression> is evaluated one time upon entering the block. Internal
elements are read the specified number of times.

test: <expression> <expression> is evaluated upon entering the block. Similar to the C++
construction while(...) {}. 
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test: <expression> <expression> is evaluated upon exiting the block. Similar to the C++
construction do {} while(...). 

· setvar 

Sets the value of an internal variable. As an example, this command is convenient to store the current offset.
The value of the current offset is stored in a predefined variable offset.

Attributes: 

var: <string> Specifies the name of the variable.
expr: <expression> Specifies an expression which result will be assigned to the variable.

Expressions

Expressions in the patterns are arithmetic expressions which syntax is similar to that of the C language, including
operation preceding. 

The following operations are supported:
+ - * / & | > < <= >= != == || &&

Predefined variables

· offset 

An offset in bytes from the pattern beginning data is currently read at. 

· start_position 

An absolute position of the pattern beginning. offset + start_position = absolute offset.

· this 
This variable exists only within the context of the ass-offset expression evaluation and is the current value
of the data field for which that expression is specified

4.6 Pattern Example I

Below is an example of a commented pattern parsing an AVI file. 
<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The pattern name is AVI File. -->
<template name="AVI File">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->

        <field offset="0x00">52 49 46 46</field> <!-- ANSI: RIFF -->

        <!-- A 4-byte signature at offset 0x08. -->

        <field offset="0x08">41 56 49 20</field> <!-- ANSI: LIST -->

    </signature>

    <!-- A data section. Its name is AVI File. This is the main data section. It is not shown in the parsing tree as
a section (its name is ignored). -->

    <section name="AVI File">
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        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: RIFF" var="signature"/>

        <!--  The current position is moved to the beginning of the file. -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. --> 

        <field type="uint32" base="hex" name="Signature RIFF as unsigned integer in hex format" var="signature"/>

        <!-- A test against the condition (signature == RIFF) -->

        <if test="signature == 0x46464952"> <!-- ANSI: RIFF -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable dataSize gets
the value of  the field. -->

            <field type="uint32" name="Size of the data in file" var="dataSize"/>

            <!-- A new internal variable endOfFile is created and the expr field evaluates its value.-->

            <setvar var="endOfFile" expr="offset + dataSize - 8"/>

            <!-- The next 4 bytes is read and shown as an ANSI string. -->

            <field type="char" size="4" name="File type"/>

            <!-- A new section named DATA is created -->

            <section name="DATA">

                <!-- A new internal variable chunksOffset is created, the expr filed evaluating its value. This variable
gets the absolute value of template offset. -->

                <setvar var="chunksOffset" expr="start_position"/>

                <!-- A loop is created. Its condition is set in the test field (while the endOfFile variable is greater
then the current position.) -->

                <repeat test="endOfFile > offset">

                    <!-- 4 bytes are read and shown as an ANSI string. -->

                    <field type="char" size="4" name="Signature"/>

                    <!-- The current position is moved backwards by 4 bytes. -->

                    <goto offset="-4"/>

                    <!-- The same 4 bytes are read and shown as an unsigned integer. The internal variable signature
gets this value. -->

                    <field type="uint32" name="Signature as unsigned integer"
var="signature"/>

                    <!-- A test against the condition (signature == LIST) -->

                    <if test="signature == 1414744396"> <!-- ANSI: LIST -->

                        <!-- The section is shown. Its name is LIST -->

                        <section name="LIST">

                            <!--  The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>
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                            <!-- The 4 bytes are read and shown as an unsigned hexadecimal integer. This field has the
attributes offset and assigned-template. If the user double-clicks this field, the AVI File LIST pattern
will be invoked and the current pattern position will be moved to the address specified in as-offset.-->

                            <field type="uint32" base="hex" name="Signature LIST as unsigned
integer in hex format" as-offset="start_position + offset - 4" assigned-
template="AVI File LIST"/>

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The listSize variable gets
its value.  -->

                            <field type="uint32" name="Size of the data in the list"
var="listSize"/>

                            <!-- The 4 bytes are read and shown as an ANSI string. -->

                            <field type="char" size="4" name="List type"/>

                            <!-- The current position is moved backward by 4 bytes. -->

                            <goto offset="-4"/>

                            <!-- The same 4 bytes are shown as an unsigned hexadecimal integer. The listType variable
gets its value.-->

                            <field type="uint32" base="hex" name="List type as unsigned integer in
hex format" var="listType"/>

                            <!-- A test against condition (type == movi) -->

                            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                                <!-- The chunksOffset variable gets the value evaluated in the expr attribute. -->

                                <setvar var="chunksOffset" expr="start_position + offset - 4"/>

                            </if>

                            <!-- The current position is moved to the address evaluated in the address attribute. -->

                            <goto address="offset + listSize - 4"/>

                        </section>

                    </if>

                    <!-- A test against condition (signature == JUNK) -->

                    <if test="signature == 1263424842"> <!-- ANSI: JUNK -->

                        <!--  The section is shown with the JUNK name. -->

                        <section name="JUNK">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
junkSize gets its value. -->

                            <field type="uint32" name="Size of the data of the junk"
var="junkSize"/>

                            <!-- The current position is moved by junkSize bytes forward.  -->

                            <goto offset="junkSize"/>

                        </section>

                    </if>
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                    <!-- A test against condition (signature == idx1) -->

                    <if test="signature == 829973609"> <!-- ANSI: idx1 -->

                        <!--  The section is shown with the idx1 name. -->

                        <section name="idx1">

                            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable
idxSize gets its value. --> 

                            <field type="uint32" name="Size of the data of the idx1"
var="idxSize"/>

                            <!-- The section is shown with the  First AVIINDEXENTRY name. -->

                            <section name="First AVIINDEXENTRY">

                                <!-- The 4 bytes are read and shown as an ANSI string. -->

                                <field type="char" size="4" name="Chunck id"/>

                                <!-- The next 4 bytes are read and shown as an unsigned hexadecimal integer. -->

                                <field type="uint32" base="hex" name="Flags"/>

                                <!-- The next 4 bytes are read ans shown as an unsigned hexadecimal integer. The offset
attribute is evaluated for this field as a sum of  the chunksOffset variable and valued of this field.  -->

                                <field type="uint32" base="hex" name="Chunk offset" as-
offset="chunksOffset + this"/>

                                <!-- The next 4 bytes are read and shown as an unsigned integer. -->

                                <field type="uint32" name="Chunk size"/>

                            </section>

                            <!-- The current position is moved by idxSiz bytes forward. -->

                            <goto offset="idxSize"/>

                        </section>

                    </if>

                    <!-- A test against the condition. &amp;&amp; is a logical AND (&&) -->

                    <if test="signature != 1414744396 &amp;&amp; signature != 1263424842
&amp;&amp; signature != 829973609">

                        <!-- An empty section is shown. Its name is Unknown signature found -->

                        <section name="Unknown signature found">

                        </section>

                        <!-- The current position is moved to the address set in the endOfFile variable. -->

                        <goto address="endOfFile"/>

                    </if>

                </repeat>

            </section>

        </if>

    </section>
</template>
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4.7 Pattern Example II

<?xml version="1.0" encoding="utf-8"?>

<!-- A pattern section. The  pattern name is AVI File LIST -->
<template name="AVI File LIST">

    <!-- A template signature section. Alignment is 1. -->

    <signature align="1">

        <!-- A 4-byte signature at offset 0x00. -->

        <field offset="0x00">4C 49 53 54</field> <!-- ANSI: LIST -->

    </signature>

    <!-- A data section. Its name is AVI File LIST. This is the main data section. It is not shown in the parsing
tree as a section (its name is ignored).-->

    <section name="AVI File LIST">

        <!-- The first 4 bytes are read and shown as an ANSI  string. -->

        <field type="char" size="4" name="Signature: LIST"/>

        <!-- The current position is moved to the beginning of the file (4 bytes backward). -->

        <goto offset="-4"/>

        <!-- The first 4 bytes in the file are read and shown as an unsigned integer. The internal variable signature
gets the value of the field. -->

        <field type="uint32" name="Signature LIST as unsigned integer" var="signature"/>

        <!-- A test against the condition (signature == LIST) -->

        <if test="signature == 1414744396"> <!-- ANSI: LIST -->

            <!-- The next 4 bytes are read and shown as an unsigned integer. The internal variable listSize gets its
value. -->

            <field type="uint32" name="Size of the data in the list" var="listSize"/>

            <setvar var="endOfList" expr="offset + listSize"/>

            <field type="char" size="4" name="List type"/>

            <goto offset="-4"/>

            <field type="uint32" base="hex" name="List type as unsigned integer in hex
format" var="listType"/>

            <!-- A test against condition (listType == movi) -->

            <if test="listType == 0x69766f6d"> <!-- ANSI: movi -->

                <!-- This chunk is not to be parsed. The current position is moved to the end of the chunk. -->

                <goto address="endOfList"/>

            </if>

            <setvar var="mediaType" expr="0"/>

            <repeat test="endOfList > offset - 8">
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                <section name="CHUNK">

                    <field type="char" size="4" name="Chunk ID"/>

                    <goto offset="-4"/>

                    <field type="uint32" name="Chunk ID as unsigned integer" var="chunkId"/>

                    <if test="chunkId == 1414744396"> <!-- ANSI: LIST -->

                        <goto offset="-4"/>
        <field type="uint32" base="hex" name="LIST chunk ID as unsigned integer in hex
format" as-offset="start_position + offset - 4" assigned-template="AVI File LIST"/>

                    </if>

                    <field type="uint32" name="Size of the data in the chunk"
var="chunkSize"/>

                    <setvar var="endOfChunk" expr="offset + chunkSize"/>

                    <!-- Rounding the value of the variable endOfChunk to a number divisible by 2. -->

                    <if test="endOfChunk &amp; 1">

                        <setvar var="endOfChunk" expr="endOfChunk &amp; 0xFFFFFFFE"/>

                        <setvar var="endOfChunk" expr="endOfChunk + 2"/>

                    </if>                    

                    <if test="chunkId == 1751742049"> <!-- ANSI: avih -->

                        <field type="uint32" name="Number of microseconds between frames"/>

                        <field type="uint32" name="Approximate maximum data rate of the file"/>

                        <field type="uint32" name="Alignment for data, in bytes"/>

                        <field type="uint32" name="Bitwise combination of zero or more of the
flags"/>

                        <field type="uint32" name="Total number of frames of data in the file"/>

                        <field type="uint32" name="Initial frame for interleaved files"/>

                        <field type="uint32" name="Number of streams in the file"/>

                        <field type="uint32" name="Suggested buffer size for reading the file"/>

                        <field type="uint32" name="Width of the AVI file in pixels"/>

                        <field type="uint32" name="Height of the AVI file in pixels"/>

                        <field type="binary" size="16" name="Reserved"/>

                    </if>

                    <if test="chunkId == 1852994675"> <!-- ANSI: strn -->

                        <field type="char" size="chunkSize" name="Stream name"/>

                    </if>

                    <if test="chunkId == 1752331379"> <!-- ANSI: strh -->

                        <field type="char" size="4" name="Type"/>
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                        <goto offset="-4"/>

                        <field type="uint32" base="hex" name="Type as unsigned integer in hex
format" var="type"/>

                        <setvar var="mediaType" expr="type"/>

                        <field type="char" size="4" name="Handler (codec)"/>

                        <field type="uint32" base="hex" name="Flags"/>

                        <field type="uint32" name="Number of the first block of the stream that
is present in the file"/>

                        <field type="uint32" name="Scale"/>

                        <field type="uint32" name="Rate"/>

                        <field type="uint32" name="Start time of stream"/>

                        <field type="uint32" name="Size of stream in units as defined in Rate
and Scale"/>

                        <field type="uint32" name="Size of buffer necessary to store blocks of
that stream"/>

                        <field type="uint32" name="Quality"/>

                        <field type="uint32" name="Sample size (number of bytes of one stream
atom)"/>

                    </if>

                    <if test="chunkId == 1718776947"> <!-- ANSI: strf -->

                        <if test="mediaType == 0x73646976"> <!-- ANSI: vids -->

                            <section name="BITMAPINFOHEADER">

                                <field type="uint32" name="Number of bytes required by the
structure"/>

                                <field type="int32" name="Width of the bitmap, in pixels"/>

                                <field type="int32" name="Height of the bitmap, in pixels"/>

                                <field type="uint16" name="Number of planes for the target device"/>

                                <field type="uint16" name="Number of bits-per-pixel"/>

                                <field type="uint32" name="Type of compression for a compressed
bottom-up bitmap"/>

                                <field type="uint32" name="Size, in bytes, of the image"/>

                                <field type="int32" name="Horizontal resolution, in pixels-per-
meter, of the target device for the bitmap"/>

                                <field type="int32" name="Vertical resolution, in pixels-per-meter,
of the target device for the bitmap"/>

                                <field type="uint32" name="Number of color indexes in the color
table that are actually used by the bitmap"/>

                                <field type="uint32" name="Number of color indexes that are required
for displaying the bitmap"/>

                            </section>

                        </if>
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                        <if test="mediaType == 0x73647561"> <!-- ANSI: auds -->

                            <section name="WAVEFORMATEX">

                                <field type="uint16" name="Waveform-audio format type"/>

                                <field type="uint16" name="Number of channels in the waveform-audio
data"/>

                                <field type="uint32" name="Sample rate, in samples per second
(hertz)"/>

                                <field type="uint32" name="Required average data-transfer rate, in
bytes per second, for the format tag"/>

                                <field type="uint16" name="Block alignment, in bytes"/>

                                <field type="uint16" name="Bits per sample for the Waveform-audio
format type"/>

                                <field type="uint16" name="Size, in bytes, of extra format
information appended to the end of the WAVEFORMATEX structure"/>

                            </section>

                        </if>

                    </if>

                    <goto address="endOfChunk"/>

                </section>

            </repeat>

        </if>

        <if test="signature != 1414744396">

            <section name="Invalid LIST signature found">

            </section>

        </if>

    </section>
</template>
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V Technical Information and Troubleshooting

This chapter covers various technical issues and troubleshooting.

· IntelligentScan technology

· Data Recovery Issues

· Extended Information Recovery

· Data Formats and Multipliers

· Data Recovery on HFS/HFS+ file system

· Supported Virtual Disk and Disk Image Formats

· Bad Sectors

· File Information (R-Studio Technician)

· Memory Usage

· Forensic Mode

· R-Studio Switches

· Properties Tab

R-Studio Features
Contact Information and Technical Support
Data Recovery Using R-Studio
Basic File Recovery
Advanced Data Recovery
Mass File Recovery
Volume Sets and RAIDs
Data Recovery over Network
Text/Hexadecimal Editor
R-Studio Emergency
R-Studio Agent Emergency

5.1 IntelligentScan Technology

R-Studio uses a unique IntelligentScan technology when it tries to recover the data on the area being
scanned. 

While scanning the selected area, R-Studio reads data directly from the disk, analyzes them, and tries to
determine a record to which the data belong. The following record types are possible:

· MBR/GPT records
· NTFS Boot Sector, Folder, and MFT records
· FAT/exFAT Boot Sector, folder, and file records
· ReFS Boot sector records and ReFS Meta blocks
· HFS/HFS+ Volume headers and BTree+ nodes
· APFS Super blocks, APFS Volume blocks, and APFS nodes
· Ext2/3/4FS SuperBlocks records
· UFS1/UFS2/FFS SuperBlock records
· Specific file signatures of Known File types for raw file carving

https://www.r-studio.com/What-is-FAT.html
https://www.r-studio.com/What-is-ExFAT.html
https://www.r-studio.com/What-is-UFS.html
https://www.r-studio.com/What-is-Raw-File-Recovery.html
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All these record types have different, but known, structure. Knowing valid values of record fields and relations
between them for each record type, R-Studio determines a record type for the data. If such record type cannot
be unambiguously determined, the data are assigned to the most probable record type. The same data can be
assigned to several record types, with a certain probability for each assignment. A list of possible files is
generated from these records.

R-Studio generates a record list for each record type. This list contains references to records assigned to a
record type from the list with their assignment probability. The same data can be included into different record
lists. Then R-Studio analyzes relations between elements in each list and between different lists, and generates a
list of found partition with their parameters, such as partition start point and probable size, file system type, cluster
size, and existence probability.

Using the file list and partition list, R-Studio reconstructs file systems and files on the found partitions. One file
can be attributed to several different partitions.

When the entire disk or its part has been scanned, R-Studio shows all found partitions. Then the parameters of
the found partitions may be manually corrected, if additional information on them is available. 

Using the IntelligentScan technology, R-Studio can recover files not only on new and existing partitions. It also
can find and recover data on partitions that have been deleted or reformatted. If, for example, there was an
NTFS partition, which later was reformatted as a FAT partition, R-Studio will show two partitions on the same
place on the disk, one having the FAT file system, the other the NTFS. Then, found files can be recovered.

The IntelligentScan technology makes R-Studio a very powerful data recovery tool, but it is not omnipotent.
As it uses probabilistic approach to data reconstruction, it cannot guarantee 100% correct results. Moreover,
even if R-Studio has reconstructed data structure correctly, it is impossible to guarantee that all found files will be
completely and correctly recovered, as new data may be already written over the old files. See the Data
Recovery Issues topic for details.

5.2 Data Recovery Issues

NEVER TRY TO SAVE RECOVERED FILES/FOLDERS TO THE SAME LOGICAL DISK WHERE
THEY RESIDE!!!

Or you may obtain unpredictable results and lose all of your data.

R-Studio writes directly to a hard drive only when writing recovered data and from its hex editor, if writing is
enabled. In all other actions, R-Studio only reads data and analyzes them, and never modifies data on the hard
drives being analyzed. 

Most operating systems use lazy-write. So, there is a time lag between file actions and actual changes on data on
a hard drive. R-Studio analyzes data on hard drives only. That is why it does not always detect recent changes in
data structure.

Most operating systems constantly write their service information on hard drives. Such writing is especially
intensive during start-up and shut-down procedures. When an operating system deletes a file/folder, it treats the
space where it has resided as empty and may write something in this place. If this happened, the file/folder and its
parameters may be detected correctly, but its data may be lost. 

Folder names like $$$Folder58448 on NTFS partitions mean that the folder has not been found on the drive but
some references to it have been. For example, folders My documents, Work, Photos have been found and all they
have one parent folder, whose description has not actually been found on the disk, so its name is unknown and
therefore represented as $$$Folder58448. It may happen that the description of such folders was outside of the

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-Disk-Partition.html
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scan area, so try to enlarge the region or scan the entire hard drive. If that does not help, most likely that the
description of the folder has been overwritten. 

Folder names like $ROOT58448 on FAT partitions mean that some folders have been found, but they cannot
be included into the folder structure for this FAT partition. Sometimes, such folders may contain other folder
structures.

If you recover a file, and it appears that the file contains wrong data, try to do the following:

· Scan: 
the logical disk, if the file has been just deleted.

the hard drive, if the data structure is damaged more seriously.

· Search for the file to be restored on all found partitions and try to recover it from all found partitions.
Check each recovered file to ensure that it contains correct data. As soon as you found the partition from
which the file is recovered correctly, use this partitions to recover all other deleted files.

If there are several deleted files to be restored, you should use a file larger than 2KB to select the required
partition.

FAT file system:

Cross-Linked Folders

Often R-Studio finds several FAT folder records that contain the same data. Such folders are called cross-

linked. R-Studio marks such folders with an arrow mark: 

R-Studio attributes the content of cross-linked folders to one folder called a target folder. When recovering, R-
Studio places the content to the target folder.

To view the list of cross-linked folders,

1 Control-click a cross-linked folder and select Cross Linked Folders on the contextual menu.

> A list of cross-linked folders will appear

You may go to any folder in this list by clicking it.

To find a target folder, 

* Control-click a cross-linked folder and select Go Target on the contextual menu, or

Select the cross-linked folder and select Goto Target on the File menu

If Go Target is gray, this folder is already the target folder.

To set the target folder manually,

* Control-click a cross-linked folder and select Set As Default Target on the contextual menu, or

Select the cross-linked folder and select Set As Default Target on the File menu.

If Set As Default Target is gray, this folder is already the target folder.

Questionable Folders

Sometimes, R-Studio may find FAT records, which look like folders, but their content is invalid. For example,
file names have invalid characters, date, time, and size, or other file attributes may look strange. Please note that
R-Studio correctly recognizes localized names. R-Studio treats such records as folders, but does not analyze
their content and structure. You can manually scan such folders, but results may be unpredictable. Usually, such
scan reveals garbage.

R-Studio marks such folders with a question mark.

https://www.r-studio.com/What-is-FAT.html
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To re-scan an object, 

* Control-click a questionable folder on the R-Studio's Folders panel and select Rescan on the

contextual menu, or

Select the questionable folder and select Rescan on the File menu.

NTFS, APFS, HFS, XFS, and ext fs file systems:

Symbolic links (symlinks)

Symbolic links (of symlinks for short) are object that contains references to other files or folders directory in the
form of absolute or relative paths and that affect pathname resolution. For example, if a symlink C:
\ProgramData\Documents points to D:\Recovered Files\Root\Users\Public\Documents, entering it
will result in entering D:\Recovered Files\Root\Users\Public\Documents.

They are present in almost all modern file systems. NTFS, HFS+, APFS, and EXT FS are probably the most
popular examples.

R-Studio shows such symlinks and their targets in the following way:

Symlinks can be marked for recovery^

Only symlinks on the picture above are marked for recovery. They will be recovered as real files and folders. 

https://www.r-studio.com/What-is-XFS.html
https://www.r-studio.com/What-are-Hard-Soft-Links.html
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Only targets (real folders) on the picture above are marked for recovery. They will be recovered as real files and
folders. 

Both  targets (real folders) and symlinks on the picture above are marked for recovery. They will be recovered
as real files and folders and symlinks. 

The R-Studio Settings topic gives more details about symlink recovery.

Files:

Hard links 

Hard links are file system entries that give file names to files. This term is usually used when files may have several
names. R-Studio shows hard links using the following icons:

A hard link: 

The target file: 

You may find a target or hard link for a file. Control-click the file and select Links on the contextual menu.

5.3 Extended Information Recovery

R-Studio supports recovery of compressed files, alternative data streams, encrypted files, file security and
extended file attributes. If the R-Studio host OS and the file system of the disk you are going to save file to
support any particular extended information, it will be saved with the file, too. Otherwise, the extended
information will be saved as separate files with the same name as the restored file and extension showing the type
of the extended information. Below is a quick reference for the host OS and file system of the target drive. 

Extended Information Required target disk FS
Encrypted files NTFS
Alternative data streams NTFS
File security NTFS
Extended file attributes NTFS or FAT

https://www.r-studio.com/What-are-Hard-Soft-Links.html
https://www.r-studio.com/What-are-alternate-data-streams.html
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5.4 Data Formats and Multipliers

You may enter data in all numerical fields either in sectors or in bytes. If there is no letters are after the number,
R-Studio assumes the numbers are in bytes.

Decimal numbers are entered as it is: 2372354

Hexadecimal numbers are entered as 0x23Fa67 or 23Fa67 hex.

The following case-insensitive notation is possible:
b 1 byte
kb 1 kb = 2^10=1024 bytes
mb 1 mb = 2^20=104857 bytes
gb 1 gb = 2^30=1073741824 bytes
tb 1 tb = 2^40=1099511627776 bytes
eb 1 eb = 2^50=1125899906842624 bytes
hex A hexadecimal number
sec (sector) A number is in sectors

You may also select the multipliers in the drop-down boxes. 

 Type an offset to which you want to go. You may select between bytes and sectors. See the
Data Formats and Multipliers topic for more details on data formats.

If a file is opened in Text/hexadecimal Editor , you may select data representation for that file.

 

When the multiplier has been changed, the data value will be changed according to the specific contextual
commands for that field:

Suppose, the initial value is 1 GB, and the sector size of the object is 512 byte. The results will be the following:

Command: No recalculate

Change from GB to MB: 1

Change from GB to Sectors: 1

Command: Always recalculate

Change from GB to MB: 1024

Change from GB to Sectors: 2097152

Command: Units type recalculate

Change from GB to MB: 1

Change from GB to Sectors: 2097152

5.5 Data Recovery on HFS/HFS+ File System

When deleting a file, macOS deletes system BTree+ records describing the file. Therefore, it is hard to recover
such file directly. Those records may remain in:

1. The swap file (if the deleted file has been deleted recently).
2. In the journal (if the HFS+ journaling is on, and the deleted file has been CREATED recently)
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Actually, if a file has been deleted, chances that the records would be found are small. To greatly increase the
chances to recover deleted files successfully , you may actively use scanning with enabled Known Files Types.

Note: All above is correct for intentionally deleted files. In case of a corrupted file system, HFS/HFS+ can be
recovered quite successfully.

When saving files with HFS+-specific attributes (resource fork, finder info, etc.) to a non-HFS+ disk, R-Studio
saves them in the so-called AppleDouble format. When they are copied to an HFS+ disk under macOS, those
attributes will be automatically restored.

5.6 Supported Virtual Disk and Disk Image Formats

Along with file formats used for purely disk backup and imaging purposes, there are file formats for virtual disks.
Virtual disks are software components that emulates data storage devices in virtual machines. A the same time,
virtual disks can be used for disk backup and imaging, too. That is why it’s expedient for disk backup and
imaging software to support various file formats for virtual disks. This is especially important for system
interoperability, when it’s necessary to use disk backup/image files on other machines where the disk backup and
imaging software isn’t installed.

Currently R-Studio supports the following virtual disk and disk image formats:

RDR: A proprietary disk image format developed by R-Tools Technology, Inc (R-TT). It is the main format
in R-Drive Image, R-Studio, R-Linux, and R-Undelete. RDR files are interchangeable, that is, any R-TT
program may load and process, within its capabilities, any rdr file created in another R-TT program. 

The following image formats can be created only in the R-Studio Corporate and Technician/T80+ versions:

VHD/VHDX: A virtual disk file format built into Windows. It’s a native virtual hard drive for Hyper-V, the
Windows virtual machine. You may read more about these file formats in Wikipedia: VHD (file format). R-
Studio creates a special file with some metadata for the VHD file format, its extension is vhr. The VHDX file
format contains this metadata within its main file.

VMDK: A virtual disk file format for the most virtual machines like VMware Workstation, VirtualBox, Parallels
Desktop for Mac, etc. You may read more about these file format in our Glossary: What is a VMDK Virtual
Disk.

VDI: A virtual disk file format for the VirtualBox virtual machine. R-Studio creates a special file with some
metadata for the VDI file format, its extension is vdr. You may read more about these file format in Wikipedia:
VDI.

R-Studio Standalone can load these image formats.

The main features of these file formats are presented in the table below:

Features RDR VHD/VHDX VMDK VDI

Several objects in
one file

Yes No No No

Compression Yes No Yes No

Encryption Yes No No No

Image Split Yes No Yes No

Native mounting on
Windows

No Yes No No

http://en.wikipedia.org/wiki/AppleSingle_and_AppleDouble_formats
https://www.r-studio.com/What-is-Disk-Image.html
https://en.wikipedia.org/wiki/VHD_(file_format)
https://www.R-Studio.com/What-is-VMDK-virtual-disk.html
https://www.R-Studio.com/What-is-VMDK-virtual-disk.html
https://en.wikipedia.org/wiki/VirtualBox#VirtualBox_Disk_Image
https://www.r-studio.com/What-is-Disk-Image.html
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Mounting on
Windows

using R-Studio
Yes Yes Yes Yes

Additional file formats that can be opened "read-only"

Extensions Description Licenses

dmg Apple Disk Image All

e01/(ewf) Expert Witness File Format Technician/T80+

aff Advanced Forensic Format Technician/T80+

5.7 Bad Sectors

Quite often, drives from which the data are to be recovered have bad sectors, or those sectors that are very
hard, even impossible, to read, mostly due to hardware problems. R-Studio tries to read such sectors several
times. The number of tries is specified either on the Settings/Bad Sectors dialog box, or on the Properties tab,
the Drive Control section, for each drive separately. 

When R-Studio encounters such bad sectors while performing various tasks and they appear unreadable, it
treats them as follows:

Object images:

R-Studio fills the space in the image file where the bad sectors should be with the pattern specified in the Pattern

to fill bad blocks field on the Settings/Bad Sectors dialog box. Please note that R-Studio writes the pattern on
the image, not on the source drive. 

Files

If Skip files with bad sectors on the Recovery dialog box is cleared,  R-Studio fills bad sectors in the recovered
file with the pattern specified on the the Settings/Bad Sectors dialog box. Information about such files will
appear in the Log.

If Skip files with bad sectors on the Recovery dialog box is selected,  R-Studio skips files with bad sectors and
displays their list on the Files with bad sectors dialog box when the recovery has been completed. You may
select files to immediately recover them or to mark for later recovery. You may also save this list to a text file.

Files with bad sectors dialog box

Files with bad sectors Buttons

Select All Click this button to select all files in the list.

Clear All Click this button to unselect all selected files.

Mark Click this button to mark all selected files in the list. 

https://en.wikipedia.org/wiki/Apple_Disk_Image
https://en.wikipedia.org/wiki/EnCase#Expert_Witness_File_Format
https://www.loc.gov/preservation/digital/formats/fdd/fdd000412.shtml
https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Image.html
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Save to File Click this button to save the list of files with bad sectors to a text file. 

Recover Click this button to immediately recover selected files. The bad sectors in the
recovered files will be filled with the pattern specified in the Pattern to fill bad blocks

field on the Settings/Bad Sectors dialog box.

Objects edited in the Text/hexadecimal editor/viewer

Bad sectors in the objects viewed/edited in the Text/hexadecimal editor are shown as filled with the pattern
specified in the Pattern to fill bad blocks field on the Settings/Bad Sectors dialog box.

5.8 Memory Usage

You may see how much memory R-Studio uses while performing a data recovery task. This is especially useful
when scanning large disks on a computer with limited resources. You may specify memory control options on the
Memory usage tab in the R-Studio Settings.

To view memory usage,

1 Select Memory usage on the Tools menu

> R-Studio will show the total memory in your computer and how much memory it uses

Memory usage dialog box

 Memory usage

Process Memory Shows how much memory R-Studio uses. Limit shows how much memory your
system can virtually allocate to R-Studio. Actual memory allocation depends also
on the RAM and swap file sizes.

System Memory
Physical

Shows how much RAM is in your system

System Memory
Swap

Shows how much virtual memory is in your system

5.9 R-Studio Command Line Command and Switches

You may start R-Studio from the terminal using the following command: 

open a R-Studio [--args -<switch>].

If there are problems in starting R-Studio and while working with it, you may use switches to avoid them.

The following switches are available:
-all_drives Forces R-Studio to show all logical disks in the system. Normally R-Studio shows

only local disks in the system. Some storage devices may pretend that they are not
local disks.

-debug Includes additional debug information. When this switch is used, an additional
command Create FS Snapshot on the context menu appears for an object with a file
system. An FS Snapshot contains system data for the file system only (file
descriptions without file contents). If a problem appears, this snapshot can be sent to
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R-Studio technical support to identify the problem. This switch greatly slows R-

Studio. You may also turn this mode on by selecting Debug Mode on the Settings

dialog box.
-flush Flushes the log file after each write to log operations. This switch is helpful when R-

Studio locks and its log file remains in memory cache unwritten to a disk. This switch
greatly slows R-Studio.

-log <filename> Started with this switch, R-Studio writes its log into the specified file. If R-Studio
locks and its log file remains in memory cache unwritten to a disk, use the -flush
switch.

-mem <size in MB> Sets memory usage limit in MB for R-Studio to reconstruct the file tree. When it
exceeds the limit, a Too many files... message appears. You may temporally stop file
listing and browse through found files. Then you can resume file listing. You also may
skip this file section and continue file listing. Example: -mem 400 - sets the limit to
400 MB.

-no_ide_ext Turns off the inquiry about extended information on HDDs in Wind9x/ME. This
switch may be helpful if R-Studio returns information about HDDs incorrectly
(detects HDD geometry incorrectly).

-no_int13 Turns off the disc access through Int13 in Wind9x/ME. This switch may be helpful if
the system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-no_ios Turns off the Wind9x/ME protected-mode I/O system. This switch may be helpful if
this system operates incorrectly (detects HDD geometry incorrectly or lock the
system).

-reset R-Studio resets an HDD controller each time it reads a bad sector. This switch may
be helpful if the controller locks after it attempts to read a bad sector, or returns
incorrect data.

-safe Disables automatic partition search on a hard drive, file system recognition on
partitions, and other potentially problematic operations.

If an unrecognized problem appears, start R-Studio with the -debug and -log <filename> switches, and
send the log and screenshot of the R-Studio main panel to the R-Studio technical support:

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average
response time less than 4 hours.

5.10 Properties Tab

Object size units

You may select the units in which the information on object sizes will be displayed. Some parameters can be
edited when the Debug mode is turned on on the Main dialog box of the R-Studio settings.

To select the units

1 Select Properties on the View menu

2 Select the units in which you want to see object sizes.

You may select
Show as Bytes
Show as Sectors

https://www.r-studio.com/What-are-Bad-Sectors.html
https://www.r-studio.com/What-is-Disk-Partition.html
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Show as Bytes and Sectors

1.Basic information

This section shows basic information for a disk object.

 More information...

Drive Type Device/disk type and subtype. Current R-Studio version supports the following types:
Disk, WORM, CDROM, Optical, Changer, Floppy, RAM Disk, LDM Partition, LDM
Component, LDM Volume

and subtypes:
Device, OS File, Physical Drive, Mount Point, Partition, Volume Set, Mirror, Stripe Set,
RAID5

Name Device/disk name

Size Device/disk size

Bus Type Device/disk bus type. Can be:
IDE/ATA, IDE/ATAPI, SCSI, Floppy, USB, 1394, SSA, FibreChannel, RAID, SMART, ABIOS

2.Information on hard drives and logical disks

This section shows available information on hard drives and logical disks. These properties depend on the
drive/disk type and appear only when applicable. Under Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10,
an IDE drive/disk may be represented as a SCSI device, that is why the SCSI Address section appears under
these OSes for those drives/disks.

 More information...

OS object Appears for image files. An object name used by OS to access the device/disk.

R-Studio driver Driver names (both internal and OS) used to access this drive/disk.

Sector Size Drive/disk sector size

Physical Drive
Geometry

This section shows physical geometry for a hard drive. For a logical disk it shows the
physical geometry for a hard drive where the logical disk resides

Cylinders

Tracks Per Cylinder

Sectors Per Track

Sector Size

Device
Identification

This section shows vendor information for the drive/disk

Vendor

Product

Firmware

Bus

SCSI Address This section shows SCSI information for the drive/disk

Port Number

Path ID

Target ID

https://www.r-studio.com/What-is-Disk-Image.html
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Lun

Windows 9x/ME adds the following properties:

Int13 Drive Number 128 for the first hard drive accessible through Int13, 129 for the second one, etc.
0...128 for drives and other devices accessible through a Windows 9x/ME protected
mode driver, if their Int13 device option is disabled. R-Studio can use Int13 disk
access, and for some drive types, like SCSI devices, Int13 access is preferable. You
may consider enabling the Int13 device option in the Windows Device Manager for
such devices.

Int13 Extension
Version

Int13 Extension Version Support for hard drives. Extended Int13 support is necessary
for large drives. If this property is zero, Extended Int13 is not supported, otherwise, it
shows Extended Int13 standard version, the large, the better.

3.Properties controlling access to hard drives and logical disks

This section shows properties that control access (read and write) to hard drives and logical disks. They are set
to their optimal values and should be altered only if access problems appear.

 More information...

Drive Control

Maximum transfer Maximum data size that can be read or written during a single access to the drive. If
there are problems with drive access, decrease the value of this property

I/O Unit Data size read or written during a single access to the drive is a multiple value of this
property. If there are problems with drive access, decrease the value of this property

Buffer Alignment Drive data transfer buffer is positioned at an address multiple value of this property. If
there are problems with drive access, increase the value of this property.

These three properties are set by OS drivers. If the drivers set incorrect values, problems may appear during
data transfer operations. You can alter them until data transfer becomes stable.

I/O Tries Number of read/write tries during access to the drive. If there are bad sectors on the
drive, increase the value of this property. This may help to successfully read those
sectors. Sometimes, if the I/O Tries parameter is set too large and there are some
unreadable sectors on the hard drive, the hard drive-controller pair may refuse to
perform any successive read/write operations with the entire hard drive when it fails to
read/write such sectors. In this case, set this parameter to zero.
The default value is specified on the Settings (Bad Sectors) panel.
R-Studio treats bad sectors in the following way:
It reads a certain part of disk (predefined by Windows) and
· If Default read attempts is set to 0, the entire part with bad sectors will be filled with

the specified pattern. 
· If Default read attempts is set to a non-zero value, R-Studio reads again that part

sector by sector, repeating the attempts the specified number of times. If R-Studio
still cannot read a bad sector, it fills the sectors with the specified pattern. In this
case only the bad sectors will be filled with the pattern, but that extremely slows the
disk read process.

For example, if you set Default read attempts to 1, a bad sector will be read 2 times.

https://www.r-studio.com/What-are-Bad-Sectors.html
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4.Partition properties

A partition is a continuous area on a hard drive, characterized by its offset and size. There are partitions on
basic disks, dynamic disks, and recognized volumes and partitions. R-Studio treats regions like partitions.

 More information...

Partition Offset Initial offset for the partition.

Partition Size Size of the partition.

Partition Type File system type for the partition. If the record in the drive partition table is incorrect,
this property may differ from the actual file system type for this partition. Still, R-
Studio will process this partition correctly, as it does not use this property.

Partition number Appears under Windows NT/2000/?XP/?2003/?Vista/?2008/?7/?8/8.1/?10 only. Shows the
number of the partition on the physical drive.

For regions and recognized partitions, Partition Offset and Partition Type properties can be manually
corrected.

5.Compound volume properties

A compound volume is a union of several partitions or other disk objects. Each union type has its own rules,
unique for each compound volume type. Among compound volumes are: Volume Sets (RAIDs Level 0),
Mirrors (RAIDs Level 1), RAIDs5 (RAIDs Level 5), both physical and created by the user (Virtual Volume
Sets, Virtual Stripe Sets, Virtual Mirrors, Virtual RAID5).

 More information...

Main properties of compound volumes are parents (disk objects from which a compound volume is
created) and their order. These properties may be viewed in the Parents tab.  For user-created compound
volumes these properties may be altered.

Raid Block Size Data block size for compound volumes of RAID (Level 0-5) types

6.LDM disks and volumes (Dynamic Disks)

LDM disks and volumes are volumes controlled by Logical Disk Manager (LDM). They are represented on a
hard drive as a LDM database rather than partition tables. Under Windows 2000/?XP/?2003/?Vista/?2008/?7/?
8/8.1/?10, LDM disks are also called Dynamic Disks.

 More information...

Offset of Logical
Disk

Initial offset of a logical disk on a hard drive. For disks, initially formatted by LDM,
this value is often 31.5KB, for converted disks, it may be larger.

Supposed Parents
Count

Supposed number of parent partitions for compound LDM volumes. If the LDM
database is not damaged, the value of this property must be equal to the number of
parent objects in the Parents tab for the disk object.

LDM Host GUID Global Unique Identifier of a computer system where this LDM disk group has been
created.

LDM DiskGroup GUID Global Unique Identifier of the LDM disk group.

LDM Disk GUID Global Unique Identifier of the hard drive.

LDM Volume GUID Global Unique Identifier of the volume.

LDM Disk ID Local hard drive Identifier, unique within this LDM disk group.

https://www.r-studio.com/What-is-Disk-Partition.html
https://www.r-studio.com/What-is-disk-format.html
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LDM Partition ID Local partition Identifier, unique within this LDM disk group.

LDM Component ID Local component Identifier, unique within this LDM disk group.

LDM Volume ID Local volume Identifier, unique within this LDM disk group.

LDM Disk AltName Additional Alternative Name given by LDM to the hard drive.

LDM Disk DriveHint Last name of the volume, under which is has been mounted in the system. May be
either a letter (C:, D:, etc.), or a mount point under Windows 2000/?XP/?2003/?Vista/?
2008/?7/?8/8.1/?10.

7.File System Volume properties

A File System (FS) volume is a disk object where a certain, supported by R-Studio, file system is present.
There are two FS volume types: FS volume on a regular disk object and a recognized volume, found by a scan
process. FS volume properties depend on volume's file system and type.

7.1.NTFS Volume properties

These properties are present for all NTFS volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information...

NTFS Information Regular volumes

Recognized NTFS Recognized volumes

Cluster Size Cluster size for the NTFS volume.

MFT record size Size of one MFT record describing one file on the NTFS volume. This is an important
property of any NTFS volume. Its common value is 1KB. If this property has
incorrect value, many files may be incorrectly recovered.

Sector Size Sector size for the physical drive. This property is read from the boot sector of the
NTFS volume and does not affect R-Studio operation.

Index Block Size Index block size for the NTFS volume. This property determines binary trees used to
store NTFS folder structure. It does not affect R-Studio operation.

MFT position MFT offset from the start of the NTFS volume.

MFT Mirror Position Second MFT copy offset from the start of the NTFS volume.

Volume size Size of the NTFS volume. This property does not affect R-Studio operation.

7.2.FAT Volume properties

These properties are present for all FAT volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information... 

FAT Information Regular volumes

Recognized FAT Recognized volumes

FAT Bits (12,16,32) FAT type. 12 for the FAT12, 16 for the FAT16, 32 for the FAT32.

Cluster Size Cluster size for the FAT volume.

First Cluster Offset Offset of the first cluster from the start of the FAT volume.

https://www.r-studio.com/What-is-FAT.html
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Boot Directory
Cluster

(For FAT32 only.) Cluster number where the root directory starts on the FAT
volume where the logical disk resides.

Root Directory
Offset

(For FAT12 and 16 only.) Root directory offset from the start of the FAT volume.

Root Directory
Length

(For FAT12 and 16 only.) Root directory length for the FAT volume.

First FAT Offset Offset for the first FAT table on the volume. Together with the Size of One Fat Table

property, is a most important property for a FAT volume. If this property is incorrect,
many files (especially fragmented ones) may be incorrectly recovered.

Size of One FAT
Table

Size of one FAT table on the volume.

Sector Size Sector size of the hard drive. This property is read from the boot sector of the FAT
volume and does not affect R-Studio operation.

Number of FAT
Copies

Number of FAT copies on the FAT volume.

Active FAT copy Active FAT table number for the FAT volume. Can be set to Disabled, Auto, 1, or 2. If
it is Disabled, R-Studio processes the volume as there is no FAT table present. This
may be useful if the volume has been reformatted and thus a new FAT table is created
and the old one is deleted. In this case, it is reasonable to recover files from the
previous volume without processing the new and irrelevant FAT table. All files will be
recovered as continuous byte chains beginning from their start cluster. Unfragmented
files will be recovered successfully. If it is 1 or 2, R-Studio uses the first or second
FAT table copy, respectively. If it is Auto, R-Studio uses both FAT table copies and
decides, which FAT table copy should be used for a particular FAT table sector. This
may be useful when both FAT tables are partially damaged. 

Major version FAT version.

Minor version FAT minor version.

Volume size Size of the volume.

7.3.Ext2/3/4FS Volume properties

These properties are present for all Ext2/3/4FS volumes and represent their main properties. For recognized
volumes, these values can be altered.

 More information...

Ext2/3/4FS
Information

Regular volumes

Recognized Ext2FS Recognized volumes

Block Size Block size of Ext2FS file system. A block in the Ext2FS file system is similar to a
cluster in the FAT file system.

First SuperBlock
Offset

Offset of the first SuperBlock from the start of the Ext2FS volume.

Blocks Per Volume Number of blocks in the Ext2FS volume.

INodes Per Volume Number of inodes on the Ext2FS volume. An inode is a record describing file's size,
attributes, position on an Ext2FS volume - all information about a file, except its name,

https://www.r-studio.com/What-is-disk-format.html
https://www.r-studio.com/What-is-ExtFS.html
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which is stored separately. Therefore, the INodes Per Volume parameter is equal to
the maximum number of files on an Ext2FS volume.

Creator OS The OS that created this Ext2FS volume. May be Linux, Hurd, Masix, FreeBSD, Lites.

Major version Ext2FS version. Usually 1.

Minor version Ext2FS minor version. Usually 0.

Last Mount Time Last mount time for this Ext2FS volume.

Last Write Time Last write time for this Ext2FS volume.

Last Check Time Last check time for this Ext2FS volume.

Volume size Size of the volume.

7.4.Recognized Volume properties

These properties are present for all recognized volumes, regardless of their file system type. They estimate
how reliable those volumes are recognized. This is useful for fast search for, and selection of, optimally
recognized volume to recover.

 More information... 

Parsed File Entries Number of files proving that this recognized volume existed. May have any non-
negative values. The main property characterizing the reliability of volume recognition.
The larger it, the higher probability that this recognized volume has file system
properties that have been correctly found.

Parsed Boot
Records

Number of boot records proving that this recognized volume existed. May be 0 or 1.
This is the second important property characterizing the reliability of volume
recognition.

Estimated Size Estimated size of the recognized FS partition/volume. This property shows the most
probable size of the recognized FS partition/volume. Alternatively, Size and Partition

Size are set to the highest possible values in order to recover the maximum number of
files.
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VI R-Studio Emergency

R-Studio Emergency is a tool that allows you to startup a computer with a damaged startup disk and recover
data stored on its hard drives. Then restored data can either be saved on its disk or transferred to a working
computer via a network.

The R-Studio Emergency version is a part of the R-Studio software package. 

You may run this R-Studio Emergency version on a computer for which you have bought an R-
Studio license, and you may not transfer the licensed software to another computer.

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Technical Information
Network Drives
Properties and Text/Hexadecimal Viewer
Log
Devices to Store Recovered Files

Hardware Compatibility List

6.1 Contact Informaiton and Technical Support

To obtain the latest version of R-Studio Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-StudioTechnical Support Team is available 24 hours a day, seven days a week, and has an average response
time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

6.2 Creating Startup Disks

· Installing R-Studio Emergency Startup Media Creator
· Creating Startup Disks Using R-Studio Emergency Startup Media Creator

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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· Creating Startup Disks for Mac and Linux Computers
6.2.1 Installing R-Studio Emergency Startup Media Creator

You must have administrative privileges to install R-Studio Emergency Startup Media Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1 Run the setup wizard

2 Read the License Agreement and accept its conditions.

3 Select the installation location

4 Select the Start Menu Folder



R-Studio Emergency 315

© 2024 R-Tools Technology Inc.

5 Wait for the program to install

6 You may start creating  R-Studio Emergency immediately upon install completion.

6.2.2 Creating Startup Disks Using R-Studio Emergency Startup Media Creator

You need to create either 

· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 50 MB. You may use this device to start both UEFI computers (modern
Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.
or

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system. You may use this disc to start both
UEFI computers (modern Windows/Mac/Linux systems) and old Windows/Mac/Linux machines.

You may create a Linux-based or WinPE based startup disk.

1 Run R-Studio Emergency
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Welcome dialog box

click the Next button to see the list of all devices on which startup disks may be created.

Startup media type selection dialog box

A Linux-based disk

Check the Hardware Compatibility List.

If you have problems with starting you computer up from the R-Studio Emergency startup disks, select
Configure startup media troubleshooting options on the Startup media type selection dialog box. Then the
Startup Media Troubleshooting Options dialog box will appear. You may configure these options to eliminate
those problems.

3 Select Linux based on the Startup OS selection and click the Next button.

Startup OS selection dialog box
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4 Read and accept the Activation terms on the R-Studio Emergency GUI Activation dialog box and click
the Next button.

R-Studio Emergency GUI Activation dialog box

If you create startup disk for R-Studio Emergency Technician, you'll need to enter your license key on the

Registration dialog box.

Registration dialog box

5 Specify the path and name for the ISO file or verify that you've select the correct USB device and click
the Next button.

Insert media dialog box
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> R-Studio Emergency Startup Media Creator will start creating the startup USB disk showing the

progress on the Creating startup media dialog box

Creating startup media dialog box

R-Studio Emergency Startup Media Creation is Finished message

Startup Media Troubleshooting Options

Those options will help you if you have problems with starting you computer up from the R-Studio startup disks.
Please, contact the R-Studio Technical Support Team for more information.

R-Studio Startup Media Troubleshooting Options dialog box

Display kernel startup
messages

if this checkbox is enabled, R-Studio Emergency displays all startup messages.
That may be useful to locate the source of the problem when your system hangs
during R-Studio Emergency startup.

Disables ACPI
Disables APIC

Select these checkboxes when your system detects some hardware incorrectly
during R-Studio Emergency startup and displays messages like: hda: lost
interrupt

Disables USB device support Select this checkbox if your system experiences problems with USB devices
during R-Studio Emergency startup.



R-Studio Emergency 319

© 2024 R-Tools Technology Inc.

Disables SCSI device support Select this checkbox if your system experiences problems with SCSI devices
during R-Studio Emergency startup.

Disables PCMCIA device
support

Select this checkbox if your system experiences problems with PCMCIA
devices during R-Studio Emergency startup.

Disables DMA for all IDE disk
drives

Select this checkbox if your system experiences problems with IDE disks during
R-Studio Emergency startup.

IRQ polling mode Select this checkbox to enable the IRQ polling mode to prevent locking the
system because a device generates too much interrupts for the system to handle.

PCI BIOS Select an appropriate option if your system experiences problems with PCI
cards. 

BIOS RAIDS Select an appropriate option if your system experiences problems with RAIDs
built in the system board.

A WindowsPE-based disk

3 Select Windows based on the Startup OS selection and click the Next button.

Startup OS selection dialog box

If you select this option for the first time, you'll need to download and install some extra Windows components.
Click the Download button and follow the on-screen instructions. When the process is finished, you'll be able to
continue creating the startup disk. 

Startup OS selection dialog box

If you select this option for the first time, you'll need to download and install some extra Windows components.
Click the Download button and follow the on-screen instructions. 

You don't have to perform these steps next times.
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4 Read and accept the Activation terms on the R-Studio Emergency GUI Activation dialog box and click
the Next button.

R-Studio Emergency GUI Activation dialog box

If you create startup disk for R-Studio Emergency Technician, you'll need to enter your license key on the

Registration dialog box.

Registration dialog box

5 Specify the path and name for the ISO file or verify that you've select the correct USB device and click
the Next button.

Insert media dialog box
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> R-Studio Emergency Startup Media Creator will start creating the startup USB disk showing the

progress on the Creating startup media dialog box

Creating startup media dialog box

R-Studio Emergency Startup Media Creation is Finished message

6.2.3 Creating Startup Disks on Mac and Linux Computers

To start a Mac or a Linux computer, you may use the following devices:

1. A USB device created using the R-Studio Emergency Startup Media Creator for Windows. See the Creating
Startup Disks Using R-Studio Emergency Startup Media Creator page for more details. 

2. A USB device created using a Mac or Linux computer. To create such device, download the ZIP archive of
R-Studio Emergency, unzip it, and write files to a FAT32-formatted USB device.

Please note that you cannot use this disk to start non-UEFI computers (old Macs, for example), nor can you just
copy those files to a CD/DVD disc to create an R-Studio Emergency startup disc. If you need a CD/DVD disk,
burn it using the ISO image.

3. A startup CD/DVD disc. Download the ISO image of that disk and burn it or use the R-Studio Emergency
Startup Media Creator for Windows to burn it on a Windows computer.

6.3 R-Studio Emergency Operation

Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent
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Technical Information
Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files

Hardware Compatibility List

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

6.3.1 Starting a Computer with the R-Studio Emergency Startup Disks

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.

To start the computer with the R-Studio Emergency startup CD/DVD disc or any removable
device,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).
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The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:

Select the R-Studio Emergency GUI (Graphic Mode) to run R-Studio Emergency in the graphic mode
in which its user interface is similar to the Windows version. If R-Studio Emergency cannot run in this
mode, restart the system in the Safe VGA mode (only VESA-compliant) which is compatible with most
video cards and monitors. If it fails too, select the Text mode in which the R-Studio Emergency user
interface is shown in the pseudo-graphic mode compatible with all video cards. The help describes this
pseudo-graphic mode.

> R-Studio Emergency will start and its Device/Disk panel will appear

To start the computer with the R-Studio Emergency startup floppy disks,
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1 Make sure that the first startup device in the system BIOS is A (Floppy)

Refer to your system documentation for details.

2 Insert the first startup floppy disk and start your computer

> The following text will appear on the screen:

Loading
Uncompressing ... OK, starting the kernel
VFS: Insert the second boot disk and press ENTER

3 Insert the second disk and press ENTER.

> R-Studio Emergency will start and its Device/Disk panel will appear

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

6.3.2 File Recovery

To recover files,

1 Select a partition on the Device/Disk panel on which the files to recover reside and press the Enter key

> R-Studiowill change its panel showing the disk's folders/files structure

2 Select the file to recover on the Files View panel. Use the Tab key to switch between panes
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Files View panel

3 Press the F2 key and specify the output folder on the Recover dialog box

Recover dialog box

External USB drives with the NTFS file system: R-Studio Emergency can save recovered files on
such disks if they are properly disconnected in a Windows system using the Safely Remove Hardware icon
in the system tray or while shutting Windows down. 

Searching for a File
Mapping Network Drives
Viewing object properties

6.3.3 Searching for a File

To search for a file, 

1 Select Find on the Tools menu (or press the Alt+F key)

2 Specify a file name or mask

Find dialog box

Look at dialog box
Deleted files: If it is selected, R-Studio makes a search among deleted files/folders.
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Existing files: If it is selected, R-Studio makes a search among existing files/folders.
Files: If it is selected, R-Studio includes files into a search.
Folders: If it is selected, R-Studio includes folders into a search.

To find the next file corresponding to the specified file mask, 

* Press the Alt+N key

6.3.4 Disk Scan

To scan an object

1 Select an object on the Device/Disk panel and press the F6 key

2 Specify the required parameters on the Scan dialog box and press the Enter key

Scan dialog box

Scan dialog box
Start: Sets the start point of the area to be scanned.
Size: Sets the size of the area to be scanned.
Numbers in these fields can be in bytes or sectors.
If no letters are after the numbers, R-Studioassumes the numbers in bytes. 
The following case-ignoring notation is possible: 

b
kb
mb
gb
tb

Bytes
Kilobytes
Megabytes
Gigabytes
Terabytes
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> When an object is scanned, it may be searched for files, and found files may be recovered the same
way as for a regular object

Scan results

Found objects:
Extra Found Files Entries of known file types have been found
Recognized1 Records and file entries are found for this partition
Recognized2 Only file entries are found for this partition
Recognized3 Only boot records are found for this partition

To save scan information

1 Select an object with scan information

2 Press the Alt+D key and select Save Scan Information on the Drive menu

3 Specify the output folder and file name on the Save Scan Information dialog box

Mapping Network Drives

To open scan information

1 Select an object to which scan information is to be opened

2 Press the Alt+D key and select Open Scan Information on the Drive menu

3 Specify the folder and file name with the scan information on the Open Scan Information dialog box

Mapping Network Drives

To delete scan information

1 Select an object to which scan information is to be deleted

2 Press the Alt+D key and select Delete Scan Information on the Drive menu

6.3.5 Disk Images

To create an image file

1 Select an object on the Device/Disk panel
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2 Press the Alt+D key and select Create Plain Image File or Create Compressed Image File on the Drive
menu

Create Image dialog box

Plain Image If this option is selected, R-Studio will create a simple exact copy of the
object. This image format is compatible with the previous versions of R-

Studio.
Compressed Image If this option is selected, R-Studio will create an image file compatible with

the images created by R-Drive Image, but incompatible with the previous
versions of R-Studio.

3 Specify the output folder and file name on the Create Image File dialog box

Mapping Network Drives

To load an image file

1 Press the Alt+D key and select Open Image File on the Drive menu

2 Specify the folder and file name with the image on the Open Image File dialog box

Mapping Network Drives

6.4 Using R-Studio Emergency as an Emergency Agent

R-Studio Emergency Linux version can be used as an emergency agent for R-Studio. Moreover, if you have
a Mac computer, this is the only way to start it with R-Studio Agent Emergency.

To start the computer with the R-Studio Emergency/Agent startup CD/DVD disc or any removable
device ,

1 Make sure that the first startup device in the system BIOS is the CD/DVD drive or the removable device

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details.

2 Insert the R-Studio Emergency startup CD/DVD disc or the removable device and start your computer

If you have a Mac computer

To start a Mac computer with the R-Studio Emergency startup disk, 

1. Insert a CD/DVD disc or connect a USB disk

2. Switch the Mac on.

3. While loading, press the Option key on the Mac keyboard (the Alt key if you use a non-Apple keyboard).
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The Options key

4. Select the EFI boot disk and press Enter.

The R-Studio Emergency startup disk

R-Studio Emergency will start loading.

Then a startup screen will appear:

Startup Options 

2 Select the R-Studio Agent Emergency to run R-Studio Emergency as an emergency agent.

> R-Studio Agent Emergency will start and its prompt will appear
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R-Studio Emergency as an Emergency Agent

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. Press Enter to start configuring the settings. A prompt to select an interface will appear. Enter the selected
interface name and press Enter.

2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional
subnet mask and press Enter.

 Network Setting Configuration

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.

 Network Setting Configuration

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 
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> R-Studio Agent Emergency will show a prompt that is ready to accept connections

R-Studio Emergency as an Emergency Agent

Now the computer may be accessed by R-Studio via network.

.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Emergency startup disk without
some additional actions. This happens because any computer should use a so-called "Secure boot" procedure to
comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents computer from
booting into any operating system that isn't digitally signed with an appropriate digital signature. "Secure boot" is
claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans, and other malicious
software. To the date, only Windows 8, Windows Server 2012, and selected Linux distributions support this
feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-Drive Image included),
and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Emergency startup
disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

The default port is 8080, and you don't have to specify it.
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2 Enter the password if required, and press the Enter key.

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

R-Studio Emergency as an Emergency Agent

6.5 R-Studio Emergency Technical Information

Properties and Text/Hexadecimal Viewer
Network Drives
Log
Devices to Store Recovered Files
R-Studio Emergency

R-Studio Emergency
Contact Information and Technical Support
Installing R-Studio Emergency Startup Media Creator
Creating Startup Disks

R-Studio Emergency Operation
Starting a Computer with the R-Studio Emergency Startup Disks
File Recovery
Searching for a File
Disk Scan
Disk Images

Using R-Studio Emergency as Emergency Agent

Hardware Compatibility List

6.5.1 Properties and Text/Hexadecimal Viewer

To view object properties, 

1 Select an object

2 Press the F7 key
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To view an object

1 Select an object

2 Press the F3 key

3 Press the F6 key to view and select file attributes

Press the Esc key to close the viewer.

6.5.2 Network Drives

To map a network drive,

1 On a dialog box with Map Network Drive, press the Alt+M key

> The Querying DHCP message will appear 

If the network has a DHCP server, the computer will obtain an IP address automatically. A list of adapters
and their IP addresses will appear on the Network Adapters dialog box.

If the network does not have a DHCP server, select a network adapter on the Network Adapters dialog
box and press the F4 key. Enter the IP address and network mask and press the Enter button.

Network Addresses dialog box

2 Select a configured network adapter and press the Enter key

3 Enter the required information on the Map Network Drive message message

Map Network dialog box

Server IP Address: IP address of the computer where the network drive is to reside.
Server Share Name: Name of the shared folder where the network drive is to reside.
Login: Username of a user on the computer where the network drive is to reside.
Password: User's password on the computer where the network drive is to reside.

For the network drive's path //SERVER/Net_Drive, 
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Server IP address: The IP address of the SERVER computer (192.168.1.20)

Server share name: Net_Drive. 

> The mounted network disk will appear

To disconnect a mounted network drive

1 Select a mounted network drive

2 Switch to the Disconnect button and press the Enter key

6.5.3 Log

To clear log information

* Select Clear Log on the Tools menu

To save log information to a file

* Select Save Log To File on the Tools menu

6.5.4 Devices to Store Recovered Files

R-Studio Emergency can write recovered files to the following devices:

· FAT devices such as USB sticks, memory cards, and other similar devices. Such devices are inexpensive and
easily available, they can be fully accessed by all operating systems, but they have one important drawback:
they cannot store files larger that 2GB. So, if you plan to recover large video files, this is not your option.

· exFAT devices such as large USB sticks and memory cards, external hard disks, and other similar devices.
They are fully accessed by all operating systems. Unlike FAT devices, they don't have the 2GB file size limit.

· NTFS disks (primarily used in Windows computers).

 Access without any third-party software:

Windows computers: full.

Mac computers: read. 

Linux computers: full.

· HFS/HFS+ disks (used in Mac computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: full. Some access problems may appear for files written by R-Studio Emergency.

Linux computers: full. Some access problems may appear for files written by R-Studio Emergency.

· Ext2/3/4 disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.
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· XFS disks (used in Linux computers). 

Access without any third-party software:

Windows computers: no.

Mac computers: no

Linux computers: full.

· Network disks. Such disks may be on other network computers or NAS devices. See the Network Drives

page for more details

How to solve file access problems on Macs

Finder in the OSX system shows such inaccessible folders and files in the following way:
Inaccessible folders in Finder

To get access to such data, do the following:

1. Under an administrator account, right-click the folder and select Get Info on the contextual menu.
Info of an inaccessible folder

Click the Lock icon in the Sharing & Permissions section to unlock the folder properties. The system will
ask you for the account password.
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2. Click the Privilege column and select Read & Write on the contextual menu.
Setting the access rights for the folder

3. If this is a folder with other folders and files, click the Properties icon and select Apply to enclosed

items.

Setting access rights for enclosed items in the folder

Then click the Lock icon to lock the properties back. 

6.6 R-Studio Emergency Hardware Compatibility List

R-Studio Emergency supports the following hardware devices:

Data Storage Devices Networking Devices

Serial ATA and Parallel ATA drivers

ACPI firmware driver for PATA

AHCI SATA

ALi PATA

AMD/NVidia PATA

ARTOP 6210/6260 PATA

ARTOP/Acard ATP867X PATA

ATI PATA

CMD / Silicon Image 680 PATA

CMD640 PCI PATA

CMD64x PATA

CS5510/5520 PATA

CS5530 PATA

CS5535 PATA

Ethernet (10 or 100Mbit)

3c501 `EtherLink`

3c503 `EtherLink II`

3c505 `EtherLink Plus`

3c507 `EtherLink 16`

3c509/3c529 (MCA)/3c579 `EtherLink III`

3c515 ISA `Fast EtherLink`

3c590/3c900 series (592/595/597)
`Vortex/Boomerang`

3cr990 series `Typhoon`

AMD 8111 (new PCI lance)

AMD LANCE and PCnet (AT1500 and NE2100)

AMD PCnet32 PCI

AT1700/1720
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CS5536 PATA

Compaq Triflex PATA

Cypress CY82C693 PATA

EFAR SLC90E66

Generic ATA

HPT 343/363 PATA

HPT 366/368 PATA

HPT 370/370A/371/372/374/302 PATA

HPT 372N/302N PATA

IT8211/2 PATA

IT8213 PATA

Initio 162x SATA

Intel ESB, ICH, PIIX3, PIIX4 PATA/SATA

Intel PATA MPIIX

Intel PATA old PIIX

Intel SCH PATA

JMicron PATA

Legacy ISA PATA

Marvell PATA support via legacy mode

Marvell SATA

NETCELL Revolution RAID

NVIDIA SATA

Nat Semi NS87410 PATA

Nat Semi NS87415 PATA

Ninja32/Delkin Cardbus ATA

OPTI FireStar PATA

OPTI621/6215 PATA

Older Promise PATA controller

PCMCIA PATA

Pacific Digital ADMA

Pacific Digital SATA QStor

Platform AHCI SATA

Promise PATA 2027x

Promise SATA SX4

Promise SATA TX2/TX4

QDI VLB PATA

RADISYS 82600 PATA

RDC PATA

SC1200 PATA

SERVERWORKS OSB4/CSB5/CSB6/HT1000
PATA

Adaptec Starfire/DuraLAN

Ansel Communications EISA 3200

Apricot Xen-II on board Ethernet

Atheros L2 Fast Ethernet

Broadcom 440x/47xx ethernet

CS89x0

Cabletron E21xx

DECchip Tulip (dc2114x) PCI

Dave ethernet support (DNET)

Davicom DM910x/DM980x

Early DECchip Tulip (dc2104x) PCI

EtherExpress 16

EtherExpressPro support/EtherExpress 10 (i82595)

Generic DECchip & DIGITAL EtherWORKS
PCI/EISA

HP 10/100VG PCLAN (ISA, EISA, PCI)

HP PCLAN (27245 and other 27xxx series)

HP PCLAN+ (27247B and 27252A)

ICL EtherTeam 16i/32

Intel(R) PRO/100+

LP486E on board Ethernet

Myson MTD-8xx PCI Ethernet

NE2000/NE1000

NI5010

NI5210

NI6510

National Semiconductor DP8381x series PCI
Ethernet

OpenCores 10/100 Mbps Ethernet MAC

PCI NE2000 and clones support (see help)

RDC R6040 Fast Ethernet Adapter

RealTek RTL-8129/8130/8139 PCI Fast Ethernet
Adapter

RealTek RTL-8139 C+ PCI Fast Ethernet Adapter

SEEQ8005

SMC 9194

SMC EtherPower II

SMC Ultra

SMSC LAN9420 PCI ethernet adapter

SiS 900/7016 PCI Fast Ethernet Adapter

Silan SC92031 PCI Fast Ethernet Adapter driver
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ServerWorks Frodo / Apple K2 SATA

SiS 964/965/966/180 SATA

SiS PATA

Silicon Image 3124/3132 SATA

Silicon Image SATA

ULi Electronics SATA

VIA PATA

VIA SATA

VITESSE VSC-7174 / INTEL 31244 SATA

Winbond SL82C105 PATA

Winbond W83759A VLB PATA

SCSI low-level drivers

3ware 5/6/7/8xxx ATA-RAID

3ware 97xx SAS/SATA-RAID

3ware 9xxx SATA-RAID

7000FASST SCSI

ACARD SCSI

ARECA (ARC11xx/12xx/13xx/16xx)
SATA/SAS RAID Host Adapter

Adaptec AACRAID

Adaptec AHA152X/2825

Adaptec AHA1542

Adaptec AIC79xx U320

Adaptec AIC7xxx

Adaptec AIC7xxx Fast -> U160

Adaptec AIC94xx SAS/SATA

Adaptec I2O RAID

AdvanSys SCSI

Always IN2000 SCSI

BusLogic SCSI

DMX3191D SCSI

DTC3180/3280 SCSI

EATA ISA/EISA/PCI (DPT and generic
EATA/DMA-compliant boards)

Emulex LightPulse Fibre Channel Support

Future Domain 16xx SCSI/AHA-2920A

Generic NCR5380/53c400 SCSI MMIO

Generic NCR5380/53c400 SCSI PIO

HP Smart Array SCSI driver

HighPoint RocketRAID 3xxx/4xxx Controller

Sun Cassini

Sun GEM

Sun Happy Meal 10/100baseT

Sundance Alta

TI ThunderLAN

ULi M526x controller

VIA Rhine

WD80*3

Winbond W89c840 Ethernet

Zenith Z-Note

nForce Ethernet

Ethernet (1000 Mbit)

Alteon AceNIC/3Com 3C985/NetGear GA620
Gigabit

Atheros L1C Gigabit Ethernet

Atheros L1E Gigabit Ethernet

Atheros/Attansic L1 Gigabit Ethernet

Broadcom CNIC

Broadcom NetXtremeII

Broadcom Tigon3

DL2000/TC902x-based Gigabit Ethernet

IP1000 Gigabit Ethernet

Intel(R) 82575/82576 PCI-Express Gigabit Ethernet

Intel(R) 82576 Virtual Function Ethernet

Intel(R) PRO/1000 Gigabit Ethernet

Intel(R) PRO/1000 PCI-Express Gigabit Ethernet

JMicron(R) PCI-Express Gigabit Ethernet

National Semiconductor DP83820

New SysKonnect GigaEthernet

Packet Engines Hamachi GNIC-II

Packet Engines Yellowfin Gigabit-NIC

QLogic QLA3XXX Network Driver Support

Realtek 8169 gigabit ethernet

SiS190/SiS191 gigabit ethernet

SysKonnect Yukon2

VIA Velocity

Ethernet (10000 Mbit)

Broadcom NetXtremeII 10Gb

Chelsio 10Gb Ethernet

Chelsio Communications T3 10Gb Ethernet
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IBM Power Linux RAID adapter

IBM ServeRAID

Initio 9100U(W)

Initio INI-A100U2W

Intel/ICP (former GDT SCSI Disk Array) RAID
Controller

LSI Logic Legacy MegaRAID Driver

LSI Logic Management Module

LSI Logic MegaRAID Driver

LSI Logic MegaRAID SAS RAID Module

LSI MPT Fusion SAS 2.0 Device Driver

Marvell 88SE64XX/88SE94XX SAS/SATA

NCR53c406a SCSI

PAS16 SCSI

PMC SIERRA Linux MaxRAID adapter

PMC-Sierra SPC 8001 SAS/SATA Based Host
Adapter driver

Promise SuperTrak EX Series

QLogic ISP4XXX host adapter family

QLogic QLA2XXX Fibre Channel Support

Qlogic FAS SCSI

Qlogic QLA 1240/1x80/1x160 SCSI

SYM53C8XX Version 2 SCSI

Symbios 53c416 SCSI

Tekram DC390(T) and Am53/79C974 SCSI

Tekram DC395(U/UW/F) and DC315(U) SCSI

Trantor T128/T128F/T228 SCSI

UltraStor 14F/34F

UltraStor SCSI

VMware PVSCSI driver

Workbit NinjaSCSI-32Bi/UDE

USB support

Cypress C67x00 HCD

Datafab Compact Flash Reader

Freecom USB/ATAPI Bridge

ISD-200 USB/ATA Bridge

ISP 1760 HCD

ISP116X HCD

ISP1362 HCD

Lexar Jumpshot Compact Flash Reader

Chelsio Communications T4 Ethernet

Cisco VIC Ethernet NIC Support

Intel(R) 10GbE PCI Express adapters

Intel(R) PRO/10GbE

Mellanox Technologies 10Gbit Ethernet

Myricom Myri-10G Ethernet

NetXen Multi port (1/10) Gigabit Ethernet NIC

Neterion X3100 Series 10GbE PCIe Server Adapter

QLOGIC QLCNIC 1/10Gb Converged Ethernet
NIC Support

QLogic QLGE 10Gb Ethernet Driver Support

S2IO 10Gbe XFrame NIC

ServerEngines' 10Gbps NIC - BladeEngine

Solarflare Solarstorm SFC4000/SFC9000-family

Sun Neptune 10Gbit Ethernet

Tehuti Networks 10G Ethernet

Token Ring driver support

3Com 3C359 Token Link Velocity XL adapter

Generic TMS380 PCI

Generic TMS380 Token Ring ISA/PCI adapter

IBM Lanstreamer chipset PCI adapter

IBM Olympic chipset PCI adapter

IBM Tropic chipset based adapter

Madge Smart 16/4 PCI Mk2

Proteon ISA

SMC ISA/MCA adapter

SysKonnect TR4/16 ISA

USB Network Adapters

ASIX AX88xxx Based USB 2.0 Ethernet Adapters

CDC EEM

CDC Ethernet support (smart devices such as cable
modems)

Davicom DM9601 based USB 1.1 10/100 ethernet
devices

GeneSys GL620USB-A based cables

Host for RNDIS and ActiveSync devices

MosChip MCS7830 based Ethernet adapters

NetChip 1080 based cables (Laplink, ...)

Prolific PL-2301/2302 based cables
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OXU210HP HCD

Olympus MAUSB-10/Fuji DPC-R1

R8A66597 HCD

SL811HS HCD

SanDisk SDDR-09 (and other SmartMedia,
including DPCM)

SanDisk SDDR-55 SmartMedia

USB 2.0

USB Mass Storage

USB Monitor

USBAT/USBAT02-based storage

xHCI HCD (USB 3.0)

Block devices

Compaq SMART2

Compaq Smart Array 5xxx

Mylex DAC960/DAC1100 PCI RAID Controller

Normal floppy disk

Promise SATA SX8

IEEE 1394 (FireWire) support

Legacy alternative FireWire driver stack

Storage devices (SBP-2 protocol)

PCMCIA network device support

3Com 3c574 PCMCIA

3Com 3c589 PCMCIA

Asix AX88190 PCMCIA

COM20020 ARCnet PCMCIA

Fujitsu FMV-J18x PCMCIA

NE2000 compatible PCMCIA

New Media PCMCIA

SMC 91Cxx PCMCIA

Xircom 16-bit PCMCIA

Other devices

Microsoft Hyper-V Utilities driver

Microsoft Hyper-V client drivers

Microsoft Hyper-V virtual block driver

Microsoft Hyper-V virtual network driver

Microsoft Hyper-V virtual storage driver

SMSC LAN95XX based USB 2.0 10/100 ethernet
devices

Sharp Zaurus (stock ROMs) and compatible

Simple USB Network Links (CDC Ethernet subset)

USB CATC NetMate-based Ethernet device

USB KLSI KL5USB101-based ethernet device

USB Pegasus/Pegasus-II based ethernet device

USB RTL8150 based ethernet device
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VII R-Studio Agent Emergency

R-Studio Agent Emergency is a tool that allows you to start a network computer with a damaged startup disk
and recover data stored on its hard drives. Then restored data can be transferred to a working computer via the
network.

It works very simple: Just start the computer with the R-Studio Agent Emergency startup disk(s) and, if
necessary, manually configure a network interface for R-Studio Agent Emergency. When started, the
computer and its hard drives can be accessed by R-Studio installed on another computer on the network. 

Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

Hardware Compatibility List
Disk Controllers
Network Cards

7.1 Contact Information and Technical Support

To obtain the latest version of R-Studio Agent Emergency, go to:

Product Site: http://www.r-tt.com
Sales Department: sales@r-tt.com

R-Studio Technical Support Team is available 24 hours a day, seven days a week, and has an average
response time less than 4 hours.

Tech. Support: support@r-tt.com
Send your support request to: http://www.r-tt.com/Support_request.html

7.2 Installing R-Studio Agent Emergency Startup Media Creator

You must have administrative privileges to install R-Studio Agent Emergency Startup Media
Creator. 

If you are not sure whether you have such privileges, you almost certainly do not have them. Contact your system
administrator for assistance.

1.Run the setup file. 
2.Follow the on-screen instructions. 

You may create startup disks even before the installation ends.

7.3 Creating Startup Disks

You need to create either 

· A startup CD/DVD disc. You may create an ISO image, or write the disc directly from R-Studio Emergency

Startup Media Creator, if there is a CD/DVD recorder in your system.

or

http://www.r-tt.com
mailto:sales@r-tt.com
mailto:support@r-tt.com
http://www.r-tt.com/Support_request.html
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· A startup FAT/FAT32 removable device recognized by your system as a bootable one. The total available size
of the device should be more than 10 MB.

or

· 4 formatted floppy disks

Check the Hardware Compatibility List.

When R-Studio Agent Emergency Startup Media Creator starts, its Welcome dialog box appears:

Welcome to R-Studio Agent Emergency Startup Media Creator dialog box

Welcome dialog box

click the Next button to see the list of all devices on which startup disks may be created.

Startup media type selection dialog box

To create a startup CD/DVD disc directly on your CD/DVD writer (if present):

1 Run R-Studio Agent Emergency

2 Select the CD/DVD writer on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.
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R-Studio Agent Emergency License Agreement dialog box

R-Studio Agent Emergency Activation dialog box

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection

4 Insert a blank CD/DVD disk into the CD/DVD recorder and click the Next button

Insert media disc dialog box
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> R-Studio Agent Emergency Startup Media Creator will start creating the startup CD/DVD disc

showing the progress on the Creating startup media dialog box

Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup CD/DVD disc,

the R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.

R-Studio Agent Emergency Startup Media Creation is Finished message

To create an ISO image of a startup CD/DVD disc

1 Run R-Studio Agent Emergency

2 Select ISO Image for a startup CD/DVD on the R-Studio Agent Emergency Startup Media Creator

dialog box and click the Next button

3 Read and accept the License Agreement and enter the R-Studio Agent registration key on the R-
Studio Agent Emergency Activation dialog box and click the Next button

Note: You should enter the registration key of R-Studio Agent, not R-Studio itself.

if you do not enter the registration key, R-Studio Agent Emergency will work in the Demo mode. You
may enter the key later when R-Studio Agent Emergency and R-Studio establish a connection.

4 Select a place and file name for the ISO image of the startup CD/DVD and click the Save button

> When R-Studio Bootable Startup Media Creator finishes writing the file with the ISO image, the R-
Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Bootable Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

5 Create the startup CD/DVD using your favorite CD/DVD creation software

Load the created ISO image into the CD/DVD creation software. Consult documentation for the software
for details.

To create a startup FAT/FAT32 removable device

1 Run R-Studio Agent Emergency

2 Select the removable device on the Startup media type selection dialog box and click the Next button

3 Read and accept the License Agreement and enter the registration key on the R-Studio Agent
Emergency Activation dialog box and click the Next button

4 Check that the correct FAT/FAT32-formatted device is selected and click the Next button

Confirm device selection dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup USB disk showing

the progress on the Creating startup media dialog box

When R-Studio Agent Emergency Startup Media Creator finishes creating the startup device, the

R-Studio Agent Emergency Startup Media Creation is Finished message will appear

You may either exit R-Studio Emergency Startup Media Creator by clicking the Finish button or create
another startup media by clicking the Back button.
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R-Studio Agent Emergency Startup Media Creation is Finished dialog box

To create floppy disks:

You will need 4 formatted floppy disks.

1 Run R-Studio Agent Emergency

2 Select Floppy Disk for the startup floppy disk on the R-Studio Agent Emergency Startup Media

Creator dialog box and click the Next button

3 Enter the registration information and number on the Registration dialog box and click the Next button

If you leave all the field blank, R-Studio Agent Emergency will work with the Demo-version limitations

4 Insert the floppy disk and click the Next button on the Insert floppy dialog box

Insert floppy dialog box

> R-Studio Agent Emergency Startup Media Creator will start creating the startup floppy disk

showing the progress on the Creating startup media dialog box

Creating startup media dialog box
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5 Insert the second floppy disk and click the OK button when the Please insert formatted diskette #2
into drive A: message will appear

Do it with the next 2 floppy disks.

> When R-Studio Startup Media Creator finishes creating the startup floppy disk, the R-Studio Agent

Emergency Startup Media Creation is Finished message will appear. You may either exit R-Studio

Startup Media Creator by clicking the Finish button or create another startup media by clicking the

Back button.

R-Studio Agent Emergency Startup Media Creation is Finished dialog box

7.4 Starting a Computer with the R-Studio Agent Emergency
Startup Disk

We recommended that you print out this help page and have the hardcopy on hand while you are
performing this action.

Before you start the computer you should be aware that your network has a DHCP server or you
know the computer's IP address and network mask.

If there is a non-IDE disk controller in your system, or you plan to use network disks or external hardware
devices, first check the Hardware Compatibility List.

If you plan to use any external device, turn it on before starting the system.

If the motherboard in your computer supports the Serial ATA (SATA) devices, but IDE disks are also present,
only the SATA devices should be set to the Enhanced Mode in BIOS.

To start the computer with the R-Studio Agent Emergency startup disks

1 Make sure that the first startup device in the system BIOS is the device from which you plan to start
your computer (a CD/DVD drive or A (Floppy)) 

Disable "Secure boot" in the system BIOS if your computer is certified to run Windows 8. Refer to your
system documentation for details. Refer to your system documentation for details.

2 Insert the R-Studio Agent Emergency startup CD/DVD disc, a removable device, or the first floppy disk

and start your computer

> R-Studio Agent Emergency will start and its prompt will appear

If you start your computer with floppy disks, you'll see prompts to insert a next floppy disk.
-----------------------------------------------------------------
Booting R-Studio Emergency. Please wait...
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Waiting 8 seconds for PCMCIA devices to settle
Booting R-Studio Agent Emergency. Now you may remove floppy.
-----------------------------------------------------------------
Querying DHCP to configure network interfaces...
Press ENTER within 10 seconds to configure them manually.

If your network has a DHCP server

The computer running R-Studio Agent Emergency will be assigned an IP address automatically

A prompt with a computer address will appear. You need to remember it to access the computer via
network.

If your network does not have a DHCP server

You need to configure the interfaces and IP addresses manually. 

1. A prompt to select an interface will appear. Enter the selected interface name and press Enter.
2. A prompt to enter its IP address and optional subnet mask will appear. Enter the IP address and optional

subnet mask and press Enter.
------------------------[ List of Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------------------
re0            Unconfigured                             RealTek 8139C+
------------------------------------------------------------------------------
# Enter interface name, 'gw' for default gateway or just press ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

3. A prompt to configure another interface, gateway, or to finish configuring the interfaces will appear. Enter
gw, enter the IP address of the gateway, and press Enter.
------------------------[ List of Interfaces ]--------------------------------
Name           IP Address            NETMASK          Vendor
------------------------------------------------------------------------------
re0            Unconfigured                           RealTek 8139C+
------------------------------------------------------------------------------
# Enter interface name, 'gw' for default gateway or just press ENTER to finish
#>re0
# Enter IP address and optional NETMASK delimited by space
#>192.168.0.10 255.255.255.0

------------------------[ List of Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------------------
re0            192.168.0.10          255.255.255.0      RealTek 8139C+
gw             Unconfigured                             Default gateway
------------------------------------------------------------------------------
# Enter interface name, 'gw' for default gateway or just press ENTER to finish
#>gw
# Enter default gateway IP Address
#>192.168.0.1

------------------------[ List of Interfaces ]--------------------------------
Name           IP Address            NETMASK            Vendor
------------------------------------------------------------------------------
re0            192.168.0.10          255.255.255.0      RealTek 8139C+
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gw             192.168.0.1                              Default gateway
------------------------------------------------------------------------------
# Enter interface name, 'gw' for default gateway or just press ENTER to finish
#>

4. Press Enter to finish configuring the interfaces, or enter the name of the next interface to configure. 

> R-Studio Agent Emergency will show a prompt that is ready to accept connections

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start to remote R-Studio...

Now the computer may be accessed by R-Studio via network.

Secure boot:

It may be impossible to start a Windows 8 certified computer with the R-Studio Agent Emergency startup disk
without some additional actions. This happens because any computer should use a so-called "Secure boot"
procedure to comply with Windows 8 hardware certification from Microsoft. In brief, this procedure prevents
computer from booting into any operating system that isn't digitally signed with an appropriate digital signature.
"Secure boot" is claimed to prevent unauthorized modification of the boot sector by bootkits, viruses, trojans,
and other malicious software. To the date, only Windows 8, Windows Server 2012, and selected Linux
distributions support this feature. As a side effect, it also prevents most LiveCDs, rescue disks (R-Studio and R-
Drive Image included), and other OS from running.

Likely enough, the other requirement of Windows 8 hardware certification is to make it possible for the user to
disable the Secure boot procedure. Those settings can be done through the system BIOS under the Boot
options. Generally, it's enough to enable Legacy support in those options, but sometimes it may require additional
actions. Please, refer to your system documentation to learn more about disabling/enabling Secure boot.

When Secure boot is disabled, it should be possible to start the computer with the R-Studio Agent Emergency
startup disk.

Please note that you should enable this feature back after using the startup disks because Windows 8 or Server
2012 may not start properly without the Secure boot feature enabled.

Starting a Connection from R-Studio Agent Emergency

When you need to connect R-Studio and R-Studio Agent Emergency over the Internet, it may be necessary
to start the connection from the computer where R-Studio Agent Emergency is running.

To connect to R-Studio's computer,

1 Press the Enter key and enter the IP address of the computer where R-Studio is running as

IPaddress:port.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel> 192.168.0.25:80

The default port is 8080, and you don't have to specify it.

2 Enter the password if required, and press the Enter key.

* R-Studio Agent started and ready to accept connections...
* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel> 192.168.0.25:80
# Enter password or just press ENTER to connect without one>PaSsWoRd1234

> When the connection is established successfully, R-Studio Agent Emergency will notify you about

this.

* R-Studio Agent started and ready to accept connections...
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* You may press ENTER to start connection to remote R-Studio...
# Enter R-Studio IP address or just press ENTER to cancel> 192.168.0.25:80
# Enter password or just press ENTER to connect without one>PaSsWoRd1234
Connection with 192.168.0.25:80 is established successfully.

7.5 R-Studio Agent Emergency Hardware Compatibility List

Disk Controllers
Network Cards

R-Studio Agent Emergency
Contact Information and Technical Support
Installing R-Studio Agent Emergency Startup Media Creator
Creating Startup Disks
Starting a Computer with the R-Studio Agent Emergency Startup Disk

7.5.1 Disk Controllers

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

Disk controllers

IDE/ATA controllers ( ata driver) *

The adapters supported by the aic driver include:

Adaptec AHA-1505 (ISA)
Adaptec AHA-1510A, AHA-1510B (ISA)
Adaptec AHA-1520A, AHA-1520B (ISA)
Adaptec AHA-1522A, AHA-1522B (ISA)
Adaptec AHA-1535 (ISA)
Creative Labs SoundBlaster SCSI host adapter (ISA)
Adaptec AHA-1460, AHA-1460B, AHA-1460C, AHA-1460D (PC Card)
Adaptec AHA-1030B, AHA-1030P (PC98)
NEC PC-9801-100 (PC98)

The aha driver supports the following SCSI host adapters:

Adaptec AHA-154xB
Adaptec AHA-154xC
Adaptec AHA-154xCF
Adaptec AHA-154xCP
Adaptec AHA-1640
Adaptec AHA-174x in 154x emulation mode
DTC 3290 SCSI controller in 1542 emulation mode
Tekram SCSI controllers in 154x emulation mode

The ahb driver supports the following SCSI host adapters:

Adaptec AHA-1740
Adaptec AHA-1742
Adaptec AHA-1740A

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Adaptec AHA-1742A
The ahc driver supports the following SCSI host adapter chips and SCSI controller cards:

Adaptec AIC7770 host adapter chip
Adaptec AIC7850 host adapter chip
Adaptec AIC7860 host adapter chip
Adaptec AIC7870 host adapter chip
Adaptec AIC7880 host adapter chip
Adaptec AIC7890 host adapter chip
Adaptec AIC7891 host adapter chip
Adaptec AIC7892 host adapter chip
Adaptec AIC7895 host adapter chip
Adaptec AIC7896 host adapter chip
Adaptec AIC7897 host adapter chip
Adaptec AIC7899 host adapter chip
Adaptec 274X(W)
Adaptec 274X(T)
Adaptec 284X
Adaptec 2910
Adaptec 2915
Adaptec 2920
Adaptec 2930C
Adaptec 2930U2
Adaptec 2940
Adaptec 2940J
Adaptec 2940N
Adaptec 2940U
Adaptec 2940AU
Adaptec 2940UW
Adaptec 2940UW Dual
Adaptec 2940UW Pro
Adaptec 2940U2W
Adaptec 2940U2B
Adaptec 2950U2W
Adaptec 2950U2B
Adaptec 19160B
Adaptec 29160B
Adaptec 29160N
Adaptec 3940
Adaptec 3940U
Adaptec 3940AU
Adaptec 3940UW
Adaptec 3940AUW
Adaptec 3940U2W
Adaptec 3950U2
Adaptec 3960
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Adaptec 39160
Adaptec 3985
Adaptec 4944UW
NEC PC-9821Xt13 (PC-98)
NEC RvII26 (PC-98)
NEC PC-9821X-B02L/B09 (PC-98)
NEC SV-98/2-B03 (PC-98)
Many motherboards with on-board SCSI support

The ahd driver supports the following:

Adaptec AIC7901 host adapter chip
Adaptec AIC7901A host adapter chip
Adaptec AIC7902 host adapter chip
Adaptec 29320 host adapter
Adaptec 39320 host adapter
Many motherboards with on-board SCSI support

Controllers supported by the aac driver include:

Adaptec AAC-364
Adaptec SCSI RAID 2120S
Adaptec SCSI RAID 2130S
Adaptec SCSI RAID 2200S
Adaptec SCSI RAID 2410SA
Adaptec SCSI RAID 2810SA
Adaptec SCSI RAID 5400S
Dell CERC SATA RAID 2
Dell PERC 2/Si
Dell PERC 2/QC
Dell PERC 3/Si
Dell PERC 3/Di
Dell PERC 320/DC
HP NetRAID 4M

The adv driver supports the following SCSI controllers:

AdvanSys ABP510/5150
AdvanSys ABP5140
AdvanSys ABP5142
AdvanSys ABP902/3902
AdvanSys ABP3905
AdvanSys ABP915
AdvanSys ABP920
AdvanSys ABP3922
AdvanSys ABP3925
AdvanSys ABP930, ABP930U, ABP930UA
AdvanSys ABP960, ABP960U
AdvanSys ABP542
AdvanSys ABP742
AdvanSys ABP842
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AdvanSys ABP940
AdvanSys ABP940UA/3940UA
AdvanSys ABP940U
AdvanSys ABP3960UA
AdvanSys ABP970, ABP970U
AdvanSys ABP752
AdvanSys ABP852
AdvanSys ABP950
AdvanSys ABP980, ABP980U
AdvanSys ABP980UA/3980UA
MELCO IFC-USP (PC-98)
RATOC REX-PCI30 (PC-98)
@Nifty FNECHARD IFC-USUP-TX (PC-98)

The adw driver supports SCSI controllers including:

AdvanSys ABP940UW/ABP3940UW
AdvanSys ABP950UW
AdvanSys ABP970UW
AdvanSys ABP3940U2W
AdvanSys ABP3950U2W

The bt driver supports the following BusLogic MultiMaster ``W'', ``C'', ``S'', and ``A'' series and compatible
SCSI host adapters:

BusLogic BT-445C
BusLogic BT-445S
BusLogic BT-540CF
BusLogic BT-542B
BusLogic BT-542B
BusLogic BT-542D
BusLogic BT-545C
BusLogic BT-545S
BusLogic/BusTek BT-640
BusLogic BT-742A
BusLogic BT-742A
BusLogic BT-747C
BusLogic BT-747D
BusLogic BT-747S
BusLogic BT-757C
BusLogic BT-757CD
BusLogic BT-757D
BusLogic BT-757S
BusLogic BT-946C
BusLogic BT-948
BusLogic BT-956C
BusLogic BT-956CD
BusLogic BT-958
BusLogic BT-958D
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Storage Dimensions SDC3211B / SDC3211F
AMI FastDisk Host Adapters that are true BusLogic MultiMaster clones are also supported by the bt driver.

The dpt driver provides support for the following RAID adapters:

DPT Smart Cache Plus
Smart Cache II (PM2?2?, PM2022 [EISA], PM2024/PM2124 [PCI]) (Gen2)
Smart RAID II (PM3?2?, PM3021, PM3222)
Smart Cache III (PM2?3?)
Smart RAID III (PM3?3?, PM3332 [EISA], PM3334UW [PCI]) (Gen3)
Smart Cache IV (PM2?4?, PM2042 [EISA], PM2044/PM2144 [PCI]) (Gen4)
Smart RAID IV

The adapters currently supported by the asr driver include the following:

Adaptec Zero-Channel SCSI RAID 2000S, 2005S, 2010S, 2015S
Adaptec SCSI RAID 2100S, 2110S
Adaptec ATA-100 RAID 2400A
Adaptec SCSI RAID 3200S, 3210S
Adaptec SCSI RAID 3400S, 3410S
Adaptec SmartRAID PM1554
Adaptec SmartRAID PM1564
Adaptec SmartRAID PM2554
Adaptec SmartRAID PM2564
Adaptec SmartRAID PM2664
Adaptec SmartRAID PM2754
Adaptec SmartRAID PM2865
Adaptec SmartRAID PM3754
Adaptec SmartRAID PM3755U2B / SmartRAID V Millennium
Adaptec SmartRAID PM3757
DEC KZPCC-AC (LVD 1-ch, 4MB or 16MB cache), DEC KZPCC-CE (LVD 3-ch, 64MB cache), DEC
KZPCC-XC (LVD 1-ch, 16MB cache), DEC KZPCC-XE (LVD 3-ch, 64MB cache) -- rebadged
SmartRAID V Millennium

The amr driver supports the following:

AMI MegaRAID 320-1
AMI MegaRAID 320-2
AMI MegaRAID 320-4X
AMI MegaRAID Series 418
AMI MegaRAID Enterprise 1200 (Series 428)
AMI MegaRAID Enterprise 1300 (Series 434)
AMI MegaRAID Enterprise 1400 (Series 438)
AMI MegaRAID Enterprise 1500 (Series 467)
AMI MegaRAID Enterprise 1600 (Series 471)
AMI MegaRAID Elite 1500 (Series 467)
AMI MegaRAID Elite 1600 (Series 493)
AMI MegaRAID Elite 1650 (Series 4xx)
AMI MegaRAID Express 100 (Series 466WS)
AMI MegaRAID Express 200 (Series 466)
AMI MegaRAID Express 300 (Series 490)
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AMI MegaRAID Express 500 (Series 475)
Dell PERC
Dell PERC 2/SC
Dell PERC 2/DC
Dell PERC 3/DCL
Dell PERC 3/QC
Dell PERC 4/Di
HP NetRAID-1/Si
HP NetRAID-3/Si (D4943A)
HP Embedded NetRAID
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mlx driver include:

Mylex DAC960P
Mylex DAC960PD / DEC KZPSC (Fast Wide)
Mylex DAC960PDU
Mylex DAC960PL
Mylex DAC960PJ
Mylex DAC960PG
Mylex DAC960PU / DEC PZPAC (Ultra Wide)
Mylex AcceleRAID 150 (DAC960PRL)
Mylex AcceleRAID 250 (DAC960PTL1)
Mylex eXtremeRAID 1100 (DAC1164P)
RAIDarray 230 controllers, aka the Ultra-SCSI DEC KZPAC-AA (1-ch, 4MB cache), KZPAC-CA (3-ch,
4MB), KZPAC-CB (3-ch, 8MB cache)
All major firmware revisions (2.x, 3.x, 4.x and 5.x) are supported, however it is always advisable to upgrade to
the most recent firmware available for the controller. Compatible Mylex controllers not listed should work, but
have not been verified.
Note: Booting from these controllers is supported. EISA adapters are not supported.

Controllers supported by the mly driver include:

Mylex AcceleRAID 160
Mylex AcceleRAID 170
Mylex AcceleRAID 352
Mylex eXtremeRAID 2000
Mylex eXtremeRAID 3000
Compatible Mylex controllers not listed should work, but have not been verified.

The twe driver supports the following ATA RAID controllers:

AMCC's 3ware 5000 series
AMCC's 3ware 6000 series
AMCC's 3ware 7000-2
AMCC's 3ware 7006-2
AMCC's 3ware 7500-4LP
AMCC's 3ware 7500-8
AMCC's 3ware 7500-12
AMCC's 3ware 7506-4LP
AMCC's 3ware 7506-8
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AMCC's 3ware 7506-12
AMCC's 3ware 8006-2LP
AMCC's 3ware 8500-4LP
AMCC's 3ware 8500-8
AMCC's 3ware 8500-12
AMCC's 3ware 8506-4LP
AMCC's 3ware 8506-8
AMCC's 3ware 8506-8MI
AMCC's 3ware 8506-12
AMCC's 3ware 8506-12MI

The twa driver supports the following PATA/SATA RAID controllers:

AMCC's 3ware 9500S-4LP
AMCC's 3ware 9500S-8
AMCC's 3ware 9500S-8MI
AMCC's 3ware 9500S-12
AMCC's 3ware 9500S-12MI

The ncr driver provides support for the following NCR/Symbios SCSI controller chips:

53C810
53C810A
53C815
53C820
53C825A
53C860
53C875
53C875J
53C885
53C895
53C895A
53C896
53C1510D
The following add-on boards are known to be supported:

I-O DATA SC-98/PCI (PC-98)
I-O DATA SC-PCI (PC-98)

The sym driver provides support for the following Symbios/LSI Logic PCI SCSI controllers:

53C810
53C810A
53C815
53C825
53C825A
53C860
53C875
53C876
53C895
53C895A
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53C896
53C897
53C1000
53C1000R
53C1010-33
53C1010-66
53C1510D

The SCSI controllers supported by sym can be either embedded on a motherboard, or on one of the
following add-on boards:

ASUS SC-200, SC-896
Data Technology DTC3130 (all variants)
DawiControl DC2976UW
Diamond FirePort (all)
I-O DATA SC-UPCI (PC-98)
Logitec LHA-521UA (PC-98)
NCR cards (all)
Symbios cards (all)
Tekram DC390W, 390U, 390F, 390U2B, 390U2W, 390U3D, and 390U3W
Tyan S1365

The following devices are currently supported by the ncv driver:

I-O DATA PCSC-DV
KME KXLC002 (TAXAN ICD-400PN, etc.), KXLC004, and UJDCD450
Macnica Miracle SCSI-II mPS110
Media Intelligent MSC-110, MSC-200
NEC PC-9801N-J03R
New Media Corporation BASICS SCSI
Qlogic Fast SCSI
RATOC REX-9530, REX-5572 (SCSI only)

Controllers supported by the stg driver include:

Adaptec 2920/A
Future Domain SCSI2GO
Future Domain TMC-18XX/3260
IBM SCSI PCMCIA Card
ICM PSC-2401 SCSI
MELCO IFC-SC
RATOC REX-5536, REX-5536AM, REX-5536M, REX-9836A
Note that the Adaptec 2920C is supported by the ahc driver.

Cards supported by the isp driver include:

ISP1000
PTI SBS440
ISP1020
ISP1040
PTI SBS450
Qlogic 1240
Qlogic 1020
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Qlogic 1040
Qlogic 1080
Qlogic 1280
Qlogic 12160
Qlogic 2100
Qlogic 2102
Qlogic 2200
Qlogic 2202
Qlogic 2204
Qlogic 2300
Qlogic 2312
PTI SBS470
Antares P-0033

Controllers supported by the amd driver include:

MELCO IFC-DP (PC-98)
Tekram DC390
Tekram DC390T

Controllers supported by the nsp driver include:

Alpha-Data AD-PCS201
I-O DATA CBSC16
Adaptec AIC-7110 Parallel to SCSI interfaces ( vpo driver)

The following controllers are supported by the ida driver:

Compaq SMART Array 221
Compaq Integrated SMART Array Controller
Compaq SMART Array 4200
Compaq SMART Array 4250ES
Compaq SMART 3200 Controller
Compaq SMART 3100ES Controller
Compaq SMART-2/DH Controller
Compaq SMART-2/SL Controller
Compaq SMART-2/P Controller
Compaq SMART-2/E Controller
Compaq SMART Controller

Controllers supported by the ciss driver include:

Compaq Smart Array 5300
Compaq Smart Array 532
Compaq Smart Array 5i
HP Smart Array 5312
HP Smart Array 6i
HP Smart Array 641
HP Smart Array 642
HP Smart Array 6400
HP Smart Array 6400 EM
HP Smart Array 6422
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HP Smart Array V100
HP Modular Smart Array 20 (MSA20)
HP Modular Smart Array 500 (MSA500)

Controllers supported by the iir driver include:

Intel RAID Controller SRCMR
Intel Server RAID Controller U3-l (SRCU31a)
Intel Server RAID Controller U3-1L (SRCU31La)
Intel Server RAID Controller U3-2 (SRCU32)
All past and future releases of Intel and ICP RAID Controllers.
Intel RAID Controller SRCU21 (discontinued)
Intel RAID Controller SRCU31 (older revision, not compatible)
Intel RAID Controller SRCU31L (older revision, not compatible)
The SRCU31 and SRCU31L can be updated via a firmware update available from Intel.
Promise SuperTrak ATA RAID controllers (pst driver)

The hptmv driver supports the HighPoint RocketRAID 182x SATA controllers.

Controllers supported by the ips driver include:

IBM ServeRAID 3H
ServeRAID 4L/4M/4H
ServeRAID Series 5
ServeRAID 6i/6M

The following controllers are supported by the mpt driver:

LSI Logic 53c1030 (Dual Ultra320 SCSI)
LSI Logic FC909 (1Gb/s Fibre Channel)
LSI Logic FC909A (Dual 1Gb/s Fibre Channel)
LSI Logic FC919 (2Gb/s Fibre Channel)
LSI Logic FC929 (Dual 2Gb/s Fibre Channel)
The SCSI controller chips supprted by the mpt driver can be found onboard on many systems including:
Dell PowerEdge 1750
IBM eServer xSeries 335

SCSI controllers supported by the trm driver include:

Tekram DC-315 PCI Ultra SCSI adapter without BIOS and internal SCSI connector
Tekram DC-315U PCI Ultra SCSI adapter without BIOS
Tekram DC-395F PCI Ultra-Wide SCSI adapter with flash BIOS and 68-pin external SCSI connector
Tekram DC-395U PCI Ultra SCSI adapter with flash BIOS
Tekram DC-395UW PCI Ultra-Wide SCSI adapter with flash BIOS
Tekram DC-395U2W PCI Ultra2-Wide SCSI adapter with flash BIOS
For the Tekram DC-310/U and DC-390F/U/UW/U2B/U2W/U3W PCI SCSI host adapters, use the sym
driver.

The wds driver supports the WD7000 SCSI controller.

7.5.2 Network Cards

R-Studio Agent Emergency is based on the FreeBSD 5.3 kernel and supports devices from the list published
at http://www.freebsd.org/releases/5.3R/hardware-i386.html.

*: Supported in the floppy version

http://www.freebsd.org/releases/5.3R/hardware-i386.html
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Ethernet NICs

Adapters supported by the sf driver include:

ANA-62011 64-bit single port 10/100baseTX adapter
ANA-62022 64-bit dual port 10/100baseTX adapter
ANA-62044 64-bit quad port 10/100baseTX adapter
ANA-69011 32-bit single port 10/100baseTX adapter
ANA-62020 64-bit single port 100baseFX adapter

The ti driver supports Gigabit Ethernet adapters based on the Alteon Tigon I and II chips. The ti driver has
been tested with the following adapters:

3Com 3c985-SX Gigabit Ethernet adapter (Tigon 1)
3Com 3c985B-SX Gigabit Ethernet adapter (Tigon 2)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseSX)
Alteon AceNIC V Gigabit Ethernet adapter (1000baseT)
Digital EtherWORKS 1000SX PCI Gigabit adapter
Netgear GA620 Gigabit Ethernet adapter (1000baseSX)
Netgear GA620T Gigabit Ethernet adapter (1000baseT)
The following adapters should also be supported but have not yet been tested:

Asante GigaNIX1000T Gigabit Ethernet adapter
Asante PCI 1000BASE-SX Gigabit Ethernet adapter
Farallon PN9000SX Gigabit Ethernet adapter
NEC Gigabit Ethernet
Silicon Graphics PCI Gigabit Ethernet adapter

The pcn driver supports adapters and embedded controllers based on the AMD PCnet/FAST, PCnet/FAST+,
PCnet/FAST III, PCnet/PRO and PCnet/Home Fast Ethernet chips:

AMD Am53C974/Am79C970/Am79C974 PCnet-PCI *
AMD Am79C970A PCnet-PCI II *
AMD Am79C971 PCnet-FAST *
AMD Am79C972 PCnet-FAST+ *
AMD Am79C973/Am79C975 PCnet-FAST III *
AMD Am79C976 PCnet-PRO *
AMD PCnet/Home HomePNA
Allied-Telesis LA-PCI
Contec C-NET(98)S (PC-98)
NEC SV-98/2-B05, B06

The lnc driver supports the following adapters:

Novell NE2100 *
Novell NE32-VL *
Isolan AT 4141-0 (16 bit)
Isolan BICC
Isolink 4110 (8 bit)
Diamond HomeFree
Digital DEPCA
Hewlett Packard Vectra 486/66XM
Hewlett Packard Vectra XU
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Also supported are adapters working with the pcn driver. The lnc driver runs these in compatibility mode, thus
the pcn driver should be preferred.
SMC 83c17x (EPIC)-based Ethernet NICs (tx driver)

The ed driver supports the following Ethernet NICs:

3Com 3c503 Etherlink II
AR-P500 Ethernet
Accton EN1644 (old model), EN1646 (old model), EN2203 (old model) (110pin) (flags 0xd00000)
Accton EN2212/EN2216/UE2216
Allied Telesis CentreCOM LA100-PCM_V2
Allied Telesis LA-98 (flags 0x000000) (PC-98)
Allied Telesis SIC-98, SIC-98NOTE (110pin), SIU-98 (flags 0x600000) (PC-98)
Allied Telesis SIU-98-D (flags 0x610000) (PC-98)
AmbiCom 10BaseT card
Bay Networks NETGEAR FA410TXC Fast Ethernet
CNet BC40 adapter
Compex Net-A adapter
Contec C-NET(98), RT-1007(98), C-NET(9N) (110pin) (flags 0xa00000) (PC-98)
Contec C-NET(98)E-A, C-NET(98)L-A, C-NET(98)P (flags 0x300000) (PC-98)
Corega Ether98-T (flags 0x000000) (PC-98)
Corega Ether PCC-T/EtherII PCC-T/FEther PCC-TXF/PCC-TXD
CyQ've ELA-010
DEC EtherWorks DE305
Danpex EN-6200P2
D-Link DE-298, DE-298P (flags 0x500000) (PC-98)
D-Link DE-650/660
D-Link IC-CARD/IC-CARD+ Ethernet
ELECOM LD-98P (flags 0x500000) (PC-98)
ELECOM LD-BDN, LD-NW801G (flags 0x200000) (PC-98)
ELECOM Laneed LD-CDL/TX, LD-CDF, LD-CDS, LD-10/100CD, LD-CDWA (DP83902A)
HP PC Lan+ 27247B and 27252A
IBM Creditcard Ethernet I/II
ICM AD-ET2-T, DT-ET-25, DT-ET-T5, IF-2766ET, IF-2771ET, NB-ET-T (110pin) (flags 0x500000)
(PC-98)
I-O DATA LA/T-98, LA/T-98SB, LA2/T-98, ET/T-98 (flags 0x900000) (PC-98)
I-O DATA ET2/T-PCI
I-O DATA PCLATE
Kansai KLA-98C/T (flags 0x900000) (PC-98)
Kingston KNE-PC2, KNE-PCM/x Ethernet
Linksys EC2T/PCMPC100/PCM100, PCMLM56
Linksys EtherFast 10/100 PC Card, Combo PCMCIA Ethernet Card (PCMPC100 V2)
Logitec LAN-98T (flags 0xb00000) (PC-98)
MACNICA Ethernet ME1 for JEIDA
MACNICA ME98 (flags 0x900000) (PC-98)
MACNICA NE2098 (flags 0x400000) (PC-98)
MELCO EGY-98 (flags 0x300000) (PC-98)
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MELCO LGH-98, LGY-98, LGY-98-N (110pin), IND-SP, IND-SS (flags 0x400000) (PC-98)
MELCO LGY-PCI-TR
MELCO LPC-T/LPC2-T/LPC2-CLT/LPC2-TX/LPC3-TX/LPC3-CLX
NDC Ethernet Instant-Link
NEC PC-9801-77, PC-9801-78 (flags 0x910000) (PC-98)
NEC PC-9801-107, PC-9801-108 (flags 0x800000) (PC-98)
National Semiconductor InfoMover NE4100
NetGear FA-410TX
NetVin 5000
Network Everywhere Ethernet 10BaseT PC Card
Networld 98X3 (flags 0xd00000) (PC-98)
Networld EC-98X, EP-98X (flags 0xd10000) (PC-98)
Novell NE1000/NE2000/NE2100
PLANEX ENW-8300-T
PLANEX EN-2298-C (flags 0x200000) (PC-98)
PLANEX EN-2298P-T, EN-2298-T (flags 0x500000) (PC-98)
PLANEX FNW-3600-T
RealTek 8029
SMC Elite 16 WD8013
SMC Elite Ultra
SMC EtherEZ98 (flags 0x000000) (PC-98)
SMC WD8003E/WD8003EBT/WD8003S/WD8003SBT/WD8003W/WD8013EBT/WD8013W and
clones
Socket LP-E
Surecom EtherPerfect EP-427
Surecom NE-34
TDK LAK-CD031, Grey Cell GCS2000 Ethernet Card
Telecom Device SuperSocket RE450T
VIA VT86C926
Winbond W89C940
C-Bus, ISA, PCI and PC Card devices are supported.

Adapters supported by the rl driver include:

Accton ``Cheetah'' EN1207D (MPX 5030/5038; RealTek 8139 clone)
Allied Telesyn AT2550
Allied Telesyn AT2500TX
Belkin F5D5000
BUFFALO(Melco INC.) LPC-CB-CLX(CardBus)
Compaq HNE-300
CompUSA no-name 10/100 PCI Ethernet NIC
Corega FEther CB-TXD
Corega FEtherII CB-TXD
D-Link DFE-530TX+
D-Link DFE-538TX (same as 530+?)
D-Link DFE-690TXD
Edimax EP-4103DL CardBus
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Encore ENL832-TX 10/100 M PCI
Farallon NetLINE 10/100 PCI
Genius GF100TXR,
GigaFast Ethernet EE100-AXP
KTX-9130TX 10/100 Fast Ethernet
LevelOne FPC-0106TX
Longshine LCS-8038TX-R
NDC Communications NE100TX-E
Netronix Inc. EA-1210 NetEther 10/100
Nortel Networks 10/100BaseTX
OvisLink LEF-8129TX
OvisLink LEF-8139TX
Peppercon AG ROL-F
Planex FNW-3800-TX
SMC EZ Card 10/100 PCI 1211-TX
SOHO(PRAGMATIC) UE-1211C

The wb driver supports Winbond W89C840F based Fast Ethernet adapters and embedded controllers
including:

Trendware TE100-PCIE *
The vr driver supports VIA Technologies Rhine I, Rhine II, and Rhine III based Fast Ethernet adapters
including:

D-Link DFE530-TX
Hawking Technologies PN102TX
AOpen/Acer ALN-320

The sis driver supports Silicon Integrated Systems SiS 900 * and SiS 7016 * based Fast Ethernet adapters
and embedded controllers, as well as Fast Ethernet adapters based on the National Semiconductor
DP83815 (MacPhyter) chip. Supported adapters include:

@Nifty FNECHARD IFC USUP-TX
MELCO LGY-PCI-TXC
Netgear FA311-TX (DP83815)
Netgear FA312-TX (DP83815)
SiS 630, 635, and 735 motherboard chipsets

The nge driver supports National Semiconductor DP83820 * and DP83821 based Gigabit Ethernet adapters
including:

SMC EZ Card 1000 (SMC9462TX)
D-Link DGE-500T
Asante FriendlyNet GigaNIX 1000TA and 1000TPC
Addtron AEG320T
LinkSys EG1032 (32-bit PCI) and EG1064 (64-bit PCI)
Surecom Technology EP-320G-TX
Netgear GA622T
Netgear GA621
Ark PC SOHO-GA2500T (32-bit PCI) and SOHO-GA2000T (64-bit PCI)
Trendware TEG-PCITX (32-bit PCI) and TEG-PCITX2 (64-bit PCI)
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The ste driver supports Sundance Technologies ST201 based Fast Ethernet adapters and embedded
controllers including:

D-Link DFE-530TXS
D-Link DFE-550TX

Adapters supported by the sk driver include:

3COM 3C940 single port, 1000baseT adapter
Belkin F5D5005 single port, 1000baseT adapter
Linksys EG1032 single port, 1000baseT adapter
SK-9521 SK-NET GE-T single port, 1000baseT adapter
SK-9821 SK-NET GE-T single port, 1000baseT adapter *
SK-9822 SK-NET GE-T dual port, 1000baseT adapter *
SK-9841 SK-NET GE-LX single port, single mode fiber adapter *
SK-9842 SK-NET GE-LX dual port, single mode fiber adapter *
SK-9843 SK-NET GE-SX single port, multimode fiber adapter *
SK-9844 SK-NET GE-SX dual port, multimode fiber adapter *
SMC 9452TX single port, 1000baseT adapter

The tl driver supports Texas Instruments ThunderLAN based Ethernet and Fast Ethernet adapters including
a large number of Compaq PCI Ethernet adapters. Also supported are:

Olicom OC-2135/2138 10/100 TX UTP adapter
Olicom OC-2325/OC-2326 10/100 TX UTP adapter
Racore 8148 10baseT/100baseTX/100baseFX adapter
Racore 8165 10/100baseTX adapter
The tl driver also supports the built-in Ethernet adapters of various Compaq Prosignia servers and
Compaq Deskpro desktop machines including:

Compaq Netelligent 10
Compaq Netelligent 10 T PCI UTP/Coax
Compaq Netelligent 10/100
Compaq Netelligent 10/100 Dual-Port
Compaq Netelligent 10/100 Proliant
Compaq Netelligent 10/100 TX Embedded UTP
Compaq Netelligent 10/100 TX UTP
Compaq NetFlex 3P
Compaq NetFlex 3P Integrated
Compaq NetFlex 3P w/BNC

The dc driver provides support for the following chipsets: *

DEC/Intel 21143
ADMtek AL981 Comet, AN985 Centaur, ADM9511 Centaur II and ADM9513 Centaur II
ASIX Electronics AX88140A and AX88141
Conexant LANfinity RS7112 (miniPCI)
Davicom DM9009, DM9100, DM9102 and DM9102A
Lite-On 82c168 and 82c169 PNIC
Lite-On/Macronix 82c115 PNIC II
Macronix 98713, 98713A, 98715, 98715A, 98715AEC-C, 98725, 98727 and 98732
Xircom X3201 (cardbus only)



R-Studio Agent Emergency 365

© 2024 R-Tools Technology Inc.

The following NICs are known to work with the dc driver at this time:

3Com OfficeConnect 10/100B (ADMtek AN985 Centaur-P)
Abocom FE2500
Accton EN1217 (98715A)
Accton EN2242 MiniPCI
Adico AE310TX (98715A)
Alfa Inc GFC2204 (ASIX AX88140A)
Built in 10Mbps only Ethernet on Compaq Presario 7900 series desktops (21143, non-MII)
Built in DE500-BA on DEC Alpha workstations (21143, non-MII)
Built in Sun DMFE 10/100 Mbps Ethernet on Sun Netra X1 and Sun Fire V100 (DM9102A, MII)
Built in Ethernet on LinkSys EtherFast 10/100 Instant GigaDrive (DM9102, MII)
CNet Pro110B (ASIX AX88140A)
CNet Pro120A (98715A or 98713A) and CNet Pro120B (98715)
Compex RL100-TX (98713 or 98713A)
D-Link DFE-570TX (21143, MII, quad port)
Digital DE500-BA 10/100 (21143, non-MII)
ELECOM Laneed LD-CBL/TXA (ADMtek AN985)
Hawking CB102 CardBus
IBM EtherJet Cardbus Adapter
Intel PRO/100 Mobile Cardbus (versions that use the X3201 chipset)
Jaton XpressNet (Davicom DM9102)
Kingston KNE100TX (21143, MII)
Kingston KNE110TX (PNIC 82c169)
LinkSys LNE100TX (PNIC 82c168, 82c169)
LinkSys LNE100TX v2.0 (PNIC II 82c115)
LinkSys LNE100TX v4.0/4.1 (ADMtek AN985 Centaur-P)
Matrox FastNIC 10/100 (PNIC 82c168, 82c169)
Melco LGY-PCI-TXL
Microsoft MN-120 10/100 CardBus (ADMTek Centaur-C)
Microsoft MN-130 10/100 PCI (ADMTek Centaur-P)
NDC SOHOware SFA110A (98713A)
NDC SOHOware SFA110A Rev B4 (98715AEC-C)
NetGear FA310-TX Rev. D1, D2 or D3 (PNIC 82c169)
Netgear FA511
PlaneX FNW-3602-T (ADMtek AN985)
SMC EZ Card 10/100 1233A-TX (ADMtek AN985)
SVEC PN102-TX (98713)
Xircom Cardbus Realport
Xircom Cardbus Ethernet 10/100
Xircom Cardbus Ethernet II 10/100

Adapters supported by the aue driver include:

Abocom UFE1000, DSB650TX_NA
Accton USB320-EC, SpeedStream
ADMtek AN986, AN8511
Billionton USB100, USB100LP, USB100EL, USBE100
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Corega Ether FEther USB-T, FEther USB-TX, FEther USB-TXS
D-Link DSB-650, DSB-650TX, DSB-650TX-PNA
Elecom LD-USBL/TX
Elsa Microlink USB2Ethernet
HP hn210e
I-O Data USB ETTX
Kingston KNU101TX
LinkSys USB10T adapters that contain the AN986 Pegasus chipset, USB10TA, USB10TX, USB100TX,
USB100H1
MELCO LUA-TX, LUA2-TX
Planex UE-200TX
Sandberg USB to Network Link (model number 133-06)
Siemens Speedstream
SmartBridges smartNIC
SMC 2202USB
SOHOware NUB100

The cue driver supports CATC USB-EL1210A based USB Ethernet adapters including:

Belkin F5U011/F5U111
CATC Netmate
CATC Netmate II
SmartBridges SmartLink

The kue driver supports Kawasaki LSI KL5KLUSB101B based USB Ethernet adapters including:

3Com 3c19250
3Com 3c460 HomeConnect Ethernet USB Adapter
ADS Technologies USB-10BT
AOX USB101
ATen UC10T
Abocom URE 450
Corega USB-T
D-Link DSB-650C
Entrega NET-USB-E45, NET-HUB-3U1E
I/O Data USB ETT
Kawasaki DU-H3E
LinkSys USB10T
Netgear EA101
Peracom USB Ethernet Adapter
SMC 2102USB, 2104USB

The axe driver supports ASIX Electronics AX88172 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-U2-KTX
D-Link DUBE100
LinkSys USB200M
Netgear FA120
System TALKS Inc. SGC-X2UL
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The rue driver supports RealTek RTL8150 based USB Ethernet adapters including:

Buffalo (Melco Inc.) LUA-KTX
Green House GH-USB100B
LinkSys USB100M
Billionton 10/100 FastEthernet USBKR2

The udav driver supports the following adapters:

Corega FEther USB-TXC
Adapters supported by the de driver include: 

Adaptec ANA-6944/TX
Cogent EM100FX and EM440TX
Corega FastEther PCI-TX
D-Link DFE-500TX
DEC DE435, DE425, DEC DE450, and DEC DE500
ELECOM LD-PCI2T, LD-PCITS
I-O DATA LA2/T-PCI
SMC Etherpower 8432, 9332 and 9334
ZNYX ZX3xx

Controllers and cards supported by the fe driver include:

Allied Telesis RE1000, RE1000Plus, ME1500 (110-pin)
CONTEC C-NET(98)P2, C-NET (9N)E (110-pin), C-NET(9N)C (ExtCard)
CONTEC C-NET(PC)C PCMCIA Ethernet
Eiger Labs EPX-10BT
Fujitsu FMV-J182, FMV-J182A
Fujitsu MB86960A, MB86965A
Fujitsu MBH10303, MBH10302 Ethernet PCMCIA
Fujitsu Towa LA501 Ethernet
HITACHI HT-4840-11
NextCom J Link NC5310
RATOC REX-5588, REX-9822, REX-4886, and REX-R280
RATOC REX-9880/9881/9882/9883
TDK LAC-98012, LAC-98013, LAC-98025, LAC-9N011 (110-pin)
TDK LAK-CD021, LAK-CD021A, LAK-CD021BX
Ungermann-Bass Access/PC N98C+(PC85152, PC85142), Access/NOTE N98(PC86132) (110-pin)

Adapters supported by the fxp driver include:

Intel EtherExpress PRO/10
Intel InBusiness 10/100
Intel PRO/100B / EtherExpressPRO/100 B PCI Adapter *
Intel PRO/100+ Management Adapter
Intel PRO/100 VE Desktop Adapter
Intel PRO/100 M Desktop Adapter
Intel PRO/100 S Desktop, Server and Dual-Port Server Adapters
Contec C-NET(PI)-100TX (PC-98)
NEC PC-9821Ra20, Rv20, Xv13, Xv20 internal 100Base-TX (PC-98)
NEC PC-9821X-B06 (PC-98)
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Many on-board network interfaces on Intel motherboards
The ex driver supports the following Ethernet adapters:

Intel EtherExpress Pro/10
Intel EtherExpress Pro/10+
The Olicom OC2220

The ie driver provides supports the following 8 and 16bit ISA Ethernet cards that are based on the Intel
i82586 chip:

3COM 3C507
AT&T EN100
AT&T Starlan 10
AT&T Starlan Fiber
Intel EtherExpress 16
RACAL Interlan NI5210

The ep driver supports Ethernet adapters based on the 3Com 3C5x9 Etherlink III Parallel Tasking chipset,
including:

3Com 3C1 CF
3Com 3C509-TP, 3C509-BNC, 3C509-Combo, 3C509-TPO, 3C509-TPC ISA
3Com 3C509B-TP, 3C509B-BNC, 3C509B-Combo, 3C509B-TPO, 3C509B-TPC ISA
3Com 3C529, 3C529-TP MCA
3Com 3C562/3C563 PCMCIA
3Com 3C569B-J-TPO, 3C569B-J-COMBO CBUS
3Com 3C574-TX, 3CCFE574BT, 3CXFE574BT, 3C3FE574BT PCMCIA
3Com 3C579-TP, 3C579-BNC EISA
3Com 3C589, 3C589B, 3C589C, 3C589D, 3CXE589DT PCMCIA
3Com 3CCFEM556B, 3CCFEM556BI PCMCIA
3Com 3CXE589EC, 3CCE589EC, 3CXE589ET, 3CCE589ET PCMCIA
3Com Megahertz 3CCEM556, 3CXEM556, 3CCEM556B, 3CXEM556B PCMCIA
3Com OfficeConnect 3CXSH572BT, 3CCSH572BT PCMCIA
Farallon EtherMac PCMCIA

The el driver supports the 3Com 3c501 8bit ISA Ethernet card.

The xl driver supports the following hardware:

3Com 3c900-TPO *
3Com 3c900-COMBO *
3Com 3c905-TX *
3Com 3c905-T4 *
3Com 3c900B-TPO *
3Com 3c900B-TPC *
3Com 3c900B-FL *
3Com 3c900B-COMBO *
3Com 3c905B-T4 *
3Com 3c905B-TX *
3Com 3c905B-FX *
3Com 3c905B-COMBO *
3Com 3c905C-TX *
3Com 3c980, 3c980B, and 3c980C server adapters
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3Com 3cSOHO100-TX OfficeConnect adapters
3Com 3c450 HomeConnect adapters
3Com 3c555, 3c556 and 3c556B mini-PCI adapters
3Com 3C3SH573BT, 3C575TX, 3CCFE575BT, 3CXFE575BT, 3CCFE575CT, 3CXFE575CT,
3CCFEM656, 3CCFEM656B, and 3CCFEM656C, 3CXFEM656, 3CXFEM656B, and 3CXFEM656C
CardBus adapters
3Com 3c905-TX, 3c905B-TX 3c905C-TX, and 3c920B-EMB embedded adapters
Both the 3C656 family of CardBus cards and the 3C556 family of MiniPCI cards have a built-in proprietary
modem. Neither the xl driver nor any other driver supports this modem.

The vx driver supports the following cards:

3Com 3c590 EtherLink III PCI *
3Com 3c592 EtherLink III EISA
3Com 3c595 Fast EtherLink III PCI in 10 Mbps mode *
3Com 3c597 Fast EtherLink III EISA in 10 Mbps mode
Crystal Semiconductor CS89x0-based NICs (cs driver)

The sn driver supports SMC9xxx based ISA and PCMCIA cards including:

3Com Megahertz X-Jack Ethernet PC-Card CC-10BT
The xe driver supports the following cards:

Xircom CreditCard Ethernet (PS-CE2-10)
Xircom CreditCard Ethernet + Modem 28 (PS-CEM-28)
Xircom CreditCard Ethernet + Modem 33 (CEM33)
Xircom CreditCard 10/100 (CE3, CE3B)
Xircom CreditCard Ethernet 10/100 + Modem 56 (CEM56)
Xircom RealPort Ethernet 10 (RE10)
Xircom RealPort Ethernet 10/100 (RE100)
Xircom RealPort Ethernet 10/100 + Modem 56 (REM56, REM56G)
Accton Fast EtherCard-16 (EN2226)
Compaq Netelligent 10/100 PC Card (CPQ-10/100)
Intel EtherExpress Pro/100 PC Card Mobile Adapter 16 (Pro/100 M16A)
Other similar devices using the same hardware may also be supported.

Adapters supported by the lge driver include:

SMC TigerCard 1000 (SMC9462SX) *
D-Link DGE-500SX *

The txp driver supports the following cards:

3Com 3CR990-TX-95 *
3Com 3CR990-TX-97 *
3Com 3cR990B-TXM *
3Com 3CR990SVR95 *
3Com 3CR990SVR97 *
3Com 3cR990B-SRV *

The bge driver provides support for various NICs based on the Broadcom BCM570x family of Gigabit
Ethernet controller chips, including the following:

3Com 3c996-T (10/100/1000baseTX) *
Dell PowerEdge 1750 integrated BCM5704C NIC (10/100/1000baseTX) *
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Dell PowerEdge 2550 integrated BCM5700 NIC (10/100/1000baseTX) *
Dell PowerEdge 2650 integrated BCM5703 NIC (10/100/1000baseTX) *
IBM x235 server integrated BCM5703x NIC (10/100/1000baseTX) *
HP ProLiant NC7760 embedded Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7770 PCI-X Gigabit NIC (10/100/1000baseTX) *
HP ProLiant NC7781 embedded PCI-X Gigabit NIC (10/100/1000baseTX) *
Netgear GA302T (10/100/1000baseTX) *
SysKonnect SK-9D21 (10/100/1000baseTX) *
SysKonnect SK-9D41 (1000baseSX) *

The em driver supports Gigabit Ethernet adapters based on the Intel 82540, 82541PI, 82542, 82543, 82544,
82546, 82546EB and 82547 controller chips: 

Intel PRO/1000 CT Network Connection (82547)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 Gigabit Server Adapter (82542)*
Intel PRO/1000 GT Desktop Adapter (82541PI)
Intel PRO/1000 MF Dual Port Server Adapter (82546)
Intel PRO/1000 MF Server Adapter (82545)
Intel PRO/1000 MF Server Adapter (LX) (82545)
Intel PRO/1000 MT Desktop Adapter (82540)
Intel PRO/1000 MT Desktop Adapter (82541)
Intel PRO/1000 MT Dual Port Server Adapter (82546)
Intel PRO/1000 MT Quad Port Server Adapter (82546EB)
Intel PRO/1000 MT Server Adapter (82545)
Intel PRO/1000 T Desktop Adapter (82544)
Intel PRO/1000 T Server Adapter (82543)
Intel PRO/1000 XF Server Adapter (82544)
Intel PRO/1000 XT Server Adapter (82544)

The gx driver supports Gigabit Ethernet adapters based on the Intel 82542 and 82543 controller chips:

Intel PRO/1000 Gigabit Server Adapter (82542)
Intel PRO/1000 F Server Adapter (82543)
Intel PRO/1000 T Server Adapter (82543)

The hme driver supports the on-board Ethernet interfaces of many Sun UltraSPARC workstation and server
models. Cards supported by the hme driver include:

Sun PCI SunSwift Adapter
Sun SBus SunSwift Adapter ``( hme'' and ``SUNW,hme'')
Sun PCI Sun100BaseT Adapter 2.0
Sun SBus Sun100BaseT 2.0
Sun PCI Quad FastEthernet Controller
Sun SBus Quad FastEthernet Controller

The my driver provides support for various NICs based on the Myson chipset. Supported models include:

Myson MTD800 PCI Fast Ethernet chip
Myson MTD803 PCI Fast Ethernet chip
Myson MTD89X PCI Gigabit Ethernet chip
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Broadcom BCM4401 based Fast Ethernet adapters (bfe driver) *

The re driver supports RealTek RTL8139C+, RTL8169, RTL8169S and RTL8110S based Fast Ethernet and
Gigabit Ethernet adapters including:

Alloy Computer Products EtherGOLD 1439E 10/100 (8139C+) *
Compaq Evo N1015v Integrated Ethernet (8139C+) *
Corega CG-LAPCIGT Gigabit Ethernet (8169S) *
Gigabyte 7N400 Pro2 Integrated Gigabit Ethernet (8110S) *
PLANEX COMMUNICATIONS Inc. GN-1200TC (8169S) *
Xterasys XN-152 10/100/1000 NIC (8169) *

The ixgb driver supports the following cards: 

Intel PRO/10GbE LR Server Adapter *
Intel PRO/10GbE SR Server Adapter *
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